An Electronic Mail System
for Microsoft Windows Systems

User Manual for Pegasus Mail Version 4
Copyright and Licensing Information

This manual, the Pegasus Mail Logo and all accompanying software and documentation are all Copyright (c) 1990-2008, David Harris, All Rights Reserved. No part of this manual or any extract from any supporting document (for example, the Pegasus Mail help file) may be reproduced electronically or by any other means without express written permission of the copyright owner.

If you have questions about the licensing terms covering this manual, or if you wish to report a breach of our licensing terms, please e-mail us at orders@pmail.gen.nz.

Colophon

This manual was prepared using Adobe FrameMaker 7, and converted to Adobe Portable Document Format (PDF) using Adobe Distiller 5.0. For fonts, it uses Arial and Times New Roman, a boring, but easily-legible and widely-available combination of typefaces.
Contents

1: Introduction .................................................. 10
   What is electronic mail? ...................................(10
   Terms and concepts ..................................... 10

2: Installing Pegasus Mail ................................... 12
   System requirements .................................... 12
   Installation ............................................... 12
   Installing Pegasus Mail on a Memory Stick .......... 13
   Preconfiguring a user mailbox ......................... 13
   Running Pegasus Mail for the first time ............ 13
   Command-line switches .................................. 14
   Accessing the Internet using Pegasus Mail ........... 15
   WinPMail, NetWare and the Microsoft Requester ... 16

3: Getting started ............................................ 17
   Running the program .................................... 17
   Now what? ................................................. 17
   Interface basics ........................................ 18
      Windows ................................................ 18
      Drag and drop ........................................ 18
      The Button Panel (also called the “main toolbar”) . 19
         Customizing the button panel ................. 20
      The floating menu ................................... 20
      The StatusBar and WindowBar ..................... 20
   Working with multiple file servers .................... 21

4: Sending Messages ......................................... 23
   Creating a new message ................................ 23
   Addressing your message ................................ 23
      Distribution (Mailing) Lists ....................... 24
      Address books ....................................... 24
      Aliases .............................................. 24
      The Addressing Centre .......................... 24
      Address completion ............................... 25
   Message options ....................................... 25
   Encryption .............................................. 27
   The Message menu ..................................... 28
   Right-clicking in a message ........................... 29
   Using styled text, pictures and formatting in messages . 30
      Basic formatting .................................... 30
      Tables ................................................ 31
      Pictures ............................................. 31
      Hyperlinks .......................................... 31
   Special message options .............................. 32
   Editor settings ....................................... 33
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom headers for this message</td>
<td>33</td>
</tr>
<tr>
<td>Sticky settings and default settings</td>
<td>33</td>
</tr>
<tr>
<td>Checking your spelling</td>
<td>33</td>
</tr>
<tr>
<td>The Glossary</td>
<td>34</td>
</tr>
<tr>
<td>Adding attachments</td>
<td>35</td>
</tr>
<tr>
<td>Working with attachments</td>
<td>37</td>
</tr>
<tr>
<td>How Pegasus Mail decides on encoding</td>
<td>37</td>
</tr>
<tr>
<td>Attaching other mail messages to a message</td>
<td>38</td>
</tr>
<tr>
<td>Extensions and Message Templates</td>
<td>38</td>
</tr>
<tr>
<td>Supported address types</td>
<td>38</td>
</tr>
<tr>
<td>Local user addresses</td>
<td>38</td>
</tr>
<tr>
<td>User groups</td>
<td>39</td>
</tr>
<tr>
<td>Internet addresses</td>
<td>39</td>
</tr>
<tr>
<td>NetWare MHS addresses</td>
<td>40</td>
</tr>
<tr>
<td>User-defined gateways</td>
<td>40</td>
</tr>
<tr>
<td>Address overrides</td>
<td>40</td>
</tr>
<tr>
<td>Mail Merge</td>
<td>41</td>
</tr>
<tr>
<td>Before you start - don't spam!</td>
<td>41</td>
</tr>
<tr>
<td>Terminology - Records and Fields</td>
<td>41</td>
</tr>
<tr>
<td>Messages and data files</td>
<td>41</td>
</tr>
<tr>
<td>Field numbers and names</td>
<td>42</td>
</tr>
<tr>
<td>Setting up a merge</td>
<td>43</td>
</tr>
<tr>
<td>Quick setup</td>
<td>43</td>
</tr>
<tr>
<td>Dry runs - testing your merge</td>
<td>43</td>
</tr>
<tr>
<td>Attachments</td>
<td>43</td>
</tr>
<tr>
<td>Merging and rich text messages</td>
<td>44</td>
</tr>
<tr>
<td>Limits</td>
<td>44</td>
</tr>
<tr>
<td>Things to watch out for</td>
<td>44</td>
</tr>
<tr>
<td>5: Reading and filing your mail.</td>
<td>46</td>
</tr>
<tr>
<td>Mail folders and trays</td>
<td>46</td>
</tr>
<tr>
<td>The Folder Manager window</td>
<td>46</td>
</tr>
<tr>
<td>Preview mode and “Classic” mode</td>
<td>46</td>
</tr>
<tr>
<td>Working with your folders</td>
<td>47</td>
</tr>
<tr>
<td>Navigating within folders and messages in preview mode</td>
<td>47</td>
</tr>
<tr>
<td>The Folders menu</td>
<td>48</td>
</tr>
<tr>
<td>Right-clicking in the list of folders</td>
<td>48</td>
</tr>
<tr>
<td>Accessing multiple mailboxes</td>
<td>48</td>
</tr>
<tr>
<td>Searching for text in your folders</td>
<td>49</td>
</tr>
<tr>
<td>Entering the text for which you want to search</td>
<td>49</td>
</tr>
<tr>
<td>Other search options</td>
<td>50</td>
</tr>
<tr>
<td>Specifying where to search</td>
<td>50</td>
</tr>
<tr>
<td>Specifying search constraints</td>
<td>51</td>
</tr>
<tr>
<td>Working with search results</td>
<td>52</td>
</tr>
<tr>
<td>Saving and loading searches</td>
<td>52</td>
</tr>
<tr>
<td>The Folder Browser</td>
<td>52</td>
</tr>
<tr>
<td>Message status indicators (folder view)</td>
<td>53</td>
</tr>
<tr>
<td>Working with messages</td>
<td>53</td>
</tr>
<tr>
<td>Replying to messages</td>
<td>54</td>
</tr>
<tr>
<td>Forwarding mail</td>
<td>56</td>
</tr>
</tbody>
</table>
Incremental search through a folder’s messages .................. 58
Selecting messages .............................................. 58
Quick-select ..................................................... 59
Grouped views .................................................. 59
The Folder menu ............................................... 61
Right-clicking within a folder .................................... 63
Re-sending a copy-to-self message ................................. 63
Reading messages ............................................... 64
Message status indicators in the reader ......................... 64
Hyperlinks and URLs (World Wide Web links) ................. 65
Working with attachments ...................................... 65
Previewing, opening and saving attachments ................. 66
Deleting attachments ............................................ 66
Replying to, and forwarding attachments ...................... 66
Annotations ....................................................... 67
Viewing the raw version of the message ....................... 67
The Reader menu ............................................... 67
Right-clicking while reading a message ......................... 68
Digests ............................................................. 70
Copying text from a message .................................. 71

6: Mail and Spam Filtering ..................................... 72
General-purpose rule-based mail filtering ....................... 72
Using the Filtering Rule Wizard .................................. 72
Using the Full Filtering Rule Editor ............................ 73
Advanced rule processing options ............................. 78
Flow Control ..................................................... 78
Creating logical operations in your rule sets ................. 79
Content Control ............................................... 80
How it works ..................................................... 81
Using the Content control dialog .............................. 81
Editing a Content Control definition .......................... 82
The General Page .............................................. 82
The Exceptions Page ........................................... 83
The Message Tests Page ....................................... 83
The Actions Page .............................................. 84
Header addition and advanced options ..................... 85
Pegasus Mail’s Content Control Filtering Language ........ 85
The types of test ............................................... 86
General layout .................................................. 88
Making the most of regular expressions ..................... 89
Matching anywhere within the text .......................... 90
Spamhalter ....................................................... 91
Spamhalter vs Content Control .................................. 91
Getting started with Spamhalter .............................. 91
Basic operation ............................................... 92
Status indication .............................................. 92
Sorting and grouped views ................................... 92
Using Spamhalter and Content Control together .......... 92
Copyright information ......................................... 92
Copies to self (outbox) .................................................. 115
Copy-to-self filtering .................................................. 116
Encryption ............................................................. 116
Sending mail .......................................................... 116
  When sending messages containing rich (formatted) text ..... 117
  Advanced settings ................................................. 117
Incoming mail .......................................................... 118
  Preview mode settings ......................................... 118
  Folder behaviours .............................................. 119
  Message reader ................................................. 120
  Content viewers ............................................... 122
  Configuration files affecting content viewers .............. 123
Hyperlinks ............................................................ 123
User interface ........................................................ 124
  List Displays .................................................. 124
  Toolbars ....................................................... 125
  Reporting/Logging ........................................... 125
    New mail reporting ...................................... 125
    System messages and logging ......................... 125
  Automatic formatting ...................................... 126
  Automatic formatting features ......................... 126
  Autoreplacement .............................................. 126
NetWare MHS/SMF settings ...................................... 127

12: Using Pegasus Mail on the Internet ....................... 129
  What you need to use Pegasus Mail on the Internet ..... 129
  Online and offline modes ................................... 130
Configuring Pegasus Mail for TCP/IP mail .................. 130
  General ........................................................ 130
  Receiving (POP3) Mail ...................................... 131
    Polling controls: ........................................ 131
    Multiple identity controls ............................ 132
  Editing a POP3 definition .................................. 132
    The “General” Page .................................. 132
    The “Security” Page .................................. 134
    The “Download Controls” page .................... 134
  Server-side mail filtering .................................. 135
  Sending (SMTP) mail ......................................... 136
    Settings controlling the way mail is sent ............ 136
  Editing an SMTP definition ................................ 137
    The “General” page .................................. 137
    The “Security” Page .................................. 138
    SMTP Authentication ................................... 138
  Dialling .......................................................... 138
SSL/TLS - Secure mail connections ......................... 139
  What the various controls mean ............................ 140
  Server certificate fingerprint tracking ................... 140
  Suppressing certificate verification ..................... 141
  Selective download of mail .................................. 141
  MultiPOP ..................................................... 142
13: IMAP4, accessing remote mailboxes .......................... 143
   Defining an IMAP profile ........................................... 143
   The “Connection” Page ............................................ 143
   The “Settings” Page ............................................... 144
       Deleted message handling ................................... 144
   The “Performance” Page .......................................... 145
       Connection management ....................................... 145
       Folder status handling ...................................... 145
       Folder list handling .......................................... 146
   The “Security” Page ................................................ 147
   Accessing an IMAP Mailbox ....................................... 147
   Using an IMAP profile Off-line .................................. 147
   Restrictions when using IMAP ................................... 148
   IMAP troubleshooting ............................................. 148
       Local issues .................................................... 148
       Remote issues ................................................. 149

14: Multiple Identities ................................. 150
   Using identities in your mail messages ...................... 150
   Attaching identities to folders ............................... 151

15: Extensions (“Plugins”) ............................... 152
   Telephone message ................................................. 152
   Mail Merge .......................................................... 152
   Business Cards ..................................................... 152
   LDAP directory service lookup ................................ 153

16: Message templates ................................. 154
   The two types of message template ......................... 154
   Using message templates to create mail ..................... 154
   Creating templates using the template editor ............. 155
   The template script language - general reference ....... 155
       String literals and filenames ............................. 155
       Optional or omitted parameters ......................... 156
       Textual substitutions ...................................... 156
   Example: ............................................................. 157
   The template script language - command summary ........ 157
       The TITLE command ........................................... 157
       The HELPFILE command ...................................... 157
       The STRING command - declaring variables .......... 157
       Creating list variables using the STRING command .. 158
   Using the SET command to set message fields ............ 158
   Using the SET command to assign values to variables ... 159
   The INSERT command - add data to a message ............ 159
   The BODY/ENDBODY commands - insert a block of text into the message 159
   The INCLUDE command - include a file or the reply body 159
   The ATTACH command - attach a file to the message .... 160
   The PICTURE command - add a picture to a template's prompt dialog 160
1: Introduction

What is electronic mail?

Electronic mail is simply the process of sending information from one computer to another. The information is normally just text, but can also be word-processor files, spreadsheets or even graphics from drawing programs. Electronic mail is based on a principle known as “store and forward” — that is, if the addressee is not there when you send the message, the message is stored until he is, at which time it is passed on (or “forwarded”) to him. Where Internet Messaging services like ICQ and AOL’s “Instant Messenger” are the Internet-era equivalents of the telephone, electronic mail is the Internet-era equivalent of the letter — electronic mail is much faster and cheaper than traditional paper mail, yet it still has the advantage of allowing recipients to handle it at a time that suits them best. Most people quickly become addicted to electronic mail (or e-mail, as it is often called), particularly international e-mail, because it is such an easy way of distributing information efficiently and quickly.

There are many ways of sending and receiving electronic mail: one popular method, for example, is using a web-based mail service like Hotmail... But if you want to get the greatest possible power, speed and flexibility in handling your e-mail, your best approach is always to install a dedicated e-mail package (also called a “client”) on your computer at home. Pegasus Mail is such a client, and this manual will help you to get the greatest ease of use and effectiveness from it.

Pegasus Mail is an electronic mail system for use on single PCs and on supported Local Area Networks such as Novell NetWare. It is designed to be as easy as possible to use, without sacrificing any power or functionality. While there are versions of Pegasus Mail for other computer systems, this manual describes the version designed specially for Microsoft Windows. The Windows version of Pegasus Mail has served the Internet community since 1993, and for historical reasons is often called “WinPMail” — we will use this “familiar name” for it in most places within this manual. With WinPMail you can send mail to users running other versions of Pegasus Mail, and via message transports such as SMTP, to users all around the world.

Terms and concepts

Throughout this manual, we will use certain conventions and terms to describe operations or features:

< F10 > Anything set in angle brackets is a single key you should press: so this example tells you to press Function Key 10. < R > would mean to press the ‘ R ’ key.

Field A field is an area of the screen where the program expects you to enter text; fields appear as outlined white areas on the screen, and when they are active, will contain a flashing bar (the cursor). Only one field is ever active on the screen at a time: you can move to the next field by pressing the < Tab > key, or to the previous field by holding the < Shift > key and pressing < Tab >. While editing the text in a field, you can correct mistakes using the < Backspace > key or the arrow keys.

Filename From time to time, Pegasus Mail might ask you for a filename, usually when you need to save information to a diskette or when retrieving information. Because of constraints imposed by the MS-Windows file system, there are certain restrictions on the characters you can use in the names you give your files - in particular, you cannot use the characters ‘|’, ‘\’, or ‘ : ’ in a filename, and you should avoid using the character ‘ ~ ’ if at
all possible. Pegasus Mail will usually allow you to specify a file in another directory using either the usual DOS path syntax (\d:\path\filename.ext), or the so-called UNC Format (\SERVER\VOL\PATH\NAME). You can use long filenames in most places in the program where you are asked for a filename — any exceptions to this rule are specifically noted where they apply in this manual.

Headers  Electronic mail messages are divided into two parts: headers and message body: the headers are special lines at the start of the message, which are formatted so that both you and the computer can read and make sense of them. Examples of headers are the To: field, specifying the addressee, and the Subject: field, which describes briefly the contents of the message. The message body is meaningful only to people — the computer will not usually attempt to interpret it. In this manual, we use the term header to mean any of the special machine-readable fields at the start of the message.

Attachments  As well as having a body part, an e-mail message can also have attachments, or files that are included with the body as part of the message. In this manual, we don’t make any specific distinction between attachments in mail you receive, and attachments to the messages you send — we assume that any differences will be obvious from the context in which the term is used.

Menu  A menu is a list of options from which you can choose an action. Pegasus Mail is menu-driven — that is, you control it by choosing what you want to do next from a menu. To choose a menu option you can either click the mouse in the Menu Bar at the top of the Pegasus Mail window, or press the <Alt> key then move the selector to the item you want and press <Enter>: the menu will open and you can choose any item by clicking it, or by scrolling the selection bar to it using the arrow keys and pressing <Enter>. Some menu options will show either an arrow or a keystroke at the right of the menu window. An arrow means that there is another menu “below” the selection, which can be opened by selecting it. If a keystroke appears at the right of a menu entry, it is called an accelerator (also called a hotkey) for that entry, which means that you can activate the menu choice without opening the menu, simply by pressing the key. As an example you can press <Ctrl+N> (hold down the <Ctrl> key and press N) anywhere in Pegasus Mail to start a new message.
2: Installing Pegasus Mail

System requirements

To run Pegasus Mail for Windows, you need a computer configured as follows:

- Microsoft Windows 98, ME, 2000, XP or NT4. Windows 95 is not supported.

- Around 7MB free disk space for the program, as well as whatever space is required to store mail as you use it. Over time your mailbox can become very large — we recommend that you install Pegasus Mail on a volume that has at least 500MB available at all times.

- 8MB RAM over and above the basic requirements of the Windows operating system. In practical terms, this means a minimum of 16MB on Windows 98, 32MB on Windows ME, 64MB on Windows NT4, or 128MB on all other versions of Windows.

- A properly-configured Internet connection. This can be any type of Internet connection supported by Windows, including ADSL and Cable modem connections, LAN connections and conventional modems. An Internet connection is only required if you plan to send Internet mail — it is quite possible to use Pegasus Mail without an Internet connection to send mail between users on a Local Area Network (LAN).

- Pegasus Mail has built-in support for Novell NetWare Local Area Networks: to use this support, you must be running a version of Novell NetWare later than v3.12 and be running a genuine Novell workstation client package on your computer — Pegasus Mail cannot use Microsoft’s NetWare client software because the Microsoft software does not properly support Novell’s interfaces. Pegasus Mail has separate modules providing specific support for Novell NDS systems and for older NetWare bindery-based systems.

Installation

To install Pegasus Mail simply run the W32-XXX.EXE distribution file (where XXX are three digits representing the version of Pegasus Mail). This file is a self-extracting installer - when you run it, it will launch straight into a conventional Windows installation procedure, which should be quite familiar. To run W32-XXX.EXE, either double-click it in a Windows Explorer or My Computer listing, or else click the Start button on the taskbar, then enter d:\path\W32-XXX.EXE, replacing d:\path with the name of the directory where W32-XXX.EXE is located. The setup program will ask you a couple of simple questions, including where you would like it to install Pegasus Mail. You can install Pegasus Mail anywhere, but we recommend that you accept the default it suggests. The installer will also give you the opportunity to create shortcuts for Pegasus Mail – we strongly recommend that you do this.

Using the Program Files directory  By default, Pegasus Mail does not suggest installing itself into the standard Windows Program Files directory structure, because Microsoft are quite specific that programs and data should not be mixed, and Pegasus Mail’s multi-user operating modes make a number of assumptions about where data can be found. There is no reason, however, why you cannot install Pegasus Mail in Program Files if you wish. In most cases, it will not significantly affect either the operation of the program or of your system. If you are unsure, though, we recommend that you accept the default installation directory, since this is guaranteed to work correctly.
If you have previously installed a copy of Pegasus Mail on your computer, the setup program will detect this and will offer to upgrade the old version for you. If you update your installation in this way, the new version of Pegasus Mail will use all your existing mail settings, folders, addressbooks and other files. If you would prefer to run both the new and old version in parallel for a while, you can perform a fresh install using Setup, then copy the file PMAIL.CFG from the old version’s directory to the new location – this will allow both versions to access your mailbox.

To install Pegasus Mail on a Network system such as Novell NetWare, follow the instructions in the Pegasus Mail Administrator’s Guide (supplied with Network-licensed copies of the manual). Configuring Pegasus Mail to use LAN-based services such as the Mercury SMTP mail transport is done using Pegasus Mail’s PCONFIG program, or if you are running in NDS mode, using the NCONFIG program supplied with Pegasus Mail.

**Installing Pegasus Mail on a Memory Stick**

Pegasus Mail can be installed onto a memory stick, in a way that allows you to take the memory stick to any computer, plug it in, and have full access to the program and your mail. Doing this requires the use of a special commandline switch that turns on Pegasus Mail’s Roaming Mode (see below for more on commandline switches). The Pegasus Mail installer automatically supplies this switch, so all you need to do if you want to install Pegasus Mail on a memory stick is to select the memory stick as the installer destination.

**Preconfiguring a user mailbox**

By default, Pegasus Mail’s installer will create a simplified installation for you. A multi-user system will be automatically built, with a single user called **Admin** created automatically: when you run your copy of Pegasus Mail, it will automatically log you in as the Admin user until such time as you create any other users. When this installation mode is used, the Pegasus Mail program files will be stored in a directory called **Programs** in the directory where you install the program, while user mail data (organized as “mailboxes”) will be stored in a directory called **Mail** in the same location.

Using a preconfigured mailbox is an easy way of getting going with the program in the shortest possible time, and makes it easy to expand the program with other users later if you wish. If, however, you have some reason for not preconfiguring a mailbox, uncheck the option in the installer, and follow the instructions in the next section, Running Pegasus Mail for the first time.

**Running Pegasus Mail for the first time**

If you did not install Pegasus Mail’s special support for the Novell NetWare Local Area Network system and chose not to have the installer preconfigure a user mailbox for you (see above), then the first time you run WinPMail it will ask you to choose from three different operating modes – single-user, multi-user and network. The choice you should make depends on how you intend to use the program:

- If there will only ever be one Pegasus Mail user on your machine and if you only have one mail account, you should select **single-user mode**. While this is the simplest operating mode, we no longer recommend that people use it as a general rule, because it makes it considerably harder to convert to a multi-user setup at a later stage. Generally, even if
you are only a single user, you are better-advised to select one of the Multi-user modes shown below.

- If you want to have more than one person using Pegasus Mail on your machine and for each person to have their own separate mail folders and address books, choose multi-user mode. There is a basic assumption in this operating mode that all the users will run Pegasus Mail on the same computer. This is the operating mode that the Pegasus Mail installer chooses automatically when you tell it to preconfigure a user mailbox for you.

- If you have a local-area network other than Novell NetWare, you should click on Network mode. In network mode, Pegasus Mail assumes that each mail user will be running Pegasus Mail on a different machine but that all users will have access to a common shared volume on your network.

If you select either multi-user or network modes, Pegasus Mail will ask you to supply a mailbox location: you should enter a directory in which Pegasus Mail can find or create a subdirectory for each mail user. In network mode, you must specify a path to a directory on the shared volume, and all users must be able to access that path from their machines. Once you have entered the path (which need not exist – Pegasus Mail will create it as required), Pegasus Mail will permit you to create mail users on the system. There are two types of user – normal users and administrative users. Administrative users may create, remove and rename other users via the Manage users... option on the Addresses menu. You must always specify at least one administrative user.

If you select single-user mode, Pegasus Mail will simply ask you for a directory where your mail files should be created: enter any valid directory name on your system – Pegasus Mail will create it if necessary.

If you intend to use Pegasus Mail’s built-in Internet mail capabilities and have properly-installed the Windows TCP/IP networking protocol on your system, the first time you run Pegasus Mail it will ask you if you wish to configure it to handle your Internet mail. If you answer yes, the Internet Setup Wizard process will run: this is a series of simple dialogs in which you type basic information such as your address and the host where Pegasus Mail should find your mail – your service provider or Network Manager will be able to provide you with this information if you do not know it. You can review this information at any time by choosing the Internet Options option from the Tools menu.(see the section at the end of this manual for more detailed information on setting up WinPMail’s built-in Internet mail services).

Command-line switches

There are four commandline switches that may be commonly used in the shortcut item you create (see Appendix A for a full list of switches). To change the commandline switches for WinPMail, click once on the icon you use to run the program, then press <Alt+Enter>. This will open the Properties window for that icon: the commandline is on the Shortcut page and is called Target. When adding switches to the commandline, make sure there is a space before and after each switch except the last one.
Accessing the Internet using Pegasus Mail

WinPMail can send and receive mail from the Internet directly using the standard Microsoft Windows networking facilities. If Pegasus Mail detects that Internet services have been installed on your system, it will automatically add extra options to your File menu providing access to its features. If you do not want Pegasus Mail to take advantage of your system’s Internet services, either select the radio button labelled Never in the Load Windows Internet Services box in the Advanced settings page of the Options dialog on the Tools menu, or add the flag “-z 1” to the commandline you use to run WinPMail. If Pegasus Mail detects Internet Services on your system the first time it runs, it will automatically open a dialog offer-
WinPMail, NetWare and the Microsoft Requester

WinPMail is extremely NetWare-aware, and takes advantage of services provided by the Novell NetWare server when run in that environment. If you have a Novell NetWare file server, you may be connecting to it using a Microsoft-supplied network component called a requester — this is the piece of software that provides the interface between your workstation and the file server. The Microsoft requester software supplied with Microsoft Windows will only work with 16-bit applications: Microsoft did not produce a 32-bit interface for this software, so 32-bit programs, such as the 32-bit version of Pegasus Mail, cannot use it. If you wish to use the Microsoft requester software, you must use the 16-bit version of Pegasus Mail: alternatively, you can upgrade to a genuine Novell requester package (such as the Novell Client/32 or ZenWorks workstation software), which will allow you to use the 32-bit version of Pegasus Mail in full NetWare mode.
3: Getting started

The early stages of using any new program, especially a large, and powerful program like Pegasus Mail, can be a little intimidating: this chapter is intended to ease you into using the program gently.

Running the program

During the installation process, the Pegasus Mail installer should have created some shortcuts in your Windows “Start” menu — you can find these shortcuts in a start group called “Pegasus Mail for Windows”. By default, the installer should also have set up Pegasus Mail as your system mail program, which means that under Windows XP, Pegasus Mail should appear pre-selected as the E-mail option on the Start menu.

To run the program, simply click the Windows Start menu button: if Pegasus Mail is set up as your system mailer, just click the E-mail option; otherwise, follow the All programs menu, select the Pegasus Mail for Windows group, and choose the Pegasus Mail for Windows item. Windows will load Pegasus Mail into memory, and it will put up its “splash screen”, a picture of a Pegasus flying in a cloudy blue sky. Depending on how you installed the program, it may ask you for your username as part of its startup process: simply enter the username you gave when you created your account the first time you ran the program. In the Novell NetWare environment, Pegasus Mail knows who you are automatically (it asks the NetWare network for this information) and will go to your mailbox directly without asking you for a username.

If you do not want Pegasus Mail to prompt you for your username each time it runs, you can provide your username on the commandline: simply edit the Windows shortcut for the program, locate the field called Target, then after winpm-32.exe, type a single space followed by the characters “-i <username>”, replacing <username> with your username.

Now what?

OK, the program is running now. What do I do from here?

Working with your mail is what this manual is all about, and all the text following this point is designed to help you to get the best use out of Pegasus Mail. To get you started, though, here are a few basic things you can do to explore the program at this point:

- **To send a mail message** Press <Ctrl+N> to start a new mail message
- **To read any new mail you have** Press <Ctrl+W> to open your new mail folder. The first time you run the program, you may find some sample new mail messages in your new mail folder — these are put there by Pegasus Mail, and you can use them to familiarize yourself with reading messages.
- **To work with your mail folders** Press <Ctrl+L> to work with your folders. The first time you run Pegasus Mail, it will automatically create some basic folders for you, but you can create other folders any time you wish.
- **To work with your addressbooks** Press the <F3> key.

The first three of these options can also be found on the File menu, and the <F3> option appears on the Addresses menu.
If you are using Pegasus Mail to access the Internet, the following three things are also basic operations:

- **To retrieve mail from your POP3 mailbox**, click the Retrieve mail button, or select Check host for new mail from the File menu.

- **To send messages you have prepared**, click the Send mail button, or select Send all queued mail from the File menu.

- **To preview the contents of your POP3 mailbox** without actually downloading the messages, choose Selective mail download from the File menu.

### Interface basics

Pegasus Mail follows all the usual conventions for MS-Windows applications so if you’ve used other Windows programs you should have few problems using it. Pegasus Mail is an MDI (Multiple Document Interface) application, which means that all the windows you open in Pegasus Mail share a common main window on the screen (called the Frame window). When you close, maximize or minimize the Frame window, all other windows in Pegasus Mail are affected as well.

### Windows

All windows in Pegasus Mail have some common features:

- **System menu** The small box at the extreme top left of a window is known as the System Menu. When you click on this box a menu offering a number of choices will appear. You can also double-click on this box to indicate that you want to close the window.

- **Minimize/Maximize/Close buttons** At the extreme top right-hand corner of most Pegasus Mail windows you will see three buttons — these are the standard Windows buttons for manipulating a window. The leftmost button (a single underline) is the Minimize button — it reduces the Window to a small title bar and puts it at the bottom of the Pegasus Mail workspace. Minimizing a window is a handy way of putting it to one side so it’s not in your way without closing it. The middle button, with a picture of two overlapped windows, is the Maximize button; clicking on it will take the window to the full size of the screen or will reduce the window to its original size. The rightmost button, with the cross, is the Close button — clicking this button will close the window completely.

- **Scroll bars** Many windows in Pegasus Mail will display Scroll Bars at the right and bottom edges. A scroll bar is used to scroll the contents of a window into view. Clicking on the arrow at either end of the scroll bar moves the display by one line; clicking in the grey area on either side of the Thumb (the grey box in the scroll bar) moves the display by a screen in that direction. You can also click on the thumb and drag it to a location to perform larger movements.

- **Resizing windows** Most of the windows in Pegasus Mail can be resized — that is, you can alter the window’s size to suit your preference. To resize a window, use the mouse to move the cursor to the lower right-hand corner of the window frame, and it will turn into a two-pointed arrow. Hold the mouse button down and drag the window to the size you want it to be.

- **Cut, copy and paste** You can press Ctrl+C to copy selected text, Ctrl+X to cut selected text or Ctrl+V to paste text at the insertion point in the current field.

### Drag and drop

Pegasus Mail makes extensive use of drag and drop, or the process where you pick something up in one part of the program using the mouse, and “drop” it by releasing the mouse
button in the place where you want it to go. As an example, you can move a message from one folder to another by clicking on it, then dragging it to the destination folder before releasing the mouse button. When you drag an item, the cursor changes to a drag outline while the operation is in progress.

Alternate actions: many drag and drop operations can have two separate logical meanings – for instance, when you drag a message to another folder, you might want to move the message, but you might equally want to copy it instead: where two such possible actions exist, Pegasus Mail assumes the most usual action by default, but allows you to specify the alternate action by holding down the <Alt> key when you release the mouse button. For example, when dragging messages from one folder to another, the most intuitive action is to move the message, but you can ask Pegasus Mail to copy the message by holding down the <Alt> key. Similarly, when dragging an address book entry from one book to another, the most intuitive action is usually to copy the entry, but once again you can ask Pegasus Mail to move the entry by holding down <Alt>. In situations like this where there is an alternate action, the drag cursor will contain a ‘+’ character if the operation will result in the entry being copied, and a ‘-’ character if it will result in the entry being moved to the new location. Operations that do not have an alternate action will display a plain drag cursor.

The Button Panel (also called the “main toolbar”)

In Pegasus Mail, most windows have their own groups of buttons arranged in a fixed toolbar just below the title: these toolbars provide easy access to functions which are specific to the window itself – for instance, the message reader window has a Print button which will cause the window to print its contents. But as well as these specific toolbars for each window, Pegasus Mail provides a group of buttons which provide access to services appropriate at any point in the program. This group of buttons is called the Button Panel, and appears by default as a toolbar immediately under the menubar of the main Pegasus Mail window. The icons which commonly appear on the button panel have the following functions:

- Compose a new mail message
- Open your new mail folder
- Open or work with any other mail folder
- Open or work with address books
- Open or work with mailing lists
- Lookup users on your local area network
- Define or work with new mail filtering rules
- Open the noticeboard system
- Print current or selected items in the frontmost window
- Select a font for the current window

If you are running WinPMail using its built-in Internet Mail capabilities, you may also see the following icons on the toolbar:

- Send any mail waiting in your outbound mail queue
Retrieve mail from your POP3 mailbox (or mailboxes)

Send and retrieve mail in one operation

Download mail from your POP3 mailbox selectively

Please see Chapter 12 in this manual for more information about using Pegasus Mail’s built-in Internet Mail capabilities.

The buttons displayed above are the ones visible on Pegasus Mail’s default toolbar layout, but you can also enable other layouts that may have other buttons: if you are unsure of the purpose of any particular button, hovering the mouse over that button will bring up a tooltip describing its function.

The identity selector: in many cases, your Pegasus Mail toolbar may contain a dropdown list control (also called a “combobox”): this control allows you to change identities at any time. For more information on using identities in Pegasus Mail, please see Chapter 14 in this manual.

Most of the buttons on the toolbar can be used from any point within Pegasus Mail, but The Cut and Copy buttons (if you are using a toolbar that displays them) will only work in text windows (such as the message editor and reader) when text is selected. The Save to disk and Read from disk buttons will work only in windows where such a disk operation makes sense, such as in the folder window, where the Save to disk button allows you to extract messages to files. Finally, the Print and Font buttons will only operate in windows where these options are available in the menu.

Extensions: Pegasus Mail supports a powerful feature called Extensions, which are third-party program modules that extend the capabilities of the system. Extensions may also add their own buttons to the button panel, in which case they will appear at the extreme right-hand end. Extensions can also add themselves to the New message menu on the File menu, and to the Addresses menu.

Customizing the button panel

Pegasus Mail’s button panel can be customized quite extensively by more advanced users: the changes are made by creating a small text file using an editor such as the Windows NOTE-PAD program. For more information on customizing the contents of the button panel, please see the file called BPANEL.TXT in the RESOURCE subdirectory of the directory where you installed Pegasus Mail.

The floating menu

Pegasus Mail has many types of windows that can be open at once while you run it – folder windows, message readers, message editors and so on. Only one window can be the frontmost window at any time, though – the frontmost window is the one you are currently working in. Special options for the frontmost window are contained in the floating menu on the menu bar – it is called the floating menu because it changes depending on the type of window that is frontmost. The floating menu is always the one to the left of the Window menu.

The StatusBar and WindowBar

At the bottom of the main Pegasus Mail window, you will see the StatusBar:
Pegasus Mail displays messages for your attention in the left-most section of the status bar, and shows your current username and new message count in the remaining panes. When it needs to display particularly long messages, Pegasus Mail may occasionally expand the message area so that it covers the other two areas. At the right-hand end of the status bar you can see three buttons and a window resize control: the buttons have the following functions:

- Indicates that Pegasus Mail is online (can establish Internet connections). Clicking this button puts the program into Offline mode, in which all Internet operations are deferred.
- The online indicator changes to this form when it has been clicked, indicating that the program is operating in Offline mode. Clicking the button while it is in this state will return the program to Online mode.
- In this form, this button indicates that no Internet connections are active. When an Internet connection is active, the button changes to this form, and operates as a “Stop” button. Clicking the button while it is in this form will abruptly cancel all active Internet operations.
- Indicates that the WindowBar (see below) is currently closed. Clicking the button while it is in this form will open the WindowBar.
- Indicates that the WindowBar is currently open. Clicking the button while it is in this form will close the WindowBar.

The Window resize control simply allows you to resize the main Pegasus Mail window – click and drag on it the way you would in any other Windows application.

When you click the Open WindowBar button, Pegasus Mail’s WindowBar will open.

The WindowBar shows all windows currently open in Pegasus Mail and allows you to switch between them with a click. What’s more, if you could drag and drop any item onto a window in Pegasus Mail, you can also drop the item onto its button in the WindowBar to achieve the same result. This is especially handy if you are dragging something but the window into which you want to drop it is currently obscured by another window. If the WindowBar has more window buttons than it can display in the available space, it will display a green arrow button at its right-hand end: clicking this button will scroll the remaining window buttons into view. Pegasus Mail automatically remembers whether or not you have the WindowBar open and restores it to that state the next time you run the program.

**Working with multiple file servers**

If you are working in the Novell NetWare Bindery mode environment, then you can be connected to several file servers at the same time. Only one copy of Pegasus Mail can be run at any time in a copy of Windows, but Pegasus Mail provides a number of features which can make working with multiple servers easier.
3: Getting started

Working with multiple file servers

Specifying a particular server If you routinely attach to several file servers on your network, you will probably want to tell Pegasus Mail to choose a particular server when it starts up. To do this, add a “-P” switch to the command line specified in the Program Manager icon you have created to run Pegasus Mail. The -P switch specifies that you prefer a particular server; it should be immediately followed on the command line by the name of the server you wish to use. You must be logged in to the preferred server already, or the switch will not work.

Example: you want Pegasus Mail to use File Server FUBAR when you run it: highlight the Pegasus Mail shortcut then press <Alt+Enter> to open its Properties dialog. In the Target field on the Shortcut page, enter the following string:

WINPM-32.EXE -P FUBAR

Changing file server from within Pegasus Mail If you want to access mail on another file server while Pegasus Mail is running, you can do so by selecting File Servers from the Pegasus Mail File menu. Doing this will open a dialog listing all the servers available on your network. File servers to which you are already attached are marked with a ‘*’ character and can be selected simply by double-clicking them.

If you want to use a file server to which you are not currently attached (one which has no ‘*’ character after its name) then you must highlight that server’s name in the list, and type a username and password in the two fields at the bottom of the dialog. When you click the OK button, Pegasus Mail will attempt to log you into that server using the name and password you supplied. If the login is successful, Pegasus Mail will then change to that server for you. When you change file servers, Pegasus Mail closes all windows associated with the file server you were previously using and starts as if from scratch on the new server, reloading your preferences and restoring your desktop (if you have this preferences option checked on the new server).
4: Sending Messages

On the File menu, you will find an item called New message, which contains the various types of message you can send using Pegasus Mail. New message will always contain at least two items, Standard message and Circulation message, and may contain other types of message depending on the plug-ins that have been installed with your system – for example, you will often see an option there for Telephone messages as well.

Standard Messages are the regular day-to-day mail message you will use most often: the remainder of this section is mainly devoted to describing how to use standard messages.

Circulation Messages are a special type of message that is passed to each recipient in the address list in order, one after the other. Each recipient can add comments to the message before it is automatically forwarded to the next recipient in the list. When the message leaves the last person in the list, it is automatically returned to the original sender. Circulation messages have been made to look as much as possible like standard messages: the primary differences are that they do not support CC: or BCC: addressing, and when you read a circulation message, an extra button, labelled Add comment and forward to next recipient appears in the message reader. You may add attachments to circulation messages (in fact, you will most often do so). Circulation messages are sent to the recipients in the order you enter their addresses in the To: field: it is important to remember this if the order in which people see the message is significant. Recipients of circulation messages can still reply normally to you if they wish to make comments that are not circulated.

Creating a new message

To start a new mail message, choose the option you want from the New message submenu of the File menu the message editor window will open, allowing you to compose your message. In this window you will find either three or four text fields – To, into which you enter the recipient’s address; Subject, into which you can enter a short précis of the message and (except in circulation messages) Cc, where you can enter addresses for people who should receive copies of the message; if you have turned on Keyword support in the Messages and replies options dialog, then there will also be a Keywords field into which you can type any keywords you want to associate with the message. You can drag and drop addresses from Pegasus Mail’s address books, user lists and distribution list windows into any of these fields, and the small addressbook button to the right of the addressing fields allows you to to open the Addressing Centre for that field (see below). Below these fields are several message control boxes that can be used by clicking on them, and the message editing box where you will type your message. The set of tabs at the top of the editor window allow you to change your view of the message at any time — each of these buttons allows you to work with a different aspect of the current message, such as file attachments and less frequently-used (special) options such as BCC – clicking on any of these tabs will switch the message editing window to the view appropriate to that tab.

Addressing your message

When the window opens, the cursor appears in the To: field. Just as you need to address an envelope so the postal service knows where a letter is to go, so you need to provide an address for an electronic mail message. E-mail addresses can take a variety of forms, depending on the location of the recipient, and the mail system used there. Pegasus Mail can accept addresses in many formats — for the most part you won’t need to be worried about the technical issues of the type of addresses Pegasus Mail can accept, since it will almost certainly accept anything you are likely to enter, but for your reference, a summary of these formats appears
at the end of this chapter. In less technical terms, however, Pegasus Mail can accept any of
the following types of address in your messages:

- **Local users** — other users on your local network or on the same machine
- **Internet addresses** — an Internet address in any valid format (for example, `support@pmail.gen.nz`)
- **MHS addresses** — if you have a Novell MHS-compatible mail system such as Connect®,
Pegasus Mail can accept addresses in any valid MHS format.
- **User groups** (if your network supports this concept) — system-defined collections of
  users
- **Distribution Lists** — arbitrary collections of addresses in lists that you create and main-
tain yourself.

**Distribution (Mailing) Lists**
Pegasus Mail allows you to store groups of addresses to which you frequently send mail in a
file, and then to use the name of that file as an address. A distribution list must be plain ASCII
text, and must contain one address per line. Any address you could normally type into any
address field in Pegasus Mail can be entered into the file, including “addresses” for other dis-
tribution lists (up to a maximum of five levels deep). While you can create distribution lists
using any text editor, you will normally create them using the Distribution List manager,
which is opened by selecting **Distribution lists** from the **Address** menu, or by pressing `<F6>`.  
To use a distribution list in an address field, type the special character `@`, followed imme-
diately by the distribution list’s filename. The Pegasus Mail addressbook window and ad-
dressing centre will do this for you automatically, but if you have created your own text file
containing addresses you can use this technique to type it into the address field manually. For
more information on Distribution Lists, please see chapter 7 in this manual.

**Address books**
Pegasus Mail incorporates an address book feature which can make entering and remember-
ing addresses much easier. You can create and manage your addressbooks at any time by
pressing `<F3>`, although you will usually use the Addressing Centre (see below) to use your
addressbook entries in your mail. From the main addressbook window, you can either drag
addresses from the address book to the address field in your message, or highlight them and
press the **Apply** button in the address book dialog. You can also perform a “quick lookup”
from your address books by entering the Name field for the entry and pressing `<Shift-
F3>`: Pegasus Mail will find the entry with that name field and will insert the address from
the entry into the addressing field for you.

**Aliases**
You can use the “Name” field of any address book entry you or your system administrator
has created as an address, simply by typing it in the address field. This use of a name as an
address is known as **aliasing**. Make sure that what you type matches exactly the text in the
address field — “Tom Jones” is not the same as “Thomas Jones” to Pegasus Mail.

**The Addressing Centre**
Pegasus Mail provides a powerful integrated tool for managing the addresses in your messag-
es; this tool, called the **Addressing Centre**, can be used any time you see the small pale-blue
addressbook button at the right of an addressing field. The Addressing Centre gives you easy
access to the contents of your addressbooks and distribution lists, allows you to use any ad-
dress you have recently used in another message, and gives you an easy way of adding and
removing addresses from an address field. You can open the Addressing Centre from
the keyboard by pressing either `<Ctrl+Shift+T>` (for the “To” field) or `<Ctrl+Shift+C>` (for the
“CC:” field). When the Addressing Centre opens, the current addresses in the relevant addressing field are displayed in the Current addresses list at the top of the Addressing Centre window. You can select any of these addresses and click the Remove button to delete them from the address field. In the lower section of the Addressing Centre window you will see a tabbed control allowing you to select between your addressbooks, distribution lists and recently-used addresses. Within each of the panes selected by the tabs, you can select an address or addresses then click the Add button at the top-right of the window to add them to the current addressing field. Alternatively, you can simply double-click any entry to add it to the address list. When you click the OK button, the contents of the message editor’s addressing field will be updated with the contents of the Current Addresses list.

The addressing centre can simplify addressing your messages significantly and is one of the most powerful features of the program — we recommend that you spend some time familiarizing yourself with the way it works.

Address completion

Another powerful feature for addressing your messages is Address Completion: when this feature is turned on (in the Messages and Replies page of the Options dialog), Pegasus Mail will try to match what you type into an address field against either your addressbooks or your list of recently-used addresses (or both); if it finds an address that matches what you have typed so far, it will “complete” it for you — that is, it will fill in the remainder of the address on the address field for you, with the text it is suggesting highlighted. If you type another character, the suggested text will be removed, and Pegasus Mail will look for a closer match based on the extra character you have typed. If the address Pegasus Mail suggests is the one you actually want to use, simply press the <End> key to accept the text. If you want to add another address at this point, type a comma to start typing a new address, at which point the address completion feature will again start suggesting addresses for you. While a little difficult to describe, in normal use address completion is simplicity itself and, as with the addressing centre, can greatly speed and simplify the process of addressing your mail.

Message options

The message editor window contains a number of controls which affect the way your message will be sent. It also has its own menu, the Message menu, which contains less frequently-used options.

The To: field  The To: field accepts the address of the primary recipients of your message — the people to whom your message is principally addressed. You can enter multiple addresses in this field, separated by commas. If you have previously used Outlook and are used to using the semicolon character (“;”) to separate addresses, Pegasus Mail will accept that, but we recommend that you break the habit: the comma is the standard separator in all other Internet mail packages and is the separator defined in the Internet Standards for electronic mail — only Outlook deviates from this. The maximum length of address fields is 32000 characters. You can access the Addressing Centre (see above) for the To: field by clicking the pale-blue addressbook button to the right of the field, or by pressing <Ctrl+Shift+T>.

The Subject: field  You should place a brief summary of your message in the subject field so that the recipient can get some idea of what your message is about when he opens his new mail folder. It is considered good electronic mail “etiquette” to provide a short, meaningful subject line. When you are replying to a mail message it is customary to use the subject of the original message introduced by the word “Re:”; Pegasus Mail automatically prepares your subject this way when you start a reply to a message.
Message options

The CC: field If you want people other than the primary addressees to receive a carbon copy of your message, enter their addresses in the CC: field. Carbon copy addressees are people you are allowing to "overhear" your conversation without it being directly aimed at them. Carbon copy recipients are shown in a separate line in your mail message and are visible to everyone who receives the message. You can use the Addressing Centre by clicking the pale-blue addressbook button to the right of the field, or pressing

Confirm reading If you place a check in the Confirm reading control by clicking it, Pegasus Mail will attempt to obtain confirmation from the recipients that your message has been read. If the recipients also use Pegasus Mail there is usually no problem with getting such a confirmation; unfortunately, other mailers may not recognize Pegasus Mail’s request and hence may not generate the confirmation for you. Individual local Pegasus Mail users may be granted the right to refuse confirmation of reading: if you send a message to a local user who has done this, you will be told by Pegasus Mail at the moment you send your message that no confirmation will be forthcoming. If the message is a circulation message and you check this control, then you will receive notification when each recipient receives the message, and also when each recipient forwards the message to the next person in the list. This can be useful if you need to find out where a circulation message has "stalled".

Confirm delivery Checking the Confirm Delivery control tells Pegasus Mail to attempt to obtain proof that the message has been delivered. Delivery confirmation differs from confirmation of reading in that it is sent to you by the remote delivery system and merely indicates that the message has been successfully placed in the recipient’s mailbox; it gives no indication that your message has actually been read. For local mail delivery is guaranteed if you see no error, but for remote mail (for example, mail sent by an SMTP gateway) there is no guarantee that the delivery system will recognize Pegasus Mail’s request (although many do).

Copy self If you want to keep a copy of your message in a folder, check the Copy self control. Pegasus Mail will make a copy of your message in your “Copies to self” folder when the message has been sent successfully. The copy self feature is generally equivalent to the Sent mail feature found in other mail programs, but Pegasus Mail makes the process optional, and offers a number of extra capabilities for your copies to self, including automatic filtering, and preference options to allow you to select the folder where the copy should be placed when the message is sent.

Urgent Check the Urgent control if you want to indicate that your message is extremely important. If the recipient is using a version of Pegasus Mail, urgent mail generates a different notification message for the recipient, and always shows in red at the top of his or her new mail folder. The effect of urgent mail for other mail systems varies from package to package but most mailers will recognize the urgent flag. It is important to note that checking the Urgent control does not make your mail travel any faster — it only changes the way the mail is handled on receipt. Urgent mail can be quite intrusive and should be used sparingly.

Encrypt Enables password-protection for your message. See the next section for more details on encryption.

Signature A signature is a small fragment of text that is added automatically to your message. Your signature usually contains information on who you are and how to get in touch with you — your phone number, fax number, e-mail address and so forth. Because much of the information you place in your signature may depend on the means by which your message is sent, Pegasus Mail supports signature sets, where you can define different signature text depending on whether the message is sent locally, via the Internet, or via NetWare MHS. Pegasus Mail allows you to create up to nine different signature sets and has a setting to suppress the addition of a signature altogether. To select a particular signature set for your message, click.
this control. You can choose any of your signature sets and can tell Pegasus Mail to use your selection as the default signature in future. For information on creating and editing signatures, see chapter 11 later in this manual.

Send  Pressing the Send button tells Pegasus Mail to check the values you have entered and attempt to mail the message. You can also press <Ctrl+Enter> to send the message.

Save  Clicking the Save button will save the message you are working on as a draft; you can resume editing your draft at any time by choosing Open saved message... from the File menu. You can also save a message by pressing Ctrl+S, or by selecting Save message from the Message menu (see below).

Cancel  Press the Cancel button to discard your message.

Encryption

Pegasus Mail can encrypt, or scramble, messages either using a robust encryption mechanism of its own, or else using encryption modules developed by other people. Encrypted messages are transmitted in a coded format which keeps them safe from prying eyes. If you check this control, a small window will open, and you will be prompted for details on the way your message should be encrypted.

Encryption method:  At the top of the dialog is the list encryption modules installed in your system: Pegasus Mail has a built-in encryptor, and unless you have installed third-party encryptors, it will be the only option in the list. Third-party encryptors will have varying availability, but if you have access to the Internet, a good place to start looking for them is on the Official Pegasus Mail web site, http://www.pmail.com. Depending on the capabilities of the encryptor you select, the three other controls in the dialog may be variously enabled or disabled.

Password:  the password is the key to the message, and may mean different things to different encryptor modules. For Pegasus Mail’s built-in encryptor, the password is used to lock and unlock the message – the recipient must know the password in order to be able to read the message. If you intend to use the built-in encryptor, you and the recipient should agree on a password or passwords in advance. Other encryptors may use the password for other purposes, or may not need it at all. Consult the instructions supplied with the specific encryptor you want to use for more information on what to enter here.

Encrypt message:  encryption is the process of scrambling the message so nobody can read it without the password. If you want to protect your message from prying eyes, use this option.

Add digital signature:  a digital signature is a complex calculation applied to the message which effectively proves conclusively that it was you who wrote the message, that you wrote it at a particular time, and that it has not been altered. A digitally-signed message can also be encrypted, but need not be. Some digital signature algorithms have been accepted as proof in courts of law around the world. Not all encryption modules will support digital signing – Pegasus Mail’s built-in encryptor does not, for instance.

The built-in encryptor:  Pegasus Mail’s encryption mechanism has been carefully designed to be compatible with Internet Mail: you can freely send encrypted messages via the Internet, although the recipient must also be using Pegasus Mail in order to be able to decode them. When using the built-in encryptor, the key you enter should have from five to eight characters — letters or digits only. You should choose a key which is not easy to guess: bad passwords
include things like your first name, your car registration, or your spouse’s name, because they are all very obvious: try using something which is not easily associated with you. The best keys are nonsense words, or words that contain numbers: examples of good keys might be “flurgle”, or “2good4u”. Make sure that you remember the key you use for a message! Even Pegasus Mail’s author cannot help you if you forget it.

The Message menu

The Message menu is enabled when a message editing window is frontmost: it contains less frequently-used options for your message.

Save message This option allows you to save your message in a draft format to which you can return later. When you select Save message from the menu, or press <Ctrl+S>, a small window will open with the title of the draft preset to the addressee and subject of your message. You can alter the title for the draft if you wish — once you have done so, press the OK button or press <Enter> to save the draft. You can reopen a draft message at any time using the Open saved message... option on the File menu. Usually when the draft of a message is finally sent the draft file is deleted, but you can create a draft which you can use as a template for future messages by checking the Stationery button when you save it. Draft messages which are saved as stationery are not deleted when they are sent, so you can use them repeatedly. The only way to delete a stationery draft is to choose Open saved message... from the File menu, highlight the draft you want to delete, and click the Delete button.

Import text file The Import text file option allows you to read a plain text file into your message: select it and a file selector window will open; choose the file and press Open, and the contents will be read into your message. The file you import should usually be plain text — note that most word processing packages do NOT create plain text files, so you usually cannot import them. There is no effective limit on the size of the file you import into your message. You can also press <Ctrl+M> to import text.

Import HTML file This option allows you to import a pre-formatted HTML document into your message, preserving as much as possible of the formatting information. When you select this option, the message’s Rich text indicator will become checked, indicating that Pegasus Mail will send the message as HTML. Pegasus Mail can import most HTML formatting features, but cannot import scripts, Java applets, ActiveX controls or other HTML extensions. It is also considered very bad form to remote-link graphics in a mail message – you should use the message editor’s Insert Picture button for this instead.

Save window size If you have resized your message editing window and wish to have Pegasus Mail use that size for future messages, select Save window size from the message menu.

Enlarge message editor Selecting this option, or pressing <Ctrl+F8> resizes the message editing area of the message so that it occupies the entire vertical height of the window, or restores it to normal size if selected again.

Find text, Find and replace, Find/replace again These commands on the Edit menu allow you to locate text in your message, or to change occurrences of one piece of text to another. Selecting Find or Find and replace will open the search dialog; enter the string you want to find (and the string you want to replace it with if you selected Find and replace) and check the Match whole words and Match case controls as required then click Find. If you are replacing text, you can also choose Replace all to tell Pegasus Mail to perform the substitution automatically on every occurrence it can find of your match text.
Right-clicking a message

When you right-click the mouse in the body of the message editor, you will be offered a menu of options specific to the message body.

**Undo, Redo**  Undo reverses the last editing change you made to the message, while Redo reverses the last undo operation. So, selecting Undo and immediately selecting Redo will leave your message unchanged. Pegasus Mail’s editor supports multiple levels of undo and redo, so you can undo many changes, not just the last one.

**Copy selection to DList**  Allows you to select an e-mail address in your message and add it directly to a distribution list, without having to copy, open the list, and paste.

**Paste unwrapped**  Pastes the contents of the clipboard at the cursor position but preserves the line breaks in the pasted data instead of reformatting it. This is useful when pasting tables or other data that might be wider than your margins.

**Paste as quote**  Pastes the contents of the clipboard at the cursor position, prefixing each line with the standard Internet quoting string, ""> " This is useful if you want to include a section from another message but show that it’s a quote.

**Import text file**  Reads a plain text file into the message at the cursor position. Lines in the file are reformatted to fit your margins if they are too long.

**Import text file unwrapped**  Same as Import text file, except that lines are not reformatted, and line breaks in the file are preserved in your message.

**Import HTML file**  This option allows you to import a pre-formatted HTML document into your message, preserving as much as possible of the formatting information. See above for advice on using this option.

**Export to text file**  Allows you to save the text of your message in a file on your hard disk.

**Reset styles**  When you are replying to a message containing text quoted from the original message, you may occasionally find that the text you are typing takes on the colour and format of the quoted text. This is a purely cosmetic effect, but if it bothers you, you can use the Reset styles option to set the current line back to your normal font and colour. You can also press <Ctrl+0> (zero) to achieve the same effect.

**Set text colour**  Allows you to change the colour of the selected text to any of fifteen predefined colours.
Using styled text, pictures and formatting in messages

Pegasus Mail has full support for composing HTML mail: HTML is Internet jargon for the special encoding of web pages that allows them to contain pictures, hyperlinks, styles and so forth, and it has spread to e-mail in the last couple of years. In other e-mail packages, HTML has become the vehicle of choice for transmitting malicious computer viruses and “trojan horses”, but Pegasus Mail goes to elaborate lengths to protect you from that kind of thing. Equally, when you compose HTML mail in Pegasus Mail, you can have every confidence that nothing about your message can pose a threat to users of other packages, even vulnerable ones.

It’s probably worth stating clearly at this point that HTML mail is not universally popular on the Internet; aside from the well-documented security problems it has spawned, HTML is not an especially good or consistent standard, and the way your message appears may vary from system to system depending on how HTML is implemented there. Add to this the fact that HTML tends to be larger than plain text, and that not all mailers can yet read HTML data, and you have a recipe for a feature that may not win you many friends if you use it without some consideration. Before you send a message containing pictures or formatting, consult the recipient and make sure that he or she is both willing and able to handle HTML mail — simply assuming that a given recipient will be happy to receive HTML mail may get you into all kinds of strife.

Pegasus Mail takes some pains to handle HTML mail responsibly; by default, it will only generate HTML mail messages if you use an option that absolutely requires it — font changes, bold/italic/underline, pictures, tables and colour changes will all tell Pegasus Mail that it needs to generate HTML for the message. If you do not use any of these features, then Pegasus Mail will send your message as normal plain-text mail, compatible with all systems. You can always tell if you have used a feature that will cause Pegasus Mail to generate HTML because the Rich Text control in the message editor will check itself; unchecking the control will force the formatting to be discarded when the message is sent, resulting in a message containing only plain text.

Basic formatting

All the things you do commonly in your word processor can also be done in Pegasus Mail’s editor – coloured, bold, underlined or italic text, indented paragraphs, centred or right-aligned lines – all these effects can be selected using the buttons on the message editor’s toolbar. Some types of indenting can even be done automatically for you — please see the Automatic Formatting page of the Pegasus Mail Options dialog (which you can find on the Tools menu) for more information on this. Note that using indented paragraphs, centred or right-aligned text will not force the message to be sent as HTML — Pegasus Mail simulates these effects in plain text mail quite well. Using bullet paragraphs, however, will force the message to be sent as HTML, because the bullet graphic characters cannot be properly-represented as text.

The Centre and Right align buttons adjust the alignment of the current paragraph. To revert the paragraph to the regular left-aligned format, click the Align left button on the editor toolbar.

The three indent buttons can all be pressed multiple times to perform multiple indents. To “outdent” text you have indented, hold down the Ctrl key as you click the button. So, if you left indent one too many times, Ctrl-clicking the left indent button will take the text towards the left margin one tab stop.
4: Sending Messages

Using styled text, pictures and formatting in messages

Tables

One of the things HTML really does very well is tables: a table is simply a neatly-tabulated grid containing data. Tables are extremely useful for presenting related information, because they guarantee that everything will line up nicely when the message is read. To create a table in your message, click the Create or edit table button and choose Insert new table. Type in the initial width and height of the table (you can add more columns and rows later) and indicate whether you want gridlines and a grey background. When you click OK, Pegasus Mail will create the table in your message, ready to use. You can click in any cell in the table and type text there, and you can also insert pictures into a cell (this is a particularly handy trick if you want to create a signature that contains a graphic). To resize columns and rows, simply move the mouse over the borderline between the two cells you want to resize: the mouse cursor will change to a resizing icon, and you can then click and drag to resize the column.

You can add or remove rows and columns from your table by positioning the text cursor inside the table then clicking the Create or edit table button again. You can also set specific background colours for the cells in your table using this button. You can also create tables within other tables — this can be useful for producing tabulations of complex data where you need to subdivide individual cells. Finally, using a table in your message will force the message to be sent as HTML mail — Pegasus Mail cannot represent complex table layouts in plain text messages.

Pictures

With the increasing availability of digital cameras, it is becoming more and more natural to want to include pictures into your mail messages. Pegasus Mail supports all the most commonly-used graphic formats (BMP, GIF, JPEG, PNG, and TIFF) and allows you to adjust the size of any graphic you include in a mail message. To insert a picture into your mail message, click the Insert picture button and select the picture file you want to include. You can also drag/drop or paste a picture into the message, but we don’t recommend this, because it may result in conversions being done that will result in very large messages. Once the graphic is visible in your message, you can resize it by clicking on it once, then dragging the “handles” around the border of the picture to the size you require. To remove a picture from your message, simply click it once to select it, then press the <Del> key. A picture is just like a single character to Pegasus Mail — it can be indented using the indent buttons, and the centre- and right-align buttons will adjust the horizontal position of the picture within the page. A very handy trick to remember is that pictures can be placed in tables (see above) — remember this when you want a picture to appear with text next to it in your message.

Background pictures (wallpaper): If you have a picture you would like to use as a background to your mail message, choose Add wallpaper from the menu when you click the Insert Picture button. A wallpaper picture appears behind the text you type. When choosing wallpaper images, try to choose pale or unobtrusive patterns that won’t interfere with the readability of your text.

Hyperlinks

When you are creating an HTML message, you can create hyperlinks — that is, a piece of clickable text that will redirect the user to a web site when it is clicked (this is exactly the same as the type of link you use all the time in your web browser). To add a hyperlink, position the text cursor at the place where you would like the hyperlink to appear, then click the Insert Hyperlink button; type in the text that Pegasus Mail should display to the user in the top field, and the actual URL, or link target, in the bottom field. The Insert Hyperlink button is only meaningful for HTML messages: in plain text messages, it is actually the recipient’s mail program that works out what is and is not clickable in the message rather than the sender’s, and there is no way of directing the way that program will behave.
4: Sending Messages

Special message options

Clicking the Special tab at the top of the message editor window, selecting Special message options from the Message menu, or pressing \(<F9>\) will all change the current view of the message editor to one containing specialised or infrequently-used options for your message.

Advanced addressing, BCC A BCC, or Blind Carbon Copy is a specialized form of Carbon Copy: a BCC recipient of a message receives a copy without the To: or CC: recipients of the message being able to tell that he or she has been copied. Only the actual BCC copy of the message contains any indication that a Blind Carbon Copy has been sent. BCC is very useful in the practice of cutthroat office politics. A preference option on the Sending mail preferences page allows you to control the way Pegasus Mail generates BCC fields in your messages.

Send replies to If you want replies to your message to be sent to an address other than your own, enter that address in this field. For example, a line manager may prefer replies to a memorandum to go to the secretary rather than to him or her directly, and so would enter the secretary’s address in this field. If you enter a reply address in this field, it will only apply to the current message: to set a reply address permanently, examine the Sending mail preferences page on the Options dialog in the Tools menu.

Use MIME features in this message for Internet/local mail MIME (Multi-purpose Internet Mail Extensions) is the dominant standard for Internet electronic mail, and makes it possible to send messages with international character sets, attachments and multimedia information in a portable way. MIME is currently the only reliable way of sending Internet e-mail containing accented characters, and as time passes, it will become the dominant way of handling electronic mail in the Internet world. If the person to whom you are mailing has a mail system which has support for MIME, then you should check this box. When it is checked, Pegasus Mail will use MIME encodings instead of uuencoding for attachments sent to the Internet when you specify “Pegasus Mail decides” as the encoding mechanism. Pegasus Mail will also encode international characters according to MIME rules when this box is checked, both for local and Internet mail.

The setting of this control is local to the message — so, turning it off will not affect other messages. You can control the default MIME setting using the Messages and replies page of the Options dialog on the Tools menu. The only time you would uncheck this control would be if you were sending mail to someone whom you suspected might not be using a MIME-capable mail system.

Do not close the window after the message has been successfully sent If you check this control, then Pegasus Mail will not close the message editor window after you click the Send button, instead leaving it open so you can continue to work with it. This is handy if you want to send several slightly different copies of a message to different addresses – you simply check this control, then make the changes prior to clicking Send for each message. When this control is checked, you can close the message editor window when you are ready by clicking the Cancel button in the main view.

Generate a message delivery transcript Mercury/32, Pegasus Mail's mail server companion product, can generate what are known as "transcripts" - reports showing the time and details of the delivery of a message you send to someone else that can be used as pretty reliable proof of delivery. Check this control to enable requests for Mercury transcripts on a message-by-message basis: you can also specify that the option should be on by default in the Messages and replies preference page. The option has no effect and is harmless if you do not use Mercury.
Message is obsolete after  If a message is only meaningful for a certain period of time, you might want to set an expiry date in this field. Enter the date and time after which the message is invalid in numeric format (for instance, “1993-8-23 11:10”). Expired messages show in grey at the bottom of the Folder browser window, and can be deleted with a single command on the Folder menu.

Editor settings

Edit settings, message width  This option allows you to control the maximum number of characters Pegasus Mail’s message editor will allow on a single line in your message. You cannot set a width greater than the current width of the message editor, so if you need to do this you must resize the window before selecting the option. The value entered here applies only to the current message: to make a permanent change of margin, use the Message formatting page of the Options dialog on the Tools menu.

Edit settings, average <Tab> width  Microsoft Windows defines the <Tab> key as the key used to move from field to field in a dialog and by default Pegasus Mail observes this convention, which means that you cannot use the <Tab> key to tabulate your message. You can override the default behaviour and allow the <Tab> key to tabulate in the editor by entering a tab width here. The width you enter is not an absolute value but is calculated based on the average width of characters in the typeface you are currently using. Altering the <Tab> width will only have an effect on the current message if you had already previously enabled Tabs in the editor using the Message formatting page of the Options dialog on the Tools menu. The value entered in the Special view applies only to the current message: to make a permanent change of tab width, use the Message formatting page of the Options dialog on the Tools menu.

Custom headers for this message

This option allows you to add specific message headers directly into the mail message generated by Pegasus Mail. It is a very technical option and should only be used if you know exactly what you are doing. Click the Add button and Pegasus Mail will open a window prompting you to enter the header you want to add. Type it in exactly as it should appear in the message, including the keyword and the colon character following it. You may not add any header that Pegasus Mail itself will add to the message, so you cannot add fields like From, To, Subject, CC, MIME-Version, Content-type and so on. The principal use of this feature is for list managers who need to add approval headers when submitting messages, and for internal use by Pegasus Mail itself – it uses it to attach special threading headers to your replies.

Sticky settings and default settings

Pegasus Mail normally remembers the last setting you used for the following message editor controls: Copy self, Confirm Reading and Confirm Delivery. This “sticky setting” behaviour can be changed using the Messages and replies page of the Options dialog on the Tools menu if you wish – you can instruct Pegasus Mail to use the same default settings for all messages instead, in which case changes to the controls listed above only affect the current message. See chapter 11 later in the manual for more details on this.

Checking your spelling

Pegasus Mail has a 65,000 word English dictionary and can check the spelling of your messages for you. To start the spelling checker, choose Check spelling from the Tools menu and the checker window will open. Checking begins from the cursor position in the message, so
if you want to check the entire message, make sure you move the cursor to the top of the message before starting the check. Pegasus Mail scans the message looking for words it cannot find in its dictionary. When it finds such a word, it shows it in the checker window and tries to find a list of suggested alternative spellings for the word. At this point, you can take several actions:

• If the correct spelling appears in the suggestion list, then you can double click on it and it will replace the incorrect spelling in the message.

• You can edit the spelling of the word manually and place it in the message by pressing the Change button.

• You can skip this occurrence of the word by pressing the Skip button. If you want to skip all occurrences of the word in this message press the Skip all button.

• If the word is correctly-spelt, you can add it to your personal dictionary by clicking the Add to dict button. Your personal dictionary can hold around 5,000 words and is stored in your home mailbox directory.

Spell checking continues until you close the checker window (by clicking the End check button) or until there are no further words to check in which case Pegasus Mail will ask you if you want to continue checking from the top of the message. While the spell checker window is open, you can move it around on the screen so you can see mis-spelt words in their context within your message.

Automatic spell checking You can instruct Pegasus Mail to run the spelling checker automatically when you click the Send button in the message editor. This option is set on the Message formatting page of the Options dialog on the Tools menu. When auto-checking a message, an extra button is available that cancels sending the message. This allows you to change your mind about sending the message if you find a sentence you’d sooner retype.

Skip quoted (“>”) lines You may not wish to correct the spelling in the text of the message to which you are replying – if so, check this control and quoted lines will not be checked. Quoted lines are presumed to be any that begin with the > character.

Start check automatically If this control is unchecked, Pegasus Mail will wait until you click the Start check button before actually beginning to check spelling. This gives you an opportunity to select a different dictionary if you wish. If you would sooner that Pegasus Mail just began checking at once using the default dictionary, check this control. This setting takes effect the next time you check your spelling.

The Glossary

Pegasus Mail’s message editor has a feature called a glossary, which allows you to take frequently-typed text and store abbreviations for it which can be expanded using a single keystroke. This can be an extremely fast way of preparing form letters using “boilerplate” text and can save a considerable amount of typing if you repeatedly send similar messages.

To create a glossary entry, type the text you want to abbreviate into your message then highlight it using the mouse or keyboard and copy it to the clipboard by selecting Copy from the Edit menu, or by pressing <Ctrl+C>. Now choose Create/Edit from the Glossary submenu of the Tools menu (or press <Ctrl+;>) and the glossary manager will open. The left-hand window in the glossary manager shows the abbreviations you have defined, while the right-hand window shows the text for the currently selected abbreviation. To create a new abbre-
viation, click the Add button; a small window will open prompting you for an abbreviation. The abbreviation is the key text you will type into the editor before pressing <Ctrl+E> to expand it — it should be short and cannot contain spaces. Once you have created the abbreviation, you can click the mouse in the right-hand window to enable it, then click the Paste button to paste the text from the clipboard into the glossary. You have now associated the text you copied from your message with the abbreviation shown in the left-hand window of the glossary manager.

To expand a glossary entry, type its abbreviation and press <Ctrl+E> (you can also use <Ctrl+/>). Pegasus Mail will open the glossary, locate the entry and replace the abbreviation in the message with the full text you defined when you created it (note - glossary entries are case-sensitive).

The buttons in the glossary manager perform the following functions:

- **Add** Used to create a new abbreviation
- **Delete** Used to delete the abbreviation selected in the left-hand window.
- **Copy** Copies any highlighted text in the right-hand window to the clipboard
- **Paste** Pastes any text in the clipboard to the right-hand window.
- **Save** Saves the changes you have made to the glossary
- **Cancel** Abandons any changes you have made to the glossary

**Embedding a file in a glossary entry:** You can tell Pegasus Mail to read the contents of a text file into your message as it expands a glossary entry by embedding a special string of characters in the glossary entry itself. The string must begin with ~? (a tilde followed immediately by a question mark), followed without spaces by the name of the file. After the filename, place a single ~ (tilde) character to mark the end of the string. The filename should include a full path (eg, C:\TEXT\TEXT.TXT) and must be a plain text file.

**Adding attachments**

Pegasus Mail allows you to attach up to 64 files to any message you send. Attachments are added by clicking the Attachments tab at the top of the message editor, which changes your current view of your message to the attachment list. You can also press <F7> to switch views.

Adding an attachment to a message requires three separate pieces of information about the file — the name of the file, what type of file it is, and how it should be encoded for transmission; of the three, the only one you must provide is the filename — the others have reasonable default values which do not usually have to be changed.

**The file name** To choose a file to attach, click the Add attachment button; a standard Windows File Open dialog will appear – navigate the way you normally would to find the file you want to attach, then double-click it. The File Open dialog presented when you click Add attachment has some extra buttons that may make your life a little easier:

- **Recent directories** presents a list of folders you have recently worked in and allows you to go straight to them:
- **Home mailbox** changes the file list to the contents of your home mailbox directory, which can be helpful from time to time if you need to find Pegasus Mail system files;
- **Go to favourite directory** takes you straight to whatever directory you have previously selected as your “favourite” by clicking the Set this directory as favourite button.
- **View text file** allows you to preview the contents of any text file before you select it.
Tip: because this is a standard Windows File Open dialog, you can right-click any file or directory to access special options associated with that file.

The file type  

Indicating the type of file is optional and is only used to provide information for the recipient when he browses the attachments. You can select from the list of available file types by clicking in the file type box. If you select *Mailer decides* for this option, Pegasus Mail will examine the file and try to work out what it is: it can recognize a number of common file formats including Microsoft Word documents and ZIP file archives. It is very important to note that Pegasus Mail does not convert the file you send in any way, no matter what file type you select — the file type is for informational purposes only. Pegasus Mail’s message reader can use file type information to run a program allowing you to view attachments from within the program, so if an applicable file type is available in the list, you should use it.

Tip: Normally, if Pegasus Mail detects that a file is a text file, it will send it without any kind of encoding, which may result in the message changing in transit (line endings may be adjusted, and some lines may be wrapped). Setting the file type to *Binary* before attaching it will force Pegasus Mail to send the file as raw, unmodified data. This can be important with certain types of file, such as INI or other configuration files, where the exact layout of the file is very significant.

Encoding  

It is generally necessary to apply a special process called Encoding to an attachment so that it passes through the mail system intact. Encoding is designed to preserve all the information about the file in a meaningful way that will be understood by the recipient’s mail program. There are several major encoding mechanisms in use and Pegasus Mail can work with most of them: the exact choice depends on how and where the message is being sent. The default encoding is *Mailer decides*; this is a very safe choice, since it allows Pegasus Mail to choose the encoding most appropriate to the route the message will take. On occasions, however, you may need to ensure that an attachment is encoded in a particular way based on knowledge available only to you, such as the mail program the recipient uses, or the nature of the attachment. In such cases, you will have to choose one of the encodings in the encoding list.

No encoding  

If you choose no encoding, Pegasus Mail will not encode the message in any way. This option is potentially quite unsafe and should generally only be used for local deliveries between Pegasus Mail users on the same server. It is not a recommended choice in the majority of cases.

ASCII text  

Choosing this encoding tells Pegasus Mail that the attachment contains only valid ASCII text with <CR/LF> line endings. ASCII text encoded attachments will be sent as normal mail messages by Pegasus Mail.

Important note! Word processor documents are seldom if ever ASCII text and should never be sent using ASCII encoding; in general, it is only safe to send a file using this encoding if you can edit it with the DOS Edit command, or with the Windows Notepad program.

UUencoding  

UUencoding is an old-fashioned encoding scheme still used quite widely on the Internet, especially on Unix systems. It is a very safe encoding in that the vast majority of mail systems will be able to decode it successfully. Pegasus Mail uses uuencoding when it sends an attachment to the Internet in a non-MIME message for which you have selected *Mailer decides* as the encoding. UUencoding an attachment increases its size by around 30% in transit. If you encounter a site which cannot cope with uuencoded data, you can find a wide variety of standalone uudecode programs on the Internet via the Internet’s FTP service – the machine http://www.simtel.net is an excellent place to start looking.
BinHex  BinHex is a very robust encoding scheme widely used on Macintosh computers. It includes a number of integrity checks on the attachment that can result in transmission errors being detected, and incorporates a simple compression algorithm which can reduce the size of the attachment. While it is probably the best of the encoding formats supported by Pegasus Mail, it is unfortunately also the least commonly used; if, however, you know that the recipient uses Pegasus Mail, or a mailer capable of handling the BinHex format, it is the best and safest encoding choice.

MIME encoding  MIME (Multi-purpose Internet Mail Extensions) is the current major standard for Internet mail encoding: it defines the way attachments and mail with special characters should be formatted for transmission. If you select MIME encoding for your attachment, then Pegasus Mail will transmit your attachment formatted according to the MIME rules, which should allow it to be read and manipulated by any MIME-compliant mailer. If the Use MIME features control in the Special message options window is checked, Pegasus Mail will default to MIME encoding when you select Mailer decides as an encoding.

Working with attachments
Use the Add attachment button to add a file to the list of attachments for the message using the currently selected encoding and file type (see above). To remove an attachment from the list, highlight it (by clicking on it in the list) and press the Remove attachment button. Removing an attachment from the list does not affect the original file in any way. To return to the editing view of your message, click the Message tab, or press <F8>; you can re-edit your attachment list at any time prior to sending the message. Clicking the Change selected button lets you adjust the file type and encoding values for any current attachment – simply select the file by clicking it, select the proper values for file type and encoding, then click Change selected.

Recently-used files  Clicking this button brings up a list of files you have recently attached to this or previous messages (the last 50 are remembered). Using this control makes it easy to add files you use frequently.

In general, you cannot send a file as an attachment if another application currently has it open. Make sure you have closed the documents you are attaching before you attempt to send the message to which they are attached, and that you do not move or delete the file prior to delivery being completed.

How Pegasus Mail decides on encoding
When you indicate that Pegasus Mail should decide how to encode an attachment, it uses the following rules to choose the most appropriate scheme:

• If the file consists only of plain ASCII text in lines shorter than 136 characters, WinPMail does not encode the attachment at all, but sends it as-is, unless the file type is set to Binary, in which case the file is sent as if it were non-textual data.
• If the address to which the message is being sent is local or an Internet address and you have checked Use MIME features in the Special view of the message editor, it will choose MIME encoding.
• If the address to which the message is being sent is local, it chooses uuencoding.
• If the address to which the message is being sent is an Internet address, it chooses uuencoding.
• If the address to which the message is being sent is a NetWare MHS address, it chooses uuencoding.
Pegasus Mail never chooses the BinHex encoding method when asked to choose an encoding mechanism – it will only be used if you select it explicitly.

**Attaching other mail messages to a message**

You can attach any mail message currently in one of your folders by dragging it from the folder and dropping it onto the message editor window. When you drop the message, a small dialog will open with a number of options that control how the message you have dropped should be handled. Check the control labelled *Add as attachment instead of including*, and Pegasus Mail will attach the message, complete with all its header information and any enclosures it contains, to the current message.

**Extensions and Message Templates**

As well as the standard Message editor, Pegasus Mail supports other methods by which you can edit or send mail messages. The first is to use *Extensions*, (which are also known as *plugins* in other applications). An extension is a specially-developed piece of software that extends the capabilities of Pegasus Mail in some way. Pegasus Mail includes a telephone message pad and a mailmerge program as standard extensions — you can access these items on the *New Message* submenu of the *File* menu, and they will usually also add their own icons to the Pegasus Mail toolbar. For more information on extensions, please see Chapter 13 of this manual.

Another way of creating or editing mail is to use a *Message Template*: Message Templates are a kind of simple script you can use to create and send mail, or to reply to mail messages. The scripting language gives comprehensive control over the way the message is created, the settings it uses, and the format and content of the text it contains. To access any templates that are available on your system, choose *Templates...* from the *New Message* submenu of the *File* menu, or press `<Shift+F7>`. Note that Pegasus Mail only ships with a couple of templates installed - you will usually write them yourself, or find them on the Internet.

When you use a template, you will typically be presented with a small dialog asking you for variables, or text that will be inserted into the mail message. At this point, you can choose to send the mail message immediately, or to load it into a standard message editor window for further manipulation. Templates are an extremely powerful way of designing your own custom forms, or for handling repetitive or complex message setup. They can be created using any text editor (such as the Windows *NOTEPAD* program) and the script language is quite simple. For detailed information on designing your own templates, please see the file called *TEMPLATE.TXT* in the *RESOURCE* subdirectory of the directory where you installed Pegasus Mail.

**Supported address types**

This is a more formal list of the type of addresses Pegasus Mail can process in your messages. Most people will not need the majority of the information in this section, so if you are not particularly interested in technical detail, please feel free to skip to the next chapter.

**Local user addresses**

Local addresses refer to users on the same system as you – for instance, if you are running Pegasus Mail on a Novell NetWare system, you can use addresses in the standard NetWare format — `USERNAME`, or `SERVER/USERNAME`; the latter case is used to send mail to a user who resides on a different file server. If you are using Pegasus Mail on a single computer but have configured it to support more than one user, then you can send mail to other users by entering the usernames they have chosen as addresses. For other Local area network environ-
ments and configurations, the exact format of a local address will depend on the details of your installation.

**Examples – Novell NetWare installation:**
- To mail to user **SJONES** on the current server, simply enter **SJONES**
- To mail to user **SJONES** on file server **SS1**, enter **SS1/SJONES**

**Examples – standalone installation:**
- To mail to the person who has chosen the username “tommy”, simply enter **TOMMY** as the address. The case of the characters you type is not significant.

**User groups**
If you are using a network environment that supports the idea of system-defined user groups (such as Novell NetWare), Pegasus Mail allows you to send mail to all members of any user group to which you have access. User groups are normally created by the system administrator, but are readable by everyone. To send to a user group, place the special character # (the hash, or pound sign) in front of the group name. In the NetWare environment you can also mail to groups on other servers. Groups are not currently supported in standalone installations – you should use distribution lists instead. You should also consider using distribution lists if you want to send mail only to some members of a group.

**Examples:**
- To mail to group **EVERYONE** on the current server, enter **#EVERYONE**
- Under NetWare, to mail to group **ADMIN** on file server **SS1**, enter **#SS1/ADMIN** – note the position of the ‘#’ character, at the start of the full address.

**Note:** the system administrator can limit the use of Group Mailing to selected users.

**Internet addresses**
If your site has a link to the Internet, then you can install a special connection which allows direct Internet mailing. The most commonly-used Internet mail transport for Pegasus Mail is called Mercury (also by the author of Pegasus Mail - visit the Pegasus Mail web site, http://www.pmail.com, for more information) — your system manager will be able to tell you if either is in use at your site. Pegasus Mail also has built-in support for Internet mail using any standard Windows Sockets implementation.

Internet addresses have the following general form:

```
username@host.domain
```

where:
- **username** is the login name of the user on the host system.
- **host** is the name of the machine on which the user is based
- **domain** is the name of the site, or location of the machine.

Any detailed discussion of Internet addressing is beyond the scope of this manual, but some points should be noted:

**Advanced formats:** Pegasus Mail will accept any valid address according to the Internet mail specification, RFC-2822. So, it is possible to enter addresses like any of the following:

```
“David Harris” <david@pmail.gen.nz>
```
Note in particular the **source routing** in the last example.

**Delivery to other NetWare servers** You can generally use the Internet gateway to deliver to other NetWare file servers on your local network by specifying the address in the form `user-name@server`.

**NetWare MHS addresses**

If Novell's Message Handling Service or a compatible system such as Infinite Technologies' Connect2is is installed on your system, then Pegasus Mail will accept addresses in any valid MHS format. MHS addresses have the form:

```
user @ workgroup
```

where:

- **User** is the MHS username for the recipient, which might be different from his or her NetWare name.
- **Workgroup** is the name of the MHS Host on which the user is found. Remote hosts that accept mail are called hubs in MHS terminology: you can mail to any hub for which your system has access information.

MHS addresses normally have a space on either side of the `@` sign; you should get into the habit of entering these spaces, since they are one of the clues Pegasus Mail uses to identify the type of address you have entered. MHS supports an extended address format as well, which will allow you to use Fax gateways, and in due course will allow you to mail to systems using totally different addressing schemes, such as X.400mailers. Pegasus Mail should accept all extended MHS address formats — some examples might be:

```
Fax @ faxgate {FAX:6434798577}
user @ smtp {“david@otago.ac.nz”}
user @ x400gate <co:fi;org:hut;na:kaukinen;>
```

You can also include an application name in a user's address if you want to ensure that he reads the message with a particular mailer. Specify the mailer by placing a period and its name after the users name, for example:

```
david . pmail @ workgrp
```

**User-defined gateways**

Pegasus Mail is able to use mail transport systems written by other developers: such mail transports are known as “user defined gateways” and are addressed using the NetWare SERV-ER/USER syntax. As an example, if your system administrator has defined a gateway called UUCP, and you want to send a message to PJONES via it, you should enter `UUCP/PJONES` as the address. Your system administrator will know if he has set up any user-defined gateways for your system.

**Address overrides**

Occasionally, you will need to mail to an address which Pegasus Mail cannot automatically detect as being of a particular type. If this happens, you may have to use an override — a special sequence of characters at the start of the address that forces Pegasus Mail to accept the
address as a particular type. Overrides consist of two or three characters and a colon: the recognized overrides in Pegasus Mail for Windows are as follows:

- **PM:** to force Pegasus Mail to treat the address as local.
- **IN:** to force delivery via the system's Internet gateway.
- **MHS:** to force delivery via MHS.
- **NB:** to force delivery to a Pegasus Mail Noticeboard.

If you use an override, Pegasus Mail will not even attempt to parse the address, and will pass it unaltered to the appropriate transport after removing the override string. The NB override is the only way to send mail directly to a noticeboard.

### Mail Merge

Many people now keep information about the people they contact in databases, contact management programs or spreadsheets. Pegasus Mail allows you to use the information from these programs to create customized mail messages.

#### Before you start - don't spam!

Before we discuss how to send out mail-merged messages, it's important to remind you that Pegasus Mail must not be used to send spam - this is explicitly stated in our terms and conditions and may also be a legal requirement in your country. Make sure that the people to whom you are sending your mail merge have consented to receive it, and provide easy, simple instructions in your message telling them how they can opt-out of future mailings in the event that they decide they no longer want them.

### Terminology - Records and Fields

We should take a moment to be clear on the terms we're going to use as we describe the mail merge process. There are two primary terms we'll be using a lot:

**Record** A record is a single line of data from your data file. It contains all the information necessary to generate a single merged message. All the records in the file are laid out in the same way, with their fields in the same order.

**Field** A field is a single piece of information from a record - for example, the e-mail address for a record will always be contained in a single field within that record. Fields can vary in length, and are separated from each other by a special character (usually either a comma or a tab).

### Messages and data files

Creating a mail merge requires two components - a standard Pegasus Mail message editor set up in a particular (but easy) manner, and a data file. The data file contains the information Pegasus Mail should use to create each message, with each line in the file containing a single record. Almost all database and spreadsheet programs can export their information in a format Pegasus Mail can use: the most common export formats are **CSV** (Comma-Separated Values) and **TSV** (Tab-Separated Values). In these formats, each field within a record is separated from the next by a reserved character - a comma (in the case of CSV) or a tab (for TSV). Pegasus Mail divides each record from the file into its fields by looking for the special reserved character between the parts.

Once you've created your data file, setting up the Pegasus Mail editor to use it is quite easy. You simply edit the message as you would normally, but wherever you want information to
be merged into the message from the data file, you type in a special placeholder, which has the form

\( \sim k<\text{field}> \sim \)

So, if you want to substitute the third field from the current record of the data file into your message at some point, you would simply type in \( \sim k3 \sim \). It's as easy as that. You can use these substitutions in any of the message editor's address fields, in the subject field, and in the message body. Pegasus Mail also has a special merge feature that allows you to specify the filename of an attachment as a field in your records (see below).

**Field numbers and names**

When Pegasus Mail loads each record from your data file, it breaks it up into its component fields, and assigns a number to each. The first piece of information on the line is field 1, the second is field 2 and so on. When Pegasus Mail encounters the special \( \sim k \) placeholder while processing the message, it examines the characters that follow the "k" and uses them to work out which field it should merge into the message at that location. For a merge to work sensibly, each record in the file should have its fields laid out in the same order - there's no point having a data file where the e-mail address is field 1 in some records and field 2 on others - it needs to be the same field in every record in the file.

**Field names**

If you find the idea of numbering the fields in each data file line a little confusing (it can be hard to remember what "field 4" was a week after you've created the file), then Pegasus Mail has a trick that can help you: you can give names to the separate fields in each record. So, you might call the first field "email", the second field "subject", the third field "product" and so on. Then, instead of using a number in the special \( \sim k \) placeholder when you want to merge a field into your message, you can use the name - \( \sim k\text{email} \sim \) instead of \( \sim k1 \sim \), for instance. Using names makes it easier to remember the fields in your data file, and makes it easier to recognize them in your message. The only restriction on field names is that no field name can start with a digit - the first character of a field name must be a letter from A to Z, although you can use digits elsewhere in the field name.

Using field names is optional - if you prefer just to use the numeric offsets for each field in the record, that's OK. You can even mix field names and numeric offsets too, if you really want. There are two ways you can give names to the fields in your data file:

**Using a separate file of field names**

Using this method, simply enter the name of a file containing the field names in order, one per line, in the Field name file text input on the message editor's Merge page. So, the first line of the field name file contains the name for the first field; the second line contains the name for the second field and so on. You can use the Edit... button next to the text input area to create and manage your field name file. Field names can contain any character except a comma.

**Including the field names in the first line of your data file**

If your source program supports it, you can format the first record in the data file so that each field in the record actually contains a name that Pegasus Mail should use for that field instead of data - here's an example first line (from a file presumed to be in CSV format):

```
email,name,product
```

This line tells Pegasus Mail that field 1 can also be called "email", field 2 can also be called "name", and field 3 can also be called "product". All the remaining records in the file are treated as data laid out using these field names.
Setting up a merge

To set up a merge, start a new message by pressing Ctrl+N, and switch to the Merge page. Click the checkbox entitled Enable Mail Merge for this message: this tells Pegasus Mail to provide specialized merge treatment when processing the message, and will enable the remaining merge controls on the page. Enter the name of the data file Pegasus Mail should use in the Data file section, and select Tab, Comma or Other to tell Pegasus Mail how the fields in the file are delimited. If you select Other, type in the special characters that separate the fields in the space provided. If you have a file of fieldnames, or want to create one, type the name in the Field name file section; or, if the data file has a first record that defines field names, check the control labelled Pegasus Mail should interpret the first line in the data file as a list of field names. That's all there is to it: now, simply switch back to the Message page and compose your message normally, remembering to use ~k<field>~ placeholders wherever you want data to be merged into the message. In particular, you must use one of these placeholders in the message's To field - using the Quick Setup button can simplify this process for you (see below). You can test your merge before sending it by doing a dry run - see below for more information.

Stationery  You can save a mail merge as stationery and reuse it as often as you wish. You can also save a mail merge as a regular message draft if you want to come back to it later.

Quick setup

The Quick Setup button on the message editor's Merge page is an easy way of filling in the To and Subject editor controls for the message: when you click this button, Pegasus Mail will open a small dialog asking you which field in each record contains the e-mail address, and which field (if any) contains the subject for the message. You can enter either a field number or a field name in these fields (although clearly you can only use a field name if your data file is set to define field names on its first line). When you click OK, Pegasus Mail will insert the proper placeholders into the To and Subject controls on the message editor's Message page for you.

Dry runs - testing your merge

If you're like me, the idea of running a mail merge that might generate thousands of messages is an extremely uncomfortable one - the mind tends to dwell on what might go wrong. Wouldn't it be reassuring if you could try a "dry run" of the merge with a few records from the data file, just to make sure that everything looks OK before you do the real thing? Well, you can - simply check the button entitled Dry run - simulate the merge on the message editor's Merge page, then enter the number of records to process in the text box. Pegasus Mail will take that number of records from the file and will process them as if a full merge were being done; instead of actually sending the messages out, however, it will simply write them into your new mail folder, where you can examine them normally. When you do a dry run, Pegasus Mail will not close the message editor window as usual when you click the Send button - instead, it will leave the message editor open. When you've had a chance to examine the dry run results, simply uncheck the Dry run... control on the Merge page and click Send to perform the actual merge. Note that when doing a dry run, Pegasus Mail will not create a copy-to-self for the merge, even if the option is selected.

Attachments

Mail-merged messages can have two types of attachment: the first is simply an attachment added the normal way in the message editor's Attachments page. When you add an attachment normally, it will be sent to every recipient of the merge. You can also specify attachments by including them as a field in your data file. When you do this, simply type the field numbers or names that contain attachment filenames in the Attachment fields section on the
message editor's Merge page. Here's an example: say that fields 4 and 5 in each record of your data file contain an attachment filename that Pegasus Mail should add for that merge: you would simply type

4,5

in the Attachment fields section. Or, let's say that you've defined field names that call field 4 att1 and field 5 att2 - you could enter this into Attachment fields instead:

att1,att2

If an attachment does not exist, or if the field is blank, Pegasus Mail will not add it, and no error will occur - so, you can send a merge where some messages have extra attachments and some don't. Attachments you specify as merge fields are only sent for the message created by the record where they appear, whereas attachments added normally are always sent as part of every message generated by the merge.

**Merging and rich text messages**

You can use any type of formatting you wish in a mail-merged message. You can place fields in tables, and you can use pictures. The only restriction is that if you attempt to apply a style to a placeholder, the style will only work if it extends at least one character before and after the placeholder - you can't have a style (such as bold or italic) that applies only to the text that replaces the placeholder character: it has to apply to text on either side of the placeholder as well, or it will be lost.

**Limits**

- A data file can have any number of records (lines)
- A single record in a data file can be a maximum of 10,000 characters long
- A single record in a data file can have a maximum of 99 fields.
- No single field in a record can be longer than 1000 characters
- Only the first 32 characters in a field name are significant

**Things to watch out for**

*Copy-to-self* be careful when using copy-to-self with mail-merge messages: when you set the copy-self flag for a merged message, the result will be that every message generated by the merge will receive a copy-to-self. Also, if you have the program set to prompt for the destination copy-to-self folder, this setting will be ignored for mail merges (although copy-self filtering rules will still be applied normally).

*Spam filtering and dry runs* when you do a dry run on a mail merge, the simulated messages are written directly into your new mail folder, where they are treated like any other new mail message: this means that new mail filtering, Spamhalter, and Content control processing will all be done on the messages. This may have unexpected effects, depending on the types of filters you have active. On the positive side, though, if your own spam filters decide that the message looks like spam, then that's quite a good indication that other peoples' filters will probably do the same, and that you should change the wording of the message to avoid that (hint: using Spamhalter's Explain spam classification option by right-clicking the message in the spam folder can give you an idea of what you might need to alter).

*Time* Running a mail merge can take quite a long time - it's one of the most intensive processes that Pegasus Mail can undertake. To give you an idea, a mail merge with 50 records and fairly simple formatting can easily take 12-15 seconds. If you have a data file with many hundreds or thousands of records, make sure you allow plenty of time for the process to complete.
before clicking the 'Send' button: while the merge process is running, you cannot perform any other action in Pegasus Mail.
5: Reading and filing your mail

Mail folders and trays

Pegasus Mail stores your mail messages in Folders: your new mail folder is created for you automatically, and you can create other folders as you need them. The program knows how to manipulate several different types of folder, although the differences between them will be transparent to you in normal use. There are very few practical limits on the number of folders you can have, or on the number of messages each folder can contain – as an example, we routinely test Pegasus Mail on mailboxes with more than 2000 folders, some of which have more than 20,000 messages. We suggest that you develop a strategy for filing your mail early on in using the program: common strategies are to create folders for mail from specific people, or for mail on specific topics. A little thought given to the way you plan to keep your mail can make it much easier to find messages later on when you have a significant amount of mail stored, especially when you automate the management of your folders with Pegasus Mail’s powerful mail filtering rules (see chapter 6 for more information on filtering).

Pegasus Mail allows you to organize your folders in a hierarchy – that is, to have folders within folders. To achieve this, it supports two kinds of folders: standard message folders, which contain messages, and trays which contain other folders. A tray can contain standard mail folders or other trays and there is no limit to depth to which you can "nest" in this manner. Trays are like subdirectories under Windows Explorer - they contain folders (like files) and other trays (like subdirectories) but cannot themselves contain messages – only folders can contain messages.

The Folder Manager window

To manage your mail folders, select Mail folders from the File menu, press <Ctrl+L>, or click on the Mail Folders button in the Button Panel and the Folder Manager window will open. The Folder Manager shows all the mail folders Pegasus Mail can find in your mailbox, as well as any System-wide folders, or folders which are available to all users on the system. Depending on how your system has been installed there may be restrictions placed on what you can do with mail in a system-wide folder — for example, you might not be permitted to delete mail from the folder or move mail into it. Folders which show in green in the folder selector are folders which contain unread mail. It is possible for unread mail to appear in folders other than the new mail folder as a result of new mail processing rules. At the extreme right of each line in the folder selector you will see a pair of numbers: these represent the total number of messages in the folder and the number of unread messages in the folder respectively.

Preview mode and “Classic” mode

The Folder Manager window can work in either of two ways – Preview mode, in which your folders are shown in a group on the left of the window, the contents of the current folder are shown at the top right of the window, and a preview of the current message is shown at the bottom right of the window; and Classic mode, in which only a list of your folders is shown, and you can open any folder in its own window. Preview mode will be most familiar to people who have previously used programs like Microsoft Outlook, while Classic mode will be familiar to long-time Pegasus Mail users. Each mode has advantages – preview mode allows you to scan messages in a folder very rapidly, while classic mode makes it easy to have different folders and messages open at the same time. Switching between preview and classic modes is simplicity itself – click the Preview button in the folder manager’s toolbar to switch to preview mode, or if you are already in preview mode, click the List button to switch back to classic mode. Pegasus Mail remembers the size and position of the window separately for
Reading and filing your mail

The Folder Manager window

We suggest that you experiment with both modes to find out which one best suits the way you work.

Note: If the folder manager window is too narrow, the Preview/List buttons may not be visible; when this is the case, there will be a green arrow button at the right-hand side of the button panel in the window: simply click this arrow button to scroll the unseen buttons into view.

Working with your folders

To open a tray or folder and work with its contents, highlight it in the folder list and press Open, or double-click on it: if the selection is a folder, it will be opened in its own window. If the selection is a tray, it will open in place, showing its contents indented one level (in a manner similar to the Windows File Manager). If you wish to close a tray, you can do so by double-clicking it again. If you have checked Save desktop state between sessions in the General settings page of the Options dialog, then the Folder Manager window will remember which trays are open and closed between sessions. As well as double-clicking them, you can also open and close trays by clicking on the little + or - box next to the folder icon, or by pressing the right arrow key (to open) or the left arrow key (to close).

Speed search You can select folders and trays quickly when the folder list window is open by typing the first few characters of the folder’s long name. If the item you select is a tray, you can open it by pressing <Return> or <Right arrow>, after which speed search will operate within the tray.

To create a mail folder or tray, click on the New button. A dialog will appear asking you for a name and type for the folder. You can enter anything you wish in the long name field up to 50 characters, but you should consider choosing a name which is a meaningful reflection of the contents of the folder. Pegasus Mail supports a variety of types of mail folder via plug-ins - depending on the plug-ins installed in your system, you may be able to create folders of various types. The two standard formats supported by Pegasus Mail are its own native format, which is backwards-compatible with earlier versions of the program, and the Unix mailbox format, which is used by programs such as Qualcomm’s Eudora. If you want to create a filing tray rather than a standard message folder, check the Tray control at the lower right of the dialog. Click on the OK button to accept the information you have given: Pegasus Mail will create the folder for you and add it to the list.

Renaming an existing folder is similar to creating a new folder: you can change the long name to anything you wish, although some types of folder may place restrictions on the characters that can be used in a name: if this is the case, you will see a warning as soon as you click the OK button.

To delete a folder, highlight it and click the Delete button. Deleting a folder is a permanent step, so you should be careful when doing it. A tray can only be deleted when it no longer contains any other trays or folders.

Navigating within folders and messages in preview mode

When the folder manager window is operating in preview mode (see above) Pegasus Mail offers some shortcuts for moving around in the preview areas. Pressing the plus or minus keys will move to the next or previous message in the current folder, while pressing the space bar will page the current message down. You can also use the <Tab> key to move from pane to pane in preview mode, in case you need to do more specific operations, such as selecting groups of messages. Using the navigation keys in preview mode can speed up working with your mail considerably.
The Folders menu
When the Folder Manager window is the frontmost window, the Folders menu is available. This menu contains specialised or less frequently-used commands for managing your mail folders and trays.

Add mailbox to list... see below, under Accessing multiple mailboxes.

Open all trays Expands every level of your folder hierarchy, revealing every folder and tray you have.

Close all open trays Makes the folder view revert to a simple list of all your top-level folders and trays.

Quick open Allows you to open any of the folders you have defined for quick moves or copies. See under The Folder Menu later in this section for more details.

Font Allows you to choose the font used to display the Folder Manager’s list of folders.

Right-clicking in the list of folders
Right-clicking a folder in the folder manager window may bring up special options specific to that folder, depending on the type of folder and the plug-in module that supports it. Most folders and trays will support some or all of the following four options:

Move selected entry... Allows you to move the tray or folder to another location in the hierarchy. You can also do this by simply dragging the folder and dropping it in its new location within the folder hierarchy.

Folder information... Usually opens a small dialog giving you specific information about the selected folder.

Close all open trays, Open all trays The same as in the Folders menu – see above.

If you click on a folder in Pegasus Mail’s own native folder format, you will see the following extra options on the right-click menu:

Check consistency Use this command if you want to make certain that a folder is intact and undamaged. Pegasus Mail will apply a number of tests designed to validate the folder’s contents and will report the results to you.

Reindex folder On rare occasions, a folder may become damaged. Pegasus Mail has a number of internal checks for this and when it detects a damaged folder, it will instruct you to use this command to rebuild the folder’s index. Reindexing a folder may result in some status information about the message being lost (for instance, whether a reply has been sent).

Recover deleted space When you delete mail from a folder, Pegasus Mail simply marks the message as deleted, but does not actually recover the space it occupies until a certain threshold is reached (usually around 20,000 characters in total deleted space). You can force Pegasus Mail to recover the space occupied by deleted messages in a folder by highlighting the folder and selecting this option. This option is always safe, because Pegasus Mail will automatically check the consistency of the folder before attempting to recover the deleted space.

Accessing multiple mailboxes
One of the most powerful capabilities of Pegasus Mail is its ability to present multiple mailboxes in your folder window. To understand how this might be useful, imagine that you are
a secretary charged with managing your employer’s mailbox in his absence: using this feature, you can simply access your employer’s mailbox from your own copy of Pegasus Mail, examine his mail, move it between folders, and even copy messages between your own mailbox and his, all without ever exiting from the program.

To add another mailbox to your folder list, choose Add mailbox to list... from the Folders menu. In the dialog that opens, you can type in either a username, or a path. If you enter a username, and have sufficient rights, that user’s mailbox will be added to your folder list. If you enter a path, all the folders that can be recognized by the foldering plug-ins installed in your copy of Pegasus Mail will be asked to report the folders they can find in that directory. Given that Pegasus Mail can read unix mailbox format folders, as used by Eudora, Netscape and other mailers, this can be an easy and effective way of importing mail from those programs when you move to Pegasus Mail.

Folders in the newly-added mailbox list may be manipulated just as if they were your own; you can open them, read the mail they contain, delete mail from them, even drag messages from them to your own folders or vice-versa.

Some notes: at present, the hierarchy of the added mailbox is not presented in your list, but any hierarchy you create is remembered from session to session without affecting the owner’s own hierarchy. The owner’s new mail folder is made available to you by this mechanism, but it will not automatically update as new mail arrives – you need to close and reopen it to see any mail that has arrived since you opened it. Finally, you should not move folders between mailboxes; Pegasus Mail permits it because there are situations where it might be useful, but doing this does not actually move the folder – it only moves the reference to that folder, which can be confusing, since the folder will no longer appear in the listing of the mailbox where it actually resides.

Searching for text in your folders

Over time, it is likely that you will build up quite a collection of e-mail (Pegasus Mail's author, for example, has over 4 Gigabytes of stored mail in more than 600 folders). As the quantity swells, it can become harder and harder to remember where you have put particular messages, especially if it is some time since you did it: in such cases, a powerful search facility becomes invaluable.

You can search your folders in two ways: either click in the list of folders and press Ctrl+F (or select Find text from the Edit menu), or open a single folder, click anywhere in its message list, and press Ctrl+F. Either method will open the Pegasus Mail folder search dialog.

Although Pegasus Mail's folder search dialog may look complex and daunting, the actual process of searching for a message is really very simple - it consists of three steps:

1: Enter the text for which you want to search
2: Tell the program the folders it should search
3: Specify any extra conditions (or constraints) to narrow the search

Only the first of these steps is required - the other two are optional, but using them can dramatically increase the speed at which the search will operate. In particular, searches that only use search constraints (that is, searches with no main expression but one or more constraints defined) are startlingly fast.

Entering the text for which you want to search

Pegasus Mail can search for a group of words, for a phrase, or for a regular expression.
When you select this type of search, Pegasus Mail will treat each word you type into the text field as a separate search item, and will match any message that contains any of those words. Messages that contain more than one word, or in which any of the search words occur frequently will be given higher relevance scores (you can sort a search result folder by relevance). Messages that contain any of the search words in the order in which they appear in the search field will score significantly higher relevance scores.

This type of search tells Pegasus Mail that you want to use a regular expression (or pattern match) and that the text you have typed in is a valid pattern it can use. Regular expressions are very powerful, but are largely aimed at advanced users.

When you select this type of search, Pegasus Mail will search for the text you enter as a literal string - so, if you enter Mary had a little lamb as your search text, Pegasus Mail will only match messages that contain all of those words in that order. This is the most basic type of search.

Other search options

Checking this control tells Pegasus Mail that it should only search for the text you have entered in the special headers that appear at the start of every mail message - it will not check the body of the message at all. This option can dramatically improve the speed of searching, so if you are sure that the text you are looking for appears somewhere in the headers of the message, checking this control is very worthwhile.

This control is only available when you have specified **Multiple terms** as the search type: it tells Pegasus Mail that a message should only match if it contains all the terms you have entered. The difference between using this control and selecting **Single phrase** as the search type is that, when using this option, the search terms can appear in any order in the message, so long as they are all present.

Usually, Pegasus Mail disregards the case of the text it is searching - so, it would regard MARY and Mary as equivalent. Checking this control tells Pegasus Mail that it should pay attention to the case of the text and match only when the search string and the text in the message are exactly the same. Note that regular expression searches are always case-insensitive - checking this control has no effect on a regular expression search.

When you search your folders, Pegasus Mail puts the results of the search in a special type of folder in the Recent search results tray in your folder list. Usually, these folders are permanent, just like any other folder, but if you check this control, Pegasus Mail will automatically delete the search results folder for this search when you exit from the program. Note that you can change the default setting for this control in your preferences, on the Folder Behaviours page.

If you start a search while the list of folders is active, Pegasus Mail will offer to search all folders in the current mailbox. If you start a search while the list of messages in a particular folder is active, the program will offer to search only that folder.

There are many other options you can use to control the range of folders in which your search will take place - you can select those options by clicking the arrow at the right of the drop-down list and selecting the option you want. Most of the search modes in the list are fairly self-explanatory, but one or two may require a little extra clarification.
Search the current folder only  The folder that will be searched if you select this search mode depends on what you are doing when you request the search: if the master list of folders is active, then the folder selected in the list will be the one searched; if you request your search when any other list or window is active, the folder displayed in that window at the time is the one that will be searched.

Select one or more specific folders to search  When you select this search mode, a button entitled Select... will appear below the list of search modes. Click this button and Pegasus Mail will allow you to search as many folders as you want for the search. Hold down the CTRL key to select multiple folders individually in this list. Only folders that can actually contain messages may be selected in this way - if you select an item (such as a Pegasus Mail tray item) that cannot contain messages, it will be ignored when the search is performed.

Search only folders whose names contain specific text If you select this search mode, a text field will appear between the list of search modes. Pegasus Mail will compare any text you put into this field with the name of every folder in your mailbox, and if the folder's name contains the text, it will be searched. The text is always matched on a case-insensitive basis - so "Copies to" and "COPIES TO" will be regarded as a match.

Allow searches in link folders and search results folders  Usually, Pegasus Mail won't search in search results folders, or in its special link folders. If you particularly want to search through these types of folder (for instance, to narrow down a search you have already done), check this control. Note that searching through link folders can be considerably slower than searching through other types of folder.

Search folders contained in sub-folders as well  This option only appears if you select Search the current folder only or Search the current folder and all folders at the same level: it tells Pegasus Mail that if any of the folders you have specified contains other folders, it should search those folders as well.

Specifying search constraints

Search constraints are controls that narrow down the selection of messages Pegasus Mail will actually examine when performing the search. While constraints are purely optional, they can have a huge impact on the speed of searching. To explain why this is so, a small discussion of how Pegasus Mail handles folders is necessary: to Pegasus Mail, a folder is usually actually two files - a master file, which contains the text of every message in the folder, and an index file, which contains a special pre-generated snapshot of certain information in the message, such as its From and Subject fields, its date, and some information about its properties. Pegasus Mail can access the index file for a folder very rapidly - far more rapidly than it can access the raw message data in the master file: so if a message can be eliminated from a search on the basis of its indexed information, no access needs to be made in the master file and the search will be faster. Because the difference in speed between accessing the index and accessing the master file is a factor of something like one hundred times, it's clearly worthwhile to optimize your searches if you can.

Constraints-only searches  If you define a search that only uses the constraints described in this section (that is, a search where the main search expression is empty but one or more search constraint is defined) then the search will be blindingly fast because Pegasus Mail never has to go to the master file for data. This type of constraints-only search is easily the fastest way to find data in your folders, if the data you need to search for is amenable to it.

Message age constraints  You can limit the messages Pegasus Mail will search to particular age or date ranges using the options in this group of controls. The program allows you to specify an arbitrary age range, or an arbitrary date range. It also provides a number of "con-
convenience" ranges pre-configured, such as Search only messages dated within the last seven days. The options are mostly quite obvious.

Other search constraints These options allow you to narrow the messages that will be searched even further. As discussed above, these options work on the information Pegasus Mail stores in the folder's index file, which means that these tests can be done very rapidly. For the From and Subject constraints, though, it is important to understand that the index only contains a subset of the actual field in the message - so, the From field in the index usually contains the person's name rather than his or her e-mail address, and this is all that can be matched by these constraints. The easiest way to understand this restriction is to look at a folder list in Pegasus Mail: whatever you can see in the From and Subject columns there is what is contained in the folder's index file, and hence is also what these constraints will examine if you enable them.

When constraining a search to messages that have had a colour assigned to them, please note that "Black" is never considered a colour. If you set a message to "Blue", then set it back to "Black", that message is regarded as not having an assigned colour any more.

Working with search results
When you perform a search, Pegasus Mail creates a special search results folder in a tray called Recent search results near the top of your master list of folders. The search results folder has the text you searched for and the date and time of the search as its name. The search results folder is a special type of folder called a link folder - it does not contain the actual messages that were found in the search, but special links to those messages instead. This means that link folders are very small and efficient, and they can contain references to messages in many other folders. When you select a link folder and view its contents, you will see an extra column at the right of the list of messages: this column shows the name of the folder where the message is actually stored. You can work with link folders in exactly the same way as you would work with any other folder.

Saving and loading searches
If you have particular searches that you perform regularly, you can save them and load them again at any time. Simply set up the search as you want it to proceed, including any folder selections on which you want it to operate, then click the Save button. Pegasus Mail will prompt you for a filename and location, defaulting to a directory called Searches in your home mailbox directory.

When you click the Load button, Pegasus Mail will prompt you to select a search you have previously saved from this dialog. Any settings you have defined in the dialog will be replaced with the values stored in the saved search.

The Folder Browser
The folder browser presents all the messages in a folder in list form, in its own window: you can open folders in their own window like this in either Preview or Classic mode. The folder browser window has its own Folder menu with sorting and special options, and a number of buttons. Each message in the folder appears on a single line in the browser window showing the sender’s name, the subject of the message and the date it was sent. If you have read the message, a tick will appear to its left and if the message has attachments, a small bullet, or dot will appear next to the tick; messages using the Internet MIME multipart format will appear marked with a small square block instead of a dot. If the folder is the new mail folder, urgent messages will appear in red at the top of the list; urgent mail is not distinguished in
any way after it has been filed (because once you've filed it, it is presumably no longer ur-

gent).

Message status indicators (folder view)
Pegasus Mail reserves a small amount of space to the left of each message in a folder to show
you status indicators, which tell you various extra pieces of information about the message.
The following status indicators can appear to the left of a message:

<table>
<thead>
<tr>
<th>Status Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A tick</td>
<td>Indicates that the message has been read</td>
</tr>
<tr>
<td>A blue arrow</td>
<td>Indicates that a reply has been sent to the message</td>
</tr>
<tr>
<td>A red arrow</td>
<td>Indicates that the message has been forwarded to another address</td>
</tr>
<tr>
<td>A paperclip</td>
<td>Indicates that the message has multiple parts (usually a textual body part and some attachments, although not always).</td>
</tr>
</tbody>
</table>

Working with messages
You can work with individual messages in the folder by clicking on them to highlight them,
or you can select multiple messages by holding down the Ctrl key as you click on them. You
can select a range of messages in the folder by holding down the Shift key and dragging the
mouse down the list. All the buttons in the folder browser will work on single or multiple
messages. The buttons along the top of the browser window can all be activated by pressing
the capital letter shown on the button (so pressing O in the folder browser has the same effect
as clicking the Open button). The buttons have the following functions:

Open Opens the message reader for all highlighted messages — see the next section for de-
tails on reading messages.

Reply Allows you to send a reply to a message or a selection of messages – this is covered in more detail below.

Forward Click the Forward button in the address browser to send the selected messages onto
another address. See below for more information.

Move Click the Move button to move the message from the current folder into another folder.
The folder selector window will open allowing you to select or create a new folder. If you
select a folder from the list and click Open, the message will be taken out of the current folder
and placed in the folder you chose.

Copy The Copy button operates in much the same way as the Move button except that a copy
of the message is placed in the selected folder — the original remains where it is.

Delete The Delete button deletes all selected messages and any associated attachments. If
you have turned on Preserve deleted messages until exit in your preferences, the message will
be moved to a special folder called Deleted messages, which Pegasus Mail will create as nec-
necessary; you can open the Deleted messages folder like any other until the moment you actu-
ally quit from Pegasus Mail at which point the contents of the folder are purged and lost
forever. If you are not preserving deleted messages, your message will be deleted as soon as
you press the Delete button. Although preserving deleted messages is an excellent safety net
it can consume considerable amounts of disk space while Pegasus Mail is running and should
be used with care in environments where disk space is low.

Info The Info button opens a dialog which contains more detailed information about the se-
lected messages, one at a time. Pegasus Mail keeps accurate information about whether each
message has been forwarded, read, and replied to.
Find  Allows you to search for text within the messages in the folder. Note that, in keeping with the standard Windows hotkey conventions, you press <Ctrl+F> to activate this command from the keyboard.

Replying to mail

Clicking the Reply button in either the folder window or the standalone message reader (see below) will cause the reply dialog to open for each selected message in order, starting a new message editor for each one. The reply dialog presents the following options for preparing your reply:

Include text of original message in reply  If you check this control Pegasus Mail will load a copy of the original message into your reply. You can freely edit the included text without affecting the original message in any way. Combined with the option to comment-out the included message, this option is an extremely useful way of providing a conversational context to your reply — it allows people who may have forgotten the content of the original to refresh their memories, and is a highly recommended technique.

Prefix the original text with ‘>’  When this control is checked, Pegasus Mail places a ‘>’ character at the start of each line included from the original message. Doing this provides a clear distinction in the reply between sections from the original message and your text in reply. This control has no effect on the message if the Include original message control is not checked. We strongly recommend that you use this control when you generate replies which include the text of the original message.

For replies to HTML, preserve the original’s formatting  When this control is checked, Pegasus Mail will examine the message to which you are replying: if it is an HTML message containing graphics or formatting of any kind, it will insert it into the message preserving the formatting it contains. When doing this, it is no longer possible to prefix lines from the original with ‘>’ markers, and that setting will be ignored. The original message will be inserted complete with all its formatting below a line saying “Original message follows”. This setting only applies to HTML messages containing formatting – it is ignored for non-HTML messages.

Omit original message’s headers  Pegasus Mail usually includes the most important headers from the original message in replies, but if you prefer to have only the message text, click this control. The setting of this control does not affect whether or not a custom header is used (see the next section).

Use custom header line  This special formatting option allows you to add an automatically-generated line of text at the start of your reply, using a template you supply. This effect is popularly used on the Internet, generally resulting in header lines which look like “On 5 May 1995, Joe Bloggs wrote”. When you turn the option on by checking the control, Pegasus Mail will open another dialog in which you should enter the template you want it to use to generate your custom header. The template is a simple line of text which can contain special placeholders showing where a text element from the original message should be placed in the formatted version. Placeholder characters consist of a tilde (~) and one special character identifying which element the placeholder represents. Pegasus Mail recognizes the following placeholders:

-~A  The original sender’s full e-mail address
-~F  The original sender’s personal name, or the sender’s e-mail address if no personal name can be found
The default template Pegasus Mail supplies is “On ~D at ~T, ~F wrote: ”; Pegasus Mail remembers whatever template you enter and whether or not you have opted to use it from session to session.

**Special handling for long lines from the original message** Different mail programs create their messages in different ways (unfortunately). Some mail programs use long lines, and some mail programs even put entire paragraphs on a single line. While Pegasus Mail can handle lines up to 1000 characters long, you typically won’t want to be sending out messages like that. Accordingly, the program offers several ways of adjusting the data from the original message to more sensible formats. If you check the radio button entitled **None**, then Pegasus Mail will not attempt to reformat the lines it includes from the original message at all: they will be included as-is, although they will be truncated at 1000 characters in length. Selecting **Reformat** tells Pegasus Mail that it should try to reformat long lines from the original message intelligently, by recognizing lines that are already quotes from earlier messages and so forth: this option works well for many types of message and is the default. If the original message is one of those bizarre monsters where entire paragraphs are stored on a single line, the **Wrap** option may work better for you: this option simply splits the line repeatedly at the right margin until there is no more left.

When it comes to handling long lines from the original message, there is no one method that will work for every possible message. Experiment with the three options to see which one you prefer in general use, and be conscious that there may be certain types of exceptional message you receive that might require the use of another option.

**Copy original’s CC field into reply** Checking this control tells Pegasus Mail to copy the CC (Carbon Copy) field of the original message into your reply, which effectively CCs the same people who received CCs of the original message.

**Identity for reply** This control allows you to use an alternative identity, or group of preference settings, when preparing your reply. If you choose an identity in this control, the settings for that identity will be applied to the reply, no matter what identity is currently active in the system. For more information on Identities, see the chapter later in this manual.

**Address reply to...** If you check the control labelled **All recipients**, Pegasus Mail will attempt to send your reply to everyone who received the original message. If the length of the addresses exceeds 32000 characters, Pegasus Mail will create a temporary distribution list containing them. Pegasus Mail tries to remove your own address from the list of addressees when you use the **All recipients** option, but cannot guarantee that it can always determine which address is yours. It attempts to preserve the precedence of the original message — so those who were CC recipients of the original message will be CC recipients of your reply. If you check the control labelled **Selected addresses**, then the group of controls at the bottom of the dialog will be enabled, allowing you to select specific addresses from the original message for your reply.

**Address options** The addressing controls at the bottom of the reply dialog allow you choose addresses from the original message to which you wish to reply. Pegasus Mail examines the original message looking for address fields and presents them to you with a control you can check or uncheck depending on whether or not you want each address copied into the To field of your reply. Clicking on the **Address reply to all recipients** control disables the address selection controls and sends your reply to all addresses. Otherwise, only the checked addresses
will be copied into the reply. Remember that the maximum length of an address field in Pegasus Mail is 32000 characters, so if you select more addresses than can fit into that length some will be truncated. When using the Selected addresses option, all the addresses you select will be copied into the To field of your reply – no attempt is made to preserve the precedence of the fields.

If your address selections result in no addresses being selected for the message, Pegasus Mail will ignore your selections and will try to use the Reply-to address then the From address from the original message in that order. Once you click OK in the reply dialog, Pegasus Mail will open a standard message editor ready for you to compose and send your reply.

Replying using a template Pegasus Mail has a template scripting language that can be used to generate pre-formatted replies: a file containing these scripting commands is called a Message Template, and can be used to automate much of the process of generating replies to messages. Using a template, you can send automatic replies with a couple of keystrokes, send back complex responses with attachments, perform list processing — in fact, nearly anything you could normally do using the standard message editing facilities of Pegasus Mail can be automated using templates. For detailed information on writing Message Template scripts, please see the file called TEMPLATE.TXT, which you can find in the RESOURCE subdirectory of the directory where you installed Pegasus Mail. To use a template to create your reply, hold down the <Shift> key as you press <R>, or as you click the Reply button. Note that as shipped, Pegasus Mail does not include any templates suitable for generating replies to mail messages — you will typically need to write these yourself, or else find them from friends or on the Internet.

Forwarding mail

Quite often, you may want to refer a message or messages to someone else, either unmodified or else adding your own comments in the process: this is called forwarding, and Pegasus Mail provides a number of powerful options for handling it.

When you click the Forward button in the folder manager window (in preview mode), a standalone folder window, or the message reader, the Forwarding dialog will open. At the bottom of the forwarding dialog you will see a list of the messages Pegasus Mail is going to forward for you - you can forward any number of messages in one operation (the Create a MIME digest option is especially useful for this). If there are messages in the forwarding list that you didn’t intend to forward, simply select them and click the Remove button – this will remove them from the forwarding list (it will not delete them or change them in any other way – it will simply remove them from the list). At the top of the forwarding dialog is an address field, complete with its own addressing centre button (please see chapter 4, Sending mail, for information on using the addressing centre) – enter the address to which you want to forward the selected messages in this field.

There are four separate ways you can proceed with forwarding the message, each represented by one of the radio buttons in the Forwarding method box:

Edit or make changes to the messages before forwarding them When you select this method, each message you want to forward will be opened in its own message editor window, where you can add or remove text before sending the message onwards. When you forward with changes like this, Pegasus Mail will send the message with new headers identifying you as the sender, because the text is no longer in its original form. Selecting this option displays three extra groups of controls in the forwarding dialog:

Word-wrap long lines in the message editor When checked, this control allows Pegasus Mail to reformat paragraphs included from the original message which can result in a
better looking but less faithfully-formatted representation of the text you are forwarding. Checking the button enables the Reformat and Wrap radio buttons next to it: as with replies (see above), these options approach the wrapping of the forwarded data differently, and each will be better for different types of message. Experiment with them to get a feel for how they work (see above under Replying for more detailed discussion on what each wrap mode attempts to do).

**Forward any attachments the message has as well**  When you check this control, Pegasus Mail will attempt to copy any attachments the message has and reattach them to the new message editor window. From there, you can use the Attachments view of the message editor to remove any of the attachments you do not want to forward, or to attach other files that you want to send as well. When using this option, Pegasus Mail does its best to preserve the filenames and all attributes of attachments.

**Header insertion** These three radio buttons allow you to control how much of the original message's headers should be included in the body of the new message that gets created - you can choose between tidy headers (only the most important headers are included), no headers, or all headers (useful for reporting abuse or spam).

**Forward the messages without editing (redirect, or “bounce”)**  When you select this forwarding method, Pegasus Mail will send the message on to the new addressee without further modifications. It adds three special Internet mail headers that indicate that the message has been forwarded, but the message will not otherwise be altered – it will still appear to be from the original sender and all attachments and other characteristics of the message will be preserved as they are. Other mail programs refer to this type of forwarding as “redirecting” or “bouncing” mail. This forwarding method has no special options.

**Start a new message with the messages attached**  This is a particularly useful forwarding method if you want to send a group of messages together for reference: Pegasus Mail starts a new mail message and adds the selected messages to it as attachments. A special option is set when attaching the messages which ensures that they are preserved as mail messages in transit, completely unmodified. You can, of course, add other attachments to the new message as well if you wish.

**Create a MIME digest containing the messages**  A MIME Digest is a specially-formatted mail message that acts as a container for other mail messages. Well-written mail programs will recognize this format and will present the MIME digest as if it were a kind of mini-folder, allowing the messages it contains to be easily browsed using familiar message reader windows. This option is particularly useful for things like discussion lists and in situations where you want to send a group of related mail messages in a way that makes it easy for the recipient to browse through them. This forwarding method has one special option:

**Subject line**  MIME digests are sent out without any further editing from you, so you can use this field to create a descriptive subject line for the digest itself. Naturally, each message within the digest will preserve its own subject line – this field simply lets you set the subject field for the digest container itself.

**Use this identity to forward the message**  All forwarding methods allow you to select a Pegasus Mail identity that should be used to create and send the message – simply select the name of the identity you want to use in this control. The default value is whatever identity you currently have selected for the program as a whole. For more information on identities, please see Chapter 14 in this manual.
Incremental search through a folder’s messages

Full-text searching can take a while: if you know that the text you want to search for appears in either the subject field or the from field of the message, however, Pegasus Mail can perform a very fast type of search called an incremental search, which is the fastest way of finding messages when you know exactly what you are looking for in a folder. Press the <F5> key or choose Incremental search from the Folder menu and a small window will open. As you type characters into this window, Pegasus Mail will scan through the messages in the folder looking for any message that contains what you have typed so far in the selected field. If multiple messages match what you have typed, Pegasus Mail will stop on the first one, but you can move to subsequent matched by clicking the Next match button, or simply pressing <Enter>. You can press <Backspace> at any time to change what you have typed so far, and the program will immediately re-search the folder. Incremental searching only looks in the text that you can actually see in the From or Subject columns on the screen: these columns typically contain a précis, or summary of the actual text in the message field – so, the “From” column usually does not show the sender’s address, just the sender’s name. Press <Esc> or click <Cancel> when you have finished incremental searching.

Selecting messages

From time to time, you may find yourself wanting to work with a group of messages that are related by some common characteristic, such as being from the same sender, or being older than a particular number of days. Pegasus Mail provides a particularly powerful command that allows you to select messages in this manner based on an arbitrary range of conditions you specify. To use the Select command, choose it from the Folder menu, or press <Ctrl+F9>, and the Select dialog will open.

The Select dialog looks complex, but is really very easy to use. All you do is create a list of Selectors, or conditions that a message must meet in order to be selected. Selectors can work on any of several standard message characteristics – choose the one you need from the group of buttons at the left-hand-side of the dialog. Each type of selector will open another small dialog prompting you for the information it needs, which is pretty obvious in most cases. Unless you use the And button (see below), any selector that matches a message will result in that message being selected. As you create each selector, it will appear in the selector list at the right-hand-side of the dialog. New selectors are inserted after the highlighted selection in the list.

Negative conditions

Sometimes, you may want to select a message that does not meet a particular condition - for instance, you might want to select all messages that are not from a particular person. In this case, simply create the Selector normally, highlight it in the selector then click the Not button; the selector will change in the selector list to indicate that you have selected negation. The Not button is a toggle, so clicking it again will reverse the negation.

Linking selectors using the And button

If you want to select a message that meets more than one condition, then you can link the selectors together by clicking the And button. When you use the And button, the two selectors that it connects must both be met before the message will be selected. You can link together as many selectors as you wish using the And button – simply click the button after you create each selector.

Selection actions

You can choose one of two actions that should happen when you click the select button: the first, Highlight all matching messages found in the folder, will simply highlight all the messages that match the selectors you have defined. This is useful if you want to move or copy the messages to another folder, or take some action that simply manipulates the messages as a group. The second action, Sort matching messages to top of the folder, moves all the messages that match your selection criteria into a group at the top of the folder; the
messages will be sorted according to whatever sort method you have currently defined for the folder, and you can change the sorting method without disturbing the grouping. This action is particularly useful if you want to read or review a group of related messages.

**Saving and loading selector sets**  Pegasus Mail remembers the selector list you have created between instances of the select dialog (so you can easily apply the same selection set to different folders, or can “tune” a selection set over two or three attempts), but it will forget them when you exit from the program. If you create a particularly useful selector set that you think you might want to use in future, click the Save button to save it to disk. You can then reload it at any future time by clicking the Load button.

**Quick-select**

Pegasus Mail provides a quick way of selecting all messages in the current folder from the same sender as the currently-selected message, or alternatively, all messages in the current folder with the same subject string. To use this quick-select operation, simply select the message you want to use as a model, and press Ctrl+Q, or select Perform quick selection from the Quick select menu on the Messages menu (if you are in Preview mode) or the Folder menu (in Classic view mode). By default, Pegasus Mail quick-selects on the From field, but you can alter this to quick-selection by subject using the options on the Quick-select menu. If you want to unselect a quick-selection you have made, press Ctrl+Shift+F9.

**Grouped views**

Pegasus Mail provides numerous different ways of sorting your folders, but sometimes sorting simply isn't enough to make it easy to navigate your mail, especially if you receive a lot of it: sometimes you want to group your messages together in ways that are more complex than simple sorting allows - Pegasus Mail allows you to do this with Grouped Views.

A Grouped View is a way of combining related messages together in groups within your folders. For example, you may want to group all the messages from Winston Churchill together in one group. Where a Grouped View improves on simple sorting, though, is that it creates a hierarchy - each group of related messages can be collapsed to a single entry in the list, making it much easier to find and work with specific classes or types of message. When in a grouped view, each group in the list has a caption, which is a kind of heading bar identifying the contents of the group. The caption has a standard collapse/expand box at its left allowing you to expand or collapse the view of that group within the overall message list.

Grouped views are essentially a layer that sits on top of a sorting method, and as such, selecting a grouped view may change the sorting method of your folder. Pegasus Mail offers the following grouped views:

**Group by day**  Messages sent on the same day are grouped together. The group's caption shows the date.

**Group by week**  Messages sent in the same week are grouped together. The group's caption shows the week covered by the group.

**Group by month**  Messages sent within the same month are grouped together. The group's caption shows the month covered by the group.

**Group by subject**  Messages with the same subject are grouped together. The group's caption shows the common subject for all the messages in the group.
Reading and filing your mail

The Folder Browser

Index by subject Messages are grouped based on the first letter of their subject lines. The caption shows the index letter for the group.

Group by thread Messages are grouped on subject, and sub-sorted by reverse date, so that the newest messages appear at the top of the group. The caption shows the common subject for the thread.

Group by thread activity The same as grouping by thread, except that the groups themselves are sorted again based on which groups contain the newest messages. Groups that contain new mail are sorted above groups that contain only read mail. This is an incredibly handy and useful way of dealing with discussion groups, mailing lists and other situations where several topics are under discussion in the same forum at any time. The group's caption shows the common subject for the thread.

Group by sender Messages are grouped by the name of the person who sent them. The group's caption shows the name of the sender.

Index by sender Messages are grouped based on the first letter of the sender's name. Each group's caption shows the index letter for the group.

Group by colour Messages are grouped by the colour you have selected for them. Each group's caption shows the colour common to the messages in the group.

Group by Spamminess Messages are grouped by the extent to which they have been classified as Spam by Spamhalter.

Note that when you turn off grouped views, the sorting mode that applied to the grouped view remains active in the list: so, if you switch to a Thread Activity grouped view then press <Ctrl+Shift+0> to return to a normal, non-grouped view, the message list will be sorted by thread.

Turning on a grouped view How you turn on a Grouped View depends on whether you run Pegasus Mail in Preview mode (with the 3-pane view) or in Classic mode (where each folder opens in its own window).

• In preview mode Choose the grouped view you want from the Grouped View submenu of the Messages menu.

• In classic mode Choose the grouped view you want from the Grouped view submenu of the Folder menu.

Alternatively, and much more quickly, you can switch between grouped views using the following special hot-key sequences:

<table>
<thead>
<tr>
<th>To switch to this view...</th>
<th>Press:</th>
</tr>
</thead>
<tbody>
<tr>
<td>No grouped view (normal view)</td>
<td>Ctrl+Shift+0</td>
</tr>
<tr>
<td>Group messages by day</td>
<td>Ctrl+Shift+1</td>
</tr>
<tr>
<td>Group messages by week</td>
<td>Ctrl+Shift+2</td>
</tr>
<tr>
<td>Group messages by month</td>
<td>Ctrl+Shift+3</td>
</tr>
<tr>
<td>Group messages by subject</td>
<td>Ctrl+Shift+4</td>
</tr>
<tr>
<td>Group messages by thread</td>
<td>Ctrl+Shift+5</td>
</tr>
<tr>
<td>Group messages by thread activity</td>
<td>Ctrl+Shift+6</td>
</tr>
<tr>
<td>Group messages by sender (“From” field)</td>
<td>Ctrl+Shift+7</td>
</tr>
</tbody>
</table>
The Folder menu

When a Folder Browser window is frontmost on the screen, the Folder menu becomes active. The Folder menu contains options which allow you to control how a folder is sorted, to locate text within messages in a folder, and special options for messages within the folder.

Select... Opens the Select dialog (see the previous section for more information on using the Select dialog).

Quick select This submenu contains the options for quick-selection in the current folder: see above for more information on quick-selection.

Incremental search... Opens the Incremental search dialog (see two sections above for more information on incremental searching).

Sorting options Pegasus Mail can sort your folder on any of six criteria — by date, by subject, by sender, by colour, by size or by thread. Sorting by thread shows the messages in the folder sorted by Subject, then sub-sorted by reverse date, which effectively groups related messages in chronological order. To change the sort order of the folder, click on the appropriate heading above the column in the folder window, or select the new sort order from the Folder menu. Pegasus Mail remembers the last sort order you selected for each folder, and applies it to each time you subsequently open that folder. You can reverse the order of any of the sorting methods by choosing Sort in reverse order from the Folder menu; alternatively, clicking the column header representing the current sort order will reverse that sort order, just as it does in Windows Explorer.

Sort unread before read If you check this option, Pegasus Mail will divide the folder into two groups of messages – messages you have read, and unread messages. Each group will be sorted using the currently-selected sort method, but the unread messages will always appear as a group at the top of the folder.

Apply timezone correction When this option is ticked, Pegasus Mail will attempt to allow for timezone differences when sorting messages by date or reverse date. This may not be completely reliable because many people do not specify their time zone correctly in mail messages, but it will mostly work. Pegasus Mail tries to adjust the messages relative to your own timezone, both for sorting and display.

Save messages to disk Select this option if you want to copy the contents of a message or messages to text files on your disk which you can then use in other applications. You can also select this choice by clicking on the Save to disk icon in the button panel, and, in keeping with standard Windows hotkeys, by pressing <Ctrl+S>. If only one message is selected, Pegasus Mail will simply ask you for a filename into which it should be placed. If more than one message is selected, a dialog will open asking you how you want to extract the messages.

- The first option, Extract to a single file, will simply place the text of all the messages in one file you name.
- The second option, Ask for names, will extract each message to a file of its own, asking you for a name for each file.
The Folder menu

The last option, Create unique names, will extract each message to a file of its own, asking you only for the name of the first file; each message after the first will be saved to a file with the same name as the first file, but a numeric extension starting at 000. All the files will be created in the same directory.

Set colour You can apply any of twenty colours to the messages in your folder. Using colours with your messages can make them stand out and when used with the sort by colour sorting option allows you to group mail based on your own selection criteria. You can also set the colour of messages using filtering rules.

Quick actions The Quick action menu option allows you to set up certain predefined operations that you can perform with a single keystroke or menu selection. Up to six quick actions can be defined using the Define quick actions... menu command. For each of the six slots, you select a type of action (Move/Copy message, or Apply filtering rule set), then either select a folder for the copy/move option, or a filtering rule set. When in a folder window, quick foldering operations will apply to all selected messages in the current folder list. You can activate any of your quick foldering operations at any time while you are browsing a folder or reading a message by holding down <Ctrl> and pressing the number of the operation you want to perform (1 through 6). If you want to be able to perform the same operation simply by pressing its number (without having to hold down <Ctrl>) then you can check the control labelled Allow activation without pressing Ctrl when in folder windows in the quick actions definition window. Filtering as a quick action is useful if you want to combine a number of operations into a single command – for instance, if you use colour coding when you file your messages, you might create a simple filtering rule set that changes the colour of the message then moves it to another folder.

Annotations An Annotation is a textual comment you have added to a mail message. You can add, view and remove annotations to any mail message using the options on the Annotations submenu. Messages with annotations are marked with a small green dot in the folder window – you can add, edit or view the annotation associated with a message by double-clicking on that dot, or by pressing <Ctrl+9>. Annotations are stored in a separate file from the message and are automatically deleted when the message is deleted. You can move an annotated message from folder to folder without disturbing the annotation.

Special options The Special submenu on the folder menu contains specialized options for dealing with messages in your folder.

UUdecode message, UnBinhex message While Pegasus Mail can always recognize attachments sent to it by other copies of Pegasus Mail, it does not always recognize the conventions used by other mailers to indicate that a mail message is an attachment. If you receive a uuencoded or Binhexed message from another mailer which Pegasus Mail does not recognize as an attachment, you can force it to extract the message using these options. Attachments sent in these formats will appear to be line after line of gibberish characters with the lines almost all the same length. Binhexed attachments will always have the legend “This file must be converted with BinHex X.X” near the top of the message, while uuencoded attachments will generally start with a line something like “begin 660 filename”. Selecting either of these options presents you with a dialog where you give a filename to which the decoded data should be saved on your system.

Invert selected items goes through the entire folder selecting any messages that are not currently selected and deselecting any messages that are currently selected. This is occasionally useful if you want to apply an action to all the messages that do not match a condition. You will most normally use this option after doing a Find operation with the Mark all matching messages option set (see above for more details).
**Mark messages as unread**  If you select this (or press Ctrl+U), then all messages highlighted in the folder window will be marked “unread”, meaning that no checkmark will appear next to their entries in the list, and new mail filtering rules will apply to them the next time the folder is opened. Messages marked as unread are not automatically moved out of the new mail folder to the main folder when the new mail folder is closed. You can use this command in folders other than the new mail folder as well, if you wish.

**Mark messages as read**  Just like the last option, except that the status of the selected messages will be changed to indicate that they have been read. You can press Ctrl+R to activate this command.

**Delete all expired messages**  Selecting this option will delete all mail messages in your new mail folder that are past their expiry date. Not all messages will have expiry dates; those which do and which are expired will display in grey in the folder. This option has no effect on folders other than the new mail folder.

**Edit message flags**  Allows you to examine and change the properties of the selected message.

**Add sender to distribution list, Remove sender from distribution list**  These options allow you to add or remove the address of the person (or people if more than one message is highlighted) who sent the message to you to a distribution list with a single command. When you select either option, Pegasus Mail will open the distribution list selector window and ask you to choose a list. The addresses will be added to or removed from the list you select.

**Find/verify digital signature**  Select this option and Pegasus Mail will ask all encryption modules installed in your system if they can find a digital signature (see the section Encryption under Message options, above) in the current message. This option is only useful if you have installed third-party encryption modules that support digital signing - Pegasus Mail’s built-in encryptor does not support digital signatures.

**Key Management**  Again, this option depends on the presence of third-party encryption modules in your system. For some encryptor modules, it will open a dialog giving you the option of working with settings specific to that module. A typical use of this option might be to add someone’s public key information to your keyring if you have a public key encryption package such as PGP installed.

### Right-clicking within a folder

When you right-click a message in a folder, you will be presented with a menu offering most of the options on the Folder menu, except the sorting options. See the descriptions above for more information on the options in the right-click menu. One extra option is available when you right-click a message in a folder - **Start new message to sender**: this is a handy way of beginning a new message to someone if you have a message from them in one of your folders: Pegasus Mail will find the proper reply address from the message and will start a new message with that address pre-entered in the To field.

### Re-sending a copy-to-self message

When you right-click on a message that was created as a copy-to-self (using the Copyself option in the message editor), an extra option will be available on the popup menu — **Resend this message**. When you select this command, Pegasus Mail will create a message editor window and will attempt to set it up as it was when the message was originally sent: this includes adding any attachments that were added to the original message, setting the address fields as they were, and adjusting the message controls (for example, Confirm reading). You can make
any further changes you want to the message before sending it again. Note that the original copy to self message is not affected by anything you do to the resent version, and if you turn on Copyself in the resent version, a new copy-to-self will be made instead of overwriting the old one.

## Reading messages

You can read any message in a folder by double-clicking on its entry, or by highlighting it and clicking the Open button. When you do so, the message reader will open, displaying the message for you. The message reader window has a set of buttons which provide most of the same functions as their counterparts in the Folder browser window and like the Folder browser, has its own menu for message-specific functions, the Reader menu. There are also four extra buttons in the window, which are discussed in this section.

The Reply, Move, Forward and Delete buttons in the message reader all have exactly the same function as the same button in the Folder browser, but apply only to the open message even if other messages are highlighted in the folder. Deleting the current message will either load the next message from the folder into the reader or close the reader window, depending on the settings you have made in the Message Reader preferences page.

### Print

The Print button prints the current message; pressing the button is exactly the same as selecting Print from the File menu. Clicking Print will open Pegasus Mail’s printer dialog box: by default, Pegasus Mail will print to the last printer you selected, or to the Windows default printer if you have never selected a printer. You can tell Pegasus Mail to use a different printer by clicking in the field containing the printer’s name and choosing from the list which appears. The Setup button brings up the dialog specific to the printer you have selected and allows you to make changes to its configuration. By default, Pegasus Mail uses the same font as the message reader window itself when printing messages: if you prefer to use a different font or size, you can alter that setting on the Message reader preferences page.

### Next, Prev

The Next and Prev buttons in the message reader replace the contents of the reader window with the next or previous message in the folder browser list from which the original message was opened; you can also press the <Keypad Plus> and <Keypad Minus> keys to activate these operations. You can control the way Pegasus Mail behaves when you click these buttons using the options on the Next/Prev skipping mode submenu of the Reader menu - the program can “skip over” mail you have already read, stopping at the next unread message, or the next message for which you have set a colour, at your option. The hot keys for changing the skipping mode, <Ctrl+Shift+0> to <Ctrl+Shift+3>, offer a very fast way of changing the way the message reader navigates within a folder - getting into the habit of using them can have an enormous impact on the efficiency with which you can read your mail.

Holding down the <Ctrl> key while clicking Next, Prev, Delete or Move will load the next or previous unread message from the folder into the Reader window instead of simply loading the next message. You can control what Pegasus Mail does when the Move or Delete buttons are clicked while reading a message using the Message Reader preferences page in the Options dialog.

### Message status indicators in the reader

To the right of the tabs at the top of the reader window, you will see a group of icons: these are the message reader status indicators, and display information about the message at a glance. If an icon is grey, then the message does not have that characteristic; if the icon is coloured, then the message does have that characteristic. So, for example, if the small “lock”
item is coloured, then the message is “locked”, or marked read-only, and cannot be deleted. The status indicators are as follows:

- The message has (or may have) attachments
- A reply has been sent for this message
- The message has been manually forwarded to another address
- The message is marked read-only (cannot be deleted or moved)
- The message’s display colour in the folder (green in this case)

Hyperlinks and URLs (World Wide Web links)

Pegasus Mail scans the messages you read for URLs (Uniform Resource Locators), or World-Wide-Web links. A URL is a special way of formatting a reference to a Web page, and usually starts with the letters http: or ftp:. When WinPMail finds a URL in a mail message, it displays it in underlined green text (you can change the colour of the hyperlinks on the Hyperlinks preferences page). When you see a URL highlighted this way, you can double-click on it to launch your Web Browser (for example, Netscape, or Microsoft’s Internet Explorer) to go to that page. Double-clicking on a mailto: URL tells Pegasus Mail to start a new message using the e-mail address in the URL. By default, Pegasus Mail uses the browser defined by your Windows settings, but if none is selected, then the first time you double-click a URL, WinPMail may ask you to tell it where your Web Browser is so it can run it: type in the path to your web browser application, or else locate the file from a list by clicking the Browse button.

Restrictions: There are certain limitations you may encounter with this feature, most specifically that some Web Browsers will not correctly start a new copy of themselves if one is already running. There is, unfortunately, nothing we can do about this – it’s a problem in the web browser applications themselves. If you encounter this problem, the only way to work around it is usually to quit from your browser before double-clicking the URL. It’s also a limitation of the message format that we cannot always correctly identify URLs that span multiple lines.

Working with attachments

If the message you are reading has attachments, the attachment indicator will be coloured in the message reader’s status panel, and the Attachments tab will be enabled to allow you to switch to the attachments view of the message, where you can examine the list of attachments. If you are working in Pegasus Mail’s preview mode, click the Attachment View button (next to the Sender information on the grey ribbon below the message list) or press <F7> to switch from message body preview mode to attachment preview mode.
The attachment view shows the filename for the attachment and the type of file if known. You can save the attachment to a disk file by highlighting it and clicking on the Save button. When you save the attachment to a file, Pegasus Mail will offer you the original filename as a filename for the new file: you can accept this name, or change it if you wish.

**Previewing, opening and saving attachments**

When you are using the message reader window (as opposed to the preview area in the multipane preview mode) Pegasus Mail can preview a range of different attachment types in the preview area of the reader’s attachments view. If it determines that it can preview a particular attachment, it will automatically load it into the preview area when you click on it. You can disable this automatic preview function by clicking the Preview button. Click the button again to re-enable the preview function. Clicking the Print button will print whatever is currently previewed in the preview area.

The Open button in the attachment browser will be available if an application is available on your system which can be run to display the attachment. To determine whether or not an attachment can be opened, Pegasus Mail first checks to see whether you have defined a suitable viewer in your preferences (see Attachment viewers in the Preferences section); if it cannot find a suitable viewer there, it examines a Windows database called the Registry, where associations are stored: these associations tie particular file extensions to applications which can read files of that type and are usually automatically updated when you install a new package. When you open an attachment, Pegasus Mail creates a copy of the file and runs the appropriate program. At this point, you can do anything you wish with the data, but if you change it, you should save the file under a different name before closing the message, because Pegasus Mail will delete it when you close the attachment browser. You cannot modify the original attachment using the Open button.

If you want to save the attachment to a file on your hard disk or network and then run a program to view or edit it, you can click the Save and Edit button. Unlike the Open button, Save and Edit creates a permanent file which you can edit as you view it. You will usually use this option when someone sends you a document to review or annotate and then return.

**Deleting attachments**

Attachments are deleted when the message itself is deleted. You can usually also delete attachments from messages while they are in the new mail folder: you can delete attachments selecting them and clicking the Delete button. This option is only available while the message is still in your new mail folder — it is not available once the message has been moved into any other folder. If you want to delete attachments from a message you have moved into a folder, you must move it to the new mail folder, remove the attachments, then put it back in the folder where you want to store it.

**Replying to, and forwarding attachments**

You can forward individual attachments from a message to another user by clicking the Forward button in the attachments view: note that this does not forward the whole message — only the selected attachment. When forwarding attachments, Pegasus Mail will start a new message for you with the selected attachment attached to it.

If an attachment is textual in nature (for instance, is a text file, or the body of an e-mail message), you can reply to it: doing this from the attachment view differs from replying in the message view in that if you ask to load the original into the message editor for the reply, the selected attachment will be loaded instead of the message body. The reply is in all other respects just the same as replying to a message in the normal way — the same addressing and message setup options are available.
Annotations

An Annotation is a textual comment you have added to a mail message. You can add, view and remove annotations to any mail message by switching to the Annotations view of the message editor (click on the Annotations tab). Messages with annotations are marked with a small green dot in the folder window. While you are using the Annotations view, you can save the annotations for the message to a disk file using the Export button, or read a text file into the annotations using the Import button. Clicking the Timestamp button is a quick way of entering the current date and time into the annotation.

Viewing the raw version of the message

When it displays a mail message to you, Pegasus Mail does quite a lot of work “tidying it up” so that you see it in a clear, easy-to-grasp format. From time to time, you may find it useful to view an e-mail message in its raw, “un-tidied” form – for instance, if you receive an offensive mail message you may want to view the full set of message headers so you can determine whether or not it is genuine. To see the message in a completely raw form, click the Raw view tab. While in the raw view, you can select any text and copy it by pressing <Ctrl+C>. You can switch quickly between the raw view and the normal message view by pressing <Ctrl+H>, or the <Backspace> key.

The Reader menu

The Reader menu contains the following less frequently-used options:

Save window size  Forces Pegasus Mail to remember the current size of the message reader window as a default for future use. If you have resized the message reader window to a size you find comfortable and would like to use that size every time you read a message, you can use this option. Pegasus Mail does not remember the position of the window, only the size. Remembering the position is not practical since Pegasus Mail can open multiple messages simultaneously and it would not be desirable to open them all on top of each other.

Toggle monospaced view  changes the font used to display the message between the Courier font and back to your normal font. Items like tables and lists may sometimes require a fixed pitch font like courier in order to display correctly. Note that formatted text, such as headers and hyperlinks, are unaffected by this command. It also has no effect on HTML or RTF messages.

Save message to file  This option allows you to take the text of the message and save it in a file on disk. Selecting the option opens a dialog asking for a filename – you can give any legal filename on any volume or device on which you have write access. The resulting file will be in plain DOS text format.

Wrap long lines, Reformat long lines  Periodically, you will probably receive mail from other mail systems where the lines are extremely long, and hence can't easily be read. These two options allow you to deal with malformatted mail of this kind - which of the two you will use depends on the message. Wrap long lines simply chops the line at the nearest space to the right margin until the line is shorter than the right margin. This option is simplistic, but will work well if the sender's mail program sends whole paragraphs as a single line. Reformat long lines applies a much more complex reformatting approach that tries to estimate how the message was intended to appear: it will usually do a better job of most messages than simple wrapping, but may scramble tables or figures that depend on long lines. After a time, you will work out which of these settings suits the particular types of mail you receive. Whichever you
turn on will remain turned on for subsequent messages until you turn it off or select the alternative method.

Next/Prev skipping mode  The options on this submenu control how Pegasus Mail should behave when you click the Next or Prev button in the message reader window. You can tell the program to “skip over” messages you have already read, messages where no colour has been assigned, or both. These options have hotkeys, and can be used as a quick way of navigating through particular types of messages in a folder, especially if you use colour coding to classify your messages.

Quick actions  Quick filing and filtering options – see The Folder Menu, above, for details.

Special options  This menu contains a subset of the options provided in the same menu in the Folder menu; for more information, see the section entitled The Folder Menu above. The options in this menu work only on the open message.

Font  The Font option allows you to choose the font which should be used to display the message from those installed in your copy of Windows. Changing the message reader font is a global operation — changing it for one message reader window will change it in all message reader windows. Note that HTML messages may specify their own default fonts, in which case the font you have selected will be overridden while the message is being displayed.

Finding text  You can find text in a mail message by selecting Find text from the Edit menu, or by pressing <Ctrl+F>.

**Right-clicking while reading a message**

When you right-click in the body of a message you are reading, a menu will open offering most of the same options as on the Reader menu. The following extra options are present:

**Copy**  Copies the current selection from the message to the clipboard

**Copy selection to DList**  If you have highlighted an e-mail address in your message, you can select this command to add that address directly to a distribution list without having to copy, open the list, paste the text, then close the list. This option can be particularly useful in conjunction with filtering rules that trigger based on distribution list membership (see the chapter on Rule-based mail filtering for more information on this).

**Open selection as hyperlink**  If a link in your message is not highlighted, or is incorrectly highlighted, you can select a block of text then choose this option to tell Pegasus Mail to pass the selected text to your web browser as if it were a hyperlink. This is especially useful for dealing with links that span multiple lines.

**Open in web browser**  Some HTML messages contain items that Pegasus Mail cannot or will not process, such as scripts or Java code: HTML being what it is, there will also be some pages that depend on particular features of a specific browser application to display. If you get a message like this, clicking this link tells Pegasus Mail to make a copy of the message as a file, then pass that file to your web browser.

**Caution!**  Pegasus Mail goes to considerable lengths to protect you from malicious content in HTML messages, but cannot do so when the content is displayed in a web browser. You expose yourself to any exploits to which your browser is vulnerable by using this option.
Show pictures (HTML only) If the message contains remote-linked graphics, these will usually display as grey rectangles in Pegasus Mail. You can tell the program to retrieve and display these remote-linked graphics by selecting this command, but please read the next cautionary section very carefully before you decide to do so.

A digression: the evils of remote-linked graphics When used in e-mail, HTML is expected to use a special type of formatting known as MHTML (Mail-based HTML), in which any graphics the page needs are included in the message as attachments and specially referenced. Unfortunately, some mail program developers have chosen to ignore MHTML, and simply use regular remote links to graphics in the messages they generate. Apart from being extremely inconvenient (because you can only read the message properly when you are online), the use of remote-linking graphics in this way creates some very serious risks of invasion of privacy. The simple fact of downloading a remote-linked graphic can reveal, for example, any of the following facts:

- That your e-mail address is valid
- That you have read the message, and when you did so
- How often you read the message
- Whether you forwarded the message to someone else
- What type of Windows operating system you use
- Your system’s Internet address, and from that, where you are located (often down to the city level), the ISP you use.
- That you are online, and if done often enough, an overall impression of your work habits and the hours you keep.

– and all of this simply by downloading and displaying a graphic. What’s worse, in many cases, the graphic may be a one-by-one pixel (that is, invisible) graphic that you’re not even aware is there; this type of “invisible graphic” is called a “web bug”, or “web beacon”, and is a cynical and insidious way of tracking information about you. Lest you think that this phenomenon is limited to spam, it should be pointed out that many large online resellers and subscription services routinely use web bugs in this way to track information about you.

For this reason, we strongly urge you not to download remote-linked graphics: sure, sometimes they will be benign, and nothing more than the result of laziness on the part of the sender or the developer of the sender’s software... But the risk associated with remote-linked graphics is so great that we do not believe you should be taking it unless you are very sure of the people with whom you correspond.

Note: Of course, there will be some occasions where you either know the people sending you the mail with remote-linked graphics, or where you’re happy to accept the risks associated with them. For cases like this, Pegasus Mail offers a Remote-linked graphics exception list, where certain addresses can be placed to allow any messages from them to display remote-linked graphics automatically. See the Message reader section in the Preferences Chapter (Chapter 11) for more on this.

Start new message to sender Selecting this option will start a new message, with the sender’s address pre-entered in the To field. If the message contains several addresses that might be used (for instance, if the message has a Reply-to field different from the sender’s From address) Pegasus Mail will pop up a small dialog allowing you to select the address to use.

Reply using a template This option allows you to generate a reply to a message using a pre-written template. Please see chapter 16 for more information on message templates. You can also simulate this command from the keyboard by holding down the Shift key when you press <R>. 
Set message colour in folder  Allows you to change the colour currently assigned to the message. The message reader’s status indicators will change to reflect the new colour immediately.

Save message data to file  Allows you to save the contents of the message to a text file. You can also press Ctrl+S to achieve this.

Spamhalter classification  The options on this submenu allow you to tell the Spamhalter Bayesian Filter (see Chapter 6) to classify the message as either spam or not-spam without moving the message from its current location, and also allow you to examine the cues in the message that led Spamhalter to classify it as it did.

Add sender’s address to...  These options provide quick ways of adding the sender’s address to various places in the system where they might be useful:

• Distribution list  allows you to add the sender’s address to any of your distribution lists. A window will open allowing you to select a list, and the address will be added to it. If the address already appears in the list, it will not be added again.

• Addressbook  allows you to create an addressbook entry for the sender, with the sender’s name and address pre-entered. A window will open in which you should select the addressbook where the entry should be created: when you select an addressbook, the addressbook entry editor for that addressbook will open, allowing you to fill out any other details before saving the entry.

• Global whitelist  allows you to add the sender’s address to your Global Whitelist. The Global Whitelist (discussed in Chapter 6) allows you to exempt certain addresses from being spam-checked. Pegasus Mail adds any candidate address it finds in the message (from the From, Reply-to and Sender fields) to the whitelist. If the address is already present in the whitelist, it will be promoted to the top of the list.

• Allow remote graphics list  This option allows you to add the sender’s address to the list of addresses whose messages should automatically be allowed to display remote-linked graphics (see above) automatically. Please exercise caution when using this option.

Remove sender’s address from...  This submenu contains options that do the reverse of the Add sender’s address to items, removing the address from the specified list.

Search for digital signature, Key management  These options allow you to perform cryptographic tests on the message, and require the installation of external third-party encryption modules. Please see the documentation for your encryption module for more information on using these options.

Message properties  Allows you to examine and adjust various pieces of information about the message.

Digests

If you are subscribed to a mailing list, you may occasionally receive mail in digest format. A digest message is simply a message that contains a number of other messages. When you open a digest message, Pegasus Mail will present it to you in a form similar to a standard folder window, allowing you to open the individual messages in the digest by double-clicking them. You can perform most standard options on messages in a digest, including printing, but you cannot move or delete an individual message from a digest (you can copy a message from a digest to a folder, though). Similarly, the quick move option will not work in digests either. You can choose the sort order of a digest by clicking on the column headings in the digest.
window; holding down Ctrl as you click the heading selects the reverse form of the sort. So, to sort by Subject, click the Subject column heading. To sort by reverse date (oldest messages first) hold down Ctrl and click the Date/Time column heading. The small button to the left of the From column heading causes the digest to appear in its natural order, or the order in which the messages actually appear in the digest.

Messages you have read in a digest will show a tick mark next to them, but for technical reasons, the tick will only appear while you have the digest open. The next time you open the digest, all the messages it contains will appear to be unread again.

**Copying text from a message**

You can copy text from a message to the Windows clipboard by highlighting the section you want and selecting Copy from the Edit menu, or by pressing <Ctrl+C>. You can select the entire message for copying by choosing Select all from the Edit menu, or by pressing <Ctrl+A>. 

---

5: Reading and filing your mail

*Copying text from a message*
6: Mail and Spam Filtering

Pegasus Mail can perform comprehensive automated evaluation and processing of your mail as it arrives in your mailbox. Using automated evaluation allows you to pre-sort messages into folders for later examination, detect and eliminate unwanted commercial e-mail, highlight certain messages that are important and so on. There are three separate processes that can perform automated handling of e-mail in Pegasus Mail:

1: General-purpose rule-based mail filtering  
   Rule-based Mail Filtering is a general-purpose system that can be used to select messages in any folder and perform arbitrary actions on them. You can create any number of rules performing a wide range of actions, and can apply them at any time. You can have any number of general-purpose filtering rule sets; Pegasus Mail also supports special sets that are automatically applied to your new mail (either when the new mail folder is opened, or when it is closed), to your copies-to-self, and another type of set that can be used to filter mail in your POP3 account before it is downloaded. General purpose filtering is not intended as a spam filter - it has a much wider range of uses and is intended for day-to-day use in sorting and arranging your mail. Pegasus Mail was the first mail program to have general-purpose mail filtering, way back in 1991, and its implementation is still the most powerful and useful in the industry.

2: Content control  
   Content control is a specialized type of filtering that provides powerful content analysis processing. While originally intended as a rule-based spam filter, Content control can be used anywhere you want to evaluate a message based on a detailed analysis of its content. Content control is a powerful complement to the Spamhalter Bayesian Spam filter (see below) – a combination of the two can catch very high levels of spam.

3: Spamhalter  
   Spamhalter is a Bayesian Spam Filter developed by Lukas Gebauer of Ararat s.r.o in the Czech Republic. Bayesian spam filters learn about your mail over time and can classify messages as spam or not-spam based on the mail you receive. Aimed purely at detecting spam, Spamhalter is a very easy and powerful tool that can achieve very high spam detection rates with very little effort or maintenance. When combined with the rule-based classifications provided by Content control, Spamhalter is an exceptionally powerful solution to the problem of spam.

General-purpose rule-based mail filtering

Pegasus Mail can process mail automatically according to sets of instructions (or rules) that you provide. This feature can be very powerful – for example, it is possible to define a set of rules which will pick out mail from a specific person, print it, then delete it, completely without your intervention. There are two ways you can create mail filtering rules in Pegasus Mail – you can use the Filtering Rule Wizard to create simple rules, or you can use the Full Filtering Rule Editor to harness the full power of the feature.

Using the Filtering Rule Wizard

If you want to perform simple tasks in your new mail folder, such as automating the filing of particular messages, then the Filtering Rule Wizard is an easy and intuitive way to do so. Simply select a message you want to use as a model for creating the rule, then click the Filter... button on the Folder window’s toolbar (the button is available in both Preview and “Classic” folder display modes). Pegasus Mail will analyze the message and will then open the Filtering Rule Wizard: this Wizard has three pages, and requires you to go through four easy steps to create the new rule.
Step 1 – Choose the test to apply  Pegasus Mail can create rules for you based on either the addresses in the message (the "From", "To", "Reply-to", "Sender", and "Return-path" headers), or on the Subject of the message. Click the radio button next to the type of test you would like Pegasus Mail to perform.

Step 2 – Choose when the rule should be applied  Pegasus Mail supports two separate sets of rules for your new mail folder: the first set is applied when the folder is opened, while the second is applied when the new mail folder is closed. Normally, you will use the Wizard to create rules that are applied when the new mail folder is opened, but if you particularly want the rule applied to the folder-close set, check this control.

Step 3 – Defining the trigger condition for the rule  The form this step takes depends on whether you chose to create a rule based on the addresses in the message or the subject; if you chose a rule based on the addresses, Pegasus Mail will show you all the addresses contained in the message and will allow you to select the ones you want to use to trigger the rule. You can select as many addresses as you wish, although you will typically only select one. The addresses you select will be the ones Pegasus Mail checks for when it applies the new rule to messages arriving in your new mail folder. If you chose a rule based on the subject, Pegasus Mail will present you with an editing field containing the subject line from the model message. You can either accept it as it is, or, more usually, you can edit it down to just the significant part for which you wish to test.

Step 4 – Define the actions to take when the rule triggers  In this step, you will choose one or more actions Pegasus Mail should take when it encounters a message matching the criteria you have chosen. The six options you can choose from allow you to:

- Move the message to a specific folder
- Set a display colour for the message
- Forward the message to another e-mail address
- Send a text file as a reply to the sender of the message
- Delete the message
- Exempt the message from further rule processing

Most of these actions are quite self-explanatory, but some combinations are not possible – for instance, you cannot both Move and Delete a message (the Wizard will not allow you to select both actions). Pegasus Mail is careful to ensure that the actions are applied in a sensible order when it creates the rule – so, if you choose to set a display colour for the message and then move it to a folder, the colour will be assigned before the message is moved. The Exempt the message from further rule processing option is a handy way of “whitelisting” particular messages – it prevents any other rule in your new mail filtering rule set from being applied to the message.

When you have decided on the actions the rule should take, click the Finish button, and Pegasus Mail will create one or more rules that implement the tasks you have requested. The Filtering Rule Wizard always creates new rules at the top of the filtering rule file, so they will be applied before any other rules you may have previously created. The Rule Editor button in the final page of the Wizard’s dialog allows you to open the Full Filtering Rule Editor so you can see or adjust the rules it has created.

Using the Full Filtering Rule Editor  Using Pegasus Mail’s Full Filtering Rule Editor is a little more complex than using the Filtering Rule Wizard, but it gives you the greatest possible control over a very powerful facility. It is also the only way you can create copy-to-self rule sets, POP3 filtering rule sets and
Mail and Spam Filtering

General-purpose rule-based mail filtering

rule sets that can be attached to folders other than the new mail folder. You can create and edit four quite distinct types of rule sets using the Full Editor:

- **New mail filtering rules, entry and exit** These are two separate sets of rules that are applied automatically to your unread mail when you open and close your new mail folder respectively. If the new mail folder is open, any new mail filtering rules you have defined for application when the folder is opened will also be applied to new incoming mail as it is picked up and added to the folder. Using new mail filtering rules approximately doubles the time it will take Pegasus Mail to open or close the new mail folder. New mail filtering rules can be accessed by clicking the Filtering rules button on the button panel, or by selecting an option from the Mail filtering rules submenu of the Tools menu. You might create entry rules to process mail you don’t usually need to see, such as confirmations of reading, or subscription requests, while you would use exit rules to clean up any mail that might be left in your new mail folder when you close it.

- **Copy-self filtering rules** These rules are applied automatically to any copies you make of your outgoing mail. This allows you to have your copies to self automatically filed based on the recipient, the subject, or any other criteria you care to define.

- **General rule sets** General rule sets can be applied to any folder or to a selection of messages in a folder at any time. They are never applied automatically – only in response to your specific command. To apply a general rule set you have created, choose Apply general rule set to folder from the Mail filtering rules option on the Tools menu. You can also use general rule sets as quick actions in your folders – this especially powerful feature allows you to perform complex sets of commands on a message with a single keystroke.

- **POP3 download filtering sets** These rules are applied to messages in a POP3 mailbox before they are downloaded. You can, for instance, create rules that only download certain messages based on their address or size (very useful if you have a POP3 mailbox shared by several addresses). POP3 rules are generally limited to tests that could be applied to message headers or attributes – you typically cannot perform extensive tests on the body of the message in a POP3 rule.

To define rules, select the appropriate option from the Mail filtering rules submenu of the Tools menu, and the rule editor will open. You can also access the new mail filtering rule set applied when your new mail folder is opened directly by clicking the Filtering rules button on the program’s main toolbar.

A rule is activated when a particular condition, or trigger is met within a message. When a rule is “triggered”, the action defined in the rule is applied to the message. This process repeats until either there are no more rules or messages, or the message is moved to a folder or deleted. You can make multiple rules apply to the same message by having them all match the same string; the rules will then be applied in the order they appear in the rule list, reading from the top down. The trigger condition can be any of the following:

- A simple textual phrase is encountered in the message headers or body
- A particular regular expression is encountered in the message headers or body
- The message date falls within (or outside) a particular range of dates
- The message is older or newer than a particular date or number of days
- The sender of the message is a member of one of your distribution lists
- The message has certain attributes (for instance, it is urgent, or has attachments)
- No condition – the rule always triggers when it is encountered.
For text matching within a message, you can perform two types of matching to detect the trigger text – *simple header* matching, where Pegasus Mail looks for the trigger text in selected common headers in the message; and *regular expression* matching, which allows you to set up complex pattern-matching criteria in the message headers only, or in the message headers and message body, or only in the message body.

To create a rule, highlight the item in the rule list before which you want the new rule to appear, then click on the *Add rule* button. The *rule type selector* window will open, in which you tell Pegasus Mail what type of rule you want to create. The following types of rule can be created; note that all rule types have an option to trigger if the condition they define is *not* met - this can be useful way of handling exceptional conditions. Similarly, all rules can be disabled, which is a handy way of preventing them from taking effect temporarily if you don’t want to delete them.

**Standard header match** (the “*Headers*” button) creates a rule which simply matches text in any of a set of predefined message headers. Simply click the controls representing the fields you want Pegasus Mail to check for the trigger text. You can check more than one control if you want Pegasus Mail to examine multiple fields. So, if you want Pegasus Mail to check in both the *From* and *To* fields for a string, you should check both controls. Pegasus Mail normally searches for the text you enter anywhere in the header, so if you enter “bed”, the rule would trigger on “bed”, “tabbed”, “albedo”, or any word containing “bed”. If you want the rule to trigger only when the field matches the trigger text exactly, check the control labelled *Message field must match this text exactly*. So, if this control were checked and the trigger text were “Subscribe”, then the text “Please subscribe me” would not cause the rule to trigger. The trigger text is not case-sensitive, so “SUBSCRIBE” and “Subscribe” would be regarded as a match.

**Regular expression match** (the “*Expression*” button) creates a rule that uses an special pattern called a *regular expression* to match lines in the messages. The *scope* controls specify in which parts of the message Pegasus Mail should try to match your expression: you can have your expression checked against only the message headers, only the message body, or against the entire message. Matching against the entire message or against the message body can slow down the process of opening the new mail folder dramatically – performance is affected by having a single rule which does a message body check, although subsequent rules will not slow the process down further. The *trigger text* for a regular expression rule contains the text or expression Pegasus Mail should attempt to find in your message. The text is always case-insensitive – so to Pegasus Mail, NORVELL@SUVM is the same as Novell@SUVM. The text must be an expression beginning at the start of a line. Your regular expression can contain the following special characters for pattern matching:

*    Matches any number of characters
?    Matches any single character (but not zero characters)
[ ]   Defines a set of characters to match (see below).
+    Matches any number of recurrences of the last character or pattern that was matched.

Sets of characters can be entered literally – for example [abcd1234], or you can specify ranges of characters using a hyphen, like this: [a-d1-4]. If you need to search for a literal occurrence of a special character, you must enter it as a set expression – so, to search for an asterisk, you would enter [*]. Remember that regular expressions begin at the start of a line, so if you want to match text anywhere in a line, the first character in the expression must be a *.
**Message size** creates a rule that triggers if the message is smaller or larger than a size you specify.

**Message date** creates a rule that compares the date of the message with a pair of dates or ages you supply. You can specify that the rule should trigger if the message falls within a particular range of dates, or has an age within a certain number of days. Dates are entered in the form YY (year) MM (month, January being 1), DD (day, 1-31), hh (hour, 0-23), mm (minute, 0-59) ss (second, 0-59). You can enter the dates in any order you wish - Pegasus Mail arranges them in proper chronological order internally. Conditions involving “Year 2000” comparisons are handled correctly. Message date rules are commonly used in general rule sets as a way of selecting messages that fall within a particular period using the *Select message* action. Message date rules always use the Date header from the message with any timezone correction applied.

**Message age** creates a rule that triggers if the *Date* field from the message is older than a particular date or a certain number of days. Dates are entered using the same format as in *Message date* rules. This type of rule is commonly used in general rule sets as a way of purging messages older than a certain age from mail folders.

**Message colour** Allows you to filter based on any colour that has been applied to a message using the folder browser or message reader *Set colour* command. This type of rule is generally only useful in general rule sets that are applied to folders other than the new mail folder.

**Attachment filtering** This button creates a special type of rule that checks the filename and/or extension of attachments to messages. The rule is special because it will always trigger if the attachment matches the conditions you specify. There are two specialized actions that are only available in attachment filtering rules – one that deletes the attachment from the message, and another that saves the attachment to a file.

**Attributes** Creates a rule that tests certain physical characteristics of a message, such as whether it has attachments, whether it has been marked urgent and so on.

**List membership scan** (the “Scan list” button) creates a rule that triggers if the sender of the message is a member of a specified distribution list (see the section later in this manual for more information on distribution lists). You can use this type of rule to control access to your mailing lists (for instance, by allowing only list members to post mail to a list); you can also use it to control *spam*, or unsolicited commercial e-mail: when you receive an unwanted message, add the sender to a “killfile” distribution list using the right-click options in the message reader or folder browser, then use this rule to delete or move all future mail from that address.

**Rule always triggers** creates a rule that has no conditions and always triggers. You will most commonly use this type of rule in conjunction with flow control actions (see later in this section).

**Comment** simply adds a textual comment to the rule set. Use this to remind yourself of why you’ve taken a particular action. Comments are ignored when rules are processed.

**Label** creates a named point within the rule set. Labels have no actions, and can be used by *Goto* and *Call* actions to transfer control within a rule set. See *Flow control*, later in this section, for more details.

The *Action* field defines what Pegasus Mail should do when the rule is triggered by a message which matches the condition you have defined. The possible actions are:
Copy message to folder
Move message to folder (terminates rule processing for the message)
Delete message (terminates rule processing for the message)
Forward message to an address
Extract message to a new text file, overwriting existing file if necessary
Append message to an existing text file, creating if necessary
Print message using current printer settings
Send text file to the sender of the message
Send a binary file to the sender of the message
Add the sender of the message to a distribution list
Remove the sender of the message from a distribution list
Highlight the message (assign a colour to it)
Run a program with the message as a parameter
Expire the message (mark it as no longer relevant so it shows in grey)
Select the message in the folder
Mark message as having been read.
Select the message in the folder (useful in general rule sets)
Play any sound (Windows .WAV files)
Display a dialog containing any textual message you wish
Terminate rule processing at once K
Call a label (transfer rule processing temporarily) K
Return from a call to a label K
Go to a label (transfer rule processing absolutely) K
Skip the next rule in the list K

When you create a POP3 rule set, the range of actions is more limited, and the following extra actions are available:

- Download message
- Leave message on server
- Delete message on server

(The items marked K in the list above are advanced rule actions covered below).

Selecting many of the actions will cause Pegasus Mail to prompt you for extra information — *Move* and *Copy*, for instance, require you to select a destination folder, while *Forward* requires you to enter the address to which the message should be forwarded. Any extra information you have provided will appear in the grey area beneath the *Action to take* field on the window. You can change the parameter for the current rule without reselecting the action by clicking the *Set* button.

The *Run a program* action will prompt for a command to run – the command can be either a Windows or a DOS program. The temporary file Pegasus Mail creates and passes to the program you run is not deleted by Pegasus Mail because there is no way Pegasus Mail can know when you are finished with it. It is up to you to delete these files as necessary.

When you are satisfied that the rule is the way you want it, click the *OK* button and it will be inserted into the rule list in front of the highlighted entry.

The sequence of rules in the rule list is extremely important, since they are applied in the order they appear in the list (remember that rule processing stops as soon as the message is deleted or moved to another folder). To change the ordering of the rule list, highlight the rule you want to shift then click on the *up* or *down* buttons at the foot of the dialog.
You can edit an existing rule in the rule list by highlighting it and clicking the Edit rule button, or by double-clicking it. Editing a rule is the same general process as creating one. You can delete a rule from the rule list by highlighting it and clicking Erase rule. Finally, to save the changes you have made to your rule list, click the Save button; if you want to discard your changes, press Cancel instead.

Using rules – an example: To create rules which would allow people to subscribe and unsubscribe to one of your mailing lists automatically by mail, you might set up rules which look like this (in these examples, we have placed a “^” character at the start of search strings to indicate that the Exact match box is checked in the rule definition):

If subject contains ^Subscribe then Add sender to list
If subject contains ^Subscribe then Send text file 'WELCOME.TXT'
If subject contains ^Subscribe then Move message to subscription folder
If subject contains ^Unsubscribe then Remove sender from list
If subject contains ^Unsubscribe then Send text file 'GOODBYE.TXT'
If subject contains ^Unsubscribe then Move message to subscription folder

Note the repetition of the match field to force several rules to apply to the same message. Remember when designing rules like this that any rule that results in the message being moved or deleted must be the last rule in the set, because Pegasus Mail stops processing rules when this happens.

Advanced rule processing options

Most of the time, you will probably use rules simply to automate the filing of your mailing list mail, and to remove unwanted messages automatically from the system; sometimes, though, you may want to do much more complex things with the rule facility, like applying multiple tests to a message (this is called logical operation) or controlling the order in which rules are processed. This section provides information on these more advanced uses of rules and assumes that you are already familiar with the basic uses – if you are not, please spend some time familiarizing yourself with the basics before tackling these advanced topics.

Flow Control

Many times, you may find that there are certain groups of rules that you want to apply repeatedly in a rule set, or that you want to have more control over the order in which rules are processed. This concept is called flow control, and Pegasus Mail provides six rule actions to support it - skip, exit, labels, call/return and goto.

Skip The simplest flow control operator is the Skip next rule action: when a rule triggers and this action is indicated, Pegasus Mail will skip over the next rule in the list without testing or applying it. You can use this as a way of handling exceptions to a general rule - for instance, imagine that you want to delete all messages where the subject contains the phrase free offer, except when that message comes from the address support@pmail.gen.nz - you would add the following two rules to your rule set:

If "From" field contains "support@pmail.gen.nz", then skip next rule
If "Subject" field contains "free offer", then delete message

Exit When a rule triggers that has the action exit this rule set, all rule processing for the current message terminates at once - no more rules are examined or actioned. The primary use of this action is to separate subroutines, or groups of rules that you access via call label actions, from the main body of your rule set.
Labels  A label is simply a name you can add to any line in your rule set. Labels are used by return and goto actions (see below) to transfer processing to a different location in the rule set. Labels can appear anywhere in the rule set - when calling or going to a label, you can go either forwards or backwards. Labels are simply a textual name - you can use any text or letters you wish up to 45 characters in length. Labels, like comments, are passive items in a rule set - on their own, they do absolutely nothing, and they have no trigger conditions.

Calls and returns  If you have defined a label in your rule set, you can call it at any time by defining a rule with the Call label action. If the rule triggers, processing of the rule set will transfer to the first rule after the label you name and will continue until either there are no more rules (in which case rule processing terminates), or a rule triggers that has the Return from call action (in which case processing resumes at the rule following the one which initiated the call).

Gotos  A goto is like a call, in that it simply transfers processing to a label anywhere else in the rule set. The difference is that you cannot return from a goto - the transfer of processing is final. Gotos are primarily useful when implementing complex logical operations.

Creating logical operations in your rule sets

Often, you may only want to apply a rule to a message if all of a number of conditions are matched, or if any one or more of a number of conditions apply. This kind of operation is known as a logical operation (it is also known by the technical name Boolean operation). Pegasus Mail implements logical operations by a combination of rule order and flow control structures. Before reading about logical operations, we strongly suggest you read the section on flow control.

Tip  When using logical operations in rule sets, it is very important to remember that rules are always applied to the message in the order in which they appear in the rule list editor, starting at the top of the list and working through to the bottom.

Applying a rule when any of several conditions is met (logical OR)  “The simplest logical operation you can create in a rule set is that where an action is applied if one or more conditions is satisfied (i.e, condition1 OR condition2 OR condition3 and so on). You can create this kind of operation simply by creating multiple rules matching on different conditions, all executing the same action. For example, say you want to highlight a message in Magenta in your folder if the subject contains the word order, or if the subject contains the word invoice or if the To: field contains the address orders@foo.bar.com - you would add the following three rules to your rule set:

If "Subject" field contains "order" then highlight message in magenta
If "Subject" field contains "invoice" then highlight message in magenta
If "To" field contains "orders@foo.bar.com" then highlight message in magenta

Notice that the action is the same in each case. In cases where repeated application of the rule action might not be desirable (for instance, copying messages to a folder, in which case you could get multiple copies of the message), more complex combinations of goto and call statements can be used to achieve the same effect - for example, like this:

If "Subject" field contains "order" then goto label "copy message"
If "Subject" field contains "invoice" then goto label "copy message"
If "To" field contains "orders@foo.bar.com" then goto label "copy message"
label "Next label"
[... other rules ...]
Label "copy message"
Always copy message to "orders"
Always goto label "next label"

In this example, any of the conditions will transfer control to the rule that actually copies the message, which in turn immediately transfers control to the first rule after the group, so you will only ever get one copy of the message.

Applying a rule only if all specified conditions are met (logical AND) Pegasus Mail offers three ways of applying a rule only if all of a set of conditions apply. The simplest way is to create multiple rules where the action for every rule but the last one is Logical AND; the last rule in the sequence should have the action you want applied to the message. When using this approach, Pegasus Mail will skip any remaining rules in the sequence as soon as any condition fails, and will continue processing at the first rule after the last rule in the sequence. When using Logical AND actions in this way, be careful if you rearrange the order of your rules, since breaking the sequence of Logical AND rules will almost certainly result in undesirable matches occurring. Pegasus Mail also provides two other ways of performing AND operations: the simpler form allows you to match exactly two conditions, using the Skip next rule action. To do this, you simply use the Skip next rule action on the first rule in the pair if the data does NOT match the first condition, then apply the action you want in the second rule only if the second rule DOES match the second condition. For instance, in the following example, we want to delete the message only if the subject field contains free offer and the from field contains aliensales.com.

If "Subject" field does not contain "free offer" then skip next rule
If "From" field contains "aliensales.com" then delete message

The more complex approach to matching multiple conditions depends on using a call statement to transfer to a group of rules where each rule returns if it does not contain the required text. This approach requires more setup, but allows you to match on an unlimited number of conditions. For instance, say we want to play a sound when we get a message from anyone at compuserve.com where the subject line contains the word Transylvania but not the word vampire, and the To: field contains the address foo@bar.com; to achieve this, we would create the following rules in our rule set -

If "From" field contains "compuserve.com" then call label next-test

Label next-test
If "Subject" field does not contain "Transylvania" then return from call
If "Subject" field contains "vampire" then return from call
If "To" field does not contain "foo@bar.com" then return from call
Always play sound "tada.wav"
Always return from call

Content Control

Pegasus Mail’s general-purpose filtering gives you enormous control over the mail passing through your system – but it is general-purpose in nature, and is not designed to perform extensive analysis of messages: instead, for that, Pegasus Mail provides a separate but parallel facility called Content Control. Using content control, you can apply your own comprehensive tests to mail passing through your system based on the contents of that mail rather than its physical characteristics. Examples of what you might use this for include —

• Spam detection This is the most common use for content control. Unlike tests that rely on the origin of the message, or the headers it contains, Content Control allows you to
detect spam based on the type of thing it is trying to sell: since most spam is trying to sell you something, a test that detects the product being pitched has a very high chance of eliminating or at least severely reducing whole classes of unwanted mail.

• **Auditing**  Using content control may allow you to detect certain types of message that need to be analyzed for security reasons. As an example, a military contractor might use content control to get an early warning that sensitive information is being disseminated inappropriately.

• **Controlling objectionable material**  After spam detection, unwanted pornographic material is probably the the greatest nuisance mail most people get on a daily basis. Using content control, messages containing objectionable material can be filtered out before delivery, and because content control works on a weighted basis, the occasional expletive we all occasionally use in our mail won't result in legitimate messages being mis-identified as pornography.

### How it works

Using the *Content control* option on the *Tools* menu, you can create sets of tests that Pegasus Mail applies to every message it processes: each set consists of three separate and optional tests -

• **A blacklist check**  You can create a blacklist of addresses and sites from which all mail is regarded as unacceptable. Blacklisted messages get a weight of 9999.

• **A whitelist check**  This is like the blacklist, except that all addresses and sites that appear in the list are never treated as unacceptable. Whitelisted messages get a weight of -9999.

• **A rule set check**  For messages that are not caught by the blacklist or whitelist, you can create arbitrarily complex sets of rules to test the content of the message. These rules are similar to Pegasus Mail's general-purpose filtering rules, but are more specific to the particular task of content evaluation, allowing unlimited numbers of "and" operations to link conditions together. Also, unlike general purpose rules, content testing rules are given a "weight": when all the rules have been processed, the weights of all the rules that were triggered are added together, and the final result is compared against a predeter-\n\n\nEach content control set has an action, which is applied when a message is deemed to have suspect content - this action can be to delete the message, to quarantine it for later examination, to forward it to an alternative address, or to return it to the sender. You can have as many content control sets as you wish - Pegasus Mail will apply them in the order they appear in the list in the Content control configuration dialog: the first set that results in the message being quarantined, deleted, or otherwise removed from circulation will terminate content control processing for that message.

### Using the Content control dialog

*To create a new content control definition*, click the "Add" button - click here for detailed information on the various settings associated with a single control set.
To change the values for a single content control definition, select the definition in the list and click the "Edit" button.

To remove a content control definition, select it in the list and click the "Delete" button: Pegasus Mail will ask you if you want to delete the list and rule files associated with the definition as well as the definition itself - if you use the lists or rules in other definitions as well, you should not delete them.

To adjust the position of a content control definition in the list, select it and click the "Move up" or "Move down" button. The position of a definition in the list is important, because Pegasus Mail applies them in the order they appear, and stops applying definitions to a message when a definition results in the message being deleted or otherwise removed from circulation.

Editing a Content Control definition
A Pegasus Mail Content Control set consists of four separate parts, each of which is edited in its own page within the Content Control editor dialog.

The "General" Page Use this page to change the name that appears next to the definition in the list of definitions, and to define the types of mail to which the set should be applied.

The "Exceptions" Page Use this page to create Blacklists, which identify senders whose mail should always be regarded as unacceptable, and Whitelists, which identify senders from whom you always want to accept mail.

The "Message Tests" Page Use this page to maintain a set of rules that should be applied to mail messages that are not covered by either a whitelist or blacklist. The rules allow you to perform comprehensive tests on the actual content of the message, and can be linked together to create chains of tests. Each rule can have a weight, and after all the rules have been applied, Pegasus Mail adds up the combined weights of all the rules that matched the message: if the combined weight is greater than a value you specify, the message is marked as acceptable.

The "Actions" Page On this page, you define what you want to happen to messages when they pass through the content control system. You can add headers to the message (which can later be detected by your filtering rules), and you can also choose other actions such as moving the message to a folder, forwarding it to another address, or deleting it.

The General Page
The settings on this page allow you to change the name that appears next to the definition in the list of definitions, and to define the types of mail to which the set should be applied.

Name for this content control definition Whatever you enter in this field is the name Pegasus Mail will use to identify this definition in the list shown in the Content control dialog. You can use any name you wish up to 50 characters in length.

Apply this definition to mail originating from Allows you to choose what type of message this set should apply to. Any source will apply the definition to any mail passing through the queue; Local addresses only will apply the definition if the sender of the message has a local address (one with no domain part); and Non-local addresses only applies the definition to any mail where the sender's address is not local (i.e, the address does contain a domain part).
The Exceptions Page

Use this page to create Blacklists, which identify senders whose mail should always be regarded as unacceptable, and Whitelists, which identify senders from whom you always want to accept mail. For Pegasus Mail users, Blacklists and Whitelists are normally just regular Pegasus Mail distribution lists, which means that you can easily manipulate them using filtering rules, and with the right-click options Add sender to mailing list and Remove sender from mailing list while you are reading a message or browsing the contents of a folder. It is also possible to share system-wide Blacklists and Whitelists by putting them in a shared directory then entering the path to that directory in this window.

**Blacklist file** Enter in this field the name of a file in which Pegasus Mail should check for addresses and domains from which mail should always be regarded as unacceptable. The file need not exist already. Once you have entered the filename, you can edit the file by clicking the edit button next to the field. Within the blacklist file, you can use asterisks as wildcard characters to match entire domains or parts of domains: so, if you want to block all users from the domain spam.com, you would enter *@spam.com. Similarly, to block all mail from any user on any machine within the spam.com domain group, you would enter *@*.spam.com.

**Whitelist file** Enter in this field the name of a file in which Pegasus Mail should check for addresses and domains from which mail should never be regarded as unacceptable. The file need not exist already. Once you have entered the filename, you can edit the file by clicking the edit button next to the field. You can use the same type of wildcard operations described for the blacklist file within the whitelist.

The Message Tests Page

Use this page to maintain a set of rules that should be applied to mail messages that are not covered by either a whitelist or blacklist. The rules allow you to perform comprehensive tests on the actual content of the message, and can be linked together to create chains of tests. Each rule can have a weight, and after all the rules have been applied, Pegasus Mail adds up the combined weights of all the rules that matched the message: if the combined weight is greater than a value you specify, the message is marked as acceptable.

**Content processing rules file** Enter in this field the name of a file containing rules written using the Pegasus Mail/Mercury content control filtering language (see below) - Pegasus Mail will apply these rules to any message that is not trapped by either the black or white lists. You can either edit the rule file by clicking the Edit button next to the field, or by using an external text editor. The internal editor has a filesize limitation of 32KB - if your ruleset file is larger than this, you will need to use an external editor to edit it.

**Checking syntax** When you are editing your rule file, you can check that the rules you have entered are syntactically correct by clicking the Check Syntax button in the rule editor: if Pegasus Mail encounters any errors in the rule set, it will pop up a dialog describing the error and place the cursor on the line where the error occurred.

**Weight at or above which this definition activates** Within the rule file, each rule can be assigned a weight, which is a numeric value; after all rules have been processed, Pegasus Mail adds together the weights assigned to every rule that matched the message - if the total weight is greater than or equal to the value you enter here, the message will be deemed "unacceptable" and will be subject to the action you define on the "Actions" page of the editor.

**Check at most this many bytes in each message** If you enter a value greater than zero here, Pegasus Mail will only scan that many characters in each message when applying your content control rule set. This can reduce the time taken to perform content control, but can also result in less undesirable mail being detected. If you find that Content Control is taking a sig-
significant amount of time on your system (for instance, if you receive many large messages), entering a value of around 8000 in here will typically provide a good balance between speed and detection.

Note that when scanning multipart messages, Pegasus Mail adds together the size of each text section it scans to calculate the number of bytes it has scanned - it does not simply blindly read through the file.

The Actions Page

On this page, you define what you want to happen to messages when they pass through the content control system. You can add headers to the message (which can later be detected by your filtering rules), and you can also choose other actions such as moving the message to a folder, forwarding it to another address, or deleting it.

*If a message has a weight greater than the activation weight...* When a message has a weight higher than the activation weight, either because it appears in the blacklist, or because its calculated weight after rule processing exceeds your predetermined value, the action you select here will be taken on the message. Some actions have a parameter (for instance, when you select Forwarding, the parameter is the address to which the message should be forwarded). The following actions are possible:

**Take no further action**   This action is useful if you want to turn off processing for a while, but still want the mail to be marked as "processed". This option is also useful if you only want standard headers added to messages as they pass through Content Control (see below for more information on adding standard headers) - you will typically select this case when you want to use filtering rules to handle such messages at a later stage.

**Add an identifying header**   If you select this action, Pegasus Mail will add an identifying header to the headers of the message but will not otherwise divert or alter the message. Whatever string you enter in the parameter field, Pegasus Mail will add as a header in the delivered message, completely unmodified (so, you must include the header keyword, the colon character, and the header body exactly as you want them to appear in the message). You can use this action as well as using the standard "graphical" and diagnostic headers (see below).

**Copy the message to another address**   Selecting this action will make a copy of the message and send the copy to the address you specify in the "parameter" field. The original message will not otherwise be diverted or altered in transit and will be delivered normally.

**Forward the message then delete it**   This action will divert the message to the address you specify in the "parameter" field. When you select Forward and delete, this action will cause all content control processing to terminate for the message, because it will be effectively removed from circulation.

**Move the message to a directory as a file**   This action diverts the message to a "quarantine directory". When you click the Set button, Pegasus Mail will prompt you to select a directory, which can be anywhere on the local machine or on your network. Pegasus Mail will move the message into this directory as a file and remove it from the queue so that no further processing or delivery occurs.

**Delete the message**   Just like it says - this action deletes the message, end of story. All content control processing ceases at this point, and the message is gone forever. We suggest you use this action with considerable care.
Header addition and advanced options

As well as taking the action you specify on the message, Pegasus Mail can add certain headers to mail to indicate the results of Content Control processing.

Add graphical X-UC-Weight headers for unacceptable mail When this control is checked, Pegasus Mail will add a header called X-UC-Weight ("UC" stands for unacceptable content) to any message that has a weight greater than the activation weight for the set (see the Message tests page for more information on how the activation weight is calculated). The X-UC-Weight is “graphical”, in that it contains a little graph that indicates how unacceptable the message actually was. The graph consists of one to four hash characters, with the following meaning:

- [###] The message has been Blacklisted, or has a weight greater than 9990
- [## ] The message's weight is more than three times greater than the activation weight for the set (in other words, it's probably particularly odious)
- [## ] The message's weight is more than twice but less than three times the activation weight for the set
- [# ] The message's weight is more than the activation weight for the set, but less than twice the activation weight

After the graphic, the actual weight of the message is shown in brackets.

Add graphical X-AC-Weight headers for acceptable mail It is possible to assign negative weights to a message during content control processing - in fact, this is what the whitelist does (it assigns a weight of -9999). If a message comes through the content control process with a negative weight, it is regarded as Acceptable - something important or desirable. If you have rules in place that have negative weights to promote the value of a message, you can instruct Pegasus Mail to add a header called X-AC-Weight ("AC" stands for acceptable content) to any messages that end up with a negative weight. This can be a very handy way of highlighting messages with important content - you can use filtering rules later in the process to detect the X-AC-Weight header and take appropriate actions. Like the X-UC-Weight header (see above), The X-AC-Weight header is graphical, in that it contains a little graph that indicates how acceptable the message actually was. The graph consists of one to four hash characters, with the same meanings as in the X-UC-Weight graph above, except that the values are negative: so, [### ] would mean that the weight of the message is less than (3 * the activation weight * -1). Similarly, [####] means that the message has been explicitly whitelisted, or has a value lower than -9990.

Add a diagnostic header showing which rules were matched When this control is checked and a rule generates any non-zero value after Content Control processing, Pegasus Mail will insert a header called X-CC-Diagnostic into the message: this header contains a summary of the rules that triggered during processing, and is a useful way of working out why a message was given the weight it received. Each rule is written into the header in an abbreviated form, unless it has a Tag defined, in which case the tag is written into the header instead. For each rule written, the weight associated with that rule is shown in brackets as well.

Pegasus Mail’s Content Control Filtering Language

Pegasus Mail's content control rule language has been designed to be simple and flexible: it is based on the use of regular expressions, which describe patterns of text within the message.
A rule set consists of a sequence of tests applied sequentially to the message.

**The types of test**

**Body and subject tests**  
these tests look for content in either the subject field or the body of the mail message. There are two types of test - a substring test, using the `CONTAINS` operator, and a regular expression test, using the `MATCHES` operator. The substring test simply looks for a group of characters anywhere in the specified location, while a regular expression test looks for more complex patterns of characters. See below for more information on the difference between substring and regular expression tests.

```
IF SUBJECT CONTAINS "string" WEIGHT x
IF SUBJECT MATCHES "regular_expression" WEIGHT x
IF BODY CONTAINS "string" WEIGHT x
IF BODY MATCHES "regular_expression" WEIGHT x
```

If you want to test for a string or a pattern in either the body or the subject field, you can use the `CONTENT` test instead - this checks in both places automatically:

```
IF CONTENT CONTAINS "string" WEIGHT x
IF CONTENT MATCHES "regular_expression" WEIGHT x
```

**Header tests**  
these tests check specific headers or groups of headers in the mail message.  
The `SENDER` test looks in the "From", "Sender", "Resent-From" and "Reply-to" fields of the message, while the `RECIPIENT` test looks in the "To", "CC", "BCC" and "Resent-To", fields.  
The `HEADER` test allows you to check any single header in the message: if the header does not exist, the test does not trigger. Finally, the `EXISTS` test allows you to check whether or not a specific header exists in the message.

```
IF SENDER CONTAINS "string" WEIGHT x
IF SENDER MATCHES "regular_expression" WEIGHT x
IF RECIPIENT CONTAINS "string" WEIGHT x
IF RECIPIENT MATCHES "regular_expression" WEIGHT x
IF HEADER "headername" CONTAINS "string" WEIGHT x
IF HEADER "headername" MATCHES "regular_expression" WEIGHT x
IF EXISTS "headername" WEIGHT x
```

**Wordlist tests - HAS and HASALL**  
There are also some more specialized tests you can use to test for groups of words in a message - `HAS` and `HASALL`:

```
IF xx HAS "wordlist" WEIGHT x
IF xx HASALL "wordlist" WEIGHT x
```

(Note that “xx” can be “subject”, “sender”, “recipient”, “header”, “content” or “body”)
Both of these tests accept a list of words separated by commas as their parameter. The `HAS` test will succeed if the message contains any of the words in the list, while the `HASALL` test will succeed if the message contains all the words in the list, in any order.

**Example:** to detect a message containing "viagra", "prescription" and "erectile"
```
IF BODY HASALL "viagra, prescription, erectile" weight 50
```

**Specialized, or arbitrary tests**  
Pegasus Mail has a number of specialized tests that are specifically designed for detecting spam (unsolicited commercial e-mail); these tests examine special characteristics of the message that could not otherwise be easily detected using standard regular expressions. Specialized tests are entered like any other rule in the rule set, and have the following general form:
The name of the test and any parameters it requires are entered as a single string after the keyword TEST: if Pegasus Mail does not recognize the name of the test, it ignores the rule. Doing things this way allows tests to be added in future without breaking existing copies of Pegasus Mail. Tests are case-insensitive unless specifically noted below.

The following tests are available at present:

**LazyHTML**  This test will trigger if the message is an HTML message that contains an IMG link to a remote graphic - apart from being extraordinarily rude and annoying, this type of link is a very reliable indicator of spam. Two parameters are available for this test - Tolerant and Strict: the Tolerant parameter tells Pegasus Mail that a message may contain one (and no more than one) Lazy HTML graphic link without triggering, while the Strict parameter tells Pegasus Mail that any Lazy HTML is to cause a trigger.

*Example:* If Test "LazyHTML Tolerant" weight 51

**HasIFrame**  This test will trigger if the message contains an HTML IFrame tag - this is an almost 100% certain indication of a virus-generated message containing viral payload designed to take advantage of an infamous activation bug in Microsoft Outlook. There is no imaginable justification for a valid e-mail message to contain an IFrame tag. This test takes no parameters.

*Example:* If Test "HasIFrame" weight 51

**HTMLComments**  This test allows you to trigger if a message has more than a certain number of HTML comments. Spam often uses HTML comments to break up keywords that would otherwise be detected as "naughty": because Pegasus Mail strips HTML tags before applying content control testing, this type of trick won't work with it, but the presence of all those comments is a dead giveaway that the message is spam. The parameter to this test is the number of comments above which Pegasus Mail should trigger the test.

*Example:* If Test "HTMLComments 20" weight 51

**Garbage**  This test simply counts the number of characters in the message that are not standard ASCII characters: if the percentage of non-ASCII characters is higher than the value you specify, the test will trigger. This test is an almost infallible way of detecting Russian and Asian spam, but you will need to be careful if you receive legitimate mail from these regions (we recommend whitelisting senders who might need to send you messages like this). The parameter to this test is a percentage value of the whole message that must be non-ASCII before a trigger occurs.

*Example:* If Test "Garbage 25" weight 51

Other arbitrary tests may be added in future versions of Pegasus Mail.

**Negating and linking tests (NOT, AND and OR operators)**  You can negate a test by using IFNOT instead of IF: similarly, you can link multiple tests together by using AND, ANDNOT, OR or ORNOT instead of IF in each test following the first.

**Substring matching vs Regular expressions**  Any test that uses the CONTAINS keyword to perform a substring search does a simple string search instead of a regular expression match: this
is a little faster and a little easier to understand than the regular-expression based versions of
the rules. Note that CONTAINS tests are completely literal - no regular expression matching
of any kind occurs. CONTAINS tests are always case-insensitive - so, the strings "foo" and
"FOO" are identical as far as a CONTAINS test is concerned.

Detecting obfuscated text  A common trick in spam is to embed unusual characters in words
that commonly trigger anti-spam routines - like "vi@gra", or "pen1s"; indeed, this technique
is now becoming so pervasive that Pegasus Mail includes a special keyword just to handle it.
When defining HAS, HASALL or CONTAINS rules, you can add the keyword OB   
(you can abbreviate this to OB if you wish) before the WEIGHT keyword in the rule - like this:

IF SUBJECT CONTAINS "viagra" OBFUSCATED WEIGHT 51

This rule will detect any of the following words in the subject line of a message: "viagra",
"v-i-a-g-r-a", "vi@gra", "V 1 -@- G R A" or even "_v$1&@(G*r*A".

If you want to test for a phrase when using the OB   keyword, you must enter the
phrase in the rule without spaces: so, if you wanted to check for any obfuscated version of
the phrase "increase the length of", you would have to enter it like this:

IF CONTENT CONTAINS "increasethe length of" OB WEIGHT 51

Note that you cannot use the OB   keyword on a MATCHES test - if you do, Pegasus
Mail will simply ignore the keyword and match using the expression you provide.

CAUTION You should exercise a certain amount of caution when using obfuscated tests, be-
cause there is a slightly increased risk of false positive matching (i.e, having two adjacent
words which while harmless on their own, add together to form a trigger word).

Tags  Any rule can have a Tag, or a name used to describe it: the tag is used by Pegasus Mail
when you have told it to construct a diagnostic header for messages, and is useful when the
test that the rule is performing is either very verbose or very obscure, or when the actual text
of the rule may contain offensive material.

Example: IF BODY HAS "Fuck, Shit" Weight 100 Tag "Rude language"

In this example, when Pegasus Mail prepares the X-CC-Diagnostic header in the message,
it will format it as Rude language (100) instead of Body Has "Fuck, Shit" (100),
which may be offensive to some people.

Tags are optional, and can appear instead of or after a WEIGHT statement. The name param-
eter to a Tag statement must always appear in double-quote marks, as shown in the example
above.

General layout
The rule language itself is not case-sensitive, so the following tests are both semantically val-
Id:

If Sender contains "foobar" weight 80
IF SENDER CONTAINS "foobar" WEIGHT 80

Furthermore, whitespace is ignored, so you can layout your tests in whatever way you feel is
clearer: as an example, the following is a completely syntactically valid test:
If
  sender contains
  "Foobar"
Weight 80

The only restriction is that neither a string nor a keyword can cross a line boundary; so, the following test is invalid:

If sender con
  tains foobar Weight 80

Examples:

1: To detect a message where the sender's address contains "spam.com"
   IF SENDER CONTAINS "spam.com" WEIGHT 50

2: To detect a message where the sender's address contains "spam.com" and the body of the message contains the word "viagra"
   IF SENDER CONTAINS "spam.com"
   AND BODY CONTAINS "viagra" WEIGHT 50

3: To detect a message where the sender's address contains "spam.com" and either the subject field or the message body contains the word "viagra"
   IF SENDER CONTAINS "spam.com"
   AND SUBJECT CONTAINS "viagra"
   OR BODY CONTAINS "viagra" WEIGHT 50

4: To detect a message where the sender's address contains "spam.com", the message has no "Date" header, and the Subject or the Body contains "viagra"
   IF SENDER CONTAINS "spam.com"
   ANDNOT EXISTS "Date"
   AND SUBJECT CONTAINS "viagra"
   OR BODY CONTAINS "viagra" WEIGHT 50

Making the most of regular expressions

The CONTAINS test does a simple string search, looking for the exact text you provide anywhere in the message. Often, however, you may want to look for patterns of text rather than exact strings: you can do this by using a MATCHES test instead of a CONTAINS test, because MATCHES tests use a special pattern-matching mechanism called a regular expression to describe the general form of text you want to find.

Using regular expressions, you can detect extremely complex patterns of text within the messages you filter. Pegasus Mail's regular expression uses what is known as a metasyntax to describe the pattern you want to match: in the metasyntax, certain characters have special meanings that Pegasus Mail applies to the text it is testing. The following special characters are recognized in your expressions:

* Match any number of any characters
? Match any single character (must match at least one character)
+ Match one or more occurrence of the last character or pattern
Set matching: the test will succeed if the next character in the input matches any character in the set. Ranges can be specified in the set using '-' (for example, [a-k] specifies every character from a to k inclusive)

Set negation: the test will succeed if the next character in the input does not match any character in the set.

/watch Match zero or more whitespace characters

/watch Match one or more whitespace characters

/c Toggle case sensitivity (case-insensitive by default)

You can use any number of metacharacters in an expression - so, for example, to detect all users at any system within the domain "spam.com", you could use the regular expression

`@*.spam.com`

The set operation is especially powerful, particularly when combined with the repeat occurrence operator: so, to detect a message where the subject line ends in a group of three or more digits (a common indicator of a spam message) you would use this expression:

`Subject:*[0-9][0-9][0-9]+`

In this expression, we use the "*" operator to match the general text within the subject line, then we use the set "[0-9]" three times to force a minimum of three digits, and a "*" operator to detect any extra digits following the third one. Because there is no "*" at the end of the expression, the digits must therefore be the last characters on the line - if there is any text following them, the expression will fail.

Case sensitivity Normally, Pegasus Mail compares all text on a case-insensitive basis - that means that it will regard "hello" and "HELLO" as being the same. In some cases, though, the case of the text you're matching can be important, so the `/c` operator allows you to toggle Pegasus Mail between case insensitive and case-sensitive comparisons. So, to detect the string "FREE!" anywhere within the subject line of a message, you would use this expression:

`Subject:/:c*FREE!*`

In this expression, the expression will only succeed if the word "free" appears in uppercase characters.

Matching anywhere within the text

Pegasus Mail's regular expression parser is designed to start at the beginning of the text it is evaluating and to stop matching at the end. As a result, if you want to find a regular expression anywhere within the text you are examining, you need to start and end the expression with an asterisk operator (*). To illustrate why this is necessary, consider the following three regular expressions:

```
Wearing a fedora hat
Wearing a fedora hat*
*Wearing a fedora hat.
```

The first of these will only match if the target text consists only of the string "Wearing a fedora hat"; if there is text before or after the string, the match will fail. The second will match only if the text starts with the string "Wearing a fedora hat". If there is any text before the
string, the match will fail, but the "*" at the end ensures that any text following the string will not prevent a match. The last example will match only if the text ends with "Wearing a fedora hat" - again, the "*" at the start of the expression will match anything prior to the string.

If you want to find the expression anywhere it occurs in the target text, you need to enter it as

*wearing a fedora hat*

If you forget to add the leading and trailing * operators, the rule will typically not work, and this error can be quite difficult to spot when you're simply reading the source file.

**Spamhalter**

Spamhalter is a Pegasus Mail plugin module that provides *Bayesian spam filtering*. Without going into the extensive mathematics behind the concept, a Bayesian filtering system gradually learns over time how to distinguish one type of message from another by looking at many examples and keeping statistics on them. When Spamhalter makes a classification error (that is, when it detects a message as spam when it is not, or vice-versa) then you can "train" it with a simple right-click so that in future it will be less likely make the error again.

**Spamhalter vs Content Control**

Spamhalter is designed as a complement to Pegasus Mail's other spam-control mechanism, Content Control. Spamhalter and Content Control approach the issue of spam from different directions, and each has specific strengths and weaknesses. Spamhalter requires very little ongoing maintenance, and has a very high detection ratio for spam: Content Control, on the other hand, requires more maintenance, but allows you to use very specific tests to detect messages, and can be used for general-purpose filtering on content. A combination of the two mechanisms can give the best possible results for managing your mail based on its content.

**Getting started with Spamhalter**

It is important to understand that any Bayesian spam filter requires a two-part initial corpus - that is, one collection of messages that are spam, and another collection of messages that are not spam. You should not enable Spamhalter until you have a total of around 100 messages of each type that you can use as your initial corpus (these messages can be in any folder - they need not all be in the same folder). Once you are ready to begin using Spamhalter, first enable it in the Spamhalter... menu on the Spam and content control submenu of the Tools menu. Next, select the spam messages in your corpus as a group, then right-click one of the messages and choose Train messages as spam from the popup menu. Spamhalter will learn from the messages, which may take some time. Once the training process has completed, select the non-spam messages from your corpus as a group, then right-click one and choose Train messages as not-spam from the popup menu. Spamhalter will now learn from the non-spam messages.

*IMPORTANT NOTE:* The messages that make up your corpus *NEED NOT* be in the same folder; what's more, there is nothing to prevent you from taking groups of messages from many folders in a piecemeal manner, selecting them, then right clicking and training as spam or not-spam, then moving to the next folder and repeating the process.

Once Spamhalter has been trained on your basic corpus, it will automatically apply what it has learned to every new message that appears in your new mail folder. Any new message it regards as spam will be moved into whatever folder you select in the Spamhalter configuration dialog as the Spamhalter spam folder.
In the early stages of using Spamhalter, it is important that you check your spam folder regularly, because until it has built up a fairly large statistical database, Spamhalter is likely to produce a number of false positives - messages incorrectly classified as spam. Moving a false positive message out of the spamhalter folder into any other folder will automatically force Spamhalter to re-classify that message and amend its statistical tables, reducing the likelihood of the misclassification in future. Similarly, if you receive spam that Spamhalter does not detect, simply move it into your Spamhalter spam folder and Spamhalter will automatically be trained on that message, increasing the likelihood that it will correctly detect similar messages in future.

Basic operation
As noted above, moving messages in and out of your Spamhalter spam folder automatically trains Spamhalter, so using it is very easy. If, for some reason, you want to classify a message as either spam or not-spam without moving it, you can right-click the message and choose either **Train as spam** or **Train as not-spam** from the **Spamhalter classification** submenu. These options have the same effect as moving the message in or out of your spam folder, but leave the message where it is.

If you want to see why a particular message has been classified as either spam or not-spam, right-click that message and choose **Explain classification** from the **Spamhalter classification** submenu: Spamhalter will open a small dialog showing you the words or phrases it has used to establish its classification and the weight those words had in the process.

Status indication
When Spamhalter is enabled, Pegasus Mail displays an extra status indicator when you are reading a message - a small icon of a traffic light. If the traffic light is green, then the message has been classified as not-spam by Spamhalter. If the traffic light is red, then the message has been classified as spam by Spamhalter. If the traffic light is grey, then Spamhalter either has not yet classified the message, or could not determine absolutely whether or not the message was spam.

Sorting and grouped views
You can sort messages in any folder by their "spamminess" by choosing **Sort by spamminess** from the **Messages** menu (in preview mode) or the **Folder** menu (if you have the folder open in its own window). Similarly, you can group messages by spamminess using the **Group by spamminess** grouped view on the **Grouped views** submenu of the **Messages/Folder** menu.

Using Spamhalter and Content Control together
Detecting spam is an inexact science, and no one tool is ever going to be able to detect everything correctly. Spamhalter's Bayesian model is a perfect complement to Pegasus Mail's built-in rule-based Content Control system: each has strengths and weaknesses, and combining them can produce extremely high rates of spam detection. It is your choice whether to use Spamhalter, Content Control, or both, but any combination of the two systems is completely valid. For beginning users, though, Spamhalter typically offers a much lower-maintenance spam filtering solution on its own than Content Control.

Copyright information
Spamhalter was developed by Lukas Gebauer of Ararat s.r.o (http://www.ararat.cz/) in the Czech Republic, and is incorporated in Pegasus Mail with permission. The core Spamhalter code is Copyright (c) 2000-2008, Lukas Gebauer. Pegasus Mail's author offers his thanks and appreciation to Lukas for his efforts.
**The Global Whitelist**

Pegasus Mail provides extensive filtering capabilities, aimed mainly at dealing with spam, or unwanted commercial mail. Unfortunately, there is no anti-spam technique that can guarantee it will provide 100% accuracy in discriminating between spam and not-spam messages - inevitably, at some point, a spam filter is going to classify a message as spam when it is not. When this happens, the mis-classified message is known as a *false positive*. False positives can have very serious implications - imagine, for a moment, that a very large order comes in but is incorrectly classified as spam: if you don't happen to scan your folder in time, you may lose the order.

Because the consequences of having false positives are so serious, Pegasus Mail provides a mechanism to help reduce them - it allows you to create a “Whitelist” of addresses from which all mail is to be treated as not-spam. When Pegasus Mail finds a message from a sender whose address appears in your whitelist, it will not pass the message to either Spamhalter or to Content Control, but will mark it as whitelisted instead and leave it in your new mail folder.

Note that whitelisting does not prevent a message from being processed by your General-purpose new mail filtering rules, although a rule test exists that allows you to detect whether or not a message has been whitelisted in your rulesets (this test is an attribute test and can be created by clicking the *Attribute* button in the filtering rule editor window).

**Managing the Global Whitelist**

You can manage your whitelist by selecting the *Whitelist...* option from the *Spam and content control* submenu of the *Tools* menu in Pegasus Mail. This will open the Whitelist management dialog, where you can add and remove addresses, and control the behaviour of the whitelist.

Your current whitelist appears in the list control at the top of the dialog. Because the list can contain many hundreds of addresses, a *Find...* button allows you to do an incremental search through the list: this means that you can enter a few characters from anywhere in the address you want to find, and the search code will automatically find the first occurrence of those characters in the address list. To skip past that occurrence and find the next match in the list, click the *Next* button, or alternatively, type in a few more characters that narrow down the search even further.

You can manually add addresses to your whitelist using the *Add* button. Similarly, you can remove addresses using the *Delete* button, and change existing entries using the *Change* button.

*Maximum number of entries in whitelist* The whitelist is maintained in memory while Pegasus Mail is running, which means that it's very fast, at the expense of occupying some of your system RAM. You can control the number of entries Pegasus Mail will store in your whitelist using this control, but spend a moment considering how many entries you really need before altering the default value. Generally speaking, a number between 500 and 1000 represents a good compromise between storage and speed. Setting a very large number (for instance, 40,000) may slow the sending and receiving of mail and cause Pegasus Mail to use more system RAM. Whenever there are more addresses in the list than the limit you specify, the addresses at the bottom of the list (which are usually the least-frequently-used) are "dropped off".

*Setting the number of entries to zero* As a special case, if you set the maximum number of entries in the whitelist to zero, you will effectively disable the whitelist without clearing it: Pegasus Mail will not check your whitelist, nor will it automatically add addresses to it, but
any existing addresses in the list will be retained. This is handy in occasional cases where you want to disable whitelisting for a while then return to it later.

*Automatically whitelist any address to which I send mail* When this control is checked (the default) Pegasus Mail will automatically add the address of anyone to whom you send a message to the top of your whitelist. If the address already exists in the whitelist, it will be automatically moved to the top of the list. This means that addresses to which you send mail frequently will tend to cluster at the top of the whitelist, while less-frequent and one-time addresses will eventually "fall off the bottom" of the list. It is worth being aware that if you use distribution lists regularly, every address in your distribution list will be whitelisted if this control is enabled.

*Make this whitelist visible for Mercury/32 to use* If you use Pegasus Mail's companion mail server, Mercury/32, you can share your whitelist with Mercury/32 v4.1 and later. This tells Mercury/32 not to apply anti-spam processing and other tests to any address it finds in your whitelist when it is attempting to deliver a message to you (it does not apply to any other users). If you would prefer that Mercury/32 did not use your whitelist, simply uncheck this control and the whitelist will apply only to Pegasus Mail itself.

**Adding addresses to the whitelist**

There are three primary ways of adding addresses to your whitelist:

1: *Manually* Use the *Add* button in the Whitelist management dialog to add the address to the list manually.

2: *Automatically* Use the *Automatically whitelist...* option (see above) to have Pegasus Mail automatically add anyone to whom you send mail to the list.

3: *Using a model* Find a message from the person you want to whitelist, and right-click it (you can do this either in the message list of a folder, or in the message reader itself). From the *Add sender’s address to...* submenu, choose *Global whitelist*.

**Specialized address forms**

There are certain specialized addresses you can place in your whitelist that Pegasus Mail will handle in specific ways.

*Domain-only addresses* If you enter an address containing no '@' symbol, Pegasus Mail will interpret that as an e-mail domain from which any mail should be accepted. So, if you want to accept mail from any user in the domain pmail.gen.nz as whitelisted, simply add an entry containing only the string pmail.gen.nz.

*Regular expressions* If you enter an address containing an asterisk (*) or a question mark (?), Pegasus Mail will treat that as a limited regular expression and process it accordingly. The '*' character represents any number of characters, while the '?' character represents any single character. So, for example, if you want to accept mail from any user at the domain pmail.gen.nz whose username starts with the letter 'D', you would add this expression as an address:

\[d*@pmail.gen.nz\]

You can only add specialized address forms of this kind using the *Add* button in this dialog - Pegasus Mail will never add them automatically.
There are probably some people in the world who only ever reply to mail, and hence never need to remember anyone else’s e-mail address, but it’s safe to assume that they are the minority. For the rest of us, there has to be some way of storing and organizing addresses we plan to reuse in future. Pegasus Mail provides two powerful core features to help you organize your pool of contacts, and has numerous other tools to help you find addresses as well. In this chapter, we’ll look at the two core features you’ll use to handle the majority of your addressing needs — address books, and distribution lists.

Address books

Pegasus Mail provides a comprehensive and powerful address book system you can use to store names, addresses and other contact details about people. The address book system is useful for much more than just e-mail addresses although it naturally provides some specialized facilities to deal with them. You can create as many address books as you wish and it is possible for the system manager to create “system-wide” address books which all users on the network can see.

To work with your address books, you can press the <F3> key, select Address books from the Addresses menu, or else click on the Address books button in the program’s main toolbar. When you do this, the Addressbook Manager will open: this window lists all your addressbooks in a pane at the top left of the window, the contents of any addressbook you select in a pane below it, and information about the current entry in that addressbook in a large pane at the right. You can use the <Tab> key to switch between the various panes in this window. The addressbook manager has its own menu, the Addressbook menu, with options which apply specifically to it. You can leave an address book open on your desktop or minimize it (by clicking the down-pointing arrow at the top right of the Window). You can move the address book to any location and set it to any size you wish — Pegasus Mail remembers the last position the window occupied on the screen when you open it and puts it there for you automatically.

Navigating within the Addressbook Manager window

As noted above, you can use the <Tab> key to move from pane to pane in the Addressbook Manager window. In the two list panes, you can speed-search through the list by typing the first couple of characters in the name of the addressbook or addressbook entry you wish to find. You can also use the up and down arrow keys to move through the list one entry at a time: if you do this in the list of addressbooks, the two preview panes will update for each entry in the list as it is selected. If you use the arrow keys in the addressbook contents list, the entry preview area will change to reflect the settings for each entry as you select it.

Working with addressbooks

You can create, rename or delete addressbooks by clicking the Book... button at the left of the Addressbook Manager’s toolbar.

Addressbook properties  Selecting this option from the Book... button menu lets you adjust key aspects of the way addressbooks are used by Pegasus Mail, most particularly whether addresses or aliases should be used when starting new mail messages, and whether or not specific addressbooks should be used to convert aliases into regular e-mail addresses.

Spare me the jargon: what do you mean by "Aliases"?  In Pegasus Mail, an Alias is a kind of "abbreviation" for an e-mail address: whatever you place in the "Name" field of
an addressbook entry can be used as if it were an e-mail address - Pegasus Mail will convert it to the proper address when it sends the message. So, if you have created an addressbook entry where the "Name" field is Bob Smith, and the address is Bob.Smith@mybusiness.com, then you can actually type "Bob Smith" into any address field in the program as if it were a valid address. Alias resolution is the process of turning the alias into the e-mail address that actually gets placed in the message.

The controls in this window are divided into two groups - one set which only change the behaviour of the currently-selected addressbook, and another set which changes the behaviour of all your addressbooks.

**Apply the e-mail address instead of the alias** If you check this control, then Pegasus Mail will insert the e-mail address from the selected addressbook entries when you use them to create a new mail message. In the default state, with the control unchecked, Pegasus Mail will insert the "Name" field of the entry as an alias.

**Do not resolve aliases in this addressbook** If you check this control, then Pegasus Mail will not check this addressbook when resolving aliases. You might want to do this for very large addressbooks, or addressbooks that you don't use much but keep only for reference purposes. Alias resolution increases the time it takes Pegasus Mail to send your messages, particularly if you have large addressbooks. Checking this control will automatically check the Apply the e-mail address instead of the alias control, because pasting the alias is only useful if the alias later gets resolved correctly when the mail is sent.

The group of controls affecting the behaviour of all your addressbooks has the same general functionality as the specific controls; checking either of them will disable the corresponding specific control.

**Double-clicking an address starts a new message** Normally, when you double-click an addressbook entry in the addressbook window, Pegasus Mail takes this as meaning that you want to edit that entry. If you would prefer that a double-click be interpreted as meaning "Start a new message using this entry", check this control.

**Working with addressbook entries**

To create an entry in your address book, click the Entry... button then select Add a new address entry and the address entry dialog window will open. Most of the fields in this dialog are self-explanatory and many are optional. The three fields which you must fill in are the Name/alias field, the Key field and the E-mail address field: Pegasus Mail will not permit you to create the addressbook entry if either the name or key field is blank and will warn you if you attempt to create an entry with no e-mail address.

If you have a mail message from the person you want to add to your address book, you can simply drag the message and drop it on the open address book. Pegasus Mail will automatically create an entry based on the information in the message and will allow you to edit it before saving it.

**The Name field** contains the name of the person associated with this entry. Once you have created an address book entry you can type in the name you enter here as if it were an address — this process of using the name as an e-mail address is called aliasing and is particularly effective in System-wide address books because it allows people to change their e-mail addresses without affecting those who want to send them mail. The name field may contain any characters except commas.
The Key field is a secondary indexing device — address books can be sorted by key or by name. While it is up to you to decide how you want to organize your address books, the usual way is to have the name field entered in the natural Firstname-Lastname format and enter the surname in the key field. Using the natural name format in the name field makes aliases work more intuitively since it lets you use a person’s name as an address in much the way you might write it, while storing the surname in the key field lets you sort the address book in a more logical manner. The key field is always uppercase and may not contain spaces.

The E-mail address field is where you enter the person’s electronic mail address. You can enter any single e-mail address recognized by Pegasus Mail in this field up to a maximum of 100 characters in length. When Pegasus Mail performs an alias resolution to convert a name field entered as an address, it replaces the name in the address field with the value it finds in the e-mail address field of the entry. You can use addresses in other addressbooks, distribution lists, or select from addresses you have used recently in mail messages by clicking the Addressing Centre icon next to the e-mail address field (please see chapter 4 - Sending mail - for more information on the Addressing Centre).

Pictures You can associate a Windows BMP picture file with an address book entry by clicking on the Set picture button. For optimum appearance, you should use a 256-colour bitmap file that is as near to 130x130 pixels as possible. You can also use 16-colour bitmaps and bitmaps of different sizes, but they will not look as good. The bitmap file you select needs to be located in the same directory as the address book itself, and WinPMail will offer to make a copy for you if you select a bitmap in a different location. Future versions of Pegasus Mail may support graphic formats other than BMP.

The remaining fields in the address book entry are provided for your use and are never directly inspected by Pegasus Mail. While the fields have headings suggestive of intended use, you can place anything you wish in them.

Editing an existing entry is much like adding a new one — when you select Edit selected entry from the Entry... button menu, the entry editing dialog opens and you can alter the contents of the entry. If you change the name or key field in the entry, Pegasus Mail will reindex and resort the list when you save your changes by clicking OK.

To delete an address book entry or a group of address book entries, highlight them then select Delete selected entries from the Entry button menu. Deletion of entries from very large address books may take some time because Pegasus Mail has to rebuild the address book. Once you have deleted entries from your address book they cannot be recovered.

To copy addresses from one address book to another, open both books, highlight the addresses you want to copy in one, then simply drag them across to the other book and drop them there. To move addresses instead of copying, hold down the <Alt> key while dragging and dropping the selected entries.

Using address books

To start a new mail message addressed to the people whose entries are currently selected in the addressbook list, click the Send mail button.

To place the addresses of the people currently selected in your addressbook into the last message you were actively editing, click the Apply button. So, if you start a message then realize that you can’t remember what address you need, you can press <F3> to open your addressbook, find the addresses then click Apply. It’s worth noting that it’s usually faster to use the Addressing Centre to do this kind of thing, but you can also do it this way if you prefer.
You can also drag an address or a group of addresses to any text field in Pegasus Mail and drop them there, which will paste in the aliases or the addresses (depending on your preferences) in that field. You can also use your address books indirectly by typing the name from an address book entry into an address field in your message — this process is called *aliasing* (see above). Finally, you can start a new message using addresses from your address book by double-clicking on any entry; if nothing is selected only the entry you double-click will be placed in the To: field of the new message otherwise all selected entries (up to the 32000 character limit of the field) will be pasted.

**Printing**

You can print selections from your address book by highlighting the items you would like to print (by holding down Shift or Ctrl and clicking on them) then choosing *Print* from the *File* menu, or by clicking on the *Print* button on the button panel. To print the entire contents of your address book, make sure that nothing is selected (click the right mouse button anywhere in the list to deselect all selections). You can choose to print either a *summary listing*, which simply shows name, address and phone number for each entry on a single line, or a *full listing*, where each entry is printed in its entirety.

**The Addressbook menu**

The addressbook menu contains extra options for your address books. The *Find* and *Find again* options on the *Edit* menu can also be used to find text in your address book. If you check the *Select all matching entries* control in the Find dialog, Pegasus Mail will highlight all entries in the book which match your search pattern, otherwise it will simply highlight the first or next match in the list. The *Find* command searches only in the name field of the address book.

*Import and export*  

*Export to tagged text file*  Takes all marked entries in the address book (or all entries if none is marked) and exports them to a text file in export format. The export format is plain text and can be directly imported into Pegasus Mail using the Import option on this menu. *Import from tagged text file* reads a text file in the format created using the Export option and adds all the entries it contains to the address book. Blank lines in the text file are ignored and records must end with "--" on a line by itself. The best way to examine the import format is to export some records from an address book and inspect the resulting text file. You can use export and import operations to copy addresses between address books.

*Import and export tab-delimited files*  If you want to move data between Pegasus Mail and other programs, the easiest way is to use tab delimited import and export. In this format, each record you import or export is stored on a single line in the text file, the fields in the record being separated by ASCII <Tab> characters. Using this format, the fields must be in the following strict order in each record:

- Name/Alias
- E-mail address
- Key
- Department
- Phone
- Fax
- Delivery address
- Postal address
- Details
- Image filename
Tab-delimited data can be produced by and read straight into many database programs, as well as into programs like Microsoft Excel. Note that when using tab-delimited data, a tab must still be present even for fields that are not supplied.

*The Sort by name and Sort by key* options in the Addressbook menu control how the current address book is sorted. The sorting mechanism is handled on a book by book basis and is remembered between sessions with the address book. The current sort order affects how speed search through the address book will work as well — if the book is sorted by key, speed search will attempt to match what you type in the key field, otherwise it will try to match the name field.

### Distribution lists

Pegasus Mail allows you to store groups of addresses to which you send mail frequently in a file. A distribution list file is simply a plain text file that contains one address per line. We call these address lists Distribution Lists in Pegasus Mail to distinguish them from Mailing Lists, which is the proper term for automated mail server processes that are widely-used on the Internet to host discussion groups. Any address you could normally type into any address field in Pegasus Mail can be entered into a distribution list, including references to other distribution lists (up to a maximum of five levels deep). While you can create distribution lists using any text editor, you will normally create them using Pegasus Mail’s Distribution List Manager which is opened by selecting Distribution lists from the Addresses menu, or by pressing <F6>. If you currently have the addressbook window open on your desktop, you can switch to the Distribution List Manager view by clicking the Distribution Lists tab.

In the distribution list manager window, a list of all your distribution lists is shown on the left, and the addresses contained in the currently-selected list are shown in the pane on the right. The right-hand pane is editable – you can type changes into it directly, or cut, copy and paste using the <Ctrl+X>, <Ctrl+C> and <Ctrl+V> keys. This makes maintaining your distribution lists extremely easy.

To add a new distribution list, click the New list... button and the list settings dialog will open.

**List title** This is simply the name which will appear in the Distribution list manager’s list of your available lists. You should normally use some easily-recognized name here. This is not a filename, so you can use any characters you wish in this field.

**To: field** If you enter a value in this field, Pegasus Mail will replace the contents of the To: field in any message in which you use the list with the text you provide. This also suppresses the enumeration of the recipients in the To: field of the message which can be desirable if the list is very large (note: this is not the case with MHS messages, where it is not possible to suppress the list of recipients). The text you provide should always be a validly-formatted Internet address — in other words, you can only enter in this field something which Pegasus Mail would accept in a message’s address field. In general, you should enter a textual name for the list in double-quotes, followed by your own e-mail address in angle brackets (< and >) – so, for example, if the list was about Rutabaga Farming and your address was mcdonald@farm.org, then you might enter this in the To: field area:

>“Rutabaga Farming Mail List” <mcdonald@farm.org>

**Reply to** If you want to set a reply-to address which should be used when mail is sent to the distribution list, enter it here. This feature is useful if you want recipients to reply to an address other than your own — to a group moderator, for instance.
Address completion

The three check boxes at the bottom of the settings dialog are exactly the same as the controls with the same names in the message editing dialog: if you check any of them, the setting will override anything you set in the message editor when you compose your message. This can be useful to force messages to distribution lists to be formatted or prepared in a particular way.

The address list The large edit control at the right-hand side of the Distribution list manager window is where you place the addresses which make up the list. You can enter addresses into the control by typing them, selecting from the Addressing Centre by clicking the Addresses button, or from other addressing aids such as the local user list (see the next chapter for more on this). Each line can contain exactly one address. Blank lines in the list are ignored. While you are editing the list, you can tell Pegasus Mail that certain addresses are to be placed in fields other than the To: field of the message. To do this, enter a line on its own containing one of the following keywords:

- \CC Indicates that all following addresses should appear in the Cc: field
- \BCC Indicates that all following addresses should appear in the Bcc: field.
- \TO Indicates that all following addresses should appear in the To: field.

You can use these special keywords as often as you wish in the list: each use of one of the keywords affects all the addresses which follow it in the file until another keyword or the end of the list is encountered.

Other editing operations You can search for text within the current distribution list by clicking the Find button. You can copy text from the distribution list by selecting it and pressing <Ctrl+C>, and you can paste text into the distribution list by pressing <Ctrl+V>.

Saving your distribution list Any changes to your distribution lists are saved any time you switch to another list or the Distribution list manager window is closed. You can also force your changes to be saved at any time by clicking the Save button – this is occasionally useful if you want to use the list you are editing in a message but do not want to close the Distribution list manager window.

To use a distribution list file, select it in the Distribution list manager’s list of lists, then drag it to the field where you want it to appear and drop it there. To start a new message addressed to the list, click the Send mail button, as in the addressbook window. Alternatively, if you have created your own text file containing addresses you can tell Pegasus Mail to use it by entering the special character @ in the To: field, followed immediately by the filename. So, to use a file created in the proper format called C:\LISTS\ADMIN.LIS, you would enter @C:\LISTS\ADMIN.LIS in the message editor’s To field.

Address completion

One of the handier features in Pegasus Mail is its ability to complete addresses for you. When you are typing addresses into the To, CC, or BCC field of any e-mail message, Pegasus Mail will compare what you are typing with addresses you have used recently, or addresses in your addressbooks. If it finds a match, it will complete the address for you, and select the text it has added. If the address is the one you want, simply press the <End> key to accept the selection, type a comma, and type in the next address. If the address is not the one you want, simply keep typing: the text you type will overwrite the suggested text and Pegasus Mail will make the comparison again based on the additions.

By default, Pegasus Mail’s address completion feature is turned on, and searches only in the list of e-mail addresses you have used recently. You can turn the feature off, or can tell it to
search your addressbooks as well as or instead of the recent addresses list, using the Sending mail preferences page (select Options from the Tools menu for this).

**System-wide addressbooks and System-wide lists**

You can create addressbooks and distribution lists that are available to all your Pegasus Mail users.

*To create a system-wide addressbook* First create the addressbook in your own mailbox, then copy the two files that comprise the addressbook in (they will have the same name, but one will have the extension .PMR and the other will have the extension .PML) into the directory where WINPM-32.EXE is installed.

*To create a system-wide distribution list*, create the list first in your own mailbox, then copy the file (which will have the extension .PML) into the directory where WINPM-32.EXE is installed.

If you would prefer to locate your system-wide entries in a directory other than the directory where WINPM-32.EXE is located, you can do so by creating environment variables pointing to the directory where Pegasus Mail should find the files: for addressbooks, the environment should be called PMR, while for distribution lists it should be called PML. So, to tell Pegasus Mail to look for system-wide addressbooks in C:\LISTS, you could create the following environment variable:

```
SET PMR=C:\LISTS
```

Please consult your Windows documentation for information on creating environment variables under your version of Windows.
8: Other addressing aids

Pegasus Mail provides a number of aids to help you find and remember addresses. These features are all located on the Addresses menu and can be accessed from almost anywhere in the program.

Administering users

User management This option is only available when you are running in non-NetWare mode and only when you have run Pegasus Mail with a username that has administrator privileges. It opens the Pegasus Mail user management dialog, allowing you to create, delete and rename new mail users on the system. If you selected Single user mode (as opposed to Multi-user or Network modes) the first time you ran Pegasus Mail, you will not see this option.

Default messages It is possible to create mail messages that will be copied into the new mail folder of any new user you create with this dialog. These messages will then be waiting for the user the first time he runs the program. To create a default message, edit a text file with any name and the extension .DMI in the same directory as WINPM-32.EXE. The .DMI file should be plain text and should be formatted as a proper Internet Mail message (send yourself a message to use as a template for this). Pegasus Mail copies any .DMI files when creating a new user if the Copy default mail messages control is checked in the User details dialog.

The Local User list

Pegasus Mail uses NetWare usernames as mail addresses and offers the local user list to look them up in the file server’s user database. You can open the local user list at any time by selecting it from the Addresses menu or by pressing the <F2> key. The user lookup window will open – type in a portion of the name you would like to find and either press <Enter> or click on the Search button. You need only type in some characters from the name – Pegasus Mail will show every entry containing the string you provide. To list all users on the server simply leave the field blank and click the Search button. The list displays the user’s NetWare username at the left and his personal name (if any) on the right. Pegasus Mail will paste the NetWare username into the address field when requested. NetWare user groups are shown with a ‘#’ character at the start of the NetWare username. Depending on your system’s configuration, you might or might not be allowed to mail to NetWare user groups: if you are not permitted to mail to groups then nogroups will show.

Showing users on other servers You can use the local address list to lookup users on any server accessible to you via Pegasus Mail. The Server field is a drop-down list which contains all the servers available to you. To lookup users on another server, choose that server from the list, enter a search string and click the Search button.

Note: At this stage, this option is only available when operating with Pegasus Mail’s NetWare Bindery mode personality module.

Selecting addresses You can select addresses from the local user list by clicking on them. To select multiple addresses, hold down the Ctrl key while you click on each entry, or hold down the Shift key and drag the mouse to select a group of sequential addresses from the list. To paste the addresses into the last address field you were using, click the Paste button. Alternatively, you can drag the addresses to any text field in Pegasus Mail by clicking on one of the addresses, holding the mouse button down, dragging them to the place you want to appear, then “dropping” them there by releasing the mouse button. This process, called drag
and drop will even allow you to paste addresses into the Windows notepad program and into some other Windows programs.

You can leave the local user list open and bring other windows to the front at any time by clicking in them. You can search for users as often as you wish simply by typing in a new search pattern and pressing \texttt{<Enter>}. The local user list can display a maximum of 500 entries. You can search for users on other file servers on the network by entering the search string prefixed with the server name and a virgule character (’/’) — for example, to search for all users whose names contain \texttt{John} on file server \texttt{THALIA}, you would enter \texttt{THALIA/John} in the search field. The system manager on the server may wish to restrict the ability of users from other servers to lookup users on the server so you may be prevented from performing the search in some cases.

**Address books and Distribution lists**

Pegasus Mail provides a comprehensive and powerful address books system you can use to store names, addresses and other contact details about people. It also provides powerful facilities for easily managing large lists of addresses called \textit{Distribution lists}. Both of these features are covered in detail in the previous chapter.

**The Logged-in user list**

Pegasus Mail offers a list of users currently logged-in to the NetWare server when you select \textit{Logged-in users} from the \textit{Addresses} menu, or when you press \texttt{<F4>}. You can use the list as an address list in the same way as the local user list and can paste and drag addresses from it in the same way. You can also send short one-line broadcast messages to the people shown in the list by clicking the \texttt{Send} button. When you click on \texttt{Send} a small window will open asking for the message to send, which cannot exceed 50 characters in length. When you have typed it, click OK and Pegasus Mail will send it to all the highlighted users in the list.

The system administrator can restrict the use of the \textit{Send message} feature and the recipient of your message will not see it if they have disabled NetWare broadcast messages.

The logged-in user list is not available in NetWare NDS mode on NetWare 4.x, 5.x and 6.x servers, because in that environment you log into the network rather than into a specific server, and there is no facility provided by the NetWare operating system to list users logged into the network.

**MHS Directory services**

If your system has Novell’s MHS mail transport system or a compatible system such as Connect’2 from Infinite Technologies installed, the \textit{MHS Directory service} option on the Addresses menu will be enabled. The \textit{MHS directory service} option gives you access to address information maintained by MHS on your server. The service looks and works exactly like a system-wide address book: you cannot change the contents of the directory service but you can select addresses from it exactly as if it were one of your own address books, either by dragging and dropping them, or by clicking on the \texttt{Paste} button.

\textit{Technical note}: Pegasus Mail reads the MHS directory service information from the file \texttt{SMF_NS.XRT}, which can be found in \texttt{MHS\MAIL\PUBLIC} in your MHS directory tree. You should only keep the directory services window open for the shortest possible time, because while it is open, NetWare MHS will be unable to update the file with new information.
Creating and working with notepads

Choosing Notepads from the Tools menu opens the Notepad window: on the left-hand side of the window is the list of notepads you have currently created – you may have any number of notepads and may give them any name you wish. To create a notepad, click the New button and enter a name for the new notepad. If you decide you no longer need a notepad, click on its name in the list then press the Delete button.

The right-hand side of the Notepad window displays the text currently stored in the notepad you have selected in the notepad list. To display the contents of any notepad, simply click on its name. Any changes made to the current notepad are saved automatically. You may enter up to 30,000 characters of text into each notepad, and may cut and paste between notepads and messages just as you would normally do, using the options on the Edit menu. Clicking the Date/Time button automatically enters the current date and time at the cursor location within the current notepad – this is a fast and handy way of timestamping messages and events. Finally, you can print any notepad by opening it then clicking the Print button.

You can save the text in any notepad to a file on your hard disk by clicking on that notepad then clicking the Export button. Text exported from a notepad can usually be read into almost any program, including word processors and mail programs. You can also read the contents of any text file on your system into a notepad by clicking the Import button. Note that word processor files are not normally text files – in order to import the contents of a word processor file into a notepad, you will usually have to save the word processor file as plain text.

Checking spelling You can check the spelling of the text in any notepad by moving the cursor to the place in the notepad where you would like checking to begin and choosing Check spelling from the Tools menu, or by pressing Ctrl+K.

Finding and replacing text You can search for text in the current notepad by choosing Find text from the Edit menu, or you replace a piece of text in a notepad with a different piece of text by choosing Find and replace. You can repeat the last find or replace operation you did by choosing Find/replace again from the Edit menu, or more quickly by pressing Ctrl+G.
10: Noticeboards

Pegasus Mail allows your system supervisor to create public noticeboards, or areas in which some or all users can post and browse through messages. The messages posted on noticeboards have almost all the characteristics of mail messages — they can have attachments, can be encrypted, and when you post them, you can keep copies for yourself, just as with mail.

To use the noticeboard feature, choose Noticeboards from the File menu or click the pinboard icon in the toolbar. If there are any noticeboards in which you have permission to browse, a list window which looks rather like a folder window will open. The name of the current noticeboard appears in the title of the window, and to the right of the title you may also see either the text Read-only, which means that you are allowed to examine the notices in this noticeboard but not post new notices, or if you have been designated as an administrator for the noticeboard, the word Administrator. A noticeboard administrator can create new noticeboards and delete messages within the current noticeboard.

The list itself can contain either messages, or other noticeboards. If you select a noticeboard and click the Open button then that noticeboard will open and become the current noticeboard. Selecting a notice and clicking the Open button will display the notice in a familiar reader window. Pegasus Mail remembers the notices you have read from session to session, and will place a checkmark next to notices you have read in the list. You can close the current noticeboard and step back to the last noticeboard you opened by double-clicking the ‘.’ entry at the top of the list.

Posting notices

If you are allowed to post notices in the current noticeboard, you can create a new notice by clicking the New Post button, which will open a notice editor window. Pegasus Mail’s notice editor is almost exactly the same as a message editor except that you cannot change the To field. All the normal message editor options are available including the glossary, the spelling checker, cut and paste and so forth, and you can add attachments to the notice just as you would with a mail message. Pegasus Mail automatically fills in the To: field of the message with the current noticeboard. You can post your notice to the noticeboard by clicking the Send button or by pressing <Ctrl+Enter>.

Following up and replying

A Followup to a notice is like a reply to a mail message, except that it is posted to the noticeboard for everyone to see. Think of a followup as your contribution to an ongoing conversation within a noticeboard. You can followup on a notice by highlighting it in the list and pressing <F>, or by clicking on the Followup button. You can also reply to a notice if you wish: a reply differs from a followup in that it is sent by normal e-mail to the original poster, and is thus private - replies are not posted on the noticeboard. Use a reply instead of following up whenever you want to discuss something “offline” with the original poster.

The followup editor window is exactly the same as the notice editor except that you cannot change the subject field - Pegasus Mail automatically creates the subject field for you. The reason you cannot alter the subject field is to allow threading - that is, when you choose to sort by Subject in the notice list, you will see all the notices in a particular thread sorted in chronological order. As with posting a notice, click Send or press <Ctrl+Enter> to post your followup. A reply to a notice is a standard e-mail message and thus has none of the restrictions of a notice.
Deleting notices, expiration

For technical reasons, only administrators of a noticeboard may delete notices posted to it – you cannot even delete your own postings unless you are an administrator. If you find you would like to delete a notice, ask the noticeboard administrator to delete it for you. Notices may, however, expire automatically after a certain number of days on the noticeboard. Message expiration is determined by the board’s administrator.

Sending mail to noticeboards

As well as posting directly to a noticeboard from within the noticeboard window, you can also send mail to noticeboards; this is convenient if you are sending a mail message to someone and want to place a copy of your message on a noticeboard – you would simply place the noticeboard’s address in the \texttt{CC} field of your message. A noticeboard’s address is expressed as the three characters \texttt{NB:} (N, B, and colon) followed immediately by the full name of the noticeboard. The name of a noticeboard is the names of all the noticeboards you would traverse to get to it, separated by periods; so, if you have a noticeboard called \texttt{Minutes}, which is located in another noticeboard called \texttt{Meetings}, which in turn can be found in a board called \texttt{Office} at the top of the noticeboard tree, then the name of the noticeboard is \texttt{Office.Metings.Minutes}, and you would send mail to it using the address \texttt{NB:Office.Metings.Minutes}. Sending mail to noticeboards does not bypass the security settings of the boards – you can only send mail to noticeboards in which you could also normally post notices. Attempting to send mail to a noticeboard in which you do not have posting rights will result in an error.
11: Preferences - customizing the way Pegasus Mail operates

Mail systems seem to be a very personal thing to most users, so Pegasus Mail has been made extremely configurable. You can alter many aspects of the way it operates using the Options dialog, which is found on the Tools menu. The Options dialog contains a number of sections, shown at the left-hand-side of the dialog: each of these sections has one or more settings pages, which allow you to control the behaviour of a specific part of the program. Clicking on a page brings the settings associated with that item into the Properties area on the right of the dialog, where you can inspect or change them. Some pages in the Options dialog, such as Edit extended features will only be available if the system administrator has granted you the necessary rights. Others, such as NetWare MHS Settings, may not be present in the list if the feature to which they correspond is unavailable or not installed on your system.

Pegasus Mail remembers your preference settings from session to session, and you can access the Options dialog at any time by pressing <Alt+F10>.

General settings

This section contains pages that allow you to configure aspects of the way Pegasus Mail behaves in an overall sense.

Basic Settings

Personal name Any string you enter in this field will be attached to your address in messages you send. Most mail programs will show the name you enter here instead of your address when displaying mail, which can make it easier to find and recognise your messages. For technical reasons, the following characters may not appear in your personal name:

" { } [ ] @ % ! * ? . < > : ; \ or /.

Try to keep your personal name short and descriptive, since this will make it clearer for the recipient.

Automatically open the new mail folder at startup If you check this control then Pegasus Mail will automatically open your new mail folder each time you run the program. If you normally run Pegasus Mail in Folder Preview Mode (see chapter 5), then checking this control will open your folder list at program startup, automatically selecting the new mail folder in the list.

Preserve deleted messages until Pegasus Mail closes If checked, then Pegasus Mail will not physically delete messages when you click the Delete button in the browser, but will move them to a special folder called “Deleted messages” instead. You can browse this folder like any other, but each time you exit from Pegasus Mail it will be emptied. Checking this control may consume disk space temporarily, but gives you an extra level of safety in case you delete something you later decide you need. Be careful, however, when using this setting in a low-disk environment. An advanced control exists to prevent the “Deleted messages” folder from being emptied on exit – see under Advanced settings, below, for more information.

Ask for confirmation before deleting objects If checked, WinPMail will ask you for confirmation whenever you delete things, such as messages from folders. If you would prefer not to be prompted this way, uncheck the control. If you do not have deletion prompting turned on, we recommend you turn on Preserve deleted messages until Pegasus Mail closes as a safeguard.
Allow read messages to stay in the new mail folder  If this is checked, then Pegasus Mail will leave mail which you have read but not moved or deleted in your new mail folder. Normally, Pegasus Mail automatically moves new mail which you have read into your Default folder (see below) when you close the new mail folder.

Ask for NetWare password at startup  If you check this item, then Pegasus Mail will require that you enter your NetWare password when it starts up. This adds security to your mailbox. This option is only available when you are using Pegasus Mail with its special support for Novell NetWare local area networks – it is not available in other environments.

Save the Pegasus Mail desktop state between sessions  If you check this control, Pegasus Mail will attempt to remember the folders, address books, distribution lists and addressing utilities which are open at the end of one session, and will reopen them at the start of the next. Checking this control also results in the folder manager window remembering which trays are open between sessions.

Use system-defined colours in Pegasus Mail’s controls  If this is checked, Pegasus Mail will respect any settings you have made in the Windows Colours and Desktop control panels when drawing its lists. If unchecked, lists will appear with a white background.

Name for default mail folder  Enter in this field the name of the folder where Pegasus Mail should place messages that have been read but left in the new mail folder when it is closed. If this folder does not exist, Pegasus Mail will create it as required, the same way as it does for copy-to-self folders. If you want mail you have read but not filed to be left in the new mail folder instead of being moved automatically, check the control labelled Allow read messages to stay in the new mail folder (see above).

Advanced Settings

This page lets you change some of the more esoteric and less often-used features of Pegasus Mail. In general terms, you should not alter anything in this screen unless you’re quite clear about what you’re doing.

Refresh the new mail folder view every...  When the new mail folder is open and frontmost, Pegasus Mail periodically scans it for new messages, which can create increased Network traffic and can slow down your system if done too frequently. Enter in this field the number of seconds which should elapse between rescans of the new mail folder. The default value, 3 seconds, is reasonable in most cases, but if you are accessing your server across a slow link, you may want to extend it. Setting the field to -1 will disable new mail rescans altogether.

Lines to scan for enclosures  Internet mail programs handle attachments in different ways: one of these ways is to tack a specially-encoded version of the attachment onto the end of the mail message. Attachments sent this way are called enclosures, and can be time-consuming to find, since the only way to be sure of detecting them is to read the message from one end to the other looking for tell-tale signs of the encoded data. In order to minimize the effect that an enclosure search has on the length of time it takes to open the new mail folder, Pegasus Mail’s message parser only examines the first x lines of each message looking for enclosures, where x is the value you enter here. Setting a larger value here will increase the likelihood of the message parser finding enclosures, but will also increase the time required to do so. Note that the only effect this has is whether or not the attachment indicator will appear next to the window in the folder browser. When you open a message and click the Attachment button, Pegasus Mail always examines the message from start to end and the setting you enter here has no effect on that.
Organization string  This field only applies to mail sent using Internet mail transports other than Mercury and compatible gateways. It allows you to set an “organization” field in your messages indicating who you are.

SMTP time zone  This field only applies to mail sent using Internet mail transports other than the Charon and Mercury gateways. It indicates your timezone relative to the rest of the world, and should be entered as a 4 digit offset from Universal Standard Time (Greenwich Mean Time). As an example, New Zealand is 12 hours ahead of GMT, so the correct value for New Zealand would be +1200.

Auto  If you check the Auto control (the default setting), then Pegasus Mail will ignore whatever is entered in the SMTP Time Zone field, and will work out the time zone by asking the Windows operating system. The main advantage of using the Auto setting is that daylight savings compensations will be applied automatically, and the format of the time zone field is guaranteed to be correct. We strongly recommend that you use this option.

Default MIME character set  The character set Pegasus Mail should use when composing MIME messages. This field should only be changed on the advice of Pegasus Mail technical support or your system supervisor. The drop-down list contains a large number of valid character sets that could be in use on your system: for users in Europe and the US, either “UTF-8” or “ISO-8859-15” are the best options.

Accept requests to “confirm reading”  This field only applies to mail sent using Internet mail transports other than the Charon and Mercury gateways: it determines whether or not you want Pegasus Mail to answer requests from people sending you mail for confirmation that you have read their message. This control is disabled if the Mercury or Charon SMTP transport is running on your system (use the option in your extended preferences instead in this case).

“Deleted messages” folder persists between sessions  If you have turned on Preserve deleted messages until the end of the session in your General preferences page, then Pegasus Mail will create a folder called “Deleted Messages” in which deleted mail will be stored. The normal behaviour in Pegasus Mail is to purge this folder when you exit from the program: if you would prefer that the folder persist between sessions without being purged, check this control. When this control is enabled, it is up to you to decide when to empty your Deleted Messages folder - it will not be done automatically. You can do this either by deleting messages in the folder (at which point they are permanently deleted), or by deleting the folder itself (Pegasus Mail will recreate it as required). You can also use filtering rules to delete messages in the folder based on their age – see the section on Mail Filtering for more information on doing this. This option is disabled in NetWare mode.

Load Windows Internet Services (WSOCK32.DLL)  WSOCK32.DLL is the module which Pegasus Mail uses to access Internet network services on your machine. This group of controls determines when Pegasus Mail should load and use WSOCK32.DLL. If Never is selected, then the file will not be loaded and the six options specific to it will never appear on the File menu. If Always is selected, then the file will always be loaded for the duration of each Pegasus Mail session. On demand only tells Pegasus Mail only to load the file when it needs to establish a connection, and to unload it when it has finished. Always will give the fastest response time and should be used if you are attached to a fast network like Ethernet; On demand only will be mainly useful to those who attach via SLIP or PPP connections and want to minimize the length of calls to their service provider.
11: Preferences - customizing the way Pegasus Mail operates

General settings

**Recovery of deleted space from folders** When you delete a message, Pegasus Mail does not actually remove the message's data from the folder - instead, it simply marks the message as "deleted", and adds the size of the message data to an internal counter. Whenever the folder is closed, Pegasus Mail checks the internal counter to see if it exceeds a particular size, and if it does, it recovers the space occupied by all the deleted messages in the folder. If the folder is very large, or if you delete information from it frequently, this process of compression may become annoying or may take too long. Changing the value of this control allows you to tune the point at which Pegasus Mail will perform the deleted space recovery operation - setting a large number will make the operation happen less frequently, at the cost of having some of your disk space occupied by "dead" data. Setting this field to 0 turns off deleted space recovery - deleted data will never be removed from the folder, and it will therefore continue to get larger and larger over time.

The default value for this field is 24000 bytes: this value has been determined over a number of years to be a good compromise between performance and efficiency - we recommend that you do not change this value unless you have a clear and specific reason for doing so.

**Mailbox location**

*IMPORTANT NOTE:* In Pegasus Mail v4.31 and v4.41, this option is non-functional. This will be corrected in a later release.

In Network mode, when you use Pegasus Mail, you are actually using a mailbox created automatically for you on the file server by NetWare. This mailbox is where all the mail you have read, your address books and distribution lists are stored. Anything you store here will count against your disk quota on the file server. You can, however, tell Pegasus Mail to store all your mail and accessories in another place of your choice, by entering the location in this dialog. The new location can be a local hard disk, a subdirectory on the current server, even a floppy diskette, although this is discouraged.

*Important note:* it is very important that all folder, message, distribution list and address book windows be closed before you attempt to use this option. Only the button panel and the local user list may be left open when you move your home mailbox, otherwise you may lose data.

*The Move mailbox contents to new location* control determines whether Pegasus Mail should move your existing mail folders, address lists and so on to the new location. If it is unchecked, Pegasus Mail will leave the contents of your existing home mailbox where they are. This option is useful if you want to force Pegasus Mail to use a home mailbox moved using another version of Pegasus Mail (the mailbox formats are completely compatible for all versions of Pegasus Mail), or if you want to use multiple home mailboxes with different contents for some reason.

*Clicking the Default button* forces Pegasus Mail to return to the original default setting for the home mailbox, which under NetWare is a special directory on the file server.

In NetWare mode, the system supervisor can force you to move your home mailbox off the file server: if this applies to you, then Pegasus Mail will open the home mailbox dialog as soon as you run the program, and will not proceed until you have selected a local mailbox.

**Extended features (Novell NetWare mode only)**

This option is only available in Local Area Network environments such as Novell NetWare, and will only be available on the Preferences menu if your system administrator has granted you the necessary rights. Extended features are capabilities in Pegasus Mail which must be
enabled by the administrator on a user-by-user basis, including autoforwarding, mail disable, and notification disable.

**Autoforwarding** If you enter an autoforward address, all mail addressed to you will be redirected to that address. There are two autoforwarding fields — one for Pegasus Mail, which can contain any address you could type into the “To” field of a message, and another, marked as “Internet A/F”, which is an autoforwarding address for messages delivered by any SMTP (Internet) gateway on your system; in this field, you may only enter valid Internet addresses. It is possible to autoforward normal (local) Pegasus Mail messages but not Internet messages, and vice versa, by entering an address in only one of these fields. Autoforwarded messages have a note in the message body indicating that they were autoforwarded.

**Deliver mail even if autoforwarding** Check this box if you want copies of messages to be delivered as well as being forwarded when you have an autoforwarding address enabled.

**Allow “confirmation of reading” requests** If this field is unchecked then users will not be able to request confirmation of reading from you. When they try to request confirmation (by setting the “Confirm reading” field in the message headers to Y), they will be immediately told that you will not honour the request. For many people, confirmation of reading is a violation of privacy, and Pegasus Mail respects this. By default, Pegasus Mail will honour all requests for confirmation.

**Disable mail delivery** Check this box if you do not want mail delivered to your address at all.

**Advise of new mail via broadcasts** If checked, you will be informed when new mail arrives via NetWare broadcast messages. Unless you are using NetWare MHS, you will usually see a NetWare broadcast message advising that mail has been delivered (these messages appear in a dialog box if you are running Novell’s NetWare support programs for Windows, or on the bottom line of the screen in a DOS session). If you receive a great deal of mail, the messages can become disruptive, so this flag allows you to disable them. Unchecking this control will not affect other NetWare broadcast messages in any way — to turn off all NetWare broadcast messages, use the NetWare CASTOFF command instead.

It is possible for the system supervisor to enable advanced features for a user, but deny the user the right to modify them. If you are not authorised to edit advanced features, the option will be greyed in the Tools|Options Dialog.

### Outgoing mail

This section contains pages of settings that control the way Pegasus Mail should prepare the mail messages you send. Some of the options in these pages are somewhat specialized, so you may feel it worthwhile to consult with an experienced user before modifying them.

### Messages and replies

**Preferred editor variation for normal messages** This group of controls allows you to add certain options to the standard message editor window Pegasus Mail will open when you press <Ctrl+N> to compose a new message. The *Add keywords field* control adds a new edit field entitled *Keywords*, into which you can add any important keywords that might be useful for indexing or searching purposes, while the *Add identity selector* option places an identity selector on the front page of the message editor instead of the *Special* page. We suggest you experiment with these controls to see if you prefer one of the alternate layouts they offer.
Use these settings when creating new messages and replies
This group of controls determines what settings are applied by default each time a new message window is created.

Use MIME features Controls the default setting of the Use MIME encodings for this message control in the Special view of the message editor. MIME is the current Internet standard for handling attachments and international characters and this control should usually be left on.

Sticky and default settings The Confirm reading, Confirm Delivery and Copy to self controls allow you to control the behaviour of the controls of the same name in the message editor. If Use last setting is selected, Pegasus Mail will use the value the control had in the last message you sent when starting a new message. If On or Off is selected, then the control will always assume that value when you start a new message, irrespective of the last setting used.

Rich (formatted) text If you set this control to On, Pegasus Mail will automatically turn on the Rich text control in every new message you create, which will result in the message going out as HTML regardless of whether or not the message contains formatting that requires HTML preparation. In its default state of Off, Pegasus Mail decides whether or not to send the message as HTML based on its content. We strongly recommend that you leave this control set to Off unless you have a specific reason for doing otherwise.

Generate transcript Mercury/32, Pegasus Mail's mail server companion product, can generate what are known as "transcripts" - reports showing the time and details of the delivery of a message you send to someone else that can be used as pretty reliable proof of delivery. Pegasus Mail now has an option on its message editor's Special page to enable requests for Mercury transcripts on a message-by-message basis, and if you wish, you can check this control to specify that the option should be on by default. The option has no effect and is harmless if you do not use Mercury.

Special settings applying to replies only
The controls in this group only apply to new message editors that contain replies to messages.

Remember address settings in reply dialog If you use Pegasus Mail’s advanced reply dialog and check this control, Pegasus Mail will remember the settings of the address controls at the bottom of the dialog from message to message. When this control is unchecked, the address controls will be reset before every reply. Leaving this control unchecked usually results in the most intuitive operation, while allowing you to direct certain replies to specific addressees.

For replies, place the cursor on an initial blank line When this option is checked, Pegasus Mail will generate your replies slightly differently when you include the original message into your reply. A blank line will be inserted before the quoted text and any custom header you have defined, and the cursor will be placed on that line. Note that this is effectively designed to allow a technique called Top Posting; which many people on the Internet dislike; exercise discretion before enabling this option.

Use message reader quoting styles in replies If this control is checked, Pegasus Mail will apply any quoting styles you have defined in the Reader settings page to your edited reply. So, if you normally show quoted text in dark red in your message reader, and this control is checked, your replies will also show quoted text in dark red. This is a cosmetic effect for your ease of use only – the quoting style is not normally sent as part of the message, but is removed prior to sending.
Address completion options

These options control the way Pegasus Mail’s address completion feature will operate (see the chapter Addressbooks and Distribution lists, for more information on address completion). If you check either of the two controls (Recently-used addresses or Addressbooks) then Pegasus Mail will search that resource when trying to complete addresses for you. To disable address completion altogether, simply make sure that neither control is checked.

Message formatting

Message editing features

This group of controls affects automatic saving and spelling checking of your mail.

Automatically check spelling before sending message If checked, Pegasus Mail will automatically invoke the spelling checker to check your message when you click the Send button.

Check for overlooked attachments before sending When this control is checked and you click Send to send a message, Pegasus Mail does a scan through the message looking for words or phrases that might indicate that you intended to add attachments: if it finds such phrases, but there are no attachments, it will put up a dialog asking you if you meant to add any attachments. This is an incredibly handy option if you are as absent-minded as I am.

Auto-save messages in progress If you enter a value (in minutes) here, Pegasus Mail will automatically make a periodic safety copy of any messages you are editing. Once the message is successfully sent, or if you cancel it deliberately, the autosaved version will be removed. If your system crashes, however, you can recover the last saved version using the Open saved message command on the File menu. Autosaved messages are identifiable by the characters [ASV] at the start of their names.

Formatting and use of styling in messages

Pegasus Mail has comprehensive support for sending HTML mail containing formatted text, pictures, tables and other “modern conveniences”. Not everyone likes this type of thing, though, so the program also lets you control how these features are used.

Disable all text styling options (never send styled mail) If you check this control, then Pegasus Mail will never send HTML mail; any text you paste into a message will have its styles stripped, and messages will always be sent as plain text. When this control is checked, Pegasus Mail behaves as a text-only mailer, and margin measurements will change to characters instead of inches or millimetres. If you are an “old school” mail user who does not like HTML mail or other styled innovations, then this control is for you.

Do not display the editor ‘styles’ toolbar If you would sooner have extra space in your message editor and do not use the editor’s formatting toolbar, check this control. The toolbar will be removed for subsequent messages and the space it normally occupies will be added to your editable message area.

Always paste plain text in preference to styled text Normally when you press <Ctrl+V> to paste text into a message, Pegasus Mail will preserve the styling of the text in the clipboard. If you would prefer that only plain text were pasted, check this control. Note that this control is automatically turned on when you check Disable all text styling options (see above): it is provided as a separate control for the benefit of people who do occasionally send styled mail but typically only want plain text inserted when they paste from the clipboard.
**Tabs and margins**

The controls in this group determine how wide the lines in your message should be, and the size of tabs. They are directly influenced by the setting of the Disable all text styling options control (see above).

**Message width**  This is the approximate maximum width of the column of text in your messages. You can set this width in either inches or millimetres, unless you have enabled the Disable all text styling options setting, in which case measurements are in characters and are exact. If your window is narrower than the message width you specify here, the width of the message will be adjusted to the width of the window instead.

**Tab width**  This is the approximate width between tab stops in your message; as with the message width, you specify this in inches or millimetres, or in characters if you have turned off text styling.

**Right margin for Ctrl+J reformatting command**  When you press <Ctrl+J> in the message editor, Pegasus Mail reformatting the paragraph containing the cursor so that it fits within a pre-selected margin, which is always measured in characters whether or not you have turned off text styling. This command is extremely useful for tidying up messages sent using mailers with much wider messages than you use. The value you enter here is the number of characters the reformatting process should try to fit on each line as it reformats the paragraph.

**Signatures**

A signature is a text fragment that is automatically added to the end of messages you send, and which is normally used to include contact information about you – you might wish to include your phone and fax number in your signature for instance. Because Pegasus Mail can use a number of different mail transports and some information, like your e-mail address, may depend on the mail transport that is used to send a message, Pegasus Mail lets you create Signature Sets, where you define text that should be added to mail sent using a particular transport. Pegasus Mail allows you to create up to nine such signature sets, and to give each signature set a name. Most people will only want to use one signature set most of the time, but if you run a business and send personal mail from the same account, you may want to be able to use different signatures for each type of mail. Similarly, you may not want your personal signature to be attached to mail you send using Distribution lists, so having multiple signature sets allows you to define separate signatures that are applied to your list mail.

To edit your signatures, simply click the Edit signatures button and the signature editor dialog will open. The key to understanding how to use the signature editor dialog is to understand the use of the two drop-down list controls at the top of the dialog. The drop-down list on the left selects the signature set you want to work with, while the drop-down list on the right selects the variant of that signature set that you want to edit. Each signature set has as many as six different variants – two for each possible type of delivery Pegasus Mail can perform (local delivery, Internet delivery or NetWare MHS delivery). The two variations depend on whether you are sending messages containing formatted text or pictures, or whether the message is being sent as plain text. This allows you to have a fancy signature that contains graphics and other formatting for when you send messages containing styled text, and to have a simpler version that is attached to your plain text messages.

As an example, when you select Local address, formatted content in the right-hand control, you will be editing the signature that Pegasus Mail will attach to any styled message it delivers to another local user on your LAN or computer. If you choose Internet address, plain content, you will be editing the version it attaches to any plain (non-formatted) message you send.
to an Internet address. This may all seem a little complex, but it gives you the maximum control over the format of the signatures that get attached to your messages.

**Hint – Pictures in signatures** If you want to include a picture in your signature, try creating a table with two columns and one row; put the picture in either the left-hand or right-hand column, and put your signature text in the other column: doing it this way will ensure that the text will align nicely when the message is sent.

In the signature editor, you do not have to enter text for signatures tied to mail transports you do not use – so, if you are not using Novell’s MHS product, you do not have to enter any text in the MHS Signature box.

**Variable signatures** You can tell Pegasus Mail to choose a piece of text at random from a file of options you create and place it in your signature. For instructions on how to do this, please consult the file `RQUOTES.R` in the `RESOURCE` subdirectory of the directory where you installed Pegasus Mail.

**Inserting signatures into the message at send time** Other mail programs offer much less flexibility than Pegasus Mail in signature handling – typically, they only allow you to define a single signature, and insert it directly into the message when you start it. While this is counter to the way Pegasus Mail is designed, if you have come from another mail package, you may prefer to work this way: if so, check the control labelled *Add this variant of the default signature on message creation*, and Pegasus Mail will insert the signature variant you choose in the body of the message when the message is started. Be aware that doing this makes it impossible to change the signature set for a message once you have started it. Because it cuts heavily into the flexibility of Pegasus Mail’s signature handling, we recommend that you leave this control unchecked, and let Pegasus Mail decide the proper signature to add to the message at send time.

**Copies to self (outbox)**

Other mail programs often have a folder called an *outbox*, where mail is placed prior to being sent. Pegasus Mail works slightly differently: because there are so many different ways mail can be sent via Pegasus Mail, many of them immediate, it makes no real sense to have a mail “queue” for all your mail. Instead, Pegasus Mail lets you make a *copy-to-self*, or a record of the message stored in a folder you designate. This separation of delivery and record-keeping makes the feature much more flexible than in other packages: you can choose which folder should receive your copies to self on an identity by identity basis (see chapter 14 for more information on identities), and Pegasus Mail’s powerful filtering facility can also be applied to your copies to self, making it possible to do very complex filing and manipulation on the copies of your mail that you keep for your own reference. The controls in this page determine how Pegasus Mail should handle your copies to self.

**Default copy-to-self folder name** Enter in this field the name of the folder where Pegasus Mail should create your copies to self. If the folder does not exist, Pegasus Mail will create one using this name – this makes it easy to archive your copies to self: all you have to do is rename your existing copies-to-self folder, and Pegasus Mail will automatically create a new one the next time you send a message.

**Ask at send time whether or not to make a copy to self** If you check this control, Pegasus Mail will ignore the setting of the *Copy self* control in the message editor window and will always ask you if you want to keep a copy of each message you send at the time you click the *Send* button.
11: Preferences - customizing the way Pegasus Mail operates

Outgoing mail

If making a copy to self, ask at send time which folder to put it in  Pegasus Mail usually stores copies to self in the folder you specify in Default copy-to-self folder name (see above). If you prefer to choose the folder in which your copies to self should be filed on a message-by-message basis, check this control. At send time, if you have indicated that you want a copy-to-self made, Pegasus Mail will open the folder selector and ask you to choose a folder where the copy should be placed.

Copy-to-self filtering
This powerful feature lets you apply a special set of filtering rules to your copies-to-self; using this rule set, you can file copies-to-self in any folder based on the characteristics of the message (who it is addressed to, the subject line and so on), you can even automatically delete copies to self that you do not want to keep. To edit your copy-to-self filtering rule set, click the Edit rules button and the filtering rule editor window will open. For more information on editing and creating filtering rule sets, please see Chapter 6 in this manual.

Encryption
The options in this window are only meaningful if you have installed a third-party encryption module such as Gerard Thomas’s QDPGP (you can find a list of available third-party encryptor modules by visiting the Pegasus Mail web page, http://www.pmail.com, and clicking the Links link). They have no effect on Pegasus Mail’s built-in encryptor module.

Default encryption method  Allows you to select the encryption module Pegasus Mail should select by default when you click Encrypt in the message editor.

Default password  If your encryption module requires a passphrase for common operation you can store it here. Pegasus Mail’s encryption and decryption dialogs have a button labelled * which will enter your default passphrase into the password field. Pegasus Mail will also use the default passphrase as the key when you have selected automatic digital signing (see below). If you check Ask at startup, Pegasus Mail will prompt you for your default passphrase when you run it and will not store it in your preferences file.

*** NOTE!! Even though Pegasus Mail encrypts your passphrase, entering it in this dialog is a security risk. You should only enter a default passphrase if your system is physically secure – that is, no-one else can access it when you are not there.

Attach a digital signature if the encryptor supports it  If the encryptor you have selected in the Default encryption method control supports digital signatures, you can instruct Pegasus Mail to add a digital signature automatically to every outgoing mail message you send by checking this control. Most encryptors will also require a default password in order to be able to complete this operation.

Sending mail
The options on this page are technical options controlling the way Pegasus Mail constructs the physical mail messages you send. You should seldom need to alter the values in this page, and we recommend that you do so only if you have a good technical understanding of how that will affect the mail you send.

Default “reply-to” address  Pegasus Mail allows you to specify a reply-to address which is different from your own on a message-by-message basis, using the message headers option while you compose your mail. In some rare cases, you may wish to specify a particular reply-to address in all your outgoing mail. If you do, enter that address in this field, and Pegasus Mail will copy it to the message headers for you every time you send a message. Typical in-
stances where this might be desirable include: a manager who wants all replies to be sent to his or her secretary, or a user who normally prefers to read mail on another machine.

**Important note:** There is almost *never* a need to use this field - in most instances, it should be left blank. You should only enter an address in this field if you are certain that you need to do so.

**Permanent BCC (blind carbon copy)** This field allows you to apply a BCC address that is applied to every message you send. This can be useful if you need to duplicate your messages on another account, or if you are required to submit all your mail to your employer. You can enter one or more addresses in this field, separated by commas; any valid address may be used. The addresses in this field are supplemental to any BCC addresses you may add on a message-by-message basis.

**When sending messages containing rich (formatted) text**

These options allow you to control the way Pegasus Mail sends messages containing styled text, such as italics and bold. Unless you have specifically told it never to send styled mail (see the Message formatting page above for more information) Pegasus Mail will send plain text messages whenever possible, sending styled messages only when you have explicitly used a feature that requires it to do so. You can always tell if Pegasus Mail is going to send a message as formatted (HTML) mail, because the Rich text control in the message editor will be checked. Clearly, the controls in this group are only meaningful when the program actually needs to generate a message containing formatted data.

**Generate multipart/alternative versions of richtext messages** If this control is checked, then Pegasus Mail will create a special mail message containing both plain and styled versions of any rich text message you send. This special format, called Multipart/Alternative, is detected by most modern mailers and allows them to choose the version they are best able to display.

**For mail sent to local addresses, use MS-RTF formatting** If this control is checked and you send a message containing rich text to a local address (another Pegasus Mail user on the same system as you), then Pegasus Mail will send the message as standard Microsoft RTF data. RTF is a very powerful format and allows the maximum flexibility in formatting. If you wish to use the right-click option Import picture file in your messages to add graphics to your mail, this option must be checked – graphics can only be sent in RTF format.

**Advanced settings**

Definitely only for the technically-aware...

**Send attachments as separate messages** When you send mail with attachments to Internet addresses, Pegasus Mail can behave in one of two ways: it can either include the attachments in with the message itself, resulting in a single large message containing everything (in this case, the attachments are really properly called enclosures); or it can generate a separate message for each attachment. The ability to split the attachments into their own messages dates from the time when the Internet was not as fast or reliable as it is now – in a lot of situations, large mail could cause real problems for some older gateway systems, and splitting the message into a group of smaller messages often alleviated that problem. These days, there is seldom a reason to check this control – all current mailers expect to see enclosures, and there are seldom problems with sending large messages any more. We strongly recommend that you leave this control unchecked unless you have specific known reasons for disabling it (for instance, you are still using a gateway that cannot handle large messages).

**Allow 8-bit MIME message encoding** One of the problems with Internet mail is that officially, it is a 7-bit protocol, which means that only the simple ASCII character set can be repre-
sented in an Internet message. This can cause problems for non-English-speaking users, since
the accented characters they need usually require a full 8 bits. More modern Internet mail sys-
tems and transports can accept and generate 8-bit data in mail messages, even though this
practice is in the strictest sense illegal. MIME, the recent Internet message format specifi-
cation, has an option for handling raw 8-bit data in mail messages, and this control tells Pegasus
Mail that it can use that option when generating messages that contain 8-bit data. If this option
is unchecked, Pegasus Mail will perform conversions on your data to ensure that it can be
carried legally across 7-bit Internet transports.

**WARNING!!** There are still systems on the Internet that cannot handle 8-bit data, especially
in message headers, and sending mail containing 8-bit data to these systems can cause serious
problems. *You are on your own if you turn on the 8-bit option in Pegasus Mail – the author
expressly rejects all responsibility for anything arising from your use of it.* We recommend
in the strongest terms that you only enable this option on the advice of a competent system
administrator.

**Don’t add “information” sections to Multipart messages** Normally, when you send a mes-
close message with a message, Pegasus Mail adds a small fragment of text describing the attach-
ment. If you would sooner it did not add this informational section to your messages, check
this control.

**Suppress BCC listings** Normally, when you send a message containing BCC addresses,
Pegasus Mail lists all the BCC addresses in the BCC field of the message sent to those recip-
ients: this means that all BCC recipients know who all the other BCC recipients of the mes-
 sage are. If you check this control, Pegasus Mail will simply enter *Suppressed* in the BCC
 field, and BCC recipients will not be able to tell whether there were other BCC recipients, or
who they were.

**Enable text-file autodetection when sending attachments** Normally, when you send an at-
tachment with a message, Pegasus Mail will apply a process called *Armouring* to the attached
file: this is a special type of encoding that allows non-textual data to be included in a mail
message. Armouring ensures the integrity of the data you send, but also increases the size of
your message by approximately a third the size of the attachment. There are certain types of
file, specifically files containing only simple text, that do not need to be armoured in this
manner: if you send such files without armouring them, your messages will be smaller. If you
check this control, Pegasus Mail will examine attachments during sending and will try to
work out whether or not they contain only simple text: if it determines that this is the case, it
will not armour those attachments, thus reducing the size of the message sent. While this
sounds good in theory, in practice you’re better to leave this control unchecked and allow
Pegasus Mail to armour all your attachments, for a variety of technical reasons. We recom-
   mend that you only use this control in very specialized circumstances, where you are regu-
larly sending large text files across slow connections (such as cellphones using GPRS).

**Incoming mail**

The pages in this section control the way Pegasus Mail handles the mail you receive, in par-
ticular the way the message reader behaves and how your folders should operate.

**Preview mode settings**

The controls on this page are mostly only relevant when you run Pegasus Mail in its Folder
Preview Mode (see chapter 5 for more information on this).

**Display a 'details' ribbon in association with the preview area** When this control is checked,
a small grey area will appear above the message preview pane, in which information about
the sender, recipient and subject of the message will be displayed. The ribbon also has a set of status indicator controls that show you at a glance whether messages have been replied to, forwarded, and so on. If you change the setting of this control, the change will take effect the next time you open the folder manager window.

**Apply filtering rules when previewing folders** If this control is checked, Pegasus Mail will apply any filtering rules associated with a folder whenever the folder is previewed in the folder manager window. If this control is not checked, then filtering rules will only be applied to a folder when it is opened in its own separate window by clicking the Open button.

**Remember and apply each folder’s sorting mode separately** If you check this control, Pegasus Mail will remember the way each folder is sorted and will restore that sorting mode when the folder is previewed. If the control is not checked, the preview window will use the same sorting mode for all folders.

**Ctrl+W activates the preview and selects the new mail folder** If this control is checked, pressing <Ctrl+W> or clicking the "Open new mail folder" toolbar button will open the folder manager window (or bring it to the front if it is already open) and select the new mail folder for previewing. If this control is not checked, then <Ctrl+W> will cause the new mail folder to open in its own window, as if you had selected it in the preview and clicked Open.

**Mark previewed messages as having been read** When checked, this control causes mail that is displayed in the message preview area to be marked as having been read. If the control is not checked, messages will only be marked as read when you explicitly open them in their own window.

**Folder behaviours**

These options control the general behaviour and display of the contents of your folders: as such, they apply to both the multi-pane “Preview” mode and the “Classic” mode, where each folder opens in its own window.

**Folder colouring** These two buttons allow you to set the colours Pegasus Mail should use to present folders that contain unread messages, and folders that have recently had unread messages added to them (for example, as a result of mail filtering). The button shows the colour currently selected for that type of display - to change the colour, simply check the button.

**Use bold to emphasize…** These controls tell Pegasus Mail that you want to see any unread message displayed in a bold typeface in the message list, or to have folders that have recently had new mail moved into them displayed in a bold typeface in the folder list.

**Grouped views** These items control the way Pegasus Mail’s Grouped Views feature (see Chapter 5) works by default. If you check Auto-open the first group in the list, then any time you select a grouped view, Pegasus Mail will expand the first group in the list. The other two options allow you to have Pegasus Mail automatically open groups that contain unread mail, or mail for which you have specified a colour. The two colour buttons allow you to set the colours Pegasus Mail should use when drawing the Grouped View caption bars - the default colours have been selected to work well with the standard colours found in typical Windows installations, but you can select any colours you wish.

**Default behaviour for Link and Search result folders** When you perform a search, Pegasus Mail stores the results in a special type of folder called a Link Folder; Link Folders differ from ordinary folders in that they do not themselves actually contain messages – instead, they contain special links to messages in other folders. When you manipulate a message in a link folder, you are actually manipulating the original in the folder where it resides behind the
scenarios. Link folders can contain messages from any number of folders, and are a fast and econo-
nomical way of storing references to messages without duplicating them. The options in this
group control the behaviour of link folders on your system.

Deleting a link from a Link Folder also deletes the original message When this control is
checked and you delete a message in a link folder, the original message will also be deleted
from the folder where it resides. When this control is unchecked, deleting a link will only de-
lete the link – the original message will be unaffected. You can force the opposite behaviour
by holding down the Shift key as you delete the link: so, if this control is checked and you
hold down the Shift key, only the link will be deleted, and vice-versa. You should probably
exercise caution when using this control – it is easy to forget that deleting the link from a link
folder is actually deleting a message somewhere else as well.

Default setting for search folders is 'Delete on exit' When you perform a search, the search
dialog has an option that deletes the search results when you exit from the program. By de-
fault, that option is unchecked, meaning that your search results will persist from session to
session, until you manually delete them. If you would prefer the default setting to be reversed,
check this control. Note that this only affects the default setting of the control in the search
dialog – you can always uncheck it for searches you want to keep, and it has no effect on any
searches that already exist on your system.

Message reader
The options in this page control the way Pegasus Mail’s message reader behaves.

Show quoted text in It is a common Internet convention to include the text of the message to
which you are replying into the reply. When you do this, it is also usual to mark the text using
the character > to differentiate it from your own text. Pegasus Mail’s message reader can dis-
play such quoted text in a different colour, and optionally using an Italic typeface. You can
select the colour and whether or not you want Italics using these controls.

Right margin for wrapping and reformatting This setting controls the column at which
Pegasus Mail should begin wrapping or reformatting lines in mail messages when either the
Wrap long lines or Reformat long lines display mode is selected (either from the Reader
menu, or by pressing <F5> or <Ctrl+F5>).

Always save the last window size used Pegasus Mail normally uses a default size for the mes-
sage reader window; this default size can be changed by the user via the Save Window Size
option on the Reader menu. If you would prefer that Pegasus Mail always save the last win-
dow size you used, check this control.

Where a choice exists, display the fancy version Many messages containing rich text data
also contain a plain text version of the same information. If this control is checked, Pegasus
Mail will display the formatted version automatically in such cases. If the control is un-
checked, Pegasus Mail will display the plain text version automatically, instead. If the mes-
 sage contains only a fancy version, Pegasus Mail will always display that version, regardless
of the setting of this control.

Turn off attachment preview by default in the attachment view Normally, when you use the
attachments page of the message reader, Pegasus Mail will try to offer a preview of the data
in each attachment as you click it. This behaviour can be turned off by clicking the No pre-
view button in the attachment view, or if you would prefer the behaviour to be suppressed by
default, by checking this button. Note that this control only alters the initial state of attach-
ment preview - you can still turn it on on a message-by-message basis by clicking the Preview
button in the attachment view.
Use alternate font for printing messages  Usually when you print a message, Pegasus Mail uses the font and size settings defined in the message reader window for the printed output – this is called **WYSIWYG output** (an acronym for *What You See Is What You Get*). Sometimes, though, a particular font combination that works well on the screen may not work well on your printer. In such a situation, you can click this button to set an alternate font style and size that Pegasus Mail should use when printing. Setting an alternate font for printing may make printing operations take longer.

When the current message is moved or deleted  This control determines what action Pegasus Mail should take when you move or delete the message you are reading. You can have Pegasus Mail load the next message in the folder from which the current message was opened, or open the message before the current message, or if you prefer, simply close the window and return to the folder.

Display remote-linked graphics in messages  An increasing number of mail messages arriving in your mailbox are likely to be HTML messages containing graphics. In a perfect world, all these messages would be what is known as MHTML messages – messages using specially constructed HTML data that allows any graphics referenced in the message to be contained in the message as attachments as well. Unfortunately, laziness and ignorance on the part of many sites generating these messages means that a significant number of them will not be formatted correctly, but will contain **remote graphic links** - that is, links that will require your mail program to establish a connection to a remote site to retrieve the graphics they represent.

Remote-linked graphics are a really bad thing, for two key reasons: the first is that they mean the message can only be viewed correctly when you are online: if you want to view the message while you're away from an Internet link, you typically will not be able to see it in its correct form. By contrast, properly-packaged MHTML messages are always viewable and require no further connection or waste of bandwidth to retrieve their graphics.

Much more seriously, though, remote-linked graphics present an insidious and extremely dangerous opportunity for unscrupulous senders to invade your privacy: by giving the remote link a few simple characteristics, it is possible for the sender to gain a considerable amount of information about anyone who downloads the graphics as they read the message. The information that can be derived includes: the fact that you have read the message; the time and date you read the message; how often you read it; whether you forwarded it to someone else; your computer's IP address; your geographical location (certainly your city location, but potentially down to the street level). Over time, this information can be tracked to build a profile of your online behaviour and the type of mail you read. And just in case you didn't get it the first time, all this information can be derived simply because when you read the message, your mail program retrieved the remote-linked graphics it contained.

Here at Pegasus Mail, we think remote-linked graphics in e-mail are a serious and much under-rated security threat: for this reason, Pegasus Mail will *never* automatically download any remote-linked graphics in an e-mail message unless you have specifically told it to do so. We accept that there are some occasions where you know the sender of the message and can be fairly sure of that person's integrity, or where you have decided that the risks are acceptable; in such cases, Pegasus Mail allows you to right-click the message and choose **Show pictures**, at which point it will go away and retrieve any remote-linked graphics it contains (note that graphics in proper MHTML messages are always displayed correctly and automatically, and entail no privacy risks). You can also indicate that certain senders are always to be trusted, and that Pegasus Mail can automatically download remote-linked graphics in mail from those senders if it senses that you are online.
To indicate that a particular sender's remote-linked graphics should be downloaded automatically, click the Exceptions button in the Display remote-linked graphics... control group on this page and add the address of the sender in the dialog that opens. From the time you do this, Pegasus Mail will automatically behave as if you have right-clicked the message and chosen Show pictures every time it displays messages from that sender.

You can also add addresses to your exception list by right-clicking a message from a sender from whom you are willing to accept remote-linked graphics, then choosing Allow remote graphics list from the Add sender address to... submenu.

Automatically if a connection exists Rather against our better judgment, we have allowed ourselves to be persuaded to add a setting that tells Pegasus Mail it should always attempt to display remote-linked graphics in any message, if it detects that an Internet connection exists. We recommend in the strongest terms that you think very hard before enabling this option - we are not being completely paranoid about this, you really *do* expose yourself to severe invasion of privacy by doing so. You have been warned.

Content viewers
When you receive a message which has attachments, WinPMail can run a program to display or edit the attachments if it can determine that a suitable candidate is available, which it does by comparing the extension of the attachment’s filename and its file type information against a list of programs you can define using this option. To define an attachment viewer, click the Add button, or double-click on an existing definition to edit it.

In the Selection criteria box, choose whether you want this viewer to be selected based on the extension of the attachment’s filename, or on its file type information. If using file type information, WinPMail will offer you its list of standard predefined file types, but you can enter any text you wish (in case you receive mail from other applications which use different file type values). When matching against what you have entered, WinPMail ignores the case of the text, but otherwise requires an exact match. You can match specific MIMEtypes in this field by entering the primary and secondary types separated by a '/' character – so, if you wanted to define a viewer that would trigger when you received a MIME-encoded JPG graphic, you would enter image/jpeg in this field.

In the Command to execute box, you should enter the path to the program you want to execute to view matching attachments; click the Browse button to select from a list. When you click the View control in the attachment dialog, WinPMail will create a temporary file containing the attachment’s data on your disk; if the program you are running only accepts files with certain extensions, you should enter the extension the program is expecting in the Extension to use for temporary file field and WinPMail will form a correct temporary filename using this extension. If you leave this field blank, WinPMail will use whatever extension the file already has. Example, On unix systems, JPEG graphic files usually have the extension .JPEG, but under DOS and Windows the extension is often found as .JPG – to view unix-origin JPEG files on your Windows system, you would match the extension .JPG, and tell WinPMail to use the extension .JPG for the temporary file it creates.

Blue entries You may see a number of entries in the content viewer list displayed in blue text – you cannot delete or alter these entries: they are system-wide entries installed by your system manager and applied automatically to all Pegasus Mail users on the system. You can override any entry in the system-wide list by creating your own version of it – a definition you create always takes precedence over those installed by the system manager. Be careful if you choose to override these settings though – they are usually there to protect you from mail-borne viruses and other nasties.
Configuration files affecting content viewers

Two system-level files can be used to customize aspects of the way Pegasus Mail handles file viewing.

*FILETYPE.PM*  
Pegasus Mail uses this file to work out what attachment type it should associate with a given file. It is used when *Mailer decides* is chosen as the attachment type in the *Attachments* view of the Message editor. Having a well-stocked *FILETYPE.PM* file means that your messages are more likely to be sent with the information necessary to allow other programs to associate file viewers with them.

*MIME-MAP.PM*  
Pegasus Mail uses this file to translate custom MIME content types into attachment types. New MIME content types are being added all the time, and using this file allows Pegasus Mail both to generate them in outgoing mail and to recognize them in incoming mail. For example, say someone sends you a MIME message with the content type `Application/MyWordProcessor`, and you have an entry that says that `Application/MyWordProcessor` is the same as "MS-Word", then Pegasus Mail will be able to work out that it can run MS-Word to view the document.

Well-documented sample versions of these files can be found in the directory where you installed Pegasus Mail. They are inherently quite technical and should only be customized by experienced users.

Hyperlinks

This page controls the way Pegasus Mail should interact with your Web browser when viewing HTML files and when you double-click on a URL in the message reader.

*Enable display of clickable links (URLS) in reader*  
If this control is checked, Pegasus Mail will highlight any valid URLs it can find in your mail messages as you read them. Double-clicking such a link tells Pegasus Mail to start your web browser with that URL.

*Highlight a maximum of xx hyperlinks in any one window*  
The process of locating and marking hyperlinks can be quite slow, especially for large messages: this control lets you limit the number of hyperlinks Pegasus Mail should find in any one window, which may result in some larger messages opening more quickly.

*Hyperlink display colour*  
Click the coloured button to set the colour Pegasus Mail should use when displaying hyperlinks. Depending on the browser you use, you may prefer either green or blue links, but you can set any colour you wish.

*Find browser automatically*  
When this control is checked, Pegasus Mail will use the Windows *URL.DLL* module to launch your browser. This method will work reliably if you have installed Microsoft Internet Explorer or Netscape Navigator v3.0 or later.

*Use URLPROXY.EXE*  
When this control is checked, Pegasus Mail invokes a small, smart program called URLPROXY, written by John Navas, which finds and starts your preferred Web browser. URLPROXY works around a number of problems in older versions of the Netscape browser, most particularly problems regarding their behaviour when they are already running. Generally, on modern systems, this control should not usually be checked, but if you are using a version of Netscape earlier than v6, you may need to enable it.

*Web browser commandline*  
You can enter here the name of a specific browser program Pegasus Mail should run instead of finding one automatically. Note that many browsers be-
have inconsistently when run from the commandline and that using this option may not pro-
 vide the results you expect.

**Use the non-standard URLs expected by MS Internet Explorer** Microsoft Internet Explorer
 uses a strange, illegal URL format that does not comply with the Internet Standards for spec-
 ifying local files. If you are using Microsoft Internet Explorer as your web browser, you must
 check this control or else you may be unable to open hyperlinks starting with “FILE:”.

**Check for suspicious “phishing” URLs in HTML messages** In the last few years, an insidious
 practice called “phishing” has risen in prominence on the Internet; phishing involves sending
 a message purporting to be from your bank or another institution that asks you to reveal your
 credit card or bank account details. Some phishing e-mails can looks particularly authentic,
 and the practice is quite deceptive. The thing that makes phishing attacks so dangerous is the
 fact that an HTML Internet hyperlink can say one thing (such as “Standard bank login page”,
 but can actually direct you somewhere else entirely (for instance “http://we.stealmon-
ey.com”). Pegasus Mail incorporates a number of checks that can protect you against Phish-
ing attacks: these checks are turned on by default, but if you don't want them, you can turn
 them off using the Check for suspicious 'phishing' URLs in HTML messages option in this
 preferences page. We strongly recommend that you leave this option enabled, and that you
 always exercise enormous caution any time you receive mail asking you to reveal personal
details.

**Default system mail program** Clicking this button tells Pegasus Mail to make some changes
 to the Windows Registry (a special database maintained by Windows itself) which will allow
 your copy of Internet Explorer and other applications to use Pegasus Mail as a mail program
 when you click on a mailto: link in a web page you are browsing.

**User interface**

This final set of pages allows you to alter the behaviour of various controls used by Pegasus
 Mail, to adjust the level of reporting and new mail checking it does, and to handle special au-
tomatic editing features in the various editing windows in the program.

**List Displays**

The items in this dialog allow you to customize the way Pegasus Mail presents many of its
 primary lists of items to you.

You can turn on **Banding**, or the display of alternate pairs of lines in the lists in different col-
 ours, in the following lists in the program:

- The list of folders in the Folder Manager window
- Within lists of messages in a folder, in either preview or classic modes
- The list of addressbook entries in the Addressbook Manager window

Banding is a visual aid that usually makes it slightly easier to scan a list of items by giving
 your eye a visual reference point. The default colours in the dialog are designed to work well
 with the standard colour palettes in Windows 98, 2000 and XP, but you can change them if
 you wish. You should be aware that the colours will typically need to be very pale - far paler
 than you might expect. Quite subtle differences in colour are all that are required to allow ef-
f ective banding.

To enable banding in a list, click the checkbox associated with that list. To select a banding
 colour, click the button at the right of the checkbox, which will be displaying the colour cur-
 rently selected for that list.
Why does banding operate on pairs of lines?  Other applications commonly implement banding on alternate lines, but when we tried this in Pegasus Mail, we felt the effect was rather “busy”.  Pegasus Mail attempts to compress as much information into the vertical space of its lists as it can, where other applications are often quite expansive in the amount of wasted vertical space they have between list items.  Alternate line banding looks quite good when there is a lot of unused vertical space, but when the data items are packed more closely together, as in Pegasus Mail, the effect is quite hard on the eyes.

Toolbars
The Button Panel preferences option allows you to control the way Pegasus Mail should present its button panel to you.  By default, the button panel will appear as a toolbar, placed directly below the main menu.  If you prefer a small floating window with fewer buttons, you can select either a vertical or horizontal configuration using this option.  When the button panel is set to be a floating window, Pegasus Mail will remember its position and whether or not it is open from session to session.  The options in this page allow you to control whether or not the buttons on the Pegasus Mail toolbars should display tooltips, and to select from a set of alternative toolbar layouts.  You can also design your own toolbar layouts with a little more work – please refer to the file BPANEL.TXT in the RESOURCE subdirectory of the location where you installed Pegasus Mail for detailed instructions on customizing the toolbar.

Reporting/Logging
Pegasus Mail offers a number of ways of reporting that new mail has arrived, and also has a powerful System Messages window where information is reported on an ongoing basis.  This page is used to control these features.

New mail reporting
These settings control how Pegasus Mail lets you know that new mail has arrived.

Notify of new mail using a floating “Tell tale” window  When this option is checked and new mail arrives, Pegasus Mail will open a small window (called a Tell tale window) above all other windows on your desktop.  In this window, it will show the number of new messages that have arrived in all available sources, including your new mail folder, the new mail folder on any IMAP server you have connected to, your POP3 server, and the new mail folders of any mailboxes you have mounted using the folder manager’s Add mailbox to list command.  The tell tale window will disappear as soon as it has no new mail to report.

Place an icon in the Windows system tray  When these options are enabled, Pegasus Mail will place an icon in the Windows system tray.  If the Animate the icon option is checked, then the icon’s wings will flap any time there is new mail waiting for you (we think this effect is rather neat).

Play a new mail alert sound  If your system has a sound card, you can have WinPMail play any suitable sound (in the Windows .WAV file format) when it detects that new mail has arrived.  Click the Select sound and Test buttons to choose and verify your new mail alert sound.  By default, alert sounds will play any time new mail arrives: if you would prefer that WinPMail only play the alert sound for new mail when it is minimized on your desktop, click the control labelled Only play the sound when WinPMail is minimized.

System messages and logging
These settings control the behaviour of the System messages window, and whether or not Pegasus Mail should create a log file of the mail you send.
Preferences - customizing the way Pegasus Mail operates

User interface

System message reporting level   This option controls the type of information that will be displayed in the Pegasus Mail System Messages window (found in the Window menu). The higher the reporting level, the more information will be reported in the window. In general terms, the default value (3: Normal) is correct for most users, and will result in useful information being reported in the window without too much clutter.

Show system messages window after applying filtering rules   Any time filtering rules are applied to a folder, the results of the operation are reported in the System Messages window. If this control is checked, then the system messages window will be opened automatically every time you use filtering rules so you can see the results.

Keep a log of messages sent (in SYSLOG.PM file)   When this control is checked, Pegasus Mail will create a log file called SYSLOG.PM in your home mailbox directory and will store information about every mail message you send there. This provides an audit trail you can examine at a later stage, or which can be used for generating statistics. The file is in tab-delimited format and is designed to be read into database or spreadsheet programs.

Automatic formatting

Pegasus Mail can perform a number of formatting operations on your text as you type it into the message editor. The settings controlling those operations are found in this page. Automatic formatting works correctly for both plain text and styled (HTML) mail.

Automatic formatting features

Turning these features on allows Pegasus Mail to apply certain types of formatting to the text you enter automatically; this can significantly reduce the time it takes to do some types of editing operation.

Pressing <Tab> at the start of a line indents the paragraph   When this option is turned on, each time you press <Tab> at the start of a line, the whole paragraph you type in will be indented one tab stop to the right.

Create a bullet item when <*><Tab> is typed at the start of a line   When this option is checked, Pegasus Mail will automatically create a bullet list entry when you type an asterisk (*) followed by a tab at the start of a line. This option only creates a single bullet item, not a bulleted list. You can also turn on bullets using the button on the editor toolbar, but many people find this approach faster and easier.

Create hanging indents on a <Tab> near the start of a line   When this option is checked and you press the <Tab> key within five characters from the start of a line, Pegasus Mail will automatically format the paragraph with a hanging indent. This is useful for creating numbered lists - just type in the number, then press <Tab> and Pegasus Mail will automatically format that paragraph for you. As with bullet items, this option only applies to a single paragraph - Pegasus Mail does not support automatic numbering of paragraphs.

Autoreplacement

Do you find that your fingers sometimes seem to have crossed connections to your brain? Do you find that you perpetually type in "taht" when you mean "that", or "teh" when you mean "the"? If so, Pegasus Mail can help you by automatically correcting these glitches as you type them.

Enable autoreplacement of common typos and abbreviations   Check this control to turn on Pegasus Mail's autoreplacement feature. When the feature is turned on, Pegasus Mail will
check each word you type against the autoreplacement list and will make any changes re-
quired automatically.

**Autoreplacement list** The list displays the autoreplacements you have defined, showing what you expect to type on the left-hand side, and what Pegasus Mail should replace it with on the right. So, if you want Pegasus Mail to correct "teh" to "the", you would click the "Add" but-
ton, and type the two words into the autoreplacement definition dialog that opens.

You can create as many autoreplacements as you wish: Pegasus Mail ships with a list of about five hundred of the most common typographic slips - you can use this list if you wish and you can supplement it with your own favourites.

**Hint – Abbreviations** You can use autoreplacement for more than just correcting errors - you can also use it as a handy way of typing common words and phrases quickly. To do this, simply create an entry where the "when this is typed" item is an abbreviation, and the "replace it with this" entry is the full text. We recommend that you prefix your abbreviations with an underscore character ( _ ) so that there's no chance of them being confused with regular automatic corrections. This use of autoreplacement is very similar to another Pegasus Mail feature, the glossary (see chapter 4), but is better-suited to short, common words and phrases.

**Example:** if you regularly type "Pegasus Mail", you might create an autoreplacement entry called "_pm" that expands to "Pegasus Mail" whenever you type it.

Note: an autoreplacement can only be a single word - Pegasus Mail cannot autoreplace phras-
es, although it can replace a word with a phrase.

**Autoreplacement and multiple languages** If you install a foreign language module for Pegasus Mail, that language will have its own autoreplacement list, separate from the lists for other languages. If you use Pegasus Mail multilingually, or if you start using a new language having previously used another, you may find that some common autoreplacements that you have previously used don't appear in the new language's autoreplacement list. You can import any autoreplacement list by clicking the Import button and selecting the file you want to im-
port. Autoreplacement filenames have the form AUTORPLC.xx, where "xx" is either "PM" for the English version of Pegasus Mail, or the two-letter language code for other languages (for example, "FR" for French, "DE" for German, or "IT" for Italian). Autoreplacement lists are usually located in your home mailbox directory. Importing an autoreplacement file perma-
nently adds all the items in the file you import to your current list.

### NetWare MHS/SMF settings

If your site is using Pegasus Mail to work with Novell NetWare MHS or another MHS-com-
patible system such as Connect^2 by Infinite Technologies, then this preferences page will be available in the list – you can use it to configure the way Pegasus Mail interacts with MHS for you.

**Note:** MHS is now a completely dead technology: Novell have not supported it for a number of years, and Pegasus Mail retains its support for MHS only for the benefit of a small number of clients who are reluctant to leave the system. It is likely that Pegasus Mail’s support for MHS will be removed at some time in the future, so if you are depending on MHS support, we suggest you begin planning a migration strategy.

**My NetWare MHS username** By default, Pegasus Mail assumes that your MHS username is the same as the first eight characters of your NetWare username (the name you use when logging into the file server). It is possible, however, for your MHS username to be different
from your NetWare name: if this is the case, then you should enter the name by which MHS knows you in this field. If you are using an SMF-71 transport such as NetWare Global MHS, you can enter a full SMF Long address form here, including a domain.

**Mailbox name**  NetWare MHS creates a mailbox for every MHS user in which new mail and attachments are placed. Usually, the name of this directory will be the first eight characters of your username, but it can be different. If Pegasus Mail warns you when it starts that it cannot find your NetWare MHS mailbox, enter the correct name for the mailbox here.

**New mail folder**  MHS knows about users and applications: a user may use more than one MHS application on the same server, but normally has one which is *preferred* — that is, to which MHS will deliver if no other mailer is specified. When a mailer is installed into MHS, it is given a name, which is usually the same as the name the developer has registered with Novell. Normally, your MHS administrator will install Pegasus Mail under the MHS application name PMAIL, but if he has not done so, you will have to enter the name he has used in this field. Another case where this field may be useful is if you have previously been using another MHS mail system at your site, and your administrator doesn’t want to reinstall all existing users with Pegasus Mail as preferred mailer. In this case, you will enter the application name for the mailer you previously used in this field. Pegasus Mail uses the name in this field to determine where it should look for new incoming mail. If you enter a different application’s name in this field, then Pegasus Mail will pretend to be that application when checking for new mail.

**Check the ’MHS’ new mail folder?**  When MHS creates a user, it normally creates a default preferred mailer for that user, called MHS. If you set this field to Y, then Pegasus Mail will pretend to be a mailer called “MHS” when checking for new mail, as well as being whatever mailer you have specified in the “application ID” field. Depending on your system and system administrator, you may have to check this item. Checking it will never cause any harm, except it may slow down checks for new mail slightly.

MHS is rather more complex to use than Pegasus Mail’s own delivery agent, and requires rather more management. If you are unsure of any of the values in this Preferences option, leave the default values as they are and consult your MHS system administrator for assistance.
12: Using Pegasus Mail on the Internet

Pegasus Mail is often used on networked systems but can also be used to send and receive mail on PCs attached directly to TCP/IP networks, such as the Internet. When used in the TCP/IP environment, Pegasus Mail uses the Internet POP3 (Post Office Protocol v3) protocol to receive mail, and the SMTP (Simple Mail Transfer Protocol) protocol to send mail. In order to handle mail this way, your PC must be equipped with a TCP/IP package which provides services using the Windows Sockets (WINSOCK) interface standard — consult the documentation for your TCP/IP package to determine whether it provides this service. Pegasus Mail’s TCP/IP mail services do not require a connection to a NetWare file server but can still be used if you have one.

What you need to use Pegasus Mail on the Internet

- A properly-installed TCP/IP package which provides a WINSOCK interface for your PC. This is seldom an issue these days, since Windows is supplied as standard with all the necessary TCP/IP networking software Pegasus Mail requires.

- A username and password on a system which will accept mail on your behalf. This system could be a Unix machine, NetWare server running the Mercury MTA, or possibly other systems as well. Check with your system or network manager to find the name of the machine you should use for this.

- The name of a machine which can send mail on your behalf. This machine will usually be the same as the machine which accepts mail on your behalf but need not be. Make sure that you have permission from the system manager of the machine providing this service before you attempt to use it.

When Pegasus Mail starts up, it checks to see if it can find the Windows WSOCK32.DLL file which provides the TCP/IP Interface and if it can, it attempts to load it. If the DLL can be loaded successfully, Pegasus Mail adds six new menu options to your File menu which allow you to access TCP/IP mail services. The first of these, Network configuration, is covered in detail below. If you do not want Pegasus Mail to load WSOCK32.DLL automatically at startup, uncheck the control in the Advanced Settings preferences dialog.

Check host for mail When you select this option, Pegasus Mail will connect to the mail host you have specified and will check to see if it has any new mail for you. If there is new mail, Pegasus Mail will download it from the host to your machine where it will appear in your new mail folder.

Send queued messages Select this option and Pegasus Mail will send any mail you have composed since the last time you chose this option. Unless you have specifically configured Pegasus Mail to do otherwise, mail is not actually sent until you choose this option: when you press the Send button in the message editor, the message is queued to be sent rather than being sent at once.

Selective mail download Preview your mailbox – see later this chapter.

Check and send mail This command both sends and receives mail in the course of a single connection.

Review queued mail When using Pegasus Mail’s internal TCP/IP based mail transport to send mail, messages are placed in a queue when you press the Send button (unless you have
the Send at once control checked in your Network Configuration dialog – see below). Queued mail is stored on your machine until you choose either Send queued messages or Check and send mail, at which time it is written into final form and transmitted. Until the time it is actually sent, queued mail is stored in a special intermediate format which allows the message to be reloaded and altered; choosing Review queued mail shows you a list of all the messages in your current outgoing mail queue and allows you to delete or edit them. Occasionally you may see a message in your queue marked [Final form]; this is a message which has been written into transmission-ready format but which for some reason (usually a connection problem) has not actually been transmitted yet. Final form messages cannot be edited, only read or deleted.

Forwarded mail For technical reasons, if you forward a mail message without editing it, Pegasus Mail has to write the forwarded message directly into final form. The effect of this is that you cannot re-edit a message you forward without changes.

Online and offline modes
You can tell Pegasus Mail to behave as though you are connected to your service provider without ever actually making any connections by selecting Enter offline mode from the File menu. In offline mode, Pegasus Mail behaves as if you are connected, but never loads WSOCK32.DLL. This is useful if you want to compose or read mail on the road, or in an airplane, or anywhere where you cannot connect normally to your service provider. You can start Pegasus Mail in offline mode by adding -O to its commandline, and you can return to normal online operation by selecting Leave offline mode from the File menu. While you are in offline mode, a small broken-connection indicator will appear in the program’s status line. Mail you compose and send while offline can be sent the next time you are online.

Configuring Pegasus Mail for TCP/IP mail
Choose Internet Options from the Tools menu before you first use Pegasus Mail’s TCP/IP mail services, or any time you need to change the settings it should use. Selecting this option opens a dialog requesting the information that is essential to allow Pegasus Mail to send mail on your behalf. The dialog is organized into pages, each dealing with a particular aspect of sending and receiving your mail.

General
Your e-mail address is Enter your e-mail address here. Pegasus Mail will enter this address in the From field of all Internet messages you send with its built-in transport.

Default timeout for network connections The number of seconds for which Pegasus Mail should wait for replies from the remote host before considering that a network problem has occurred and aborting the transaction. This value is used in any POP3 or SMTP definition (see below) that does not have its own timeout value defined - it is a kind of “global default” value. A setting of 30 seconds (which is the default for the field) is usually fine for most networks, but if you have a slow or intermittent connection, you may need to set it to a higher value.

Easy, step by step Internet Mail setup Click the button labelled Start Setup Wizard if you would like to start a Wizard that will prompt you for all the information needed to send and receive mail. This option is strongly recommended if you are new to the Internet.

Create Internet session logs...: Enabling this control tells Pegasus Mail to create a transcript file for every Internet session it conducts with a remote server. The session file will be created in your home mailbox directory and will have a name of the general form TCPxxxx.WPM,
where the “xxxx” will be a series of four digits or letters. Each session file contains an exact transcript of all the data exchanged by Pegasus Mail and the remote server, as well as descriptions of any low-level networking errors encountered during the process. Internet session logs are an invaluable diagnostic tool when trying to work out why a particular problem is occurring, but because they can consume disk space at an alarming rate and typically slow down the transactions between Pegasus Mail and the server somewhat, you will normally only turn them on when tracking a specific problem.

**Receiving (POP3) Mail**

When you select this page, you will be presented with a list of **POP3 definitions** that are currently active. Each of these definitions contains all the settings Pegasus Mail needs to access a single mailbox at your ISP or on another remote server. If you have several e-mail addresses or mailboxes you need to monitor, you can create as many separate definitions as you need to manage them all. Definitions can be enabled or disabled at the click of a single button, so if you have some POP3 mailboxes you only want to access at certain times, you can leave them in the list in a disabled state until you need them, at which time you can enable them.

**POP3 definitions and multiple identities:** Pegasus Mail supports the idea of multiple identities, where an “identity” is simply a different set of preference settings that you can switch to at any time (see chapter 14 for more on Identities). Each identity within Pegasus Mail can have a different set of active POP3 definitions - this allows you to switch, for example, between office and on-road environments very easily. It also means that you may actually have more POP3 definitions than appear in the list in this window, because some of them may not be meaningful in the context of certain identities. For this reason, when you click the “Add” button to create a new POP3 definition in this window, Pegasus Mail will present you with another list that shows all the definitions available in your mailbox. At this point, you can either select a definition that is not currently in your active list, or create a completely new definition if you need it.

**Order of POP3 definitions:** The order in which your POP3 definitions appear in this list is quite important, because Pegasus Mail will poll the mailboxes in the order they appear in the list. If some of your definitions access very slow servers, you may want to consider putting them at the end of the list of definitions so that they are polled last: this means that mail can be retrieved quickly from faster or closer servers, allowing you to start working with that mail while the slower servers are accessed.

**Removing a definition:** It is very important to understand that when you click the **Remove** button in this dialog, you do not actually delete the definition - you merely remove it from your active list (this is why the button is labelled **Remove** instead of **Delete**). The definition will remain available in your master definition list and can be added back at any time by clicking the **Add** button. If you want to delete a definition permanently so that it no longer even appears in your master definition list, first remove it from the list by clicking **Remove**, then click the **Add** button, select the definition in the master list, click **Delete** to delete it permanently, then click **Cancel** to back out of the master list without selecting anything. A definition can only be deleted permanently if it is not in use in any of your identities.

**Polling controls:**

The controls in this group determine how frequently Pegasus Mail should pass through your list of active definitions checking them for new mail.

**Check for new new POP3 mail every x seconds idle** Controls periodic checking on the host for new mail. If you enter a positive value here, Pegasus Mail will check the host after that many seconds have elapsed during which you have not pressed a key or clicked the mouse.
Enter 0 to disable periodic checking altogether. If the *Idle* control is checked, Pegasus Mail will only check when you have not clicked the mouse or pressed a key for the period shown - this is typically only useful on slower systems and the control can almost always be left unchecked these days.

*Check whenever the new mail folder is opened* When this box is checked, Pegasus Mail will automatically make a pass through your list of active definitions checking them for new mail every time you take an action which opens the new mail folder — for example, clicking in the *New Mail* icon on the toolbar, or choosing *Read new mail* from the *File* menu. When it is unchecked, Pegasus Mail will only check for new mail on the host when you explicitly tell it to do so by selecting *Check host for new mail* from the *File* menu or by clicking the *Check your POP3 host* globe button on the toolbar. If you are running on a slower link (for instance, a SLIP link), you will usually uncheck this box.

**Multiple identity controls**

As discussed above, Pegasus Mail supports the idea of *Multiple Identities* (see chapter 14): because it is possible to use multiple identities for reasons other than simply separating your POP3 mailboxes - for instance, to distinguish between different roles in an organization (you might have one identity with settings suitable for a webmaster and another with settings suitable for your normal role) - Pegasus Mail allows you to create a kind of “linkage” between your identities so that active POP3 definitions in other identities can be polled at the same time as the active list in your current identity. The two controls at the bottom of the *Receiving* (POP3) page are used to control this. If you check the control labelled *When checking for mail, perform checks for all identities*, whenever you initiate a new mail check, Pegasus Mail will test every definition that is active in any identity you have set up, with the exception of those identities where you have checked the *Don’t check this identity when checking multiple identities* control. Setting up different combinations of these two controls in your identities allows you to arrange the way your mail is checked in different ways.

*Note:* These multiple identity controls are basically an artefact of earlier versions of Pegasus Mail where only one POP3 mailbox could be defined per identity: in those versions, these controls provided the primary means of checking multiple POP3 mailboxes. More recent versions of Pegasus Mail allow you to have multiple active definitions in each identity, so these controls are no longer as necessary as they once were, but they have been retained for the benefit of users upgrading from earlier versions. The practical benefit offered by these controls is now quite specialized and you will normally not use them.

**Editing a POP3 definition**

To adjust the settings in any of your POP3 definitions, select it in the list and click the *Edit* button. Note that changes made to a POP3 definition are global - if the definition is in use in any other of your identities, the changes you make will take effect there as well. When you edit a definition, a dialog containing three pages will open.

**The “General” Page**

*Enter a name for this definition* Whatever you type here is the name Pegasus Mail will display in your active definition list for this definition. You can enter any name you like up to a maximum length of 50 characters.

*Server host name* The name of the host machine to which Pegasus Mail should connect in order to retrieve your mail. You can enter the name as a numeric IP address (for example, 192.156.225.2), or if your site has a name server, you can enter the machine’s name here (for example, parnassus.pmail.gen.nz).
Username  The username you have been allocated on the remote machine. Enter here the name you would use if you were logging in to the machine, remembering that on some systems the case of the text may be significant.

**Hint:** If you have never logged into the remote machine but know your e-mail address, then you can work out both the host name and your username from that address. Your username is all the text before the ‘@’ symbol, while the machine name is all the text after the ‘@’ symbol. So, if your address is david@parnassus.pmail.gen.nz, then the host name is parnassus.pmail.gen.nz and your username on that host is david.

Password  The secret word which authenticates that you are who you say you are when you attempt to login to the host machine or retrieve mail from it. If you leave this field blank, Pegasus Mail will prompt you to enter it each time you start the program up, but will not store it in your profile. The password is stored encrypted in your preferences file if you enter it here.

Server TCP/IP port  The TCP/IP port on which the POP3 server is listening. In almost all cases this should be 110, and you should only change it on the specific advice of your Service Provider or Network Administrator.

Timeout  The number of seconds for which Pegasus Mail should wait for replies from the remote host before considering that a network problem has occurred and aborting the transaction. If you leave this field set to 0 (zero), Pegasus Mail will use the default value found on the General page of the Internet Options dialog (see above for more information). You will normally only set a value in this field if the server is especially remote or slow and requires a longer value than the default setting.

Count messages when checking but don’t download them  The process of downloading mail from the host can place considerable performance demands on your machine, and while it is in progress, other applications may be affected. Because this can be disruptive, even with long idle values, you may prefer to have Pegasus Mail simply count the number of new messages on the host when it does a periodic check, but not download them until you explicitly tell it to do so by clicking the Retrieve POP3 mail button on the toolbar. The number of new messages is then displayed on the program’s status line, or in the telltale window if the application is minimized. Interruption to other applications is minimized on your machine if you have this option checked.

Delete mail on server once it has been successfully retrieved  If you check this box, Pegasus Mail will delete mail messages on the host after it has successfully downloaded them to your local machine. If you want to leave copies of all messages on the server to read when you next login to it, uncheck the box. If the box is unchecked (so that mail is not deleted), and you have not checked the Download only unread mail control in the Download Controls page (see below) then each time you tell Pegasus Mail to check for new mail, the messages you have already downloaded will be retrieved again, unless you are using the Mercury Mail Transport system on the host: Mercury can be configured to present only the mail you have not read or downloaded each time you login.

Scheduling  This option allows you to force Pegasus Mail to check some hosts less frequently than others: it works in conjunction with the Check for new new POP3 mail every x seconds idle option on the Receiving (POP3) page of the Internet Options dialog (see above). If you enter a time in minutes here, Pegasus Mail will only check this host at most once during that length of time, no matter how many basic POP3 scans it may do in the interim. For example, if you have Check for new new POP3 mail every x seconds idle set to 30 seconds, but enter
a value of thirty minutes here, Pegasus Mail will perform sixty scans (two per minute) through your active list before it will activate this definition. This can be useful when dealing with servers that are less important to you, or that place restrictions on how frequently you can poll them for mail.

The “Security” Page
This page includes options for increasing the security of your mail downloads.

SSL/TLS options These options are covered in their own section at the end of this chapter - please refer to that section for more information.

APOP shared secret APOP is an extension to the POP3 protocol that allows a more secure login to the POP3 server. When using this method of logging in, both you and the server have knowledge of a special phrase, or shared secret. If you are connecting to an APOP-capable server and have been assigned an APOP shared secret, enter it here and Pegasus Mail will use it to login. Note that your APOP shared secret is almost never the same as your normal password – it will be a specially-assigned passphrase specific to your mail account. If you are unsure whether or not you should be using this option, contact your ISP or network administrator.

The “Download Controls” page
This page contains items that allow you to tune the way Pegasus Mail interacts with your mailbox on the remote server.

Download only unread mail The usual way of operating a POP3 mail account is to delete copies of mail on the remote host once they are successfully downloaded; in situations where you may use several machines to access your mail, or if you regularly read your mail on the remote host machine as well, this approach may not suit your work patterns. Checking this control tells WinPMail to try to determine which messages on the remote host you have already read, and download only those you have not read; clearly, this option is only meaningful if the Delete mail from host once successfully retrieved control is not checked. Unfortunately, the POP3 protocol does not provide any automatic way of determining whether or not mail messages have been read or not (although a recent version of the POP3 standard provides a command which helps in this area), so WinPMail has to use a complicated set of rules to determine each message’s status instead. Working with this control checked can approximately double the time it takes to download new mail from the remote host, or longer if you have excessively large numbers of messages there. If your remote host’s POP3 server complies with Internet standards document RFC1725 or later revisions, then the process of determining unread mail adds very little perceptible delay to the process – your service provider will be able to tell you if your POP3 server is compliant.

In order to implement this command, WinPMail will create a file called MEMORY.PM in your home mailbox, which it uses to “remember” the messages it has already seen in your remote mailbox. A limitation of the feature is that each PC you use will have a different MEMORY.PM file, and hence each PC you use will see every message at least once. Copying MEMORY.PM between your systems will give you a consistent view of the messages you have read on the host.

During any connection, download at most x messages When set to a non-zero value, this option tells Pegasus Mail that it should only attempt to retrieve at most the number of messages you specify. Why would you want to do this? There are two primary reasons. Firstly, if the mailbox is a technical support or helpdesk mailbox, you may want to have several people accessing it, each downloading only one message at a time: doing things this way rotates the load of maintaining the mailbox more evenly, and automatically covers the situation
where one person is away at any given time. The second scenario occurs if you have to access your mailbox over an unreliable connection (one that fails a lot). It is standard behaviour in the POP3 protocol for a mailbox to be reset to its initial state whenever an abnormal connection termination occurs: when this happens, the next time you access the mailbox, all the messages you previously downloaded or deleted will have reappeared and will be downloaded again. Downloading only a few messages at a time reduces the likelihood of having to retrieve your entire mailbox again after a connection failure.

Do not download any message larger than... If you are using a slow connection to your mail host, then you may want to leave mail larger than a certain size unread on the server to save time when downloading. If this is the case, enter the largest message size you will accept in this field, in kilobytes. If you do not want any limit on the size of mail Pegasus Mail will retrieve, set this value to ‘0’. When Pegasus Mail leaves a message on the server as a result of this setting, it writes a message indicating that into the System Messages window (on the Window menu).

Server-side mail filtering

Normally, Pegasus Mail applies its General-purpose filtering rules after you have downloaded your POP3 mail into your local mailbox. On occasions, though, this may be unhelpful or too late - for example:

- If you share a mailbox with other people (for instance, a so-called domain mailbox) then you don't really want to download their mail as well as your own - you would sooner only retrieve your own mail and leave theirs on the server for them to download at their leisure.

- A secretary, for instance, may want to download only messages from particular clients from her employer's mailbox while he is away.

- If you have a very slow connection, you may want to retrieve only mail marked as urgent, or from particular people, leaving the remainder until another time when you are better able to deal with it.

In all these cases, it would be better if you could apply filtering rules to the mail as it resides on the mail server, before you download it, using those rules to choose which messages should be downloaded and which should not. Pegasus Mail allows you to do this.

Filtering rule set This control selects the set of filtering rules that Pegasus Mail should apply to messages in the mailbox prior to downloading them. Filtering rule sets for use in server-side filtering are a special type of filtering rule set that must be created using the Create/Edit POP3 rule set option on the Mail filtering rules submenu of the Pegasus Mail Tools menu. You must create your POP3 rule set before you can select it in this control. You can also use the same rule set in as many POP3 definitions as you wish. To select a POP3 server-side filtering rule set to use for this definition, click the Select button and choose it from the list of available sets. If you have set a server-side filtering rule set but no longer wish to use it, click the Clear button - this will remove the set from the definition, but will not delete it.

Lines to retrieve from each message's body for filtering Pegasus Mail performs its server-side POP3 filtering by retrieving the headers of each mail message and applying the rule set you have selected to those headers. It is possible to download a certain number of lines from the message body as well as the headers - this can increase the effectiveness of the filtering rule set (clearly the filtering rule set cannot work on the entire message, since that would be the same as retrieving it: the value of server-side filtering is its ability to work on a portion of the message only, since this is a fast operation). If you want Pegasus Mail to retrieve some
Configuring Pegasus Mail for TCP/IP mail

lines from the message body of each message when filtering, enter that number of lines here. Note that if your filtering rule set only works on message headers, then there is no point in entering a non-zero value here.

**Default action for messages still present after filtering** When Pegasus Mail applies a server-side POP3 filtering rule set to a message, there are three possible actions that can occur at the end of the process:

1: The message may be deleted on the server
2: The message may be downloaded from the server
3: The message may be explicitly left on the server - neither downloaded nor deleted.

Pegasus Mail needs to know which of these actions it should apply in the absence of an explicit command - that is, when a message passes through a server-side filtering rule set without triggering any rules at all. Select the default option you want Pegasus Mail to assume for such messages from the three provided here.

**Sending (SMTP) mail**
The options in this page control Pegasus Mail’s behaviour when sending mail using the built-in SMTP client. SMTP (which is an acronym standing for “Simple Mail Transfer Protocol”) is the standard mechanism used to exchange e-mail on the Internet. Simple and robust, it has carried hundreds of billions of mail messages for over thirty years and appears unlikely to be replaced at any time in the near future.

As with POP3, you create SMTP definitions that encapsulate all the settings Pegasus Mail needs to be able to transmit mail using the SMTP protocol. Where it is very likely that you may have a need for multiple POP3 definitions, however, you will less frequently need multiple SMTP definitions, for a variety of reasons. In normal cases, only a single definition will be enabled for any single Pegasus Mail identity.

**Settings controlling the way mail is sent**
These options control the general behaviour of Pegasus Mail when sending mail to the Internet, and are not specific to any particular SMTP server you might use. As a result, they are edited directly in the Sending (SMTP) page of the Internet options dialog, rather than as part of the process of editing any specific SMTP definition.

**Send mail at once without placing in queue** Normally, Pegasus Mail stores mail messages you send on your local hard disk until you explicitly select Send all queued mail from the File menu. If you would prefer Pegasus Mail to send messages immediately you press the Send button in the message editor, check this box.

**Use in preference to LAN mailer for Internet mail** This option only applies when you are connected to a NetWare file server which is running either Pegasus Mail’s companion mail server, Mercury, to provide Internet mail services. Usually, when you send Internet mail, Pegasus Mail will default to using the services provided by Mercury if they are available, but if you prefer it to use its built-in SMTP client instead, check this box.

**Use for all outgoing mail, regardless of address** If you check this control, then Pegasus Mail will only use the built-in mail routines to send mail, even if the address appears to be local. If you are the only person using Pegasus Mail on your PC, you should probably check this field.
Using Pegasus Mail on the Internet
Configuring Pegasus Mail for TCP/IP mail

Send any mail in the queue during idle checks If this control is checked, Pegasus Mail will send any mail you have queued for delivery any time it checks your POP3 mailbox. If the control is unchecked, Pegasus Mail will only send queued mail when you explicitly choose Send all queued mail from the File menu, or click the Send all queued mail toolbar button.

Send mail before retrieving mail via POP3 If this control is checked and you click the Both get and send mail button on the toolbar, Pegasus Mail will send messages using the SMTP protocol before retrieving mail from your mailbox using the POP3 protocol. On some systems, this may allow you to see delivery failure notifications on the mail you have sent more quickly. Note, though, that some mail systems may require you to perform a POP3 mail check before they will allow you to send mail via SMTP.

Editing an SMTP definition.

To adjust the settings in any of your SMTP definitions, select it in the list and click the Edit button. Note that changes made to an SMTP definition are global - if the definition is in use in any other of your identities, the changes you make will take effect there as well. When you edit a definition, a dialog containing two pages will open.

The “General” page

Enter a name for this definition Whatever you type here is the name Pegasus Mail will display in your active definition list for this definition. You can enter any name you like up to a maximum length of 50 characters.

Server host name The address or name of the machine which Pegasus Mail should contact to deliver mail on its behalf. In almost all cases, this can be the same address as your POP3 mail server host (see above), but if you are unsure, contact your system manager for instructions.

Server TCP/IP port Controls the port which Pegasus Mail will attempt to “plug into” on the SMTP host when sending mail. This should almost always be 25, and should only be changed by experienced users or on the instructions of your ISP or network administrator.

Timeout The number of seconds for which Pegasus Mail should wait for replies from the remote host before considering that a network problem has occurred and aborting the transaction. If you leave this field set to 0 (zero), Pegasus Mail will use the default value found on the General page of the Internet Options dialog (see above for more information). You will normally only set a value in this field if the server is especially remote or slow and requires a longer value than the default setting.

Use an alternate e-mail address for the SMTP envelope This is one of the most technical options in the entire Pegasus Mail program, and is difficult to explain. When Pegasus Mail sends a message for you, it actually sends two sections – the message itself, and another part called the envelope, which is used by the various mail systems that handle your message to work out its destination. One of the pieces of information in the envelope is the sender’s e-mail address: the only place you will usually ever see this envelope address is in a special field in the mail message called “Return-path”. If this control is unchecked, Pegasus Mail will write your regular e-mail address, as it appears in the General page of the Internet options dialog (see above), into the envelope. On some occasions, however, you may find that your ISP’s mail server requires an alternative e-mail address (for example, one based on your POP3 username) of your regular e-mail address, in which case you would check this control and enter the alternate e-mail address in the text field provided. You should usually only change the setting of this control on advice from Pegasus Mail technical support or from your Internet Service Provider.
The “Security” Page
This page includes options for increasing the security of your mail downloads.

SSL/TLS options: these options are covered in their own section at the end of this chapter - please refer to that section for more information.

SMTP Authentication
With the increase in “spam”, or unsolicited commercial e-mail on the Internet, many Internet Service Providers have toughened up the rules they use to determine whether or not you can use their systems to send e-mail: the process of proving that you are entitled to send mail via a particular ISP’s systems is known as Authentication, and Pegasus Mail supports all the most common ways of authenticating yourself:

Do a prior POP3 login to authenticate before sending mail  Checking this option tells Pegasus Mail that it needs to login to a POP3 mailbox briefly before attempting to send mail. Some ISPs will track how recently you have accessed your mailbox, and will allow you to send mail via their servers if you have done so within a particular period prior to your attempt: your ISP will tell you whether or not their service requires this type of authentication. Checking this control enables the text field where you can select the POP3 definition Pegasus Mail should use to perform the authentication. When performing a POP3 pre-authentication like this, Pegasus Mail does not actually attempt to download any mail - it simply logs into the server then logs out, a procedure that adds very little time to the entire process of sending mail.

Login to the SMTP server using the following details   If you check this control, you can enter a specific username and password that Pegasus Mail can use to authenticate itself directly to the SMTP server using a process called SMTP AUTH. Pegasus Mail supports the three most common SMTP AUTH mechanisms, which are called CRAM-MD5, LOGIN and PLAIN: the program can automatically detect that these mechanisms are available and will use the most secure variant it can. Your ISP will be able to tell you whether or not his SMTP server requires the use of SMTP AUTH authentication.

Login to the SMTP server using a POP3 username/password   This option also enables SMTP AUTH (see the preceding item), but uses the username and password combination from a POP3 definition to authenticate to the server. If the SMTP server uses the same details you use to login to your POP3 server, this option reduces the number of definitions into which you have to enter your password. Aside from this convenience factor, it is no different from the preceding option.

Dialling
If you are connecting to the Internet using a modem, then you will probably want Pegasus Mail to dialup your service provider automatically, and hangup when it has finished. Unfortunately, Windows offers poor facilities for this, but Pegasus Mail supports most of them. Click the Dialling button in the Network configuration dialog to choose a dialling method.

No explicit dialling support  Dialling is properly the function of the underlying network layer in your Windows operating system, not of Pegasus Mail. At some point, it may happen that Microsoft may actually get this part of their operating system working properly, at which time dialling will be handled by Windows itself. When this is the case, check this control and Pegasus Mail will leave all connection issues to Windows.
Run programs to dial and hang up  This option allows you to specify programs that Pegasus Mail should run before and after it connects to the Internet. If you are running Windows NT, 2000 or XP, you can use the NT RASDIAL program in these fields. Under Windows 95, you can use a rather neat program by Claudio Fahey called RasDial95, which has the same functionality. RasDial95 is included with Pegasus Mail by the author’s permission – you can find it in the RESOURCE directory of the location where you installed the Pegasus Mail executable files. RasDial95 has good documentation explaining its use, and may be used under Windows later versions of Windows as well as under Windows 95.

Use IE4/Win98 dialling functions in WININET.DLL  If you are running Windows 98 or later, or if you have installed Microsoft Internet Explorer v4.x or later, then you can use the dialling functions contained in a system module called WININET.DLL, which is supplied as part of both those systems. This is usually the cleanest way of dialling and hanging up if you have access to it.

Don’t dial, but hangup automatically using HANGUP32  The Microsoft networking software in Windows can usually dial your connection automatically, but mostly cannot hangup correctly. Selecting this option tells Pegasus Mail to install a special Pegasus Mail extension called HANGUP32 written by John Navas: HANGUP32 hangs up the connection after ten seconds have elapsed from the time when Pegasus Mail disconnects.

**NOTE**  When you change from the HANGUP32 option to any other dialling option, you should immediately quit and restart Pegasus Mail as soon as you close the Tools | Options dialog.

SSL/TLS - Secure mail connections

SSL (an acronym standing for "Secure Sockets Layer") is an Internet Standard for creating and managing encrypted connections between a client (a program such as Pegasus Mail) and a server (such as a POP3 server from which Pegasus Mail retrieves your mail messages). By encrypting the data as it passes between the client and the server, the risk of your mail being intercepted or compromised in transit is effectively eliminated. The price for this extra security is slightly slower transfer of mail and slightly increased complexity of setup.

Before you enable SSL support in Pegasus Mail, you need to ask your system administrator or ISP if his server offers support for SSL version 3 encrypted sessions. You also need to ask whether the server supports SSL via direct connection, or via a STARTTLS command (don’t worry too much about what this all actually means - the answer you are given simply determines which button you should check in the Pegasus Mail configuration dialog). If the administrator tells you that his server supports SSL via direct connection, you will also need to ask him what port number should be used to connect to the server when using SSL.

Once you have the necessary information, go to the Security page for the POP3, SMTP or IMAP definition you want to secure in Pegasus Mail. An explanation of the various controls is given below, but as a quick-start guide, you can use these guidelines:

If your ISP or administrator told you that his server supports SSL via direct connection, then check the radio button entitled Via direct SSL connect in this dialog. You will also need to switch to the General page and tell Pegasus Mail to use the port number you were given at the same time.

If your ISP or administrator told you that his server supports SSL via a STARTTLS command, then check the radio button entitled Via STARTTLS (or STLS) command. In this case, you do not have to change the port on the General page.
If your ISP cannot tell you the port number the SSL server is listening on, this table of commonly-used values may help you:

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Port number</th>
</tr>
</thead>
<tbody>
<tr>
<td>POP3 over SSL</td>
<td>995</td>
</tr>
<tr>
<td>SMTP over SSL</td>
<td>465</td>
</tr>
<tr>
<td>IMAP over SSL</td>
<td>993</td>
</tr>
</tbody>
</table>

**What the various controls mean**

*Via direct SSL connect*  
Tells Pegasus Mail that the server expects SSL negotiation to occur as soon as a connection is made between the client and the server. This operating mode is in disfavour amongst the powers-that-be on the Internet, and its use will decline over the next few years, primarily because it requires the use of a special port number for the encrypted version of each protocol that uses it.

*Via STARTTLS (or STLS) command*  
Tells Pegasus Mail to perform a normal connection to the server, but before transferring any data, to ask the server whether it supports SSL connections. If the server indicates that it does support SSL connections, Pegasus Mail will issue a command that tells the server to switch to an encrypted session. This is the preferred and recommended way of handling SSL sessions on the Internet.

*Never*  
Tells Pegasus Mail not to attempt to negotiate an SSL session even if the server appears to support it.

**Server certificate fingerprint tracking**

As well as providing encrypted transfer of data between a client and a server, the SSL protocol includes methods of authenticating that the server and the client are who they say they are via the use of Public Key Certificates. Because such certificates are expensive and difficult to obtain, they are seldom used on the client side of the connection, but the server must always provide a certificate. The server's certificate is currently generally of dubious value in proving the actual identity of the server, but it does have one absolutely invaluable characteristic - its fingerprint. All public key certificates can be uniquely identified by this fingerprint: by comparing the fingerprint of the certificate the server offers you with either a known fingerprint (presumably supplied separately by the system administrator), or the last fingerprint Pegasus Mail saw from the server, it is possible to detect that the certificate has changed.

If the certificate has changed, this may represent an innocent administrative issue (for instance, the old certificate may have expired or been replaced), but it may also indicate a security breach, or the presence of a “middleman” eavesdropping on your messages in transit. In either case, the fact that the certificate has changed acts as a warning to you to contact your ISP or system administrator to check on the integrity of the system.

Checking the control labelled *Enable server certificate fingerprint tracking* tells Pegasus Mail to compare the server's certificate fingerprint with a stored value. You can either paste a value supplied by your ISP into the text field called *Current certificate fingerprint* or, if you leave the text field blank, Pegasus Mail will fill it in with the certificate fingerprint for you the next time you connect to the host. It is slightly more secure to be able to paste a known fingerprint value for the certificate, but this will seldom be available. Allowing Pegasus Mail to fill it in for you still gives you useful security because you are mainly interested in the fact that the certificate has changed, rather than that it is the one you expect to see. The fingerprint Pegasus Mail stores is a 32-character string of numbers and letters called an *MD5 Hash*. Your
ISP or system administrator may ask you for this particular jargon term when supplying you with the proper fingerprint value.

**Suppressing certificate verification**

When Pegasus Mail connects to an SSL-enabled server and negotiates a secure connection with it, the server is required to pass Pegasus Mail a piece of data called a certificate (see above for more details about certificates): the certificate is intended to prove that the server is who it claims to be. Unfortunately, in the course of its development, the SSL mechanism has spawned many offshoots and variations, and this has resulted in a very real unevenness in the way certificates are prepared and represented. Pegasus Mail is normally quite strict about ensuring that the certificate passed to it by the server is in a valid form, but sometimes you're going to run into servers that will offer you invalid certificates: one of the annoying (and really quite worrying) things about the Internet is that many other packages will simply ignore certificate problems and hence will appear to "work" with the server, even though their security has been compromised - the rationale is that ease of use is more important than security, which we feel is a dangerous attitude.

If you encounter an SSL-enabled server to which you cannot connect using Pegasus Mail, the most likely reason is a problem with its certificate. When this happens, you can tell Pegasus Mail not to verify the contents of the certificate it is passed by the server, by checking the control labelled *Disable certificate validation*. In many cases, this will allow you to connect to the server, but it carries considerable risk. We strongly recommend that you do not use this option until you have exhausted all other possibilities. Your first point of contact should be the administrator of the server with the invalid certificate: he is doing neither himself nor his users any favours by installing a broken certificate on his server - even if other programs accept it in its broken form, it is clearly better that the certificate be correct, since this ensures that security is properly-preserved.

When this option is enabled, Pegasus Mail can no longer perform certificate fingerprint tracking (see above for more details), so the security of your connection is considerably reduced. Once again, we recommend that you put pressure on the system administrator to fix the problem rather than to use this workaround.

**Selective download of mail**

Pegasus Mail incorporates a feature that allows you to preview the contents of your POP3 mailbox without actually downloading all of it. Based on the preview, you can select certain messages to be downloaded and/or deleted then complete those actions with a single button press. The aim of the command is to reduce the time you are connected to an absolute minimum – Pegasus Mail disconnects after retrieving the preview allowing you to browse the preview at your leisure. This can be particularly valuable if you need to access your mailbox while you are away from your normal environment, since it can save considerably on toll calls.

In order to provide the preview, Pegasus Mail downloads only the message headers of every message in your mail folder. If you have turned on *Download only unread mail* in your Network configuration, then the selective download will only download a preview of messages you have not already seen. Once the headers have been downloaded, Pegasus Mail opens a preview window listing the Sender, Subject, Date and Size of each message waiting for you. You can examine the complete set of headers for the message by double-clicking it. To indicate that you want to retrieve particular messages, highlight them then click the *Mark for retrieval* button. Similarly, to indicate that particular messages should be deleted, highlight them then click *Mark for deletion*. You can indicate that the selected messages should be retrieved then deleted using the *Mark for both* button. The marking operation does not do any-
thing immediately – it simply tells Pegasus Mail what to do with the message when the Make it so button is pressed. Messages marked for retrieval will show a green tick in the “r” column at the left-hand side of the preview window, while messages marked for deletion will show a red cross in the “d” column.

You can unmark messages you have marked by highlighting them and selecting the same operation again (this is called toggling). You can do this for as long as you wish until you decide you are ready to proceed. At that point, click the Make it so button and Pegasus Mail will re-connect to your mailbox to complete the actions you have requested. Note that if a message is marked for both retrieval and deletion, it will not be deleted unless it is successfully retrieved first.

**MultiPOP**

Earlier versions of Pegasus Mail were shipped with an extension (see chapter 15) called MultiPOP, which allowed you to access any number of POP3 mailboxes from the same copy of Pegasus Mail. Starting with Pegasus Mail v4.1, the functionality of MultiPOP has been formally built into the program, and the MultiPOP extension is no longer included. We strongly recommend that if you have older versions of MultiPOP on your system, you remove them and no longer attempt to use them. At some point in the future, the facilities used by MultiPOP will cease to be supported, and we recommend that you convert your MultiPOP usage to the built-in capabilities instead.
13: IMAP4, accessing remote mailboxes

IMAP4 (an acronym standing for “Internet Mailbox Access Protocol version 4”) is an Internet protocol that allows you to access mailboxes and their associated folders stored on a remote computer. IMAP differs from POP3 in that POP3 only permits you to access your new mail on the remote system, whereas IMAP allows you to manipulate your entire folder structure on the remote system. Pegasus Mail’s support for the IMAP4 protocol has designed to be as transparent as possible – in general, when you access your IMAP folders on a remote system, you should not be able to tell them apart from any other folder you would regularly use.

Defining an IMAP profile

An IMAP profile contains the information Pegasus Mail needs to establish a connection to your remote mailbox. When you edit an IMAP profile, Pegasus Mail will present you with a dialog that has four pages. The first three pages allow you to configure IMAP-specific features of the profile, while the fourth page, ”Security”, allows you to configure the use of secure SSL connections for the profile.

The “Connection” Page

Enter a name for this definition  Enter here the name Pegasus Mail should display for this entry in the IMAP Profiles dialog box and in the Folder Manager window. You can call your profile entry anything you wish, up to a maximum of fifty characters.

IMAP Server address  The Internet name of the machine to which Pegasus Mail should connect in order to access your remote mailbox. The machine must be running a piece of software called an IMAP4rev1 server - ask your ISP or network administrator to confirm that this piece of software is available on the machine before trying to connect to it. You can enter either a name (like myhost.mydomain.com) or an IP address (like 225.198.64.37) in this field.

Server port  This is, if you like, the number of the socket on the remote machine where Pegasus Mail should "plug in" to access the server. In most cases, this should be left at its default value, 143, but on rare cases, your ISP or network administrator may tell you to use a different port number.

Timeout  This controls how long Pegasus Mail should wait for responses on your network before assuming that a problem has occurred. For more information on timeouts, click here.

Login name  The name Pegasus Mail should use to login to the server.

Password  The password matching the login name you gave. When you type in your password, it will display as asterisks.

HINT  You can leave any of the username, the password or the server address blank, and Pegasus Mail will prompt you for them when you connect using the profile.

Mailbox reference  This field is not usually required, but some servers may require assistance in locating the directory where your mail folders are located. For example, on some unix IMAP servers, you may need to give the path to your mail directory, as ~myname/Mail, in this field. In general, you should only enter a value in this field if instructed to do so by your ISP or network administrator.
The “Settings” Page

This server supports folders within folders Some IMAP servers will allow you to create mail folders inside other mail folders along with the messages they contain, while some will not. Servers that do not allow folders within folders will create trays that can contain folders, just like Pegasus Mail’s standard folder view. Checking this control helps Pegasus Mail to work out how it should go about creating folders for you on the server. At the time of writing, the following common IMAP servers do support folders within folders (i.e., this control should be ticked if you are using one of these servers): Netscape IMAP Server, Microsoft Exchange IMAP Server, Novell GroupWise IMAP Server, Cyrus IMAP Server. Most unix-based IMAP servers, especially the University of Washington UW-IMAPD reference server do not support folders within folders, and hence this control should be left unticked if you are accessing one of these servers. Mercury/32, Pegasus Mail’s companion product, shares the same message store as Pegasus Mail and hence does not support folders within folders, so you should leave this control unchecked if you are connecting to it.

Pegasus Mail displays a folder that can contain other folders as a hybrid item in its folder manager window - it looks like a regular mail folder icon that has a letter sitting on top of it; it also has the [+ ] toggle control that allows you to see the other folders it contains. Double-clicking one of these hybrid folders will open it and display its messages, as will highlighting it and clicking the open button. Use the [+ ] toggle or the left/right arrow keys to display any other folders that may be nested inside the item. You can also right-click the entry and select Expand or Collapse entry to display the contents of the folder without actually opening it.

Always connect to this profile at startup If this control is checked, Pegasus Mail will mount this profile in your Folder Manager window automatically each time you run the program.

Make this definition’s INBOX folder the default new mail folder When this option is checked, Pegasus Mail will regard the INBOX from this definition as its primary new mail folder when the definition is active. The effect of this is that pressing <Ctrl+W>, or selecting any option that views your new mail will open this folder, and the toolbar "Edit new mail filtering rules" button will open the rule set associated with this folder instead of the normal one.

Periodically update the INBOX view "INBOX" is the name that IMAP servers give to the folder where new and unread mail is placed on arrival. If you want Pegasus Mail to check this INBOX folder periodically to see if new mail has arrived for you, tick this control and enter a number of seconds between checks in the field labelled every xx seconds. Performing periodic checks requires a TCP/IP connection, so if you are using a dialup link to the Internet, you will need to experiment to see whether this option is useful to you. You should generally not set a periodic check period shorter than fifteen seconds.

Deleted message handling

When you work with local folders, Pegasus Mail allows you to save the messages you delete in a folder called “Deleted messages” until you exit from the program. When working with an IMAP mailbox, however, it's sometimes impractical or undesirable to download a copy of the message just so you can delete it. To get around this, Pegasus Mail offers three ways it can handle messages that are deleted within the mailbox controlled by each IMAP profile.

Move them to an IMAP folder called xxx This is basically the same as the local option except that the deleted messages folder is stored on the IMAP server instead of locally. If the folder does not exist, Pegasus Mail will create it for you automatically. This option is very fast and is recommended in practically all cases.
Move them to the local deleted messages folder if active  This option tells Pegasus Mail that it should treat IMAP messages like any other message and to make copies of them in a local deleted messages folder if you have enabled that option in your preferences. When this option is enabled, Pegasus Mail may have to download the message when you delete it (so it can store it in the local folder); as a result, this option can be quite slow, but it does mean that you can access the deleted messages at a later time, even if you don't have an IMAP session active.

Delete them immediately and do not keep a safety copy  If you select this option, Pegasus Mail will ignore all other settings and will delete the message at once without making any kind of "undo version" for you. This is the fastest setting of all, but also prevents you from ever recovering any message you delete without meaning to.

The “Performance” Page

IMAP is a very intensive protocol and can be used in a great many ways. Some IMAP operations are very "expensive" in computing terms - that is, they either take a long time or consume considerable amounts of computing resources. The options on this page allow you to tune the way Pegasus Mail uses the IMAP protocol to suit your needs and environment.

It is important to note that enabling some of these options involves a trade-off between performance and features: so, enabling some operations may speed up access to your IMAP mailbox while also disabling or reducing the effectiveness of other features in the program. Where such trade-offs exist, they are noted in the descriptions below.

Connection management

Mailbox is accessed exclusively by this copy of Pegasus Mail  If you only ever access this mailbox via IMAP, and using a single copy of Pegasus Mail, then checking this control will speed up a number of operations because it allows Pegasus Mail to make some assumptions that it cannot reliably make if the mailbox could be accessed by another program. If, however, you ever access this mailbox by some other means - for instance, using a local copy of Pegasus Mail that accesses it directly instead of via IMAP, or by using a WebMail server, you must not check this control.

Keep a utility connection open when this definition is active  Checking this control tells Pegasus Mail to keep a base connection open with the IMAP server at all times while the profile is active, over and above any connections required to display individual folders or messages. Using a utility connection allows Pegasus Mail to get regular folder status (for instance on the INBOX folder) more efficiently, and will speed up other operations in the program, especially the Use fast folder listing commands option (see below).

Trade-off: The trade-off for enabling this option is that Pegasus Mail will keep your Internet connection open for the entire time the IMAP mailbox is present on your desktop. If you operate on a LAN or on a high-speed Internet connection, such a trade-off is usually no issue, and in those environments this option is recommended.

Folder status handling

The process of getting status information for folders (i.e, getting the total number of messages and the number of unread messages in the folder) is one of the more "expensive" operations you can perform on many IMAP servers, and reducing the number of status requests required can have a considerable impact on the time it takes to establish an initial connection.

Only get folder status for INBOX when connecting  Usually when you connect to an IMAP server, Pegasus Mail will ask the server for status information about each of your folders. It
defines this in order to present you with the total number of messages and unread messages in each folder. Processing these status requests can be quite slow, especially across dialup links: if you are finding that it takes a long time to connect to your IMAP mailbox, or if you only want to make a quick check for new mail, tick this control and Pegasus Mail will only ask for status on the server's INBOX (or new mail folder). This can result in a marked improvement in performance when connecting, at the price of not knowing how many messages are in any of your IMAP folders except your INBOX.

... And also get status for any subscribed folders IMAP servers allow mail programs like Pegasus Mail to store a list of folders that can be very quickly accessed at any later time; this process is known as Folder Subscription, and you can subscribe and unsubscribe your folders by right-clicking them and selecting the appropriate option from the popup menu. When this option is selected, Pegasus Mail will retrieve your list of subscribed folders when you connect to the mailbox and will get the status of those folders. This option can only be enabled when you have checked Only get folder status for INBOX... (see above).

Folder list handling
Like the process of getting folder status, the process of listing the folders in a mailbox can be very "expensive" under IMAP. Reducing the number of LIST commands issued can have a very considerable performance impact on IMAP connections.

Use fast folder listing commands When this option is selected, Pegasus Mail will only retrieve the top-level folders in the mailbox when it initially connects. From that time, whenever you open a tray or folder that contains other folders, Pegasus Mail will issue a new list command to the server to get the folders in that level of your folder tree. If you have a complex folder structure with many folders below the top level of your folder list, this command can save a considerable amount of time on connection, and if you enable the utility connection option (see above), the delay involved in fetching new parts of your folder list becomes minimal.

Trade-off: when you use this option, Pegasus Mail will not be able to access any folder in a level of your folder tree that you have not explicitly opened (because it won't yet know that the folder exists). This is primarily an issue if you use filtering rule sets on IMAP folders, because Pegasus Mail will not be able to move messages into folders you have not yet seen in the session. If you do not use filtering rules, or if you only filter messages into folders that are always visible, this option can give a major performance improvement. This option is incompatible with the List only subscribed folders and Mailbox is accessed exclusively by this copy of Pegasus Mail options. You also cannot use a profile where this option is enabled in Offline mode.

List only subscribed folders in this mailbox As described above, IMAP servers allow mail programs to store arbitrary lists of folders in what is known as a subscription list. The subscription list can be retrieved very quickly by the mail program and usually does not entail the performance hit that normal list commands do. Selecting this option tells Pegasus Mail to display only the contents of your subscription list when you connect to the server - all other folders will be unavailable during the session. This option is normally used in a secondary definition for a mailbox, typically when accessing the mailbox over a slow or unreliable link, such as a GSM cellphone. Your primary connection will connect to the same mailbox but will not have this option enabled, so you see all your folders and use the right-click option to select those that should be in your subscription list. Then, when you have to connect quickly to your mailbox, you can use the secondary profile with this option enabled to establish a fast connection that only displays the folders you are directly interested in. This option is incompatible with the Use fast folder listing commands and Mailbox is accessed exclusively by this...
Accessing an IMAP Mailbox

To access a remote IMAP mailbox in Pegasus Mail, you use the IMAP Profiles option on the Tools menu to create a profile: a profile contains the name of the host computer where the mail folders reside, your login name and password for that machine, and possibly some optional settings to control the way the program interacts with the remote IMAP server.

Once you have created a profile, it will be remembered from session to session and you can connect to it simply by selecting it in the IMAP Profiles dialog and clicking the Connect button. Pegasus Mail will open the Folder Manager window and will create a new root mailbox entry there, then it will login to the IMAP server you have defined and get a list of the folders available on that server. These folders will appear in the Folder Manager window list and can be manipulated and used just like any other folder within Pegasus Mail. This process of connecting to an IMAP server and presenting its mailbox view is called mounting the mailbox in technical terms.

You can create as many profiles as you wish, and you can have up to 20 IMAP profiles mounted in your folder view at once as you wish. There is no reason why you cannot mount two IMAP mailboxes on completely different systems and drag and drop messages between their folders. Only one copy of any given profile can be mounted at a time - you cannot create a second copy of an IMAP mailbox in your folder list if it is already mounted there.

To finish an IMAP session and terminate the connection to the IMAP server (or dismount the mailbox), right-click on the root entry for the mailbox you want to dismount and choose Remove this mailbox.

Using an IMAP profile Off-line

As you use an IMAP profile online, Pegasus Mail will build up a cache of information from the remote IMAP mailbox. This means that information about folders, headers and messages is stored locally on your PC. Pegasus Mail allows you to access this locally cached data in offline mode, without requiring any kind of network connectivity to the remote host. When you mount an IMAP profile offline, you can see all the folders in the profile, and can read any messages that are present in the folder cache. In offline mode, the IMAP profile is read-only - you cannot delete, change or add messages or folders in the profile while offline.

To use an IMAP profile offline, you must already have connected to it online at least once. Certain options on the "Performance" page of the IMAP definition editor, most notably the Fast Listing and Subscribed folders options, will prevent you from using a profile in offline mode if they are set. Actually using the profile offline is simplicity itself - simply select the profile you want to use then click the Use offline button in the profile list window instead of the Connect button.

Hint: if you want to make sure that all the messages in a folder are available for use in offline mode, right-click the folder in the list of folders and select the Cache all messages option from the right-click menu. Note that caching an entire folder may take a while if the folder is large.
Restrictions when using IMAP

IMAP is a general-purpose protocol, and as such will not necessarily support all the operations that a feature-rich program like Pegasus Mail offers; furthermore, some operations may work, but with certain restrictions.

Operations that will not work at all The following operations will not work at all when using IMAP folders:

- You cannot set the display colour of a message in an IMAP folder
- You cannot access the message properties for an IMAP message, nor can you change the “From” and “Subject” items displayed in the folder browser.
- You cannot delete attachments from IMAP messages, even if they are in the IMAP inbox (although if you move them into your local new mail folder, you can remove the attachments there then move the message back into the IMAP inbox).
- You cannot expire a message in an IMAP folder

Operations that have restrictions The following operations may have restricted functionality when used on IMAP folders:

- Annotations will be lost if the cache for the folder is cleared or damaged. Annotations are also only accessible on the machine where they were created – they are actually stored on the local system, not on the IMAP server (IMAP does not support the idea of annotations).
- Not all message flags can be stored on an IMAP server; as a result, although you will still be able to see that you have replied to a message, you will not see any status indication showing that you have forwarded a message.

IMAP troubleshooting

IMAP is one of the most complex and difficult protocols in common use on the Internet, and its use is often not without a certain number of problems. The issues you can run into when working with an IMAP mailbox fall broadly into two classes – local problems, where there is a problem on your local machine, and remote problems, where the problem is either something wrong on the IMAP server to which you are connecting, or on the network between your machine and the server.

Local issues

Far and away the most likely cause of local problems is damage to the files in which Pegasus Mail stores its cached information from the IMAP server. Damage to the cache files can occur as a result of a program or system crash, disk errors, viruses, or by the interference of anti-viral background scanner programs (which in our opinion are almost at the level of causing more problems than they solve). Typical symptoms of local cache damage are messages that display either a blank message body or the wrong message body; messages that cause crashes when displayed; or messages that appear to be incomplete when displayed.

If you believe the symptoms of the problem you are encountering indicate damage to the cache files, right-click the IMAP folder in the list of folders and choose the Folder Information... option: in the dialog that opens, click the Verify button beneath the Body cache file field and see if Pegasus Mail reports any errors. If errors are reported, the verification dialog may recommend you take certain action – typically clearing the cache. Note that whilst it is always safe to clear the body cache, doing so will impact on your ability to use the IMAP folder offline, and will introduce delays in reading messages in the folder.
Remote issues
As previously noted, IMAP is a large and complex protocol, and its implementation can be somewhat uneven. When attempting to diagnose remote errors for an IMAP profile, one of the key issues is attempting to determine whether the problem lies in the network, or in the way Pegasus Mail and the server are interacting with each other. Network problems typically have symptoms like timeouts, connection failures or erratic delays. Network problems are beyond the scope of this manual to help solve – if you are having network-related problems, try increasing your Pegasus Mail timeout values, and if that does not help, see if you can find an experienced Internet user to assist you.

Problems in the way Pegasus Mail and the server are interacting are usually slightly easier to track down. Firstly, make sure that the basic settings for your IMAP profile are correct –

- Make sure that you have entered the IMAP Server address correctly
- Make sure that there is actually an IMAP Server running on that machine
- Make sure that the TCP/IP port is correct - the default is 143, but some systems may use other values. Consult the machine's administrator to find the proper port value.
- Make sure that the IMAP Server is an IMAP4rev1 server - this is important: Pegasus Mail does not support earlier versions of the IMAP protocol.

If your problem is that you cannot create folders within other folders, make sure that This server supports folders within folders is checked in the profile definition for the server you are accessing.

If the problem involves erratic display of folders, or folders appearing in the wrong places (or not at all), try disabling all options on the Performance page of the IMAP profile editor: many of the performance options require the use of more esoteric parts of the IMAP protocol, and it is possible that the server to which you are connecting may not correctly implement them.

All other problems are essentially beyond the scope of a general-purpose manual like this to diagnose, and will require specific investigation. Pegasus Mail includes an invaluable tool to help you gather the information you need for this: TCP/IP session logging. At the bottom of the General page of the Internet Options dialog on the Tools menu, you will see a control labeled Create Internet session logs...: enabling this control tells Pegasus Mail to create a transcript file for every Internet session it conducts with a remote server. The session file will be created in your home mailbox directory and will have a name of the general form TCPxxxx.WPM, where the "xxxx" will be a series of four digits or letters. Each session file contains an exact transcript of all the data exchanged by Pegasus Mail and the remote server, as well as descriptions of any low-level networking errors encountered during the process.

Creating an Internet Session Log that captures the problem as it occurs will make it considerably easier for whoever ends up troubleshooting your problem to work out where the problem lies - indeed, since the problem is almost always at or near the end of the file, generating a session log may give you an idea of how to solve the problem on your own, even if you know little or nothing about the Internet protocols in use.

Please note that if you have a Pegasus Mail Support Subscription from a former paid version of the program and apply to us for formal technical support on an IMAP-related problem, the first thing we will do is ask you for an Internet Session log showing the problem, so you can expedite the process by creating a log and sending it with your initial request for support.
14: Multiple Identities

One of Pegasus Mail’s most powerful features is its support for multiple identities. An identity is simply the set of configuration options and preference settings that control the way the program acts and behaves when you send and read mail. From time to time, it’s convenient to be able to “wear more than one hat”: you might fulfil two roles in your organization, each needing a different personal name; or some of your recipients may need to receive mail using a particular encoding; or you might be a manager for a certain mailing list and need to show that in your messages – there are many reasons why you might need to change your settings in order to satisfy the needs of a particular situation.

Under Pegasus Mail, this is easy – it allows you to create multiple sets of preferences, each with its own name, and select between them simply by choosing them from a list on the toolbar. To create a new identity, simply choose Identities from the Tools menu and the Identity Management window will open. Click the Add... button, and give your new identity a name. You will usually want to base your new identity on the settings in an existing identity – select that identity from the list, then click OK. Your new identity will now appear in the list: it will have all the same settings and options as the identity on which you based it, but it has not been selected as your “active” identity yet. Close the Identity Management window: notice that the Identities list on the toolbar has not changed. Now, go up to that list, and select your new identity from it. Now go into Tools, then Options, and make whatever changes you need to your settings.

When you change identities using the list on the toolbar, all of your program settings are updated to reflect those of the new identity. You can change identities as often as you wish. When you reply to, or forward a mail message, you can also choose an identity in those dialogs: when you do this, your current identity will be unchanged, but that individual message will go out with the settings from the identity you choose.

Identities are a convenient way of working with multiple POP3/SMTP mail accounts – you can create multiple identities, each with the proper settings for a different mail account, then access that mail account simply by changing identities before clicking the Get mail or Send mail buttons.

A small range of preference settings are not affected by identities: these include your home mailbox location, window positions, the toolbar, and the list of folders in the folder manager window. If you want to change any of these items, you should create a different Pegasus Mail user and start the program as that user.

Pegasus Mail always starts up using the <Default> identity, and the <Default> identity cannot be deleted or renamed.

Using identities in your mail messages

When you start a new message, Pegasus Mail uses your current default identity as a source of settings for the message editor window. You can change the identity used for the message by pressing F9 to switch to the editor’s special view, then selecting the identity you want to use. The signature, confirm options and copyself settings for the message will be changed immediately to reflect the settings in the identity you have chosen.

When you reply to a mail message, you can select a specific identity that Pegasus Mail should use for the reply using the control in the reply options dialog. The settings from the identity you select will be applied to the message editor in which your reply appears — as with a new
message, however, you can change your identity at any time using the option on the editor’s Special view.

**Attaching identities to folders**

In normal use, you will tend to group like messages together in their own folders within Pegasus Mail. You might do this either explicitly, by moving messages into the folder manually, or automatically, via filtering rules. In situations like this, you will often find that you tend to use a particular identity any time you work with the messages in the folder. To simplify this process, Pegasus Mail allows you to associate an identity with a folder — that way, any time you reply to a message in the folder, the settings from the associated identity will be automatically applied to the reply. To associate an identity with a folder, open the Folder Manager window by choosing Folders from the File menu, then right-click on the folder in the list. From the popup menu, choose Set default identity for entry and select the identity you want to use with the folder from the selection dialog that opens. To remove the association, repeat the same steps, then choose <No identity> from the identity selector dialog.
15: Extensions ("Plugins")

Pegasus Mail has a built-in plug-in interface that allows third parties to develop modules called Extensions, which look and behave like part of the program. Extensions can appear in their own windows and can access every part of the system.

**Installing extensions**  If you have a WinPMail Extension you want to use on your system, follow the instructions supplied with it for installation: in general, you will have to copy a file with the extension .FFF into the same directory as WINPM-32.EXE (or into your home mailbox if you are on a network and do not have access to that directory); there will probably also be a Windows DLL file you will have to copy to your machine, usually into the same location as the .FFF file.

**Using extensions**  Some extensions will be run automatically when you start WinPMail, but you will have to start most of them deliberately. You can load an extension either by selecting it from the Extensions submenu of the Tools menu, or by opening the Extensions Manager (select Extensions Manager from the Extensions menu of the Tools menu), which lists the Extensions WinPMail has been able to find on your system. To start an extension, simply double-click on its entry in the list. The Extension Manager window can be left open on your desktop and will remember its position from session to session.

Many extensions may add themselves to the New message submenu of the File menu, or to the Addresses menu. For example, the telephone message adds itself as a new message type, while the LDAP extension adds itself as an address lookup tool.

**Sample extensions**  WinPMail is supplied with a number of extensions you can use on your system. These extensions are:

**Telephone message**

The telephone message extension is an electronic version of a phone message pad. Simply by filling in a few blanks you can send out advice of a telephone message to anyone whose address you have.

**Mail Merge**

The Mail Merge Extension lets you create personalised “form letters” by merging a data file containing addresses with a template letter containing the format of the message. The effect is almost exactly like a word processor’s mail merge function. The Mail Merge extension has its own online help detailing file formats and usage.

Note that as of Pegasus Mail v4.4, the Mail Merge capability has been built into the program as a core feature: the Mail Merge extension is still provided, however, for the benefit of people who may have built up libraries of files that work with it. Generally, however, the build-in Merge capability (described in Chapter 4) is substantially more powerful than the extension and should be used in preference to it.

**Business Cards**

The Business Card extension allows you to create a message containing your personal contact information, which can then be sent out at any time. The business card you send is readable and useful to anyone, but other Pegasus Mail users will actually see your card represented graphically on the screen and will be able to add your details to their address book with the
press of a single button. The business card remembers the information you enter, so you only need to enter it once. Business cards are a very handy way of sending your contact information out to friends, clients and businesses.

**LDAP directory service lookup**

This specialised extension allows you to look up names and e-mail addresses using LDAP (an acronym standing for “Lightweight Directory Access Protocol”), an emerging standard on the Internet. Ask your system administrator or ISP whether or not there is an LDAP server you can use to perform address lookups. There are also some public LDAP servers like Four11 and Bigfoot. The Extension includes comprehensive help on forming your queries.

The following more specialized extensions are also included with Pegasus Mail:

**PH Lookup interface**  PH is a directory protocol which allows you to look up the e-mail addresses of other users by supplying their surname as a match. If your site has a PH server running (your system administrator will be able to tell you whether or not this is the case) then you can use this extension by entering the address of the PH server in the extension. Pegasus Mail’s companion server product, Mercury, contains an excellent PH server.

**Finger Lookup**  Finger is a simple protocol which lets you see public information about users on a remote system. Practically all unix systems will support Finger, as will some other systems. Simply enter the address of the host to check and the username of the user you are interested in (requires WINSOCK.DLL).

**Developing extensions**  The Pegasus Mail extension manager API is publicly available. If you are interested in developing extensions for Pegasus Mail, retrieve the file WPMFORMS.ZIP using this URL:

```
ftp://ftp.usm.maine.edu/pegasus/wpmforms.zip
```

This file contains complete documentation and sample source code for many of the extensions provided with Pegasus Mail.
Imagine that you're the webmaster for your Internet site; you receive a huge amount of mail, for much of which the answers are essentially the same... You laboriously reply to each message, removing the pieces you don't want, typing in your canned response, then sending the message. Wouldn't it be good if there was some way of automating all of this? Well, there is - Message Templates.

A Message Template is simply a type of script that tells Pegasus Mail how to compose a mail message. The template script commands allow you to set any address or feature field, include the original message for replies (or a portion of the message), change or modify addresses, add attachments and generally give you complete control over the shape of your automatically-generated message. What's even better, you can define variables in templates: when you use the template, Pegasus Mail will prompt you for values for the variables it contains; the script language can then take the values you enter, manipulate them, and insert them seamlessly into the generated message (think of this as a kind of mail merge, where Pegasus Mail prompts you for the text you want to merge into the message).

Using a message template, you can generate a complex mail message and send it with only a couple of keystrokes.

The two types of message template

Pegasus Mail supports two types of templates - those used to create new messages from scratch, and those used to create replies to messages. For both types of template, the template file itself is simply a plain text file containing template script language commands, one per line.

Templates used to create new messages have the extension .PM5; the name portion can be anything you wish. Templates used to create replies to messages have the extension .PM6; once again, the name portion can be anything you wish. Generally, you do not have to be worried about the actual details of the template name or extension - Pegasus Mail's template editor will handle them for you.

For both types of template, the script language's TITLE command (see below) must be the first line in the file, so that Pegasus Mail can show the name in its selector window. Pegasus Mail will not burrow through a template file looking for a TITLE command if it is not on the first line.

Template files can be located in your home mailbox directory, or may be placed in the same directory as the Pegasus Mail executable program, in which case they become system-wide and are made available to all users running that copy of the program. There is no effective limit on the number of templates you can define.

Using message templates to create mail

You can create a new message using a template by selecting Template... from the New Message submenu of the File menu, or by pressing <Ctrl+F7>. This will open a dialog listing all the templates available on your system. Select the template you want to use by highlighting it and clicking Open, or by double-clicking it. A window will open prompting you for any variables the template uses; at this point, you can choose whether to open a new message editor window filled out with the message created by the template, or simply to send the message without further ado.
Creating templates using the template editor

Creating templates using the template editor

You can use a template to create a reply to a message in one of two ways:

1: Right-click the message and choose Reply using template... from the popup menu that appears.

2: Highlight the message, then hold down <Shift> as you press the "Reply" button, or else hold down <Shift> and press the R key.

Creating templates using the template editor

Creating a template script is essentially a simple form of programming. If you have ever used a scripting language such as Microsoft Visual Basic then the Pegasus Mail template script language shouldn't be very challenging for you, but even if you've never done any programming at all, the process should be significantly simplified for you by using Pegasus Mail's template editor.

The template editor allows you to edit your template script in an editing area, and also has a list of the possible script language commands at the left-hand side of its window. Double-clicking any of the commands in the list will open an Editing Assistance Dialog, which will prompt you for each of the pieces of information required by the command and will then insert the completed command into the script buffer for you.

Using the Editing Assistants simplifies template creation considerably because you no longer have to remember the syntax for the commands, and any special handling (such as quoting string literals or filenames that contain special characters) is done for you automatically.

To use the template editor, choose Template editor... from the Pegasus Mail Tools menu. A dialog will open asking you what type of template you want to edit - choose either a template used to create new messages from scratch, or a template used to generate replies to other messages. You will then be able to select a template from those already present on your computer, or create a new template.

Once you have selected a template to edit, the template editor dialog will open. The script of your template will appear in the large editable area on the right of the window, and the Editing Assistance list will appear on the left of the window. You can either type commands and text straight into the editing area, or else you can create a template command by double-clicking the command you want to create in the list. When you use the Editing Assistants, the new command you create will be inserted at the cursor position if the cursor is at the start of a line, or on a line following the current line if the cursor is anywhere else.

Once you have finished creating your template, click the Save button to save the changes you have made. You can use your modified template immediately in any of the ways supported by Pegasus Mail.

String literals and filenames

Most template script commands in the language accept strings as parameters. String literals of this kind must be entered in quote characters if they contain spaces or special characters. For example, if you want to use the insert command to write the string Mary had a little lamb into an outgoing message, you would need to enter the command like this:
insert "Mary had a little lamb"

since otherwise, only the word "Mary" would be inserted.

If your string contains a quote character, or a backslash character, then you will need to perform a small amount of conversion. So, if you want to insert the string \"Mary had a \"little\" lamb\" you would have to enter the "insert" command like this:

insert "Mary had a \"little\" lamb"

These rules for string construction apply in all places throughout the script language. If you are using the Pegasus Mail template editor to create your templates, it will perform all the necessary conversion and quoting of the string for you, saving you the trouble of remembering to do so.

Filenames are treated as strings by the script language, and as such are subject to the same rules. In particular note that long filenames containing spaces will need to be quoted, and that "\" characters will need to be doubled in file paths... So, if you wanted to use the include command to include the file \"c:\docs\Mary's \"little\" lamb\", you would need to form the command as

include "c:\\docs\\Mary's \"little\" lamb"

As with string literals, the built-in template editor will take care of these conversion issues for you as required.

Optional or omitted parameters

Some script commands are shown as having "optional" parameters. This notion needs some clarification... A parameter may be omitted only if all the parameters following it are also omitted - it is not possible to omit only one parameter from the middle of a list. So, using the include command (see below) as an example, if you wanted to include a file in quoted format, you would have to include the "0" value for the count parameter as well.

Textual substitutions

Practically any string parameter to a script command can contain textual substitutions: these are special character sequences that are replaced by variables or other information when they are encountered. Pegasus Mail recognizes the following textual substitutions in any place where they may be used:

- \vvar\_name\~ The current value of a template script variable
- \z\ A single newline (CR/LF)
- \f\ The "from" field of the original message
- \s\ The "subject" field of the original message
- \r\ The preferred reply address for the message
- \k\headername\~ Any header from the original message
- \n\ The current user's basic username
- \i\ The current user's Internet e-mail address
- \8\ The current user's username truncated to 8 chars
- \p\ The current user's personal name preference
- \d\ A random integer expressed as 4 hex digits
- \y\ The current date and time in RFC822 format
- \%\name\% The value of environment variable \%name\%
- \l\name\~l The user's address looked up from a synonym file
The template script language - command summary

Example:
Assuming that the current user's name is "david" and the variable "sub" has been assigned the value "your order", the string

"This is a message from ~8, regarding ~vsub~"

would yield the following string after substitution:

"This is a message from david, regarding your order."

Command substitution is the single most powerful feature of the scripting language used for templates, and a good understanding of what it can do is essential for writing useful scripts.

The template script language - command summary

The TITLE command

Syntax: title <string>

Set the title (the name that appears in the list of available templates) for the template file. string can be any string up to 50 characters in length, and can contain all command substitutions except for variables, which are not defined at the time this command is processed. This command must be the first command in a template and must be present - if you omit it, the template will not appear in the list of templates.

The HELPFILE command

Syntax: helpfile <filename> [section]

Set the help file that should be accessed when the user clicks the Help button in the variable prompt dialog. filename should be a full reference to any valid Windows Help file (*.HLP) on your system, and may contain all command substitutions except for variables, which will have not been defined at the time this command is processed. section is an optional integer value that indicates the context help section within the help file that should be presented when the help button is pressed. If it is absent, section 0, the table of contents, is presented.

The STRING command - declaring variables

Syntax: string <name> ["Default"] ["Prompt"] [len] [flags]

Define a variable for use within the script. A maximum of 20 variables may be defined for any script. name is the name for the variable; it must not contain spaces, and is not case-sensitive (so var1 and VAR1 are considered the same). All the parameters following the name parameter are optional (see above for more information on exactly what "optional" means in this context), and you can end the string early if you wish. default is a string which should be used as a default value for the variable: if it contains spaces or special characters, it must be enclosed in quotes (see String literals and filenames for more information). If this parameter is omitted, the default value is an empty string. prompt is the string Pegasus Mail should place next to the editing field in the variable prompt dialog. If omitted or zero-length, Pegasus Mail
will not prompt the user for a value for this variable. \textit{len} is an integer defining the maximum allowable length of this variable. If omitted, the default is "no limit". \textit{flags} is a set of one or more options that define the format and type of the variable: the following flag values are available:

- \texttt{multiline} creates a multi-line variable
- \texttt{address} creates an e-mail address variable
- \texttt{filename} creates a filename variable
- \texttt{password} creates a password variable
- \texttt{list} creates a list of items - see the next section for more details
- \texttt{uppercase} specifies that the variable must be all in uppercase

Only \texttt{uppercase} may be used with other values.

**Creating list variables using the STRING command**

When you use the \texttt{list} flag in a \texttt{string} command, you create a variable that has a list of possible values from which the user can select. \texttt{list} variables require that you provide a \texttt{default value} for the variable, which contains the list of possible values the variable can have. The first character in the \texttt{default value} should be the character used to separate the list items from each other, and the remainder of the \texttt{default value} should be the items, separated by that character.

**Example:** Assume that you want to allow the user to select from the values "Red", "Green" and "Blue", contained in a list variable called \texttt{v1}: your \texttt{string} statement would look like this:

\begin{verbatim}
string v1 ";Red;Green;Blue" "Select a colour" 0 list
\end{verbatim}

**Using the SET command to set message fields**

\texttt{Syntax: set <field> = <"value">}

This form of the \texttt{set} command sets a field within the mail message being generated by the template to the specified value. \texttt{field} may be one of the following:

\begin{description}
\item[1:] fields that accept a string value - these are: to, cc, bcc, reply-to, subject and identity
\item[2:] fields that accept a 'Y' or 'N' value - these are: urgent, confirm-reading, confirm-delivery, copyself, volatile and mime
\item[3:] fields that accept a special value: there are two special fields that have their own specific syntax:
\end{description}

\begin{verbatim}
header (a fully-formed e-mail header including the keyword)
encrypted("encryptor_name", "password", "flags")
\end{verbatim}

When encrypting a template message, use the \texttt{encrypted} field with the \texttt{set} command. "\texttt{encryptor}" is the name of the module that should be used for encryption - to use the Pegasus Mail built-in encryptor, use the name "\texttt{builtin}". "\texttt{password}" is the password for the message - this can be up to 96 characters in length. "\texttt{flags}" controls the type of encryption performed; to encrypt a message, set it to 1; to add a digital signature to the message, set it to 4; to perform both operations, set it to 5. Note that you cannot set the \texttt{encrypted} field using Pegasus Mail's template editor's assisted editing feature - you must do it by manually typing it into the editor area.
The volatile field tells Pegasus Mail to write the message directly to final form when sending using the built-in SMTP transport. You will need to set this to "Y" if you are attaching files that will be deleted once the template has been processed.

All textual substitutions are supported for the value parameter.

**Using the SET command to assign values to variables**

Syntax: set variable <variable_name> = <"value">

This form of the "set" command changes the current contents of any defined variable to the value you specify in value. All textual substitutions are supported for the value parameter.

To copy the value of one variable to another, use an expression containing the ~v textual substitution, like this:

```plaintext
set variable v1 = "~vv2~"
```

**The INSERT command - add data to a message**

Syntax: insert <"string”>

Write data into the body of the message being generated. string can contain any command substitution: if it does not contain a ~z textual substitution to force a line break, then the next insert command will write data onto the same line in the body. A single insert command may not insert more than 1024 characters into the message body.

**The BODY/ENDBODY commands - insert a block of text into the message**

Syntax:

```plaintext
Body
<text>
EndBody
```

The Body and EndBody commands provide an easy and convenient way of entering a large chunk of multi-line text into the body of the mail message being generated by the template. Start the block of text with Body on a line of its own, then enter the text you want to appear in the message, exactly as you want it to appear. You do NOT have to quote strings or follow any of the requirements for string literals and filenames in the text you enter, and you can include any textual substitution you wish in the block of text. When you have finished entering the text, start a new line and place the EndBody command on that line, on its own.

**Example:**

```plaintext
Body
This is a sample of text. These two lines will be entered exactly as shown here.
EndBody
```

**The INCLUDE command - include a file or the reply body**

Syntax: include <filename> [count] [flags] 

Include either a text file, or the body from the message to which a reply is being generated. The text from the file or message is included as-is into the message body - textual substitutions are not performed on the included data, but if you are including a file, the filename pa-
16: Message templates

The template script language - command summary

Parameter may contain any valid textual substitutions. If count is present and non-zero, only that
many lines of the included file or the body of the included message will be read. The flags
parameter controls the behaviour of the command and can be any combination of the following options:

<table>
<thead>
<tr>
<th>Flags</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>quoted</td>
<td>&quot;Comment-out&quot; the included text using &quot;&gt;&quot;</td>
</tr>
<tr>
<td>message</td>
<td>Use when including files that contain e-mail message data.</td>
</tr>
<tr>
<td>noheaders</td>
<td>If message is also present, omit its RFC822 headers</td>
</tr>
<tr>
<td>keyheaders</td>
<td>If message is also present, include only &quot;significant&quot; headers</td>
</tr>
<tr>
<td>nobody</td>
<td>If message is also present, omit the message body</td>
</tr>
</tbody>
</table>

The ATTACH command - attach a file to the message

Syntax: attach <filename> [type] [encoding] ["Desc"]

Attach a file to the message being generated by the template. Only "filename" is a mandatory
parameter - the others can be omitted and are sensibly defaulted if not present. Any valid tex-
tual substitution can be used in the filename. If the filename contains spaces, it must be quot-
ed according to the rules described in String literals and filenames, above. Type is any string
describing the type of the file - for instance, "RTF_FILE". It must not contain spaces and
is not constrained to the list of possible values inside Pegasus Mail itself. Encoding is an in-
teger value that specifies how the file should be encoded for transfer; the following values are
declared:

<table>
<thead>
<tr>
<th>Encoding</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Pegasus Mail decides</td>
</tr>
<tr>
<td>1</td>
<td>No encoding - very dangerous</td>
</tr>
<tr>
<td>2</td>
<td>ASCII text</td>
</tr>
<tr>
<td>3</td>
<td>UUencoding</td>
</tr>
<tr>
<td>4</td>
<td>BinHex 4.0</td>
</tr>
<tr>
<td>5</td>
<td>Basic MIME encoding</td>
</tr>
</tbody>
</table>

Unless you are very sure of what you are doing, use 0 for encoding. Desc is a textual descrip-
tion of the file; it may contain any text, including spaces, and is truncated at 63 characters.

The PICTURE command - add a picture to a template's prompt dialog

Syntax: picture <flags> <filename>

Add a picture at the top of the variable prompt dialog. The picture specified by filename must
be a Windows BMP file in 16 or 256 colours: owing to quirks in the way Windows handles
256 colour bitmaps, we strongly recommend that you use 16-colour bitmaps if your display
runs in 256 colour mode or lower. For the Win16 version of Pegasus Mail, the bitmap must
not be larger than 60,000 bytes. You may use any textual substitution in the filename para-
meter. The bitmap is centred horizontally in the display and the dialog will adjust size to fit the
vertical dimensions of the image. Exactly one image may be added to the prompt dialog. flags
will be used in future to offer extra formatting options. For now, it is unused, must be present,
and should be set to zero.

Note: if the filename contains spaces or special characters, it must be quoted according to the
rules described in String literals and filenames, above.

The TEXT command - add text to a template's prompt dialog

Syntax: text <flags> <"string"
Add a line of descriptive text to the dialog presented to prompt for script variables when the template script is activated. The line of text is added above any variable editing fields, and below any picture defined using a picture command. You may specify up to 10 lines of descriptive text, and each line may contain any valid textual substitutions. The \texttt{flags} parameter will be used in future, but should currently be set to zero. To introduce a blank line between groups of lines, use a text statement with an empty quoted string - like this:

\begin{verbatim}
  text ""
\end{verbatim}

\section*{The EXTRACT command - parse an e-mail address}

\textit{Syntax:}\ extract address \var{1} \var{2}
\begin{itemize}
  \item \texttt{extract text} \var{1} \var{2}
  \item \texttt{extract user} \var{1} \var{2}
  \item \texttt{extract domain} \var{1} \var{2}
\end{itemize}

This command allows you to extract a component part from an e-mail address. \var{1} refers to the variable containing the address to be manipulated. \var{2} is the variable where the result of the manipulation should be placed - it can be the same as \var{1}.

\begin{verbatim}
extract address \kern5pt yields the minimum form of the e-mail address
extract text \kern5pt yields the personal name field from the address
extract user \kern5pt yields the simple user name portion of the address
extract domain \kern5pt yields the domain portion of the address
\end{verbatim}

\section*{The LOOKUP command - get a text item from a list variable}

\textit{Syntax:}\ lookup \texttt{"string"} \var{1} \var{2} \var{3}

Attempt to locate the string \texttt{"string"} in the list variable \var{1}; if a match is found, the position in the list where the item was matched is noted, then the item at the same ordinal position in the list variable \var{2} is copied into the string variable \var{3}. It is an error for either \var{1} or \var{2} to be anything other than a list variable. If \texttt{"string"} cannot be found in \var{1}, the contents of variable \var{3} are not changed.

\textbf{Example:}\ list variable \texttt{v1} contains \texttt{"Monday"}, \texttt{"Tuesday"} and \texttt{"Wednesday"}; list variable \texttt{v2} contains \texttt{"Open"}, \texttt{"Closed"} and \texttt{"Open"}; the command

\begin{verbatim}
lookup "Tuesday" v1 v2 v3
\end{verbatim}

will result in variable \texttt{v3} containing the value \texttt{"Closed"}. A common form of this command will use the current value of \texttt{"var1"} as the string parameter, using the command substitution \texttt{"~vvar1~"}.

\section*{The CHAIN command - run one template after another}

\textit{Syntax:}\ chain \texttt{"filename"}

Execute another template when the current template completes. \texttt{filename} should be the path to a valid template file, and may contain textual substitutions. The filename must conform to the rules for \texttt{String literals and filenames} (see above). Only one \texttt{chain} command may be present in any template. If the current template is cancelled by the user, the \texttt{chain} command will not be executed.
Appendix A – Command-line options

Pegasus Mail recognizes the following command line switches:

**Application control:** These switches control the program’s basic operational modes.

- `-A` Force WinPMail to start in non-NetWare mode
- `-U <user>` Start WinPMail as another user (the “Become” switch”. -U can only be used in NetWare modes.
- `-I <user>` Provide a username on the commandline; only works in non-NetWare (standalone) mode.
- `-W <path>` Forces WinPMail to load the WINSOCK.DLL specified in <path>, rather than performing the usual Windows DLL search algorithm.
- `-MS` Start a new, separate WinPMail session. You *must not* use this switch to start two sessions connected to the same mailbox - you can only use this switch to start separate sessions accessing different mailboxes.

**-Z – Feature control:** This switch takes a single integer parameter constructed by adding together any of the following values:

1 Disable Internet services (do not load WSOCK32.DLL)
16 Force MIME formatting for noticeboard postings
32 TCP/IP debugging mode (use the checkbox in the Internet options dialog instead of using this switch)
128 “Blind load” WSOCK32.DLL (often needed when running on Linux systems under WINE, or when running on older Windows NT systems)
1024 Use blocking sockets for Internet traffic (sometimes needed to work around problems in non-Microsoft network stacks)
131072 Do not automatically start the Internet Setup Wizard for first-time users.

**Mail from the commandline:** Use these flags if you want to use WinPMail to send messages directly from the command line.

- `-T <address>` Specify the “To” field for the message
- `-F <path>` Specify the full path to the file containing the text to send
- `-C <address>` Specify the “CC” field for the message (optional)
- `-S <“Subject”>` Specify the subject for the message. Note that the subject text must be enclosed in “quote” marks.
- `-B` Indicates that the file referenced in the -F switch is actually a binary file that should be sent as an attachment to the message.

Comprehensive documentation on the full range of commandline options available in Pegasus Mail can be found by selecting Commandline options from the program’s Help menu.
Appendix B: Public (System-wide) folders

In normal use, two different users cannot access the same Pegasus Mail mailbox at the same time (indeed, they must not do so, because it practically guarantees loss of data). The need for several users to access a set of folders simultaneously, however, is quite common and quite reasonable, so how can it be done? The answer is via public folders.

A public folder is a directory in which each message is stored as a single file. Pegasus Mail has special code that controls access to these files, ensuring that multiple users can be working in the folder at the same time. To the user, public folders work just like their own private folders, except that they have their own entry in each user's mailbox list.

Defining Public Folder Trees

To define a public folder tree, simply select Public folders... from the Pegasus Mail Tools menu. In the dialog that opens, click the Add tree button. Pegasus Mail will prompt you for a Descriptive name for the tree, which is the name that will appear next to the top-level entry in the user's mailbox list, and a path where the mail folders should be created. The path should be the name of a directory, and need not exist (Pegasus Mail will create it if it does not). Once you have added a Public folder tree, it will appear in your folder list immediately, and you can begin creating folders in it at once. Anyone else running the same copy of Pegasus Mail will also see the new folder tree the next time they run the program - for this reason, public folders are easiest to use when you run a single copy of Pegasus Mail centrally installed on a file server. If each user has his or her own copy of Pegasus Mail, each user will need to go through the Add tree process once in order to add the Public folder tree to their list.

Public folder trees are added to each user's mailbox list in the order they appear in the Public folders dialog. You can rearrange this order using the Move up and Move down buttons, although changes in the order of definitions will not take effect until you restart the program.

A single copy of Pegasus Mail can have up to 15 different public folder trees active at any time. This is particularly useful if you have a corporate structure where each department needs its own public folder trees but may wish to access public folders from other departments as well.

Creating public folders

To create a public folder, simply select the top-level Public folder entry where you want to create it (or any other folder within it), and click the Add folder button in the folder manager window, just like you would for one of your own folders. When you create a Public folder, however, there are a couple of extra steps.

Firstly, Public folders are different from regular Pegasus Mail folders in that they can contain both messages and other folders (a normal Pegasus Mail folder can only contain messages, or folders, but not both). For this reason, you typically need to tell Pegasus Mail whether it should create the new folder within the selected folder in the list, or at the same level as the selected folder. Do this using the Choose position for folder options at the bottom of the Add folder dialog.

Once you have given your new public folder a name and told Pegasus Mail where to place it, click the OK button: a second dialog will open, asking you to specify the way the folder should manage attributes and annotations. Each folder in a Public Folder tree can behave in one of two ways:
Creating public folders

**Global attributes**  In this mode, messages in the folder have a single set of attributes and a single annotation, which are shared by all users. So, if one user reads a message, it will be marked as read for all other users of the folder as well. Similarly, if a user creates an annotation for a message in a Global attributes folder, that annotation will be visible to all other users, and all other users will be able to modify or delete it as well. Global attribute folders are perfect in shared-task situations, such as helpdesks or project discussions.

**Personal attributes**  In this mode, each user has his or her own private view of messages in the folder. Even if another user reads a message, the message will still appear unread for other users who have not yet read it. Equally, each user can create annotations to the message without them being visible to other users, and other users cannot alter or delete those annotations either.

The attributes that are affected by the folder's behaviour mode are Read, Answered, Forwarded, Urgent and Colour.

Aside from the specifics of their attribute management mode, Public folders behave in every way like your own personal folders - you can create filtering rules that move messages into them, can preview them in preview mode... Whatever you can do with one of your own folders you can also do with a public folder.
Appendix C – DDE and MAPI services

DDE (Dynamic Data Exchange)

Pegasus Mail has full support for the Windows DDE (Dynamic Data Exchange) communications protocol. DDE is a method by which applications can communicate with each other on a client/server basis, the client requesting that the server take certain actions or supply certain information.

The DDE implementation in Pegasus Mail offers a complete method of sending mail, providing access to the full range of Pegasus Mail message features. It also provides access to environmental information about the running copy of Pegasus Mail – for instance, the name of the current user, the location of his or her home mailbox and so on. Finally, the DDE interface provides a way for you to instruct Pegasus Mail to download and send messages using its built-in TCP/IP mail transport.

The DDE services provided by Pegasus Mail can be accessed from any environment that provides support for DDE, including Microsoft Visual Basic and Word Basic (the macro language of Microsoft Word), Borland’s Delphi, and many database programs. One of the advantages of DDE is that it obscures the difference between 16- and 32-bit applications, so you can use DDE to communicate with either version of Pegasus Mail from any other application.

Because we are continually working to improve Pegasus Mail’s DDE interface, it is documented comprehensively in a text file called \WINPMDDE.TXT, which will have been installed in the RESOURCE subdirectory of the directory where you installed Pegasus Mail. Please consult this file for complete reference information on the functions available via DDE.

MAPI Interfaces

MAPI (Mail Application Programming Interface) is a programming interface that allows an application (such as a word processor or spreadsheet) to send and receive mail by calling a mail program. There are two variants of MAPI - Simple MAPI and MAPI 1.0.

Simple MAPI This is the most widely-used and supported version of MAPI; although a simple interface (as its name suggests), it is quite functional for basic sending and receiving of mail messages. Pegasus Mail has a very solid Simple MAPI implementation that supports sending mail but not retrieving it (this will change in future as we add the functionality for handling incoming mail to the code).

MAPI 1.0 This is a gargantuan, impossibly complex “standard” introduced by Microsoft in 1997. In theory, MAPI 1.0 allows multiple mail applications on the same system, but in practice, as soon as you install Microsoft Outlook on any Windows computer, the underlying MAPI libraries are changed so that only Microsoft products can be specified in a user’s MAPI profile. Unfortunately, Microsoft Office only supports MAPI 1.0 – it will not work with a Simple MAPI implementation. Pegasus Mail includes a MAPI 1.0 implementation, but is affected by the presence of Microsoft Outlook as described above. As a result, it is currently not possible to use Pegasus Mail with Microsoft Office or any other application that requires a full MAPI 1.0 interface.

Installing Pegasus Mail’s MAPI support

Because of their restricted usefulness, Pegasus Mail’s MAPI interfaces are not installed by default when you install the program. To install them, double-click the installer icon that was
MAPI Interfaces

placed in the Start Menu group when you installed Pegasus Mail. The MAPI installer requires very little input, but we recommend that you read the dialogs it presents carefully.

Limitations

As noted above, Pegasus Mail currently only supports sending mail from MAPI-enabled applications – it does not at present allow MAPI applications to retrieve mail from your new mail folder or other folders. This facility would potentially be useful for applications such as Palm Inc’s Palm Pilot synchronization software, so we are planning to support it as and when we can find the resources to produce the code. Please watch our web site –

http://www.pmail.com

– for announcements about the availability of updated MAPI interfaces.
Appendix D – Updates, technical support

Official download sites and web pages

The official web pages for Pegasus Mail can be found at the following locations:

- **Home page**
  [http://www.pmail.com](http://www.pmail.com)
- **Downloads page**

If you are viewing this manual in Adobe Acrobat, the links shown above will be clickable.

Getting technical support

Your first port of call for technical support for Pegasus Mail is the program’s help file. The answers to most questions can probably be found there: if you can’t find it at a glance, try searching the index for the help file, then going through this manual in more detail. If none of that yields any helpful results, your best option is to check our online resources:

- **The Pegasus Mail community - http://community.pmail.com** This is our primary support centre, a place where users can support each other. The author and test team for Pegasus Mail are regular participants in the community, and it’s far and away your best bet for getting the answers you need quickly and painlessly. If you use Mercury, the companion e-mail server for Pegasus Mail, this site is also your premier source of technical support for that product.

- **The Pegasus Mail Online knowledgebase - http://kbase.pmail.gen.nz** This interactive knowledgebase contains numerous articles on configuration, installation and troubleshooting for both Pegasus Mail and Mercury.

- **The Pegasus Mail home page - http://www.pmail.com** Our base of presence on the Internet, our home page contains announcements about new releases, security issues and patches, and is the primary source of downloads for both Pegasus Mail and Mercury.
Appendix E – Troubleshooting and FAQs

Pegasus Mail is a very large, rich application which can run in a very wide range of environments; because of this versatility, there will inevitably be times when things just don’t work. This appendix lists some of the most common problems and tells you how to get assistance.

Troubleshooting

First things first  If you have a problem, the very first thing to do is to consult the Pegasus Mail online help file. In general, the online help is the most up-to-date source of information on the particular version of the program with which it is associated. In our experience, over 70% of all problems arise from incorrect installation, or from providing incorrect values during configuration. Go through the program making sure that everything looks correct (a valuable source of information for this is the Info button in the About Pegasus Mail dialog, which you can find on the program’s Help menu).

If you are running Pegasus Mail on a Local Area Network, your next port of call will be your File Server Supervisor (or your mail system administrator if you have one). These people have local knowledge about your environment which makes them the most likely candidates to be able to solve your problem.

Next, check our knowledgebase  We offer a comprehensive searchable online repository of information about Pegasus Mail and Mercury - this is usually where the most up-to-date fixes and solutions can be found: visit the knowledgebase at http://kbase.pmail.gen.nz.

If you are having connection problems with WinSock-based mail, try enabling TCP/IP debugging mode in Pegasus Mail by going into the Tools | Internet options dialog and checking the control labelled Create Internet Session Logs (at the bottom of the General page). This will create a set of trace files called TCPXXXX.WPM (the “xxxx” will be an arbitrary sequence of four digits or letters) in your home mailbox directory which contains the full text of every TCP/IP connection made during the session and a number of potential error diagnostics. If you report problems with the built-in TCP/IP mail transport to Pegasus Mail technical support, you will inevitably be asked to provide this trace file, so it’s worth creating and examining it in advance.

If you’ve gone through these options and still have no solution, send electronic mail to support@pmail.gen.nz: this will retrieve an automatic reply listing the available technical support options. Of particular interest are FAQ files (Frequently-Asked Questions): these files, which can be retrieved automatically by mail, list all the most common questions and answers we know of, and are kept well up-to-date. Finally, if you cannot find an answer to your question, consult Appendix D in this manual for details on how to contact us for formal technical support.

Some frequently-asked questions

Why do all my folders and other mail files appear twice in Pegasus Mail?

If you can see two entries for each Distribution List, Folder, Addressbook or other WinPMail file, then you have probably installed Pegasus Mail in the same directory as your home mailbox (as opposed to using the recommended installation); this causes WinPMail to see every file as both personal and system-wide, and to list them twice.
Appendix E – Troubleshooting and FAQs

Some frequently-asked questions

Solution: Reinstall Pegasus Mail, placing the program files in a directory other than your home mailbox directory.

I want to use the built-in Internet Mail facilities but I don’t get the Internet Options item on the Pegasus Mail Tools menu.

This usually means either that Pegasus Mail has been set not to load, or cannot find a Windows system file called WSOCK32.DLL. Go into your Advanced settings preferences and make sure that the Internet services loading control is set to either Always or On demand. If this appears to be set OK, then Pegasus Mail cannot locate the file; make sure that you have actually installed the Windows TCP/IP Networking Protocol in your Network control panel. If all else fails, use the -W <path> commandline switch to tell WinPMail where to find the file. On systems where the Internet Services facilities are built-in and there is no file as such, use the command line switch -Z 128 to force Pegasus Mail to “blind load” the file (this switch may be required if you are running Pegasus Mail under the WINE emulator on a linux system).

I occasionally see messages appearing in my new mail folder from “Unknown” with no subject. What are these messages?

The folder into which I filter unwanted spam messages occasionally gets damaged, or even vanishes altogether! What’s going on?

Both these situations are symptomatic of Pegasus Mail being unable to open a file as it loads a folder. The most common cause for this is another process on your computer preventing Pegasus Mail from accessing the file, and the most common culprit is a background anti-virus scanner. Based on our technical support experience, background anti-viral scanners account for around 50% of all the support requests we see, and have been responsible for damage to folders and loss of data. We strongly recommend adjusting your anti-viral scanner so that it does not attempt to scan files in your home mailbox directory. Pegasus Mail is effectively immune to all known viruses anyway, so having your anti-viral scanner operating on your mailbox directory actually gains you very little extra security.

I have just purchased a new computer and I want to move my Pegasus Mail files to it from my old machine. How can I do this?

Follow these steps -

1: Install Pegasus Mail normally on the new machine. Create a mailbox for yourself.
2: Run Pegasus Mail on the new machine, then without doing anything else, select "Help", then "About Pegasus Mail". Click the "Info" button, and find the entry in the list called "Home mailbox location". Note this directory down on a piece of paper, then cancel out of the dialog and quit from Pegasus Mail immediately.
3: Run Pegasus Mail on the old machine. Repeat the steps in (2), noting down your old mail directory.
4: Copy all the files from the directory you found in (3) into the directory you found in (2). The easiest way to do this is usually across a network if you have one, or via a PC-connection program such as PC-Anywhere, but you can also do it using floppies, CD-Rs or backup programs. Be careful if using CD-Rs to do the copy - the files may be marked read-only when you copy them to the new location; if this is the case, you must remove the read-only flag before attempting to run Pegasus Mail.
The next time you run Pegasus Mail on the new machine, it should see all the same mail files and settings that you previously used on your old system.

I installed Pegasus Mail in Single-user mode but now I want to switch to Multi-user mode because I need more than one user. How can I do this and keep all my existing mail files?

Follow these steps:

1: Run your single-user copy of Pegasus Mail, select "Help", then "About Pegasus Mail". Click the "Info" button, and find the entry in the list called "Home mailbox location". Note this directory down on a piece of paper, then cancel out of the dialog and quit from Pegasus Mail immediately.

2: Make sure that Pegasus Mail is not running. Now, in the directory where Pegasus Mail is installed, locate the file PMAIL.CFG. Delete this file.

3: Run Pegasus Mail again. It will behave as if being started for the first time. Choose Multi-user mode, tell Pegasus Mail where to place your mailbox directories, then create a user for yourself and login as that user.

4: Select "Help", then "About Pegasus Mail". Click the "Info" button, and find the entry in the list called "Home mailbox location". Note this directory down on the piece of paper you used in (1), then cancel out of the dialog and quit from Pegasus Mail immediately.

5: Copy all the files in the directory you noted down in (1) into the directory you noted down in (4). You can use Windows Explorer or a DOS COPY command in a command prompt session to do this.

The next time you run Pegasus Mail as the new user, it should see all the same mail files and settings that you previously had in single-user mode. Once you are sure that the files have been safely transferred, you can delete the contents of the directory you noted down in (1).

Some of my correspondents send me messages with very long lines that run off the end of the window when I read them in Pegasus Mail. How can I view these long lines in Pegasus Mail?

Use one of Pegasus Mail's wrapping functions. Press <F5> to reformat the lines in the message, or press <Ctrl+F5> to perform simple wrapping of the lines at the space nearest to the right margin. These options appear on the Reader menu in the program while you are reading the message.

When I send an Internet message, the Pegasus Mail status bar shows two messages being sent, even though I actually only sent one. What is the mysterious second message?

Only one message is actually sent. For a brief period while the message is being processed, two copies of it exist in the mail queue - the "interim" version that you created when you pressed the Send button in the message editor, and a "final form" version prepared by Pegasus Mail for delivery to the Internet. Once the final form version has been successfully sent, the interim version is deleted. Pegasus Mail is simply being over-helpful in reporting the existence of both versions to you.

Any time I try to send an Internet message, I get an error back from Pegasus Mail that says something like "550 relaying denied", or "550 we do not relay, sorry".

This isn’t actually an error from Pegasus Mail – it is simply reporting back to you an error that it has received from your ISP’s server. Your ISP's mail server has been configured not to accept mail on behalf of senders it does not recognize, and it does not recog-
nize you. A properly-configured server should accept mail based on your workstation's Internet IP address, not your mail address, but there are some that only check the address in the "From" field. Choose Internet Options from the Pegasus Mail Tools menu and check that your e-mail address is correct - you should probably ring your ISP's helpdesk and confirm that the address is the right one.

You may also find that your ISP requires SMTP authentication in order to send mail via their servers. Pegasus Mail supports SMTP authentication using two separate methods, called CRAM-MD5 and LOGIN. You will need to configure Pegasus Mail to use SMTP authentication using the options on the SMTP page of the Internet Options dialog on the Tools menu.
Index

This index is hyperlinked: if you are using Adobe Acrobat Reader 4 or later, you can jump to any indexed entry by clicking on the page number at the right of the column.

(Copy) .......................... 34, 71
(Delete line) ...................... 29
(Delete word right) .............. 29
(Distribution lists) ............... 100
(Expand glossary) ................. 35
(Local user list) .................. 102
(Logged-in users) ................. 103
(Mail folders) ..................... 46
(Message options) ................. 32
(Paste) ............................. 35
(Preferences) ...................... 107
(Save message) .................... 28
(Select all) ....................... 71
(key) .............................. 33

Symbols

27

Numerics

8-bit data .......................... 118

A
Abbreviations ........................ 34
Abbreviations, expanding .......... 127
Accelerator ........................ 11
Address books ........................ 24, 95, 103
   aliasing .......................... 96
   deleting entries .................. 97, 98
   e-mail address field .......... 97
   finding text ....................... 99
   key field ........................ 97
   length restrictions .............. 97
   name field ........................ 96
   selecting addresses from ......... 24
   sorting ............................ 99
   system-wide ....................... 95, 96
Address completion ................. 100, 113
Addressbook menu ................... 95
Addresses
   address books ...................... 24, 95, 97, 103
   Addressing Centre ................. 24
   aliases ............................ 24
   definition ........................ 23
   distribution lists ................. 24
   Internet ........................... 39
   Local NetWare ...................... 38
   menu ............................... 102
   MHS ................................. 40
   MHS Extended ........................ 40
   overrides .......................... 40
   pasting from address books ...... 24, 98
   selecting for replies .............. 55
   Alert sounds ...................... 125
   Aliasing ........................... 24, 96, 98
   allows ............................. 15
   Alt key ............................ 11
   Annotations ....................... 62
   ASCII text ........................ 36
   Attachment preview, setting default state 120
   Attachments ........................ 35
   adding ............................. 37
   adding messages .................. 38
   deleting ........................... 66
   encoding .......................... 36
   ASCII text 36
   binhex 37
   how WinPMail decides .......... 37
   no encoding 36
   uuencoding 36
   file name ........................ 35
   file type ........................ 36
   filtering and removing ........... 76
   message indicator ................ 52
   removing .......................... 37
   saving to disk .................... 66
   viewing ........................... 66
   working with ...................... 65
   Audit trails ...................... 81
   Autoreplacement ................... 126
   Autoreplacement and multiple languages 127
   Autosave .......................... 113
   B
   Background pictures ............... 31
   BCC (Blind carbon copy) ......... 32
   Becoming another user ............. 15
   BinHex ............................ 37, 62
   Boilerplate text ................... 34
   Broadcast messages ................. 103
   C
   CASTOFF (NetWare command) ....... 99
   CC (Carbon copy) .................. 26
   copying into reply ................ 55
   Certificates (SSL) ................ 140
   Check consistency (folder) ....... 48
   Circulation messages ............... 23, 26
   Classic mode (folder view) ....... 46
copy to self ............................. 26
copying mail between .................. 53
creating ................................ 47
deleting ................................ 47
getting info ............................. 53
moving mail between .................. 53
Public .................................. 163
renaming ................................ 47
selecting ................................. 46
sorting .................................. 61
system-wide ............................. 46
Folders menu ........................... 48
Followup ................................ 105
Font
  in message editor ..................... 29
  in message reader .................... 68
Formatting
  disabling ............................. 113
  turning on by default .............. 112
Forwarding mail ......................... 53, 56
  when using WinSock .................. 130
G
Gateways ............................... 40
Global whitelist ....................... 70, 93
Glossary ................................ 34
Graphics, displaying when reading a message ......................... 69
Grouped views
  Preference settings ................. 119
Groups .................................. 39, 102
H
Headers
  adding to messages ................... 85
  definition ............................ 11
HTML .................................. 67
  special Content Control tests for 87
HTML mail, displaying by default .... 120
Hubs (MHS) ............................. 40
Hyperlinks
  inserting into messages ............ 31
Hyperlinks, selecting text and opening as 68
I
Identities ............................... 150
  using in new mail messages ........ 150
  using in replies ..................... 150
iFrame
  detecting using Content Control ... 87
Import
  addressbooks ........................ 98
Import text ............................ 28
Include original message ............ 54
Info (message) ......................... 53
Installation ........................... 12
Internet ................................ 37
  addresses ............................ 39
  gateways ............................. 39
  mail standard (RFC822) .......... 39
K
Key management ....................... 63
Keywords
  entering in messages .............. 23
L
Lazy HTML ............................. 87
link folder ............................. 52
Link folders .......................... 119
Local user list ......................... 102
Location of files ...................... 13
Long filenames ....................... 11
M
Macintosh ............................. 37
Mail between servers .................. 40
Mail Merge ............................ 41
Mailing to groups ..................... 39, 102
Mailto
  URLs .................................. 65
Memory stick, installing on .......... 15
Menu
  definition ............................ 11
  system ................................ 18
Menu bar ................................ 11
Mercury ................................. 153
Message digests ....................... 70
Message drafts ......................... 28
Message expiry ........................ 33
Message menu .......................... 28
Message width ........................ 33
MHS .................................. 37, 40, 103, 127
  extended addresses ................. 40
  hubs .................................. 40
  mailbox name ......................... 128
  new mail folder ...................... 128
  username ............................. 128
MHS directory service ................. 103
MIME ................................. 118, 122
  digests ................................ 70
  encoding ............................. 37
Minimize ................................ 18
MultiPOP ............................... 142
N
Netscape ............................... 65
NetWare Global MHS .................. 127
NetWare MHS ........................... 40
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetWare user groups</td>
<td>39, 102</td>
</tr>
<tr>
<td>Network configuration</td>
<td>16</td>
</tr>
<tr>
<td>Newmail filtering</td>
<td>46, 72</td>
</tr>
<tr>
<td>Next button (reader)</td>
<td>64</td>
</tr>
<tr>
<td>Next/Prev skipping mode</td>
<td>64</td>
</tr>
<tr>
<td>Notepad</td>
<td>36</td>
</tr>
<tr>
<td>Noticeboards</td>
<td>105</td>
</tr>
<tr>
<td>mailing to (NB override)</td>
<td></td>
</tr>
<tr>
<td>Obfuscated text</td>
<td>88</td>
</tr>
<tr>
<td>detecting using Content Control</td>
<td></td>
</tr>
<tr>
<td>Open saved message</td>
<td>28</td>
</tr>
<tr>
<td>Other message options</td>
<td>32</td>
</tr>
<tr>
<td>Overrides (addressing)</td>
<td>40</td>
</tr>
<tr>
<td>Paste</td>
<td>35</td>
</tr>
<tr>
<td>as quote into message</td>
<td>29</td>
</tr>
<tr>
<td>Into fields</td>
<td>102</td>
</tr>
<tr>
<td>unwrapped into messages</td>
<td>29</td>
</tr>
<tr>
<td>Pasting plain text</td>
<td>113</td>
</tr>
<tr>
<td>Personal name</td>
<td>107</td>
</tr>
<tr>
<td>PGP (Pretty Good Privacy)</td>
<td>63</td>
</tr>
<tr>
<td>PH directory interface</td>
<td>153</td>
</tr>
<tr>
<td>phishing</td>
<td>124</td>
</tr>
<tr>
<td>Pictures</td>
<td></td>
</tr>
<tr>
<td>in mail messages</td>
<td>31</td>
</tr>
<tr>
<td>using in tables and signatures</td>
<td>31</td>
</tr>
<tr>
<td>Pictures, displaying in messages</td>
<td>121</td>
</tr>
<tr>
<td>Plug-in modules</td>
<td>38</td>
</tr>
<tr>
<td>Pornographic mail</td>
<td>81</td>
</tr>
<tr>
<td>filtering using Content Control</td>
<td></td>
</tr>
<tr>
<td>Preconfiguring a mailbox</td>
<td>13</td>
</tr>
<tr>
<td>Preferences</td>
<td></td>
</tr>
<tr>
<td>default reply address</td>
<td>116</td>
</tr>
<tr>
<td>leave read new mail</td>
<td>108</td>
</tr>
<tr>
<td>open new mail at startup</td>
<td>107</td>
</tr>
<tr>
<td>personal name</td>
<td>107</td>
</tr>
<tr>
<td>preserve deleted messages</td>
<td>107</td>
</tr>
<tr>
<td>Preserve deleted messages</td>
<td>53, 107</td>
</tr>
<tr>
<td>Prev button (reader)</td>
<td>64</td>
</tr>
<tr>
<td>Preview mode</td>
<td>46</td>
</tr>
<tr>
<td>Preview mode vs Classic mode</td>
<td>46</td>
</tr>
<tr>
<td>Printing</td>
<td>64</td>
</tr>
<tr>
<td>Printing, specifying font</td>
<td>120</td>
</tr>
<tr>
<td>Reading mail</td>
<td>64</td>
</tr>
<tr>
<td>Redo</td>
<td>29</td>
</tr>
<tr>
<td>Reformat line breaks</td>
<td>56</td>
</tr>
<tr>
<td>Reformating, margin for</td>
<td>120</td>
</tr>
<tr>
<td>Registry</td>
<td>124</td>
</tr>
<tr>
<td>Regular expressions</td>
<td></td>
</tr>
<tr>
<td>case sensitivity</td>
<td>90</td>
</tr>
<tr>
<td>in Content Control</td>
<td>89</td>
</tr>
<tr>
<td>matching anywhere in text</td>
<td>90</td>
</tr>
<tr>
<td>Reindex folder</td>
<td>48</td>
</tr>
<tr>
<td>Remote-linked graphics</td>
<td>69, 121</td>
</tr>
<tr>
<td>Replace text</td>
<td>28</td>
</tr>
<tr>
<td>Reply address, setting</td>
<td>32, 117</td>
</tr>
<tr>
<td>Replying to all</td>
<td>55</td>
</tr>
<tr>
<td>Replying to mail</td>
<td>53</td>
</tr>
<tr>
<td>Resize window</td>
<td>18</td>
</tr>
<tr>
<td>RFC822</td>
<td>39</td>
</tr>
<tr>
<td>Rich text</td>
<td>117</td>
</tr>
<tr>
<td>RTF (Rich Text Format)</td>
<td>67</td>
</tr>
<tr>
<td>Rules</td>
<td>46, 72</td>
</tr>
<tr>
<td>exact text match</td>
<td>75</td>
</tr>
<tr>
<td>Runtime-loadable encryptors</td>
<td>27</td>
</tr>
<tr>
<td>S</td>
<td></td>
</tr>
<tr>
<td>Save message</td>
<td>28</td>
</tr>
<tr>
<td>Save to disk</td>
<td>61</td>
</tr>
<tr>
<td>Save window size</td>
<td>67</td>
</tr>
<tr>
<td>Saving a message you are working on</td>
<td>27</td>
</tr>
<tr>
<td>Scroll bars</td>
<td>18</td>
</tr>
<tr>
<td>Search result folders</td>
<td>119</td>
</tr>
<tr>
<td>Selecting messages</td>
<td>58</td>
</tr>
<tr>
<td>Selective download of mail</td>
<td>141</td>
</tr>
<tr>
<td>Sending mail</td>
<td>27</td>
</tr>
<tr>
<td>Servers</td>
<td></td>
</tr>
<tr>
<td>mail between</td>
<td>40</td>
</tr>
<tr>
<td>Signature</td>
<td></td>
</tr>
<tr>
<td>defining</td>
<td>114</td>
</tr>
<tr>
<td>omitting</td>
<td>26</td>
</tr>
<tr>
<td>variable</td>
<td>115</td>
</tr>
<tr>
<td>SMF</td>
<td>127</td>
</tr>
<tr>
<td>SMTP</td>
<td>10</td>
</tr>
<tr>
<td>Sorting mail messages</td>
<td>61</td>
</tr>
<tr>
<td>Sounds, new mail alerts</td>
<td>125</td>
</tr>
<tr>
<td>Source routing</td>
<td>40</td>
</tr>
<tr>
<td>Spam</td>
<td></td>
</tr>
<tr>
<td>detecting using Content Control</td>
<td>80</td>
</tr>
<tr>
<td>Spamhalter</td>
<td>70</td>
</tr>
<tr>
<td>Speedsearch, in folder names</td>
<td>47</td>
</tr>
<tr>
<td>SSL</td>
<td>139</td>
</tr>
<tr>
<td>Ports</td>
<td>140</td>
</tr>
<tr>
<td>STARTTLS (SSL command)</td>
<td>139</td>
</tr>
<tr>
<td>Stationery</td>
<td>28</td>
</tr>
<tr>
<td>Subject</td>
<td></td>
</tr>
<tr>
<td>field</td>
<td>25</td>
</tr>
<tr>
<td>System menu</td>
<td>18</td>
</tr>
<tr>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>Quick actions</td>
<td>62</td>
</tr>
<tr>
<td>Quick folders</td>
<td>48</td>
</tr>
<tr>
<td>R</td>
<td></td>
</tr>
<tr>
<td>Read text into message</td>
<td>28</td>
</tr>
<tr>
<td>Reader menu</td>
<td>64, 67</td>
</tr>
<tr>
<td>O</td>
<td></td>
</tr>
<tr>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Pasting plain text</td>
<td>113</td>
</tr>
<tr>
<td>Personal name</td>
<td>107</td>
</tr>
<tr>
<td>PGP (Pretty Good Privacy)</td>
<td>63</td>
</tr>
<tr>
<td>PH directory interface</td>
<td>153</td>
</tr>
<tr>
<td>phishing</td>
<td>124</td>
</tr>
<tr>
<td>Pictures</td>
<td></td>
</tr>
<tr>
<td>in mail messages</td>
<td>31</td>
</tr>
<tr>
<td>using in tables and signatures</td>
<td>31</td>
</tr>
<tr>
<td>Pictures, displaying in messages</td>
<td>121</td>
</tr>
<tr>
<td>Plug-in modules</td>
<td>38</td>
</tr>
<tr>
<td>Pornographic mail</td>
<td>81</td>
</tr>
<tr>
<td>filtering using Content Control</td>
<td></td>
</tr>
<tr>
<td>Preconfiguring a mailbox</td>
<td>13</td>
</tr>
<tr>
<td>Preferences</td>
<td></td>
</tr>
<tr>
<td>default reply address</td>
<td>116</td>
</tr>
<tr>
<td>leave read new mail</td>
<td>108</td>
</tr>
<tr>
<td>open new mail at startup</td>
<td>107</td>
</tr>
<tr>
<td>personal name</td>
<td>107</td>
</tr>
<tr>
<td>preserve deleted messages</td>
<td>107</td>
</tr>
<tr>
<td>Preserve deleted messages</td>
<td>53, 107</td>
</tr>
<tr>
<td>Prev button (reader)</td>
<td>64</td>
</tr>
<tr>
<td>Preview mode</td>
<td>46</td>
</tr>
<tr>
<td>Preview mode vs Classic mode</td>
<td>46</td>
</tr>
<tr>
<td>Printing</td>
<td>64</td>
</tr>
<tr>
<td>Printing, specifying font</td>
<td>120</td>
</tr>
</tbody>
</table>
System messages window  . . . . . . 126
System-wide addressbooks  . . . . . . 95
System-wide folders  . . . . . . . . . . . 46

T
Tab key  . . . . . . . . . . . . . . . . . . . 10
Tables
  creating  . . . . . . . . . . . . . . . . . . 31
  resizing  . . . . . . . . . . . . . . . . . . 31
Tabs  . . . . . . . . . . . . . . . . . . . . . 33
TCP/IP  . . . . . . . . . . . . . . . . . . . 15
Telltale window  . . . . . . 125, 133
Templates  . . . . . . . . . . . . . . . . . . 38
  using in replies  . . . . . . . . . . . . 56
Threading  . . . . . . . . . . . . . . . . . . 61
Thumb (scroll bar)  . . . . . . . . . . . . 18
To
  field  . . . . . . . . . . . . . . . . . . . . 25
Transcripts  . . . . . . . . . . . . 32, 112
Trays  . . . . . . . . . . . . . . . . . . . . . 46

U
Undo  . . . . . . . . . . . . . . . . . . . . . 29
Unix  . . . . . . . . . . . . . . . . . . . . . 36
  mailbox format  . . . . . . . . . . . . . . 47
Urgent mail  . . . . . . . . . . . . 26, 52
URL  . . . . . . . . . . . . . . . . . . . . . 65
URLPROXY.EXE  . . . . . . . . . . . 123
User groups  . . . . . . . . . . . . . . . . . 39
Usercodes
  as addresses  . . . . . . . . . . . . . . . . 102
User-defined gateways  . . . . . . . . . . 40
UUencoding  . . . . . . . . . . . . . 36, 62

V
Viewing attachments  . . . . . . 66, 122

W
WAV files (sounds)  . . . . . . . . . . . 125
Web browser, opening message in . . 68
Web bugs  . . . . . . . . . . . . . . . . . . 69
Whitelist  . . . . . . . . . . . . . . . . . . . 93
Windows
  closing  . . . . . . . . . . . . . . . . . . 18
  maximize, minimize  . . . . . . . . . . 18
  resizing  . . . . . . . . . . . . . . . . . . 18
  saving size  . . . . . . . . . . . . . . . . . 67
WINSOCK.DLL  . . . . . . . . . . . 109, 129
Word processor  . . . . . . . . . . . . . 28, 36
World Wide Web  . . . . . . . . . . . . . 65

X
X.400  . . . . . . . . . . . . . . . . . . . . 40